LXR•TEST 6.0 Created By: Mark Biewer, Bill Lair, Sue Prine and Rhett Tindall.
LXR•TEST 6.0 User’s Guide Documentated By: Eric C. Peng, with contributions from Jera Lewis.

Special thanks to our tens of thousands of enthusiastic users whom we’re dedicated to serve.

LXR•TEST Serial Number: __ __ __ __ __ __ __ __ (e.g., LX – 012345)

LXR•TEST Product Support: All copies of LXR•TEST are assigned a software key, that contains a unique serial number, which is enclosed with the registration card. The serial number is the first set of six digits, following the two letter prefix. Record this serial number in the space provided above for quick reference. When contacting our product support specialists, you will be asked to provide a registered serial number.

Please complete and return the registration card today! It is very important that you promptly return your Registration Card. We only provide warranty support to registered primary users. Proper registration will ensure you receive notification of important revisions or updates. If you have a change in the primary user of the software, please notify us using the Change of Primary User Card. At LXR, we respect your privacy. It is our policy not to release this information to third parties.

About Copy Protection and Piracy: LXR•TEST is not copy protected because we prefer not to punish the many honest users for the wrongs of, who we believe are, a few dishonest users. Instead, we have invested our resources into making LXR•TEST a better program and in prosecuting violators. We have put a lot of effort into developing a comprehensive assessment program which we believe is the very best. All we want is for users to pay for it. We have encountered people that believe (for more reasons than you can imagine) it is OK to make illegal copies of software. It’s not OK. In fact, software piracy is theft of what we do to earn a living. Please help by reporting offenders to us - you can make a difference! Thank you!

Proprietary Notices The software included in this document is a licensed product. The software may be used or copied only in accordance with the terms of the End User License Agreement, a copy of which is in Appendix K. If you have any questions about what constitutes legal or illegal use, please contact Logic eXtension Resources.

Third Party Notices: American, British, Spanish, French, medical and legal lexicons are copyright © 1999 Wintertree Software, Inc.

LXR•TEST is a trademark of Logic eXtension Resources, a division of Applied Measurement Professionals, Inc. All other product names are trademarks or registered trademarks of their respective owners.

Documentation Changes: Logic eXtension Resources reserves the right to periodically revise this documentation without any obligation to inform any person or organization.
# Table of Contents

**TABLE OF CONTENTS**

**ABOUT THE USER’S GUIDE**
- Structure of the User’s Guide ................................................................. 11
- Style of the User’s Guide ....................................................................... 13

**PART I: GETTING STARTED WITH LXR•TEST** ........................................... 15

**Chapter 1: LXR•TEST Introduction** ......................................................... 17
- What is LXR•TEST? .................................................................................. 19
- What’s New in 6.0? .................................................................................. 20
- Online Documentation & Resources ....................................................... 21
- Contacting LXR ....................................................................................... 21

**Chapter 2: LXR•TEST Installation** .......................................................... 23
- System Requirements ............................................................................ 25
- Package Contents .................................................................................. 25
- Installing the LXR•TEST Software ......................................................... 26
- Checking the Web for Program Updates ................................................ 27
- Updating Files From Prior Versions ....................................................... 27

**Chapter 3: LXR•TEST Tutorial** ............................................................... 29
- Quick Start ............................................................................................. 31
- Question Banking ................................................................................... 39
- Creating Question Banks ....................................................................... 46
- Test Development .................................................................................. 69
- Building Test Forms From Specifications ............................................. 89
- Scores Window Features ....................................................................... 95

**Chapter 4: LXR•TEST Reference** .......................................................... 101
- Main Window ......................................................................................... 103
- Projects Window .................................................................................. 107
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Questions Window</td>
<td>113</td>
</tr>
<tr>
<td>Tests Window</td>
<td>189</td>
</tr>
<tr>
<td>Specs Window</td>
<td>203</td>
</tr>
<tr>
<td>Scores Window</td>
<td>209</td>
</tr>
<tr>
<td>Grading Window</td>
<td>244</td>
</tr>
<tr>
<td>Students Window</td>
<td>251</td>
</tr>
<tr>
<td>Headers Window</td>
<td>261</td>
</tr>
<tr>
<td>Online Window</td>
<td>265</td>
</tr>
<tr>
<td>What About “Forms?”</td>
<td>267</td>
</tr>
</tbody>
</table>

**PART II: ONLINE TESTING**

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 5: Online Testing Introduction</td>
<td>273</td>
</tr>
<tr>
<td>Chapter 6: Online Testing Installation</td>
<td>275</td>
</tr>
<tr>
<td>Chapter 7: Online Testing Tutorial</td>
<td>279</td>
</tr>
<tr>
<td>Chapter 8: Online Testing Reference</td>
<td>299</td>
</tr>
</tbody>
</table>

**PART III: USING MARK READERS**

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 9: Mark Reader Introduction</td>
<td>323</td>
</tr>
<tr>
<td>Chapter 10: Mark Reader Installation</td>
<td>327</td>
</tr>
</tbody>
</table>
Reader Hardware and Forms Setup ................................................................. 329
Hardware and Software Verification ............................................................. 330

**Chapter 11: Mark Reader Tutorial** ............................................................... 335
Reading for Internally Created Test ................................................................. 337
Reading for Externally Created Test ................................................................. 339

**Chapter 12: Mark Reader Reference** .......................................................... 343
Mark Reader Menus ......................................................................................... 345
Mark Reader Hardware ................................................................................... 350
Mark Reader Forms.......................................................................................... 355
Mark Reader Troubleshooting .......................................................................... 359

**APPENDICES** ............................................................................................ 371
Appendix A: Glossary ....................................................................................... 373
Appendix B: Substitution Variables ................................................................. 379

**Appendix C: Merge Fields Names & Gradebook Format** ............................. 383
Questions File Merge Field Names ................................................................ 385
Specifications File Merge Field Names ......................................................... 387
Scores File Merge Field Names ...................................................................... 387
External Answer Key (Import) Merge Field Names ...................................... 387
Grading Table Merge Field Names ................................................................. 388
Students File Merge Field Names .................................................................. 388
Scores File Export Gradebook Format ........................................................... 389

**Appendix D: Sample Reports** .................................................................... 393

**Appendix E: Mark Reader Hardware** ......................................................... 425
Chatsworth 1000 ............................................................................................ 427
Chatsworth 2000 ............................................................................................ 429
National Computer Systems Sentry 3000 .................................................. 431
National Computer Systems Sentry 3051 & Sentry 3061 ............................ 435
National Computer Systems OpScan 2, 3, 4, 4XP ...................................... 439
National Computer Systems OpScan 5, 6, 7, 8 .......................................... 443
Scanning Systems SR-360 & SR-360V ........................................................... 447
Scanning Systems SR-380 & SR-380V ........................................................... 449
Scanning Systems SR-601 .............................................................................. 451
Scanning Systems SR-607 .............................................................................. 453
Scanning Systems SR-700 .............................................................................. 455
Scantron Corporation 1200, 2100, and 5100 ................................................. 459
Scantron Corporation 1300 ............................................................................ 463
Scantron Corporation 1400, 5200, 5200S ....................................................... 467
6 | Table of Contents

Scantron Corporation 8000, 8200, 8400, 8600 ................................................................. 471
Scantron Corporation Scanmark 2000, 2010, 2250, 2260, 2500 ....................................... 475

Appendix F: Sample Forms ..................................................................................................479
Appendix G: Keyboard Shortcuts ......................................................................................483

Appendix H: Online Web Setup .........................................................................................485
   Setting Up the LXRWeb Folder as an Application Under IIS ........................................ 486
   Setting File Permissions .................................................................................................488

Appendix I: Error Handling ...............................................................................................491

Appendix J: Upsizing to SQL Server 7 ............................................................................493

Appendix K: Licensing .......................................................................................................497
   End User License Agreement (EULA) ........................................................................... 497

INDEX .................................................................................................................................505

TABLE OF FIGURES

Figure 1: Questions Window ..............................................................................................47
Figure 2: Questions Window, LXR•TEST Toolbar, Tests Window ......................................69
Figure 3: Question Panel in Tests Window .........................................................................75
Figure 4: Selection Window ..............................................................................................85
Figure 5: Main Window .....................................................................................................103
Figure 6: ODBC DSN Option ...........................................................................................106
Figure 7: Projects Window ...............................................................................................107
Figure 8: Questions Window ............................................................................................113
Figure 9: Relocate Question Toolbar Window ..................................................................117
Figure 10: Questions Window With New Question Toolbar Location ..............................118
Figure 11: Question Toolbar .............................................................................................118
Figure 12: Navigation Toolbar ........................................................................................120
Figure 13: Selection Toolbar ............................................................................................122
Figure 14: Layout Toolbar ...............................................................................................123
Figure 15: Answers Area: Free Format, Open-Ended Response ......................................125
Figure 16: Answers Area: Free Format, Letter Response ................................................126
Figure 17: Answers Area: Free Format, Short Answer Response .....................................126
Figure 18: Answers Area: Free Format, Numeric Response ............................................126
Figure 19: Answers Area: Free Format, Scientific Response ...........................................127
Figure 20: Answers Area: True / False ............................................................................127
Figure 21: Answers Area: Multiple Choice, Single Response .........................................128
Figure 22: Answers Area: Multiple Choice, Multiple Response ......................................129
Table of Contents

FIGURE 69: SCORES TOOLBAR ................................................................. 213
FIGURE 70: SCORE REPORTS: SCORE DESCRIPTION SETUP .................. 214
FIGURE 71: SCORE REPORTS: ITEM STATISTICS SETUP ......................... 215
FIGURE 72: SCORE REPORTS: TEST STATISTICS SETUP ......................... 217
FIGURE 73: SCORE REPORTS: INDIVIDUAL FEEDBACK SETUP .................. 218
FIGURE 74: SCORE REPORTS: INDIVIDUAL SCORES SETUP ..................... 219
FIGURE 75: SCORE REPORTS: GROUP DETAIL SETUP ................................ 220
FIGURE 76: SCORE REPORTS: GROUP SUMMARY SETUP .......................... 221
FIGURE 77: SCORE REPORTS: SCORE DISTRIBUTION SETUP ................... 223
FIGURE 78: SCORE REPORTS: SCORE SUMMARY SETUP .......................... 224
FIGURE 79: SCORE REPORTS: DEMOGRAPHICS SETUP ............................ 225
FIGURE 80: SCORE REPORTS: MASTERY SPECIFICATION SETUP .............. 226
FIGURE 81: SCORE REPORTS: MASTERY DIRECTORY SETUP ..................... 228
FIGURE 82: SCORE REPORTS: MASTERY SUMMARY SETUP ...................... 229
FIGURE 83: SCORE REPORTS: GROUP MASTERY SETUP .......................... 231
FIGURE 84: SCORE REPORTS: MASTERY COMPARISON SETUP .................. 232
FIGURE 85: SCORE REPORTS: INDIVIDUAL MASTERY SETUP .................... 234
FIGURE 86: GRADEBOOK EXPORT (SCORES) FIELDS ............................... 237
FIGURE 87: VALID SHORT FIELD NAMES ................................................. 238
FIGURE 88: DEMOGRAPHICS WINDOW ...................................................... 242
FIGURE 89: RESPONSE WINDOW ............................................................ 242
FIGURE 90: GRADING WINDOW ............................................................... 245
FIGURE 91: GRADING TABLE REPORT SETUP .......................................... 249
FIGURE 92: STUDENTS WINDOW ............................................................. 251
FIGURE 93: STUDENTS TOOLBAR ........................................................... 253
FIGURE 94: STUDENT REPORTS: STUDENT LISTING SETUP ..................... 255
FIGURE 95: STUDENT REPORTS: PRESLUG FORMS SETUP ...................... 256
FIGURE 96: HEADERS WINDOW ............................................................... 261
FIGURE 97: HEADERS LAYOUT TOOLBAR ............................................... 263
FIGURE 98: HEADER/FOOTER/COVER SETUP ......................................... 264
FIGURE 99: EXAMPLE OF A SCORES FILE ASSOCIATION WITH TEST FORM 0 269
FIGURE 100: EXAMPLE OF A SCORES FILE ASSOCIATION WITH TEST FORM 1 270
FIGURE 101: EXAMPLE OF A SCORES FILE ASSOCIATION WITH TEST FORM 2 15
FIGURE 102: ONLINE WINDOW SETUP, LAN TEST .................................. 302
FIGURE 103: ONLINE WINDOW ACCESS ................................................ 304
FIGURE 104: ONLINE WINDOW ADMIN ................................................... 305
FIGURE 105: ONLINE WINDOW DISPLAY ............................................... 306
FIGURE 106: ONLINE WINDOW REPORT ............................................... 307
FIGURE 107: ONLINE LAN LOGON WINDOW ........................................... 315
FIGURE 108: ONLINE LAN COVER PAGE WINDOW ................................... 315
FIGURE 109: ONLINE LAN TESTS WINDOW ............................................. 316
FIGURE 110: ONLINE WEB LOGON WINDOW (WITH PASSWORD OPTION) ........ 318
FIGURE 111: ONLINE WEB COVER PAGE WINDOW ................................... 318
FIGURE 112: ONLINE WEB TESTS WINDOW ............................................ 319
FIGURE 113: READER SETUP ................................................................. 345
FIGURE 114: FORM SETUP ..................................................................... 347
FIGURE 115: QUESTIONS REPORT ................................................................. 395
FIGURE 116: BANK INFORMATION REPORT .............................................. 396
FIGURE 117: BANK LISTING REPORT ......................................................... 397
FIGURE 118: ITEM DISTRIBUTION REPORT .............................................. 398
FIGURE 119: BANK LINK REPORT .............................................................. 399
FIGURE 120: TEST ..................................................................................... 400
FIGURE 121: ANSWER KEY REPORT ......................................................... 401
FIGURE 122: RESPONSE BOOKLET REPORT ........................................... 402
FIGURE 123: TEST DESCRIPTION REPORT .............................................. 403
FIGURE 124: TEST SPECIFICATION REPORT .......................................... 404
FIGURE 125: SPECIFICATION OVERLAP REPORT .................................... 405
FIGURE 126: SCORE DESCRIPTION REPORT ............................................. 406
FIGURE 127: ITEM STATISTICS REPORT .................................................. 407
FIGURE 128: TEST STATISTICS REPORT .................................................. 408
FIGURE 129: INDIVIDUAL FEEDBACK REPORT ........................................ 409
FIGURE 130: INDIVIDUAL SCORES REPORT ............................................ 410
FIGURE 131: GROUP DETAIL REPORT ....................................................... 411
FIGURE 132: GROUP SUMMARY REPORT ................................................ 412
FIGURE 133: SCORE DISTRIBUTION REPORT .......................................... 413
FIGURE 134: SCORE SUMMARY REPORT ................................................ 414
FIGURE 135: DEMOGRAPHICS REPORT .................................................... 415
FIGURE 136: MASTERY SPECIFICATION REPORT .................................... 416
FIGURE 137: MASTERY DIRECTORY REPORT .......................................... 417
FIGURE 138: MASTERY SUMMARY REPORT ............................................ 418
FIGURE 139: MASTERY GROUP REPORT ................................................ 419
FIGURE 140: MASTERY COMPARISON REPORT ...................................... 420
FIGURE 141: INDIVIDUAL MASTERY REPORT ........................................ 421
FIGURE 142: GRADING TABLE REPORT ................................................... 422
FIGURE 143: STUDENT LISTING REPORT ............................................... 423
FIGURE 144: LXR•TEST RESPONSE FORM 20020 .................................... 481
FIGURE 145: LXR•TEST RESPONSE FORM 26133 ................................... 482
Structure of the User’s Guide

The structure of the LXR•TEST 6.0 User’s Guide follows the nature of the LXR•TEST program and its software options. Since the LXR•TEST 6.0 software has three components – main software, mark reader option, and online testing option – the body of the User’s Guide has three parts.

Part I of the User’s Guide (Chapters 1-4) covers the main LXR•TEST software. Also known as the “authoring component”, the main LXR•TEST software enables you to create and manage your questions, build tests from question banks, and manually score and track test results.

Tip! If you are an experienced user of a previous version of LXR•TEST software, then you may want to jump straight to the “Quick Start” tutorial in chapter 3 (beginning on page 31).

- **Chapter 1: LXR•TEST Introduction** (beginning on page 17) briefly surveys the many capabilities of the LXR•TEST 6.0 software, and provides references on how to contact LXR, should you have future sales, support, and training needs.
- **Chapter 2: LXR•TEST Installation** (beginning page 23) summarizes the package contents of your LXR•TEST purchase and presents both minimum and recommended system requirements for running the main LXR•TEST software.
- Chapter 3: LXR•TEST Tutorial (beginning on page 29) walks you through basic program use, through a series of tutorial topics: from entering questions to building tests. The later part of the chapter does contain a few tutorials on using the more intermediate/advanced features of the main LXR•TEST software.
- **Chapter 4: LXR•TEST Reference** (beginning on page 101) explains in detail the various windows and controls of the main LXR•TEST software. Descriptions follow the order of the program’s toolbar and menu items.
Part II of the User’s Guide (Chapters 5-8) covers the Online Testing Option portion of the LXR•TEST software. The Online Testing Option enables you to create computer-based tests which you can administer either over a local area network, or over the World Wide Web.

- Chapter 5: Online Testing Introduction (beginning on page 273) briefly introduces the concept and practice of online testing, explains how LXR•TEST accomplishes online testing, and considers possible advantages and disadvantages to employing online testing.

- Chapter 6: Online Testing Installation (beginning page 275) provides an overview of the installation and setup requirements for LAN-based or Web-based testing.

- Chapter 7: Online Testing Tutorial (beginning on page 279) walks you through both the creation and administration of a LAN-based test as well as of a Web-based test.

- Chapter 8: Online Testing Reference (beginning on page 299) explains in detail the Online Window, and the controls of the Student LAN Client software and the controls of the Web browser, when logged into a Web-based test. Descriptions of the Online Window follow the order of the Online toolbar and menu items.

Part III of the User’s Guide (Chapters 9-12) covers the Mark Reader Option portion of the LXR•TEST software. The Mark Reader Option enables you to interface the LXR•TEST software with an optical mark reader in order to scan results from bubble sheets. Using an optical mark reader with LXR•TEST allows for the rapid collection of test results, which can then be easily summarized in the various LXR•TEST report formats (as discussed in Part I).

- Chapter 9: Mark Reader Introduction (beginning on page 323) briefly introduces the concept and practice of using an optical mark reader (OMR), as well as LXR•TEST’s enhanced scoring capabilities when interfaced with a compatible OMR and supported OMR forms are used.

- Chapter 10: Mark Reader Installation (beginning page 327) covers the setup procedures to properly interface compatible OMR and OMR forms for use with LXR•TEST.

- Chapter 11: Mark Reader Tutorial (beginning on page 335) walks you through using LXR•TEST to score tests created by LXR•TEST as well as tests not created by LXR•TEST. A brief discussion follows on interpreting the Item Statistics report for scanned survey results.

- Chapter 12: Mark Reader Reference (beginning on page 343) explains in detail the LXR•TEST menu items that correspond to OMR use. This section also surveys compatible OMR equipment and supported OMR forms, and provides a brief reference guide to troubleshooting common OMR-related LXR•TEST error messages.
Style of the User’s Guide

The User’s Guide was written to serve both as a guide for learning how to use the program, as well as a reference on the program controls and features. Please make note of the following stylistic protocol, which is used throughout this manual:

- Each part of the document is structured in the following format: begin with an introduction chapter, continue with an installation chapter, follow with a tutorial chapter, and conclude with a reference chapter. In addition, the beginning of most chapters will include a brief outline of the topics to be covered.
- While a program version number is usually specified when talking about LXR•TEST, if a program version number is not specified, assume that LXR•TEST 6.0 is the referenced version.
- The words “file” and “database” have the same meaning.
- Objective names in the tutorial exercises are in CAPITAL LETTERS.
- The symbol ▶ indicates a procedural step to be followed when the symbol is the first symbol from the left text margin; otherwise, the symbol ▶ indicates a submenu choice.
- The names of program windows and controls are boldfaced in procedural steps.
- Filenames and text to be typed during procedural steps are in Courier font; existing filenames will also be in Courier font.
- Filenames not included in procedural steps will be indicated by double quotation marks.
- Web addresses such as www.lxr.com will also be in Courier font.
- Since Windows is a very visual-oriented system, most of the instructions in this manual are based on using mouse actions. In most cases, keyboard methods are not discussed. However, a complete listing of shortcut keys can be found in Appendix G: Keyboard Shortcuts. All references to double-clicking or clicking refer to the leftmost or first button on your pointing device (mouse, track ball, etc.), unless stated otherwise.
- To explain the differences between a note, tip, or caution:
  
  Note: A note designates either additional information pertaining to a topic, or an additional procedural step related to the current discussion.

  Tip! A tip is a helpful suggestion, which is optional to the current discussion.

  CAUTION! A caution is critical information to pay attention to; failure to do so may result in undesirable results.
Part I: Getting Started with LXR•TEST
Chapter 1: LXR•TEST
Introduction

Chapter Overview:

What is LXR•TEST?.........................19
What’s New in 6.0?..........................20
Additional Resources......................21
Contacting LXR.............................21
What is LXR•TEST?

Congratulations on your purchase of LXR•TEST! We know of no other assessment software on the market which allows you to create and administer exams in both paper and pencil format and in computer format, while also incorporating optical mark reader scanning capability. In fact, we believe you have purchased the best “total package” assessment software on the market today. If you are a new user of LXR•TEST, we briefly introduce the software below and hope you will find LXR•TEST’s features powerful, its ease-of-use flexible, and its scope of assessment capabilities extensive. If you are a returning user of LXR•TEST, you may want to skip ahead to the next section entitled “What’s New in 6.0?”

LXR•TEST combines question banking, test creation, scoring and report analysis capabilities into a single comprehensive assessment package. While LXR•TEST is intended for use across all levels of educational assessment, from grade school through university, LXR•TEST is equally applicable for use in industrial and commercial training and certification programs. In fact, anyone involved in assessment on a repetitive basis will benefit from the technologies encompassed in LXR•TEST.

LXR•TEST has various features, including: two-level question categorization, linking questions to reference material, enhanced question selection by user-defined criteria, historical question statistics, two and three column test layouts, multiple test sections, overall and section test scores, customizable headers and footers on numerous scoring and mastery achievement reports. Further, LXR•TEST can be used to process survey data, to provide detailed test results reporting, in student remediation, in student placement, in criterion-referenced testing, objectives-based assessment, and in analysis of instructional effectiveness.

There are optional software extensions that can be added to support optical mark readers or perform online, computer-based testing. LXR•TEST 6.0 is available only for the Windows operating environment. For required and recommended system specifications for running LXR•TEST, please refer to the section entitled “System Requirements” found on page 25. LXR•TEST is a licensed product; its use is governed by the End User License Agreement (EULA), located in Appendix K: Licensing.

Potential benefits of LXR•TEST—when combined with either the Mark Reader Option or the Online Testing Option—include increased instructional time, increased testing accuracy, shorten test administration time, instant feedback for students and increased formative learning for students.
What’s New in 6.0?

Our 6.0 release represents the most dramatic change in the LXR·TEST product line, which began in 1986. *Everything* about 6.0 is new from the foundation up, resulting in a comprehensive, state-of-the-art testing system. Through many “behind-the-scenes” changes, we have greatly enhanced LXR·TEST’s functionality, including a new database system that allows for high performance, scalable network use.

Here are a few of the visible changes you will experience in 6.0:

- Enhanced graphic and multimedia support – file support including: GIF, JPEG, TIFF, BMP, AVI, MOV, MPEG, WAV and more.
- Enhanced text-editing capabilities, including inline objects that wrap like text, colored text, automatic reformatting of text and easier-to-use margin controls.
- Support for ActiveX/OLE objects (i.e., directly imbedding or linking documents from other applications, such as word processors, spreadsheets, etc.)
- All new, Online Testing Option, featuring both LAN and Web-based test delivery, with multiple tests linking capability.
- Potential test items can be summarized in one of 10 different hierarchical classification schemes.
- Question feedback can be customized for every choice—or for the entire question.
- Resizable and moveable controls and grids.
- Multiple-form test construction can be done automatically, using user-defined specifications.
- Comprehensive, new grading tables that can establish mastery, partial mastery and non-mastery achievement thresholds; tests now can be scored against multiple grading tables.
- Dozens of new scoring and mastery achievement reports, including group comparisons and test section scoring features.
- Extensive, new statistics stored for each question, including per test and cumulative statistics, including average time students spent on any particular question (valid for LAN and Web-based tests).
- Scores database now can store student response records from multiple tests.
- Enhanced question linking (including “do not use with this item” feature), multi-response scoring, up to 26 multiple “choices”, fractional point values, longer categories (formerly called “key words”), new medical dictionary, import/export templates (including capability to export in Rich Text and HTML formats for use with other applications), HTML-based online help.
• Re-entrant online tests, and linked online tests.
• Database security feature.

There are far too many new features to list here. You'll want to take the time to read/learn about all the new features in LXR•TEST 6.0.

Online Documentation & Resources

Additional learning and reference resources relating to LXR•TEST, including information on new and updated program features, can be found at our web site.

www.lxr.com

Should you have a need to further your skills on LXR•TEST use, you also can learn about upcoming training classes on our web site.

Contacting LXR

Our professional staff is ready to assist you with your LXR•TEST sales, support and training needs. To receive customer support, please contact your authorized reseller.

Address: Logic eXtension Resources
435 Marina Drive
Georgetown, SC 29440
U.S.A.

Telephone: 1-843-520-2992
Fax: 1-843-520-2994

E-mail:
Presales Questions: sales@lxr.com
Orders/ Upgrades: orders@lxr.com or visit our store on the Internet: store.lxr.com
Technical Support: support@lxr.com
Software Training: training@lxr.com

Office Hours: Monday - Friday
8:30 a.m. - 5:00 p.m. Eastern Standard Time
Chapter 2: LXR•TEST Installation

Chapter Overview:

System Requirements.................................25
Package Contents......................................25
Installing the LXR•TEST Software.................26
Checking the Web for Program Updates..........27
Updating Files From Prior Versions............27

The installation chapter covers the prerequisites prior to installation as well as the steps to follow to install LXR•TEST on your machine. An installation wizard program will facilitate the install process by automating many of the steps involved in installing the program.

After installing LXR•TEST, you can check for program updates on the web. This chapter also will discuss how you can update files from previous 5.x versions of LXR•TEST.
System Requirements

LXR·TEST 6.0 was designed to operate on a PC compatible microprocessor running a Windows operating system (98/ME/NT4/2000).

You will need:

- A hard disk with at least 50 megabytes of available disk space to perform the install. However, the software may use considerably less space after installation is complete. The actual disk space you will ultimately need will depend largely on the size of the question banks you plan to create or use.

- At least 64 megabytes of built-in memory is required. More memory will be needed if you incorporate large graphics, work with large question banks, generate online tests, perform large scoring runs, or run multiple programs simultaneously.

- A CD-ROM drive for installing the software.

The following are additional system recommendations:

- At least a Pentium 2 (200 Mhz or better) microprocessor.
- A minimal screen resolution of 800x600.

If you are also using the Mark Reader or Online Testing Option, refer to Part III or Part II, respectively, of the User’s Guide for additional installation details.

Package Contents

With your LXR·TEST package you should have received the following:

| Registration Card, Change of Primary User Card | It is very important that you promptly return your Registration Card. We only provide warranty support to registered primary users. Proper registration will ensure you receive notification of important revisions or updates. If you have a change in the primary user of the software, please notify us using the Change of Primary User Card. At LXR, we respect your privacy. It is our policy not to release this information to third parties. |
| User’s Guide | What you are currently reading. |
| Program Disk | The installation CD contains the LXR·TEST program and all supporting files, including the spelling checker, sample files, and LXR·TEST help file. The program disk label identifies the program version. |
Installing the LXR•TEST Software

LXR•TEST includes three different installation setup programs: Main Setup, Student LAN Client Setup, and Web Server Extensions Setup. (Refer to Chapter 6 for information on Student LAN Client Setup and Web Server Extensions Installation.)

Note: If you purchased the Online Testing Option with LXR•TEST 6.0, then the Online Testing Option will automatically be installed upon main program installation.

Follow these steps to install the LXR•TEST software:

Note: To install LXR•TEST or any of its components on Windows NT or Windows 2000, you first must be logged in with administrator status.

- Start Windows.
- Insert the LXR•TEST program CD into your CD-ROM drive.
- Double-click on My Computer.
- Double-click on the CD-ROM drive icon to access the LXR•TEST program CD.
- Double-click on the LXRTTest folder.
- Double-click on the Setup.exe program file.
- When prompted, enter your software key exactly as indicated with your registration card. You will not be permitted to continue the installation without the correct software key.
- Either accept the default program folder location (C:\Program Files\LXR\LXRTEST v6) for the LXR•TEST program or specify a new folder location.
- Choose Typical for the type of setup.
- Either accept the default Windows folder name (LXR•TEST 6.0) or specify a new folder name.
- Follow any remaining directions as presented.
Checking the Web for Program Updates

When LXR·TEST installs, it installs Start menu objects that allow for automatic checking and updating program components via the Web:

- “LXR·TEST Update via Internet” will navigate to our LXR web site and check for a revision of the core program that is newer than that installed on your machine. If there is a newer revision of the program, then you will be prompted to enter your software key before your program is automatically updated to the newer revision.
- The other two update objects in the Start menu: “Student LAN Client Update via Internet” and “Web Server Extensions Update via Internet”, function in similar fashion as the core program update object.

The LXR·TEST program itself will also contain an “LXRTEST Update” option in the Utilities menu. From this menu option, you also can check for version updates on our web site. If a newer update is found, it will automatically be downloaded and installed. After installation, you will have to exit LXR·TEST 6.0 and restart.

Updating Files From Prior Versions

If you have existing files created by LXR·TEST 5.1 (or 5.0) they will need to be updated to the new 6.0 format in order to be used in LXR·TEST 6.0. This update is done automatically by the LXR·TEST 6.0 program when you open the older 5.x files. The update process will save a converted copy of your 5.x file(s), while leaving your 5.x file(s) untouched.

Note: When you open your LXR·TEST 5.x files in LXR·TEST 6.0, you will need to set the “Files of type” box to “LXRTEST 5.1 Files”. This will cause the 5.x files to display in the Open dialog.
All LXR•TEST 5.x (Windows) files are upward compatible with LXR•TEST 6.0. Once files are updated to 6.0 format, the 6.0 copy of the files may *not* be used with older 5.x programs. There are several conversion preferences you may set in the File ➔ Preferences menu. Refer to page 155 for details.

**Tip!** You should always maintain a current, backup copy your data files before you do any significant work on them – including an update process.

If you have existing 5.x question databases in Macintosh format, you will need to use the Mac-to-Windows Bank Converter to convert the files into Windows format before you can convert them to 6.0 format. For your convenience, a 5.x Mac-to-Windows Bank Converter program has been included on the LXR•TEST 6.0 Professional installation CD, located in the Utilities/MacToWin folder.
Chapter 3: LXR•TEST Tutorial

Chapter Overview:

Quick Start...............................31
Question Banking.........................39
Creating Question Banks...............46
Test Development........................69
Building Test Forms From Specs.......89
Scores Window Features...............95

The tutorial chapter provides step-by-step tutorial lessons on LXR•TEST question and test basics, as well as advanced test building, question banking, score analysis, and other features.

Detailed information on program elements relating to each of these topics is included in Chapter 4 Reference.
Quick Start

To help you quickly get up and running with the LXR•TEST 6.0 program, this Quick Start Tutorial was designed to guide you through the procedures involved in working with projects, question banks, tests, and online LAN tests. It is highly recommended that if you work through this tutorial that you do so from its beginning to its end.

Note: This Quick Start tutorial will assume that you have a working knowledge of the Windows Operating System environment, and that you have experience with a prior version of LXR•TEST.

If you are a new user to LXR•TEST, it is recommended that you skip over this tutorial to the second one on “Question Banking,” beginning of page 39.

Projects Window

- From the Main Window, click the Projects button.
- Verify that the Project is set to Local and that the Common Project Directory is selected and set to C:\Documents and Settings\User Name\My Documents\LXRData\ You will store your files here.
- Click OK to close the Projects Window.
Creating a Question Bank

- From the Main Window, click the Questions button on the LXR•TEST toolbar.
- Choose Create a new Questions database. Click OK.
- Type in the name QuickStart.LXRBank. Click Save.
- Verify that Type is set as Multiple choice: single.
- Change the Objective from UNTITLED to TRIVIA.
- Now click in the empty space directly above the multiple-choice letters.
- Type in the following question: How many days are in February during a leap year?
- Click in (or TAB to) the A box, then type 28.
- Click in (or TAB to) the B box, then type 29.
- Click in (or TAB to) the C box, then type 30.
- Click in (or TAB to) the D box, then type 31.
- Click on letter B to checkmark the correct answer.
Your **Questions Window** should look like this:

![Image of a question bank](image)

- Click **Save** from the **File** menu, or press **CTRL+S** on the keyboard, to save the bank.

  Note: If you were to create another question this question would automatically be saved in the bank database.

Now that you know the basics of creating questions, you will open an existing bank that contains several questions in order to demonstrate how to build a test.
Building a Test

- Click **Projects** on the **LXR•TEST** toolbar.
- Change the **Project** to **Samples**.
- Click **OK** to close the **Projects Window**.
- Click **Questions** on the **LXR•TEST** toolbar.
- Choose **Open existing Questions database**. Click **OK**.
- Select **Sample Questions.LXRBank** and click **Open**.
- The **Questions Window** will display:

![Sample Questions Window](image)

- Click on **Tests** on the **LXR•TEST** toolbar.
- Choose **Create a new Test database**. Click **OK**.
- Type in the name **QuickTest.LXRTest**. Click **Save**.
The **Tests Window** will display:

- Select LANGUAGE ARTS 1 in the left panel.
- Click the **Move** button.
- Repeat the last two steps for LANGUAGE ARTS 2, LANGUAGE ARTS 3, LANGUAGE ARTS 4 and LANGUAGE ARTS 5.
- From the **File** menu, **save** the test.
Printing a Test

- From the **File** menu, choose **Print > Test Reports**.
- Verify that **Output** is set to **Preview**:

![Test Reports dialog box](image)

- Click **OK**. QuickTest.LXRTTest will display in single-page format in **print preview**.
- Click **Close** to exit the **print preview**.
Building an Online LAN Test

Now that you have built a test, creating an online test will be easy.

Note: The LXR•TEST Online Testing Option will need to be purchased and installed in order to create online LAN or Web tests.

- Sample Questions.LXRBank and QuickTest.LXRTest must be open.
- Click on Projects on the LXR•TEST toolbar.
- Change the Project to LAN Tests. Click OK.
- From the Main Window, click Online on the LXR•TEST toolbar.
- Choose Create a new Online database. Click OK.
- Type in the name QuickOnline.LXROnline. Click Save.
- Notice in Associate Files that the test filename is QuickTest.LXRTest.
- From the Online Window, click the Display tab.
For **Test Name**, change **QuickTest** to **Quick Start Online Test**:

You are ready to build the Online LAN test. Click the **Save and build online test** button.

Once the online test has been built, the **Take Test** button becomes available. Click it if you want to take the online test now.

**Congratulations, you have completed the Quick Start tutorial!** The next tutorial on Question Banking begins the more in-depth tutorials.
Question Banking

Questions are the essential ingredients to constructing tests and your question bank is the database that contains your questions. This section addresses question entry and is intended for users who want to enter their own questions into LXR•TEST. If you already have one or more question banks in LXR•TEST format, you may want to skip to the Test Development section.

Planning for a New Question Bank

Before jumping right in and creating your first bank of questions, there are several questions you should consider in order to get the most from LXR•TEST.

How do you want to organize/catagorize your questions?

Do you have a preferred standard font for most of your text?

Do you have a particular question layout preference?

Question Banking Concepts

Practically every aspect of LXR•TEST centers on the question bank. Therefore, it is important for you to understand the basic concept of how this file works.

The questions bank contains questions (made up of text, graphics, and even movies), question answers, and other question information. You can think of the questions bank as a collection of alphabetically, indexed question cards. This “indexed file” can contain literally thousands of questions. Each question needs to be uniquely identified so you can access any question instantly.

LXR•TEST indexes each question with both an “objective name” and a “sequence number.” For example, an objective name could be INERT GAS. A “sequence number” is simply an ascending number (beginning at the number one) that is attached to each question within an objective. Thus, while an objective name distinguishes questions into different groups, a sequence number distinguishes individual questions within a group.
Continuing our example, when you enter the first question for the objective INERT GAS, the question will be uniquely identified by LXR•TEST as INERT GAS 1. When you add a second question to the INERT GAS objective, it will be uniquely known as INERT GAS 2. As you continue to add questions to your bank, your questions will always be kept in entered-order within their objective, where objectives are alphabetically ordered. Having questions uniquely identified in this manner provides you and the LXR•TEST program an immediate way of accessing question information, no matter how large your question bank grows! You will want to think about how you want to classify your questions even before you enter the first question.

Classifying Your Questions

The classification scheme you establish depends, to a certain extent, on which edition of LXR•TEST you are using.

If you don’t plan to use score reporting features of LXR•TEST, you should consider classifying your questions into objectives for which you would build tests.

For example, if you simply build tests by choosing questions from a book chapter, then consider classifying your questions by book chapter. That is, assign chapter names as your objectives; e.g., BIOLOGY CHAPTER 01, BIOLOGY CHAPTER 02, BIOLOGY CHAPTER 03, etc.

However, if you primarily build your tests by choosing questions from different concepts, then consider classifying your questions by those different concepts. For example, for elementary school math you may choose the following objectives: ADDITION, SUBTRACTION, FRACTIONS, LONG DIVISION, etc.

If later you decide to change your classification scheme, you can do so. It’s of course much easier to start off on the right foot!

However, if you plan to use score reporting features of LXR•TEST, you will want to think a little further about how to classify your questions. A number of scoring reports provide student performance feedback by objective. Student mastery information also is specified and reported by objective. So, when you enter your questions, make sure you enter them under the same objective topics you expect to use on performance reports.
Question Appearance

LXR•TEST provides question layout templates found to be popular by most users and you should not change these settings unless you have a compelling reason to do so. While LXR•TEST offers tremendous flexibility in the layout of questions and exams, you will find that it is distinctly to your advantage to know what you are changing before you alter factory settings. Many of the question settings only apply to new questions that you enter, so it is important to set these settings before entering your first question. If later you want to edit entered questions, you may need to use the Global Changes menu option (see page 178). If you have particular question layout requirements, you should read Question Setup on page 173.

If for some reason you want to change the factory appearance settings, then it is highly suggested that you first experiment on a very small number of questions in a new bank. Enter a few trial questions, print a few tests, and confirm that you like the margins, fonts, and labels. Take the time beforehand to be sure, before you enter hundreds (or thousands!) of questions and then discover you want to, or must, change them all. Minutes spent in up front validation can save you many times over in making changes downstream.

To inspect question appearance settings, choose Question Setup (Utilities menu) and glance at the Margins, Font/Size/Style, Labels, and Category Titles tabs.

Click the Cancel button on Question Setup to preserve factory settings.

By now you should have thought about how you will classify your questions and now are ready to build your first bank!
Setting Up Your Preferences

Before creating a bank of questions, you should set up the Preferences:

- From the File menu, choose Preferences.
- The Preferences dialog box will display:

![Preference dialog box]

Note: For detailed discussion on the various features of Preferences, refer to page 153. It is recommended that you take the time to peruse that section.

- From the Editor tab, verify that Drag-and-drop text editing is selected. This will enable you to move highlighted graphics and text selections with the mouse.
- Verify that Default tab stops are set to 0.0 in and that all Question settings are selected.
Click the **Converter** tab:

- Verify that **Automatic Conversion** is cleared. When **Automatic Conversion** is cleared, you will be able to access the next three options.

- Ensure that **Prompt before converting primary 5.1 file** is selected. This option will warn you before you convert a 5.1 file to 6.0 format.
Click the **Headers** tab:

- Notice the Factory headers file path. Verify that **If header not open, use factory headers on reports** is selected.

- Click the **Units** tab.

- Ensure that **Units** are set to your desired unit of measurement (e.g., inches, centimeters).
Click the **Aux Files** tab:

![Aux Files tab screenshot]

Notice the **locations** of where these **file types** reside. You can change these locations using the **Browse** button or by typing in the desired file path. If any changes were made, click **OK** to save the changes.

You are now ready to begin building your first bank of questions.
Creating Question Banks

You will need to create a bank database first. This can be done in two ways:

- From the **File** menu, choose **New ▶ Questions**.

  OR

- Click on **Questions** in the **LXR•TEST** toolbar.

You are presented with two choices: **Create a new Questions database** or **Open existing Questions database**. Select **Create a new Questions database**. Click **OK**.

- The default bank database name is **Questions.LXRBank**. You can give the bank any name; leave the file extension or omit it - the program will automatically append the bank database extension. Click **Save**.

The newly created bank is presented in the Questions Window. (The term “Questions Window” is used generically - it actually displays all types of questions, including instructions.) For more detailed information about the Questions Window, refer to the Questions Window reference entry, beginning on page 113.
Questions Window

The Questions Window displays the first (untitled) question in your bank. Think of this window as a view of the current (question) card in a deck of (question) cards. You can browse through your questions by using the Navigation toolbar, located just above the Objective Name box. You will notice two sets of two greyed buttons on each side of the Navigation toolbar. Normally, these buttons are available and allow you to go back and forth between individual questions, or between sections of questions. Since you created a new bank (with no question content), the navigation buttons are greyed out, meaning they are inaccessible. When a bank contains multiple questions and objectives, you can browse the Objective Name for the desired objective. Likewise, you can browse within an objective, via the Sequence Number box, to locate a particular question.
Questions and Instructions

Questions and instructions both are stored as records in the question bank. The main difference between a question and an instruction is the Item Type, or Type. Essentially, the Type difference means an instruction will have neither an associated correct answer nor question statistics. Furthermore, unlike a question, an instruction can be used repeatedly on a test.

Entering Questions

- The first thing you should do for any new question is to give it an Objective. Click on the Objective box and replace UNTITLED with MATH for this tutorial question.

  Note: The Objective can contain a maximum of 20 characters - all letters appear in upper case. Non-consecutive spaces, numbers, and other characters are acceptable. (In your “real” bank of questions, you probably want to be more descriptive in naming your Objective, e.g., DECIMAL TO PERCENT.)

- A Sequence number is automatically assigned to this question (in this case, 1).

  Note: Each Objective may have as many as 999 questions assigned to it (1 to 999).

This question is now uniquely identified by LXR•TEST as MATH 1. MATH 1 is referred to as the Question ID. Since you may have as many objectives as you want, the number of questions in a Questions bank is limited only by the capacity limit of the LXR•TEST database engine, which is 2.14 gigabytes.

  Tip! Upsizing your bank to SQL Server format will remove this Microsoft Access database capacity limit.

After assigning the question an Objective and Sequence, you would want to assign the question its Type. The default question Type is “Multiple choice: single”, meaning a single correct answer, multiple choice question. Leave the Type setting.

Now you are ready to type in the question text:

- Click the cursor in the Stem Box directly above the letter A.

- Type the question: Express 0.74 as a percent. Click the Choice Box to the right of A.

- Type 0.74. TAB to the next choice box.
- Type 7.4. TAB to the next choice box.
- Type 74. TAB to the next choice box.
- Type 740. TAB to the next choice box.

Note: While pressing the “TAB” key will advance the cursor to the next edit box, pressing the “Shift+TAB” keys will retreat the cursor to the previous edit box. Refer to Appendix G for other keyboard shortcuts.

Tip! For multiple-choice questions, it is good form to enter the choices in rank order of answer values. For instance, answer choices should be entered in ascending (or descending) order if they are numbers.

Notice that the four choices are displayed in a single column. If your choices are short in length, as in this example, you may find displaying them in a single column is an inefficient use of space. Choices can be arranged in multiple (horizontal) columns underneath the stem (question).

- With the ABC Col box, click the up arrow until you reach 4. The choices now appear in four columns.

With your first question entered and properly formatted, you now need to indicate the correct response:

- To mark a correct answer, move the cursor over the label (letter) of the correct answer. Notice that the cursor changes into a check mark when hovering over a label.
- Click label C.

The image of a checkmark displays next to C. By marking the correct answer, now you can use LXR•TEST to print answer keys and score student tests.

Note: You do not need to “save” each question before you create or edit another question. All questions are automatically saved in the questions database when you create or move to another question. Refer to page 109 for further discussion on this auto-saving feature.

Enter a second question:

- Click the New Question button on the Question toolbar; there is also one in the Navigation toolbar for convenience. Notice that LXR•TEST automatically assigns the next Sequence (2) of the same Objective (MATH) for the new question; the question type remains multiple choice: single.
Click the question Stem Box.

Type the question: What is the area of a square with sides of length 3 cm?

Press TAB to advanced to Choice Box A.

Note: In order to enter a superscript, first click the Baseline Settings button and choose “Raise baseline 3 pts and reduce font size 2 pts”. Next, type in the text to be superscripted.

Type 3 cm$^2$.

Repeat the previous two steps to type in the next three choices: 6 cm$^2$, 9 cm$^2$, and 12 cm$^2$.

Click once on letter C to mark the correct answer.

Note: Question content for surveys can be created simply by not marking the correct answer.
Inserting Graphics

Next, you want to insert graphics into questions. The third question you will enter is also a multiple choice, single-response question:

- Click the New Question button.
- Assign MATH as the Objective and 3 as the Sequence.
- Click the question Stem Box.
- From the Insert menu, choose Graphic Inline.

Note: A discussion of the differences between inline and floating graphics begins on page 161.

- The Open dialog box will appear. Use the built-in folder drop-list to navigate to C:\Program Files\LXR\LXRTEST v6\Samples. Highlight the Sample.Bmp picture file and click Open.
- Press the Enter key 2 times to make room between the graphic and the question text.
- Type the question: When Wheel A turns 1 revolution, how many revolutions does Wheel B turn?

Note: If you want to move a graphic, first verify that Drag-and-drop text editing is selected in the Editor tab of Preferences (File menu). Double-click the graphic (the entire graphic will be selected in inverted colors) and then click-hold-and-drag the graphic to the new location.

Inline graphics are treated by LXR•TEST as a single text character. You can insert/move a graphic to any location where a text character can be entered.

- Click (or TAB to) each of the Choice Boxes and type into the respective boxes: 1, 2, 3.14, and 6.28.
- Click label B to mark the correct answer.
Your “final product” should look like:
Entering Instructions

Now that you know how to enter test questions, you’ll also want to know how to handle test instructions. Any instruction, reference material, or special comments that you have for students taking a test is considered Instruction Type. In fact, any question you don’t want numbered on a test must be entered as an instruction.

› Click the New Question button on the LXR•TEST toolbar.

› Type INSTRUCTIONS M/C in the Objective; the Sequence will be 1.

› Select Instruction from the Type box.

› Click the Stem Box and type in the following instruction: Select the best answer for the following multiple-choice questions. Indicate your answer by choosing the letter corresponding to your choice. Answer all questions.

Checking Spelling

LXR•TEST’s spelling checker enables you to check questions in your banks for spelling errors. The spelling checker includes a 100,000 word dictionary and allows you to add words to this dictionary.

To check the spelling of your entire question bank:

› Confirm that the current question displayed in the Questions Window is the first question of your bank and that All questions are selected in the Selection toolbar.

› Either click the Check Spelling button in the Question toolbar or select Spelling from the Utilities menu.

› The Spelling window displays. Make sure Suggestions is selected, to receive spelling suggestions for misspelled words. Click Go.

Note: The spelling checker always starts with the current question and moves toward the end of the bank. It does not automatically “wrap around,” so any questions that precede your currently displayed question will not be proofed. All questions including the current question and those following will be proofed, even if selected questions are displayed.
To select questions of misspelled words for later correction:

- From the **Spelling Window**, have the **Select Misspelled Items** option checked.
- Now when you click **Go**, the spelling checker will select all questions that contain misspelled words and the selection will be indicated in the **Selection** control portion of the **Questions Window**.

**Tip!** The “Select Misspelled Items” option is helpful when checking spelling of large banks. You can tell LXR•TEST to scan while you work in another application.

### Printing Questions

Now you will begin learning about LXR•TEST’s printing features.

To use print preview:

- From the **File** menu, choose **Print** ➤ **Question Reports**.
- The **Question Reports** dialog box is where you will configure your printing options:
  
  ![Question Reports dialog box]

- From the **Questions** tab, ensure that **Output** is set to **Preview**.
With **Preview** selected, whatever you print will be sent to the screen instead of to the printer. Notice the many options for the print format of your questions. Examine the options under **Print Parts**. These options determine what part of a question is printed. By default, only question **number**, **stem**, and **choices** are selected for printing. You can choose other print options, such as **Mark correct answer**, which will print the correct answer's checkmark for each multiple-choice and true/false question.

Note: LXR•TEST remembers your print settings, and will display them the next time you display a print options window.

- Click **OK** to print preview the bank.
- Click **Close** to exit the print preview.

To print:
- From the **File** menu, choose **Print > Question Reports**.
- From the **Questions** tab, ensure that **Output** is set to **Printer**.
- Verify that your printer is turned on.
- Click **OK**.
- A **Print** window appears. Verify all printer settings. Click **OK** to begin printing.

**Tip!** You may want to have a hard copy of your questions for proofreading. Questions are always printed in the order they appear in your bank (i.e., alphabetically, by objective). Use **Print > Test Reports** for printing questions you've already assembled in test. For steps on how to print a test, refer to page 36.

## Linking Questions

If you have used a previous version of LXR•TEST, then you should be familiar with the program feature of question linking. For those new to LXR•TEST, question linking is associating one question to another (or to a group of questions). This feature is useful when you want to have an instruction question “lead” a group of questions. Without going into all the details of linking questions, you should know that there are three types of question links: inclusive soft links, inclusive hard links, and exclusive links. Please read the “Link” section of Chapter 4: LXR•TEST Reference for discussion on the nature and use of each of these link types.
Creating Links

Building an inclusive soft link:

- Click the Show Links button on the Question toolbar, or choose Links from the View menu.

- The Link Window displays:

![Link Window](image)

- To link the INSTRUCTIONS M/C item with the MATH 1 question, you will first need to move the INSTRUCTIONS M/C item to the Linking Area.

- Highlight the INSTRUCTIONS M/C question, and click the right direction button to move this question to the Linking Area.

- Repeat the previous step for the MATH 1 question.

- Now that these two items have been moved into the Linking Area, they are ready to be linked together. Click the Set Links button.

- Notice that the Linking Area is empty and that there is a plus symbol next to the MATH 1 question; this means that the question is linked to another question, or group of questions.

- Click on the plus symbol to expand the associated MATH 1 link.
Tip! You can expand a linked question either by double-clicking on the question or by clicking once on the + symbol next to the question.

- Your Link Window should look as follow:

![Link Window](image)

There is now a light-blue colored chain link next to INSTRUCTIONS M/C, below the MATH 1 question. This blue link indicates that INSTRUCTIONS M/C is inclusively soft linked to MATH 1. When you build a test and include the MATH 1 question, the INSTRUCTIONS M/C item will automatically be placed ahead of the MATH 1 question on the test.

You can in likewise fashion build a hard link, but first clear the previously set link:

- Ensure that MATH 1 question is highlighted. Click the right direction button.

- Notice that INSTRUCTIONS M/C is also brought into the Linking Area. Click the Clear Links button.

- Notice that everything is restored to its original state.

- Click the Done button to close the Question Linking window.

Building an inclusive hard link:

- Click the Show Links button on the Question toolbar, or choose Links from the View menu.

- Click on the Inclusive Hard Links tab.
Notice how similar this tab is from the Inclusive Soft Links tab, except for the description of Hard Links in the lower left region. Move all four questions, in order, over to the Linking Area.

Tip! You can highlight multiple questions using the keyboard-mouse short-cut features built into Windows: Hold the Ctrl key down as you click individual questions, or click on the first question of a desired group and then hold the Shift key down before/as you click on the last question of a desired group.

Click on the Set Links button.

Again, notice how the Linking Area is empty. However, this time a plus symbol is next to each question. All questions are inclusively hard-linked together.

Click the plus symbol to expand MATH 2. The Link Window should now look as follows:

Notice that with hard-linking, the chain link by each linked question is black color-coded. Whenever you move one of the hard-linked questions to a test, the entire group of inclusively hard-linked questions will be moved over to the test, and kept in the sequential order they were linked! Hard-linking has the advantage over soft-linking of being able to place instruction items anywhere in the group of linked items.

Lastly, there are exclusive links. These are new to LXR•TEST. Before you start this example, clear the previous hard links and click Done.
Building an exclusive link:

- Click the Show Links button on the Question toolbar, or choose Links from the View menu.
- Now click on the Exclusive Links tab.

Note: There are two ways to implement exclusive links: “Keep Away From First” and “Keep All Apart”. Keep Away From First makes the first item in the Linking Area exclusive from the remainder Linking Area items. Keep All Apart makes all the items in the Linking Area exclusive from each other. If items are exclusive of one another, then when you try to move both onto the same test, LXR•TEST will prevent you from doing so, unless you override the warning.

- Move the MATH questions over to the Linking Area.
- Verify Keep Away From First is selected.
- Click on the Set Links button.
- The Linking Area is cleared and there is a plus symbol next to each MATH question. Expand the MATH 1 question:

Notice that instead of chain links next to MATH 3 and MATH 2 questions there are red X’s. These X’s signify that exclusive links are in place. Since you chose to set “Keep Away From First” exclusive links, what would happen when you moved the MATH 1 question to a test is that the program would not permit you to move automatically either or both of the remaining MATH questions to the test; you would first be warned.
Tip! Exclusive links are useful in preventing use of a question that would provide the answer to another question.

- Clear these exclusive links.
- Move the three MATH questions, in order, to the Linking Area.
- Select Keep All Apart and click on the Set Links button.
- Expand each MATH question and you will notice that each of the MATH questions is exclusive from the others:

Because you chose “Keep All Apart”, if you were to move any MATH question to a test, another MATH question would be prohibited from being moved to the test automatically.

Tip! If you want to change the first item in the Linking Area when creating exclusive links, you can easily move another item to take its place: simply highlight another item in the Linking Area, then click-hold-drag this selected item into the first item’s position. This will bump the previous first item to the second item’s position, and bump the previous second item to the third item’s position, and so forth.
Importing Questions

The ability to import questions from one bank to another is a powerful tool. In particular, you would be spared from manually re-entering question data.

In LXR•TEST 6.0, the import feature includes both a template system and an import wizard to simplify the import process.

Importing Without a Template

To execute a basic import of questions from another bank:

- Open the Questions bank, which you have been working with throughout this tutorial chapter.

- From the File menu, choose Import.

- The Template (Import) window displays:

  ![Template Window]

  - No Template should be selected.
Click **Next** to advance to the **File Type/Format** (Import) window:

You must specify both a file type and a file format for import. Notice both the Type Description and the Format Description for each file type and file format.

- Select **Questions** for the **File Type** and choose **Native** for the **Format**.

Note: For discussion on importing from other supported file formats, refer to the discussion of **Import file formats**, beginning on page 147.
Click **Next** to advance to the **Files** (Import) window:

Notice that the Destination has been completed for you. Verify the file path to locate your **Questions** bank. For this example, you will import questions from the **Sample Questions** bank. You need to specify this in the **Source**:

- Either type in or browse for this folder:
  
  `C:\Program Files\LXR\LXRTEST v6\Samples\Sample Questions.LXRBank`
Notice that the **Source** box has been completed:

- Click **Next** and then **Finish** to proceed with the import.

- Before the import attempt proceeds, the **Question Import** dialog box prompts. The program wants to know what you want to do if incoming questions have the same question ID as questions in the existing bank.

- Select **Resequence incoming item** because the Sample Questions file contains MATH questions.

Progress of the import will display in a status window. When the import is finished, LXR•TEST indicates whether the import was successful or not.
When you examine “Questions.LXRBank” after the import, you will notice that the bank has grown considerably. Notice that LXR•TEST maintained alphabetical order of the questions and resequenced the incoming MATH questions from the “Sample Questions” bank: While MATH 1, MATH 2, and MATH 3 are still the questions you entered, the remaining MATH questions are those imported from the “Sample Questions” bank.

**Importing With a Template**

An import template will store the import wizard’s settings. Therefore, if you want to repeat a particular import process, the template will facilitate the procedure.

- From the File menu, choose Import.
- Select Create New Template:
  ![Import Template Dialogue Box](image)

- In Template, rename the template to ImportQuestionsTemplate.LXRT.
- Type in a description for the template in Template description; e.g., Template for importing native questions from the sample questions file.
When you click the Next button, the Import Wizard will step you through, as discussed in Importing Without a Template.

After you click Finish and receive the Question Import prompt, choose Replace existing item.

After the import has completed and the template has been saved:

When you run Import and choose Recall Existing Template, a list of available import templates will display:

- Click on the desired import template to highlight its name. Its name will display in the Template edit box.
- Click Finish to run the template, and select (in Question Import) how incoming items are to be handled.

You will be prompted regarding the success or failure of the import process.
Inserting MathType™ Equations

For some instructors, the ability to insert mathematical equations into questions is essential. The easiest method for inserting equations is to create them in the source application (i.e., MathType or Microsoft Word Equation Editor) and then cut-and-paste them into the LXR•TEST question.

- Create the equation in the source application.
- Select the equation in the source application:

![Equation in MathType](image)

- Copy the equation.
- Paste the equation into the desired location in the desired LXR•TEST question:

![Equation in LXR•TEST](image)

Aligning the equation to the baseline setting of the sentence may need to be done manually:

- Click once on the equation in LXR•TEST to select the equation. Once the equation is selected, a dash-lined box surrounds the equation.
Right-click on the equation, and choose the **Adjust Baseline** option:

![Adjust Baseline](image)

Use the **Baseline adjustment** box to manually adjust the baseline of the equation to match that of the sentence.

Click OK when finished. Your finished product will look in similar fashion as the following example:

![Equation in LXR•TEST](image)

**Tip!** If you create an equation with Microsoft Word Equation Editor and create the equation at the end of a word, then when you cut-and-paste the equation into the LXR•TEST question, the equation’s baseline setting will automatically be adjusted to match that of the sentence in the question.
Test Development

There are four simple components for generating a test:

- Open/Create a LXR•TEST questions bank.
- Open/Create a LXR•TEST tests file.
- Move questions onto the test.
- Save/Print the test.

Preparing for a Test

A bank must be open in order to build a test. To get started quickly, use the “Sample Questions” file to create your first test:

- Begin by clicking the Projects button on the LXR•TEST toolbar.
Verify that the Project is set to Samples. Click OK to exit the Projects Window.

Click the Questions button on the LXR•TEST toolbar or choose Open ▶ Questions from the File menu.

Select Open existing Questions database. Because the Project is set to Samples, you should immediately find the Sample Questions file.

Note: You can also access the file through the File menu’s Recent Questions, if you stepped through the previous tutorial on Creating Question Banks.

Highlight the Sample Questions file. Click OK to open the file.

Tests Window

Next, you need to create a tests file:

Click on the Tests button on the LXR•TEST toolbar or from the File menu choose New ▶ Tests.

Choose Create a new Test database. Click OK.

The default filename for a new test is Test.LXRTest. Click Save to keep this name.
The **Tests Window** displays:

![Tests Window screenshot](image)

The Tests Window has two panels, or “scrollable lists”. The Questions Panel, on the left, displays all questions that are available to be moved to the test. If the “Question View” is set to “Item”, then each question will be displayed in alphabetical order, by objective. The Test Panel, on the right, lists the bank items placed on the test. The items on the test will always be displayed by question ID.

**Tip!** If you want to inspect or edit a question, simply double-click its question ID from within either panel. This question will display in the questions window. To edit this question, make the question window active by either clicking on the questions window or clicking on the Questions button, on the LXR•TEST toolbar.

### Adding a Question

Before beginning this exercise, ensure no questions are highlighted in either panel. If there are highlighted questions, click directly above the panel to remove all highlighting.

- Click once on LXR•TEST 1 in the **Questions Panel**.
Click the Add test items button to put LXR•TEST 1 on the test:

Note: REFERENCE 2 instructional item was also moved to the test because there was a question link between the two questions. For discussion of Question Links, refer to page 165.

The LXR•TEST 1 question now appears in the Test Panel and is indicated as question 1 of section 1 of the test. Notice on the right, above the Test Panel, that the number of items is now 1, with total test Points of 1 and difficulty level of 0.95. Each of these test values are automatically updated as additional items are added to or removed from the test.

Removing a Question

To remove a question from the test:

Select the LXR•TEST 1 question in the Test Panel.

Click the Remove test items button to remove the item from the test.

This question moves back into the Questions Panel, and is once again an available question to put on the test.
Removing a Question

Note: By moving items onto a test, LXR•TEST prevents you from accidentally putting a question on a test twice!

Go ahead and remove the REFERENCE 2 item as well.

You can build a test by moving items to the test one-at-a-time, or you can select multiple items and move this group of questions over to the test with a single mouse click (see next section).

Adding Consecutive Questions

To highlight consecutive questions:

- Click once on LXR•TEST 3 in the Questions Panel.
- Hold the Shift key and click once on LXR•TEST 6, in the Questions Panel.
- Now that you have selected a group of questions, move these questions over to the test.
The **Tests Window** should look as follows:

![Tests Window Image]

Note: The insertion pointer ▶️ indicates where future moved items would be placed next on the test.
Adding Non-Consecutive Questions

You may want to add non-consecutive questions as well:

- First, click directly above the Questions Panel to deselect any highlighted items.
- Hold the CTRL key and click once on FLAGS 2.
- Hold the CTRL key and click once on LANGUAGE ARTS 1.
- Repeat this selection procedure for questions LANGUAGE ARTS 3, LANGUAGE ARTS 4, and LANGUAGE ARTS 8.
- The Questions Panel displays as follows:

![Figure 3: Question Panel in Tests Window](image)
Move these newly selected items over to the test:

Note: Although you have moved only 9 items over to the test, the “Items:” count is 13! This is because the FLAGS 2 question is a matching question, where each part of the matching question is considered by LXR•TEST to be a separate question, for testing and scoring considerations.

Each non-instruction type item in the Test Panel is preceded by a “1,” which indicates that each question is in section 1 of the test. For information on test section breaks, refer to discussion of Test Toolbar controls on page 192.

Adding Questions Randomly

LXR•TEST allows for the random assignment of questions to a test. While there are many ways to employ the question randomization feature, perhaps the most useful way is to use the feature when the Question View is set to display questions by “Objective”.

From the Tests Window:

- In Question View, choose Objective.
The open bank’s questions are displayed according to objective. For this exercise, you will have LXR•TEST randomly select 3 questions from the REAL ESTATE objective to move onto the test:

- Click once on the REAL ESTATE objective to select it.
- Click the text box to the right of the button.
- Type in 3.
- Click the **Pick** button.

Notice the three REAL ESTATE questions moved onto the test. The Pick feature is indeed a powerful feature. In fact, you can use this feature just as easily with any of the Question Views.

**Note:** With the Question View set to “Objective”, clicking the Add test items button would move all REAL ESTATE items over to the test.
Changing the Question Order

Reexamine the Test Panel. Notice that the REAL ESTATE items are located after the LANGUAGE ARTS items. How about moving the REAL ESTATE questions in front of the LANGUAGE ARTS items:

- In the **Test Panel**, select the three REAL ESTATE items.
- Click on one of the highlighted questions. While holding the mouse click, drag the highlighted questions until the **Insertion Pointer** moves directly above the first LANGUAGE ARTS question.
- Release the mouse click and the three REAL ESTATE questions will move to their new positions:

![Test Panel Image]

Notice how the REAL ESTATE and LANGUAGE ARTS questions were automatically renumbered.
Inserting Questions

As you may already be aware, LXR•TEST normally moves questions to the end of the test. This is because the insertion pointer typically follows the last item in the Test Panel. By moving the insertion pointer to a new location within the Test Panel, you can insert questions at any location in your test. Further, highlighting any question in the test panel automatically relocates the insertion point immediately before this highlighted question.

Saving a Test

Before proceeding further, you should save your test.

▸ From the File menu, choose Save.

Note: The tests file only contains a list of the Question IDs, the name(s) of the bank file(s) where the questions are stored, the order of the items on the test, and the answers to test questions.

Previewing a Test

To view a test without actually printing a paper copy:

▸ From the File menu, choose Print ▶ Test Reports.
From the **Test Reports** window, you can choose to print a test, an answer key, a response booklet, or a test description report. The **Test** tab displays:

- Verify that **Output** is set to **Preview**.

For discussion of all the presented options, refer to page 194.

- Click **OK**. The **print preview** displays the test on screen.

The print preview is the same as that of other Windows applications. In print preview, you can choose to display the test in one or two pages at a time on the screen, as well as zoom in or zoom out. You can use the side scroll bar, the Page Down and Page Up keyboard keys, or the “Next Page” and “Prev Page” buttons to “flip through” the test pages.

**Note:** The test has both a header and footer on each page of the test. By default, LXR•TEST uses the configured headers and footers found in the “FactoryHeaders.LXRHeaders” file, unless otherwise specified. Refer to page 156 for further details.
Printing a Test

Once you have previewed the test and are satisfied with the appearance of the questions, you are ready to send the test to the printer.

- From the File menu, choose Print ➤ Test Reports.
- Under Output, select Printer.
- Verify that your printer is turned on and has sufficient ink and paper.
- Click OK.

LXR•TEST has a variety of print options. For more information on these options, see the “Print ➤ Test Reports” section of Chapter 4: LXR•TEST Reference.

Printing an Answer Key

For the instructor, an answer key for the test is crucial for grading. Since the correct answers are marked for the bank items, it is easy for LXR•TEST to produce an answer key.

- From the File menu, choose Print ➤ Test Reports.
Select the **Answer Key** tab:

Note: Verify that Versions are set from 0 thru 9. Refer to page 267 for discussion on the difference between test versions and Test Forms.
If you **preview** the answer key, it should look as follows:

![Answer Key Report](image)

**ANSWER KEY REPORT**

<table>
<thead>
<tr>
<th>#</th>
<th>ID</th>
<th>Points</th>
<th>Type</th>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>REFERENCE 2</td>
<td>INS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>LXR*TEST 3</td>
<td>1.00</td>
<td>MCS</td>
<td>I</td>
<td>I</td>
<td>I</td>
<td>I</td>
<td>I</td>
<td>I</td>
<td>I</td>
<td>I</td>
<td>I</td>
<td>I</td>
</tr>
<tr>
<td>3</td>
<td>LXR*TEST 4</td>
<td>1.00</td>
<td>MCS</td>
<td>A</td>
<td>A</td>
<td>D</td>
<td>B</td>
<td>B</td>
<td>D</td>
<td>C</td>
<td>A</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>LXR*TEST 5</td>
<td>1.00</td>
<td>MCS</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td>5</td>
<td>LXR*TEST 6</td>
<td>1.00</td>
<td>MCS</td>
<td>C</td>
<td>B</td>
<td>D</td>
<td>D</td>
<td>A</td>
<td>C</td>
<td>B</td>
<td>C</td>
<td>A</td>
<td>D</td>
</tr>
<tr>
<td>6</td>
<td>FLA002</td>
<td>1.00</td>
<td>MAT</td>
<td>I</td>
<td>I</td>
<td>I</td>
<td>I</td>
<td>I</td>
<td>I</td>
<td>I</td>
<td>I</td>
<td>I</td>
<td>I</td>
</tr>
<tr>
<td>7</td>
<td>FLA002</td>
<td>1.00</td>
<td>MAT</td>
<td>C</td>
<td>C</td>
<td>C</td>
<td>C</td>
<td>C</td>
<td>C</td>
<td>C</td>
<td>C</td>
<td>C</td>
<td>C</td>
</tr>
<tr>
<td>8</td>
<td>FLA002</td>
<td>1.00</td>
<td>MAT</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>9</td>
<td>FLA002</td>
<td>1.00</td>
<td>MAT</td>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>10</td>
<td>REAL ESTATE 5</td>
<td>1.00</td>
<td>MCS</td>
<td>C</td>
<td>D</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
</tr>
<tr>
<td>11</td>
<td>REAL ESTATE 6</td>
<td>1.00</td>
<td>MCS</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>12</td>
<td>REAL ESTATE 10</td>
<td>1.00</td>
<td>MCS</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>A</td>
<td>B</td>
<td>C</td>
</tr>
<tr>
<td>13</td>
<td>LANGUAGE ARTS 1</td>
<td>1.00</td>
<td>MCS</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>A</td>
<td>B</td>
<td>C</td>
</tr>
<tr>
<td>14</td>
<td>LANGUAGE ARTS 3</td>
<td>1.00</td>
<td>MCS</td>
<td>D</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>A</td>
</tr>
<tr>
<td>15</td>
<td>LANGUAGE ARTS 4</td>
<td>1.00</td>
<td>MCS</td>
<td>D</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>A</td>
</tr>
<tr>
<td>16</td>
<td>REFERENCE 5</td>
<td>INS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**SECTION 1 (10 items)**

<p>| | | | | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>T</td>
</tr>
</tbody>
</table>

**Total Score:** 10.180
Printing Response Booklets

LXR•TEST can print response booklets for students if an optical mark reader and/or OMR forms are not available options. A tests file must be open and saved in order to print a response booklet.

- From the File menu, choose Print Test ▶ Test Reports.
- Select the Response Booklet tab:

You may want to preview the response booklet before printing. If so, select Preview under Output.

Otherwise, verify that Printer is selected under Output, then click OK.

Criteria-Based Test Construction

Up to this point, the method employed in building a test was to select (highlight) questions within the Questions Panel (left panel) of the Tests Window and move them to the Test Panel (right panel). Now you will be introduced to additional test building methods that are based on the concept of selecting questions according to specific criteria.
Understanding Question Selection

Question selection is a simple, yet very important, concept. One analogy is to think of the questions bank as a collection of alphabetically indexed question cards. Imagine that anytime you wanted to select a card (question) for a test, you would put a paper clip on that card. LXR•TEST works similarly: the program will set the “Selection” option button to “Selected” within the Questions Window. You can also select (or deselect) any question by clicking the “Select this one” checkbox. In addition, LXR•TEST can select questions automatically based on almost any pre-defined criteria.

In version 6.0, the LXR•TEST Selection Window has been greatly enhanced.

![Figure 4: Selection Window](image_url)

One enhancement of the Selection Window in 6.0 is the drop-down list interface. As shown above, you are now able to specify the search field(s) by choosing from a list of all available program fields. Depending on the Field(s) chosen, the Value drop down list may also be accessible, as demonstrated in the following illustration.

- Click on the Select Questions button on the Question toolbar to open the Selection Window. Or choose Select from the Select menu.
Another enhancement is the addition of “OR” boolean (IF-THEN) logic. Now, instead of being required to find only those questions that meet every specified criteria, the user is free to search for a group of questions where some items will meet the specified criteria more than others. The search range is now greatly expanded by this feature and by the following discussed feature.

A final enhancement is that the user interface of the Selection Window will easily allow users to extend their searches to multiple search criteria, thereby allowing easily for 1,000’s of different possible searches to be made.

Custom Question Selection

For this demonstration, continue to use the “Sample Questions.LXRbank” file.

Suppose you want to build a test containing questions that (inclusively) meet the following criteria:

- Objective = RESPIRATORY CARE
- Type of Question = Multiple Choice
- Difficulty = MEDIUM

With the Sample Questions file open,

- Click the Select Questions button on the Question toolbar, or choose Select from the Select menu.
- Click the down arrow to bring up a list of values to choose from.
Choose **Objective** from the **Field** box. Notice that **Operator** now displays the value **contains**. Leave it as is.

Choose **RESPIRATORY CARE** from the **Value** box.

At this point, your **Selection Window** should display as follows:

![Selection Window](image)

Since you want an inclusive search, choose **and** from the **Action** box.

Notice how you now have a second search row. This time, choose **Layout** from **Field**.

Leave **Operator** set as **contains**.

Set **Value** to **Multiple Choice: single**. This indicates that you are interested only in multiple-choice questions that have only a single correct answer.

Once again, set **Action** to **and**.

For our third row, set **Field** to **Category 2 (Difficulty)**; set **Operator** to **equals**; set **Value** to **MEDIUM**; set **Action** to **END**.
Your **Selection Window** should display as follows:

Click the **Select** button to find and select all questions within the **Sample Questions bank** that meet these specific requirements.

Notice that the program found four questions and indicates this as “Selected Questions: 4” in the upper-left portion of the Selection Window. Selection Type is now automatically set as “From within those already selected.” You could continue to refine your search, but let’s stop at this point.

Click the **Done** button to return to the **Questions Window**.

Notice that the **Questions Window** now displays the first of the four selected questions:
Building a Test Using Question Selections

After your questions are entered, building the test is easy.

With the Sample Questions Bank still open:

- Create a new tests file called SelectionTest.LXRTest.

- By default, the Questions Panel of the Tests Window will show all items in the currently open bank. Within Question View, choose Selected to display only selected questions.

- Now you should see only the four previously selected questions in the Questions Panel.

- Move these questions to the Test Panel, and the test is made!

- Save this test. If you have not saved the test after changes were made, you will be prompted to do so.

Note: To clear your selected questions, choose Clear Selected from the Select menu of the Questions Window.

Building Test Forms From Specifications

The purpose of this tutorial topic is to step you through the process of building test forms from a Specifications file. For discussion on the concept of a test form, refer to the section entitled “What About Forms?” beginning on page 267. For discussion on the Specification Window, refer to page 203.

Preparing a Specifications File

Before you specify criteria, you need to have a bank and test open, and then create a specs file:

- Open the Sample Questions bank.

- Create a new test, calling it CriteriaTest.LXRTest.

- Click the Specs button on the LXR•TEST toolbar.
Choose Create a new Specifications database. Click OK.

Type in the name TutorialSpecs.LXRSpecs. Click Save.

Verify in the Bank field that the associated bank is Sample Questions.

In the Max Test Forms edit box, enter 5.

In the Max Item Duplication edit box, enter 30.

Verify that Build Type is set to Progressive.

Your Specifications Window should display as follows:
Writing the Specifications

Now you’re ready to begin “writing” the specification criteria:

- Notice that **Field** has an **END** value.
- Click the down arrow to open a list of values to choose from.
- Change the **Field** value to **Objective**.
- Notice that the **Operator** value is set automatically to **contains** and that **Action** is also set automatically to **pick**.
- Leave the **Operator** value alone, but set **Value** to **PHYSICS**.
- Change the **Action** value to **and**. Notice that the number **1** that was in the **Pick** column disappeared.
- Change the **Field** value of the second row from **END** to **Category 6**.
- Set **Value** (in the second row) to **Application**.
- Change the **Pick** value to **5**.
Your **Specs Window** should display as follows:

![Specs Window](image)

**Building the Tests Forms**

- You’re ready to build the test forms, click the **Validate and Build** button.
- A dialog box advises that there are not enough bank items matching the criteria. In other words, there are **not** at least 5 PHYSICS questions.
- Click **OK**. Notice the number 4 appears in the **#Avail** column. This indicates that you can pick from only 4 questions.
- Change the **Pick** value from 5 to 2.
- Because a 2-item physics test is not useful, you should finish building test forms with at least 5 items.
- In the third row, set the **Field** value to **Objective**, the **Value** to PHYSICS, and the **Action** to **and**.
- In the fourth row, set the **Field** value to **Category 6**, the **Operator** to **not equal**, the **Value** to **Application**, and **Pick** to 8.
» Click the **Validate and Build** button.

» Again, you are warned about picking too many items. Change **Pick** from **8** to **4**.

» Click the **Validate and Build** button again.

» Notice in the **Total Forms Built** field that 2 test forms have been created:

![Test Form Diagram](image)

» To view the contents of the two constructed test forms, switch to the **Tests Window**.
Change the test form number within the **Forms** box from **0 to 2**:

As you can see, you have two different test forms, each with 6 physics questions, that have met your test specification criteria.
Scores Window Features

Once a test has been administered, either by paper-and-pencil, online via a Local Area Network, or online via the Web, LXR•TEST provides the scores file to collect student response data. However, the scores file can be used for more than data collection.

In fact, from the Scores Window you will be able to import/export student demographic information, sort student response data for analysis and reporting, and update question statistics.

For more in-depth information about the Scores Window, refer to the Scores Window reference discussion, beginning on page 209.

Looking Up Student Information

LXR•TEST has a feature for “looking up” information, including code fields (a.k.a., C-fields), from a Students database and copying it over into a Scores file.

To take advantage of this feature, you will need to create or open a Students file. For additional information on creating a Students file, refer to the Students Window reference discussion, beginning on page 251.

Use the LXR•TEST Sample files as follows:

- Open the Sample Scores file by clicking on the Scores button on the LXR•TEST toolbar.
- Notice that the related tests and bank files were automatically opened. Now open the Sample Students file.
- Switch back to the Scores Window.
- Notice that there is no data in the C8 (Code 8) field.
From the **Score** menu, choose **Lookup Student Info**. A dialog box allows you to customize from which students database fields you want to update the **Scores Window**.

![Image showing the Lookup Student Info dialog box](image)

**Note:** For each Student ID in the Scores Window, LXR•TEST will attempt to find a matching ID in the Students Window. For each matching ID, LXR•TEST will replace the data in the Scores Window of your selected field(s) with the corresponding field data from the Students Window.

- Unselect all fields except **Code 8**, and click **OK**.
- Notice that LXR•TEST updates all empty **Code 8** entries.

### Sorting, Selecting, and Reporting Score Data

Generating score reports is as easy as choosing any of the reports within the Print option of the File menu. In this section, you will learn how to generate score reports for subsets of students.

You need to start with the **Sample scores file**:

- Verify that the **Sample Scores** file is open.
- Verify that the **Sort Direction** button has the dark arrow pointing up, indicating **Sort Up**.
- Double-click the code field label **C2** to sort alphabetically (ascending or descending) the students within the **Code 2** field. School codes are stored in this field for the **Sample Scores** file.

Notice that the students for school “CN” are first in the field and that the students for school “FB” are at the end. Let’s say you wanted to know how the students from school “CN” and from school “EJ” performed. In order to do so, you first need to learn how to select scores:
Right-click any CN entry within the C2 column. A pop-up displays:

Choose Select CN.

Notice X marks now appear within the S column (left of the ID column) for each student from school CN, indicating that these records have been selected.

Note: To clear the selection, right-click again on any CN entry and select “Clear Selection”. Or you can choose “Clear Selected” from the Select menu.

With the CN records selected, right-click on the C2 value of Ej. Notice the pop-up has changed:

You can select Ej, select Ej in addition to those already selected, or select Ej from within those already selected. If you choose the first option, an Ej selection will replace the current CN selection. The third option does not make sense in this case. You want to select Ej in addition to those already selected. This will grow our selection of score records.

Notice that the number of selected score records is now 29.

Now that you’ve selected a subset of student data, send this to the printer:

From the File menu, choose Print > Score Reports > Statistics
Choose the **Test Statistics** tab:

- Notice that **Specify students** is set to **Selected students**, because of the selected records in the **Scores Window**. Switch the **Output** to **Printer**.

- You receive a bar graph summarizing the combined test performance of students from schools coded **CN** and **EJ**.

  **Tip!** Using this technique of selecting groups of student score records and printing test statistics reports also can be a useful way of comparing performance between different groups of students.
Updating Question Response Statistics

If you’ve created both bank and tests files from the LXR•TEST program, and you have scored test data – refer to Chapter 11 on using optical mark readers – you can easily update the statistics for each question item that was on the administered test.

- With the bank, tests, and scores files open, choose Update Question Statistics from the Score menu.

- Your bank items for the administered test now have updated statistics.
Chapter Overview:

Main Window.................................103
Projects Window...........................107
Questions Window...........................113
Tests Window.................................189
Specs Window.................................203
Scores Window.................................209
Grading Window.............................244
Students Window.............................251
Headers Window.............................261
What About “Forms?”.........................267

This reference chapter was intended to provide a structured way for you to explore each of the primary windows within LXR•TEST. Reference on these windows, as well as on menu options, are presented in the order they appear in the program. In addition to discussion of the windows, there is a conceptual discussion on the differences between test forms and test versions, as well as on how multiple tests can be associated with one score file (What About “Forms?”).

Some menu items will change depending on the currently active window. If you are researching a program feature, but do not know under which window or menu the feature resides, use the Index to find page references quickly.

Note: For reference information on the Online Testing or Mark Reader features respectively, refer to Chapters 8 and 12 of this guide.
Main Window

When you launch LXR•TEST, you begin with the Main Window and the LXR•TEST toolbar. The Main Window is the forum for all other windows; those you will use to create and maintain questions, tests and scores files.

Main Window Description

![Figure 5: Main Window](image)

The Main Window consists of two primary areas: a column of buttons along the left side, and a workspace for displaying program windows of files you are using. The column of buttons is the LXR•TEST toolbar, which allows you quick access to the various database files that are the building blocks of LXR•TEST. You can click any button on the LXR•TEST toolbar to open a database or bring a database already open to the top of the work area. The behavior of these buttons—including from where a file is opened and how it is opened—is configured within the Projects Window.

**Tip!** If you open several databases and the workspace becomes cluttered, you can easily re-organize the windows by choosing the Reset or Cascade option (Window menu).
Main Window Menus

**File Menu**

- **New**  
  Create a new file. File types are same as those listed on the LXR•TEST toolbar.

- **Open**  
  Open a file.

- **Close**  
  Close the active file. (Displays only when a file is open.)

- **Close All**  
  Closes all open files. (Displays only when a file is open.)

- **Save**  
  Saves the current file. (Displays only when a file is open.)

- **Save As**  
  Prompts for a filename before saving the current file. (Displays only when a file is open.)

- **Print Setup**  
  Set/adjust printing settings.

- **Print**  
  Print reports related to the current file. (Displays only when a file is open.)

- **Import**  
  Import from a file. Choose the file type and file format to import from.

- **Export**  
  Export a file. Choose the file type and file format to export to.

- **Send**  
  E-mail the current file. (Displays only when a file is open.)

- **Recent Questions**  
  Recently created/opened files are listed here.

- **Recent Online Tests**

- **Preferences**  
  Set up preferences for file conversion, system-level security, and other options.

- **Exit**  
  Quit the LXR•TEST program.
Main Window Menus

View Menu

LXR•TEST toolbar
Selects the LXR•TEST toolbar.

Status Bar
Selects the status bar (bottom of Main Window).

Utilities Menu

Question Setup
Configure question margins, fonts, labels, category titles, and bank copyright.

Repair Database
Attempts to rebuild a corrupted LXR•TEST database file.

Compact Database
Removes unused space from a LXR•TEST database file.

LXRTEST Update
Checks for a newer version of the program via the Internet.

Help Menu

Help Topics
HTML Help on LXR•TEST

About LXR•TEST
Splash screen with program’s copyright, version number, and user registration info.

LXR•TEST toolbar

The LXR•TEST toolbar facilitates the opening and closing of databases used by LXR•TEST. Refer to Figure 5: Main Window. If a database window is already open, then it will be made the active window when its Toolbar button is clicked.
ODBC DSN

When you click on a button on the LXR•TEST toolbar, a choice dialog box for the database type displays:

![Figure 6: ODBC DSN Option](image)

In the lower right corner is an ODBC DSN option button. This option is for logging into your SQL Server in order to access your SQL Server databases within LXR•TEST. Refer to Appendix J: Upsizing to SQL Server for information on how to convert LXR•TEST native databases to SQL Server format.
The Projects Window is where you establish your preferences for the locations of your various LXR•TEST files. The Common Project Directory will typically be the place where LXR•TEST creates or opens files. Since your files can also be on your desktop or on a server, the Projects Window provides you with an easy mechanism to indicate where you want to store your work.

Projects assist you in defining the scope of your work. If you plan on building different types of tests (e.g., LAN and Web tests) or store your work in different file locations, then you should find the Projects feature to be both necessary and extremely useful.

Note: Project information is stored with each user’s profile. If more than one user accesses the computer, each person will have his/her own set of project preferences.

Projects Window Description

![Figure 7: Projects Window](image)
Project: Choose an existing project or create a new one. A project establishes the base location for the collection of files that LXR•TEST uses. You can create as many projects as you like. LXR•TEST establishes these project names for you: Local, LAN Tests (on Local Area Networks), Web Tests (on the World Wide Web), and Samples. These are simply convenient names for file locations. In fact, a project named “LAN Tests” could be set to point to file locations of Web tests. Remember, when you create a project, you do not actually create any files, only the preferred locations for storing files.

Note: The “Samples” project stores the folder location of where the sample files are located.

Is a Web Project

Selects whether this project is for building Web Tests. When this option is selected, the Web Server Location edit box will become accessible (see Web Server Location entry).

Web Testing:

Web Server Location

Specify the URL of the currently active web server to be employed in Web Test construction and administration. (“Is a Web Project” option must also be selected.) You must also include the shared (i.e., lxrweb) folder, that was installed by the Web Server Extensions, in the web server location.

Note: If you use the Browse button to locate your web server, then you will need to navigate through the network neighborhood to the correct location.

You will also want to read the note in the following Default Directory description, concerning the file locations of files related to web test administration.

Note: In order to create multiple web testing environments on the same server, you need to install multiple instances of the “lxrweb” components via the Web Server Extensions. For example, if one web-testing environment was located at “\firstlocation\lxrweb” while another environment was located at “\secondlocation\lxrweb”, there would be no directory conflicts.

File Locations:

Common Project Directory

Works in conjunction with the specified Default Directories. When the Common Project Directory (CPD) is checked, LXR•TEST sees the CPD as a “root” directory for the storage location(s) of LXR•TEST file types (banks, test, etc.). If no Default Directories are specified, then all LXR•TEST file types will reside in the same folder, whose path is specified in the CPD box.
**Toolbar Action**

Use the drop down lists to configure how LXR•TEST should handle the button clicks on the LXR•TEST toolbar. For instance, when the Question button is clicked, if the Toolbar Action has been set to Open Last, then the last question bank opened will be re-opened. A different Toolbar Action may be set for each LXR•TEST toolbar button.

**Prompt:** Prompts you for the name of the file to open.

**Open Last:** Automatically opens the most recently opened file, for this file type.

**Create New:** Prompts you for a filename before creating a new file.

**Default Directory**

Works in conjunction with the Common Project Directory. This is the designated folder for storing files of each particular file type. If the Common Project Directory is *unselected*, then the file path specified in the CPD box will be the prefix of each Default Directory path. For example, if the Common Project Directory (CPD) is set as \Network\Shared\ and the Questions Default Directory is set as "Questions," then when the CPD is *unselected*, the questions files directory would become \Network\Shared\Questions.

**Note:** When building Web Tests, certain file locations are preset according to the web server location (see Web Server Location entry). Any relevant files must be placed in certain fixed directories within the web server location. For example, if your web server location is \server\lxrweb\ and you have a scored test, then your Scores database must be located in the \server\lxrweb\scores\ directory. The predetermined file locations have dimmed display, indicating that you will not be able to change them. You should note that this file placement restriction does NOT apply to files used in LAN testing. LAN testing files can be stored in any location on your network, so long as they are accessible to those taking the test.

**Automatic File Saving**

With LXR•TEST 6.0's new database features, certain database files save incrementally – i.e., as you advance to the next record, the database saves any changes. Three of the databases, in particular, behave in this manner: the Questions file, Scores file, and Students file. While the other data file types are also true databases, such as the Tests file, you will find the option of discarding editing session changes upon closing the window.

**Note:** The Projects window is an exception: when you click OK, changes are saved; to discard changes, click Cancel.
File Dependencies

When you open files in LXR•TEST, other files are often needed and are automatically opened by the program. Such files are considered “prerequisite” files by the program. For example, a scores file needs an open tests file for the Scoring Key. Likewise, the tests file needs the corresponding bank file(s) open, for the correct answers and point values of questions on the test.

Here is a list of the major LXR•Tests file types, describing their purpose and any prerequisite file associations:

<table>
<thead>
<tr>
<th>File Type</th>
<th>Purpose</th>
<th>Prerequisite files</th>
</tr>
</thead>
<tbody>
<tr>
<td>.LXRBank</td>
<td>Contains all question content.</td>
<td>None</td>
</tr>
<tr>
<td>.LXRTest</td>
<td>Contains list of question IDs of the questions that comprise a test.</td>
<td>Requires: .LXRBank</td>
</tr>
<tr>
<td>.LXRSpecs</td>
<td>Contains list of criteria for selecting questions to build a test, and the resulting lists of question IDs for the generated test versions, that are based upon the specification criteria.</td>
<td>Requires: .LXRBank</td>
</tr>
<tr>
<td></td>
<td>Note: A tests file must be open for a specs file to update the built forms on the test.</td>
<td></td>
</tr>
<tr>
<td>.LXRScores</td>
<td>Contains list(s) of students’ test response data.</td>
<td>Requires: .LXRTest, .LXRBank Optional: .LXRGrading, .LXRStudents, .LXRHeaders</td>
</tr>
<tr>
<td>.LXRGrading</td>
<td>Contains set of grading parameters for generating various score reports.</td>
<td>None</td>
</tr>
<tr>
<td>.LXRStudents</td>
<td>Contains list of demographic information about each student.</td>
<td>None</td>
</tr>
<tr>
<td>.LXRHeaders</td>
<td>Contains header/footer/cover content and format for various reports.</td>
<td>None</td>
</tr>
<tr>
<td>.LXROnline</td>
<td>Contains subset of item content needed for publishing a LAN or Web test.</td>
<td>Requires: .LXRTest, .LXRBank Optional: .LXRScores, .LXRGrading, .LXRStudents, .LXRHeaders</td>
</tr>
</tbody>
</table>

When you close a file, LXR•TEST stores the exact location (path) of any prerequisite files, so that these files can be quickly opened the next time you open the “dependant” file. However, if you relocate a prerequisite file, this can cause a problem for LXR•TEST. If you move files from one location to another, LXR•TEST follows a couple of rules, as described below, to determine whether to use prerequisite files from the original (remembered) location or the file’s actual (new) location:
If the file you are opening has NOT been moved:
If LXR•TEST determines that the file you are opening is indeed in the same location as when it was created, then the program will search for any prerequisite file(s) in the following order:

- Look for the prerequisite file at the same location the prerequisite file was last opened (the remembered location).
- Look for the prerequisite file at the current project location.
- Look for the prerequisite file in the same location as the file you are opening.
- If the prerequisite file(s) can’t be found, you will then be prompted for the location of the prerequisite file.

If the file you are opening has moved:
If LXR•TEST determines that the file you are opening is not in its last (remembered) location, then the program will search for the prerequisite file(s) in the following order:

- Look for the prerequisite file in the same location as the file you are opening.
- Look for the prerequisite file at the current project location.
- Look for the prerequisite file at the location it was last opened (i.e., the remembered location).
- If the prerequisite file(s) can’t be found, you will then be prompted for the location of the prerequisite file.
Questions Window

The Questions Window is for viewing and editing question-related information. From the Questions Window, you can open question banks one at a time.

Questions Window Description

![Questions Window](image)

Whenever you open a questions file, the Questions Window will display the first question in your file. No matter the order you entered your questions and instructions, they will always be presented alphabetically, by objective, in the Questions Window.

Question “items” are distinguished from one another by both an Objective Name and a Sequence Number. The Objective Name usually corresponds to a question topic or category. For example, INERT GASES could be an Objective for a set of chemistry questions. The Sequence Number is a sequential numbering system for the questions within each Objective. Thus, the first question in the INERT GASES Objective would have a Sequence “1,” while the second question would have a Sequence “2,” and so forth.
Note: The combination of Objective Name and Sequence Number is called Question ID. Questions are ordered within a bank in ascending Question ID order. The maximum number of questions per objective is 999.

This method of question identification provides an easy way of tracking questions and is essential when multiple persons are collaborating on building a bank of questions. This question identification system also is responsible for LXR•TEST’s ability to accumulate and update question statistics when questions are scored on a test.

By incorporating database techniques, LXR•TEST enables you to enter thousands of questions in a single questions file! Regardless of the size of your questions file, LXR•TEST will open and display any question in your Questions Window with similar speed (i.e., no need to load every preceding question, causing the user to wait).

Note: As you enter questions in the Questions Window, you do not need to periodically “save” your questions. LXR•TEST automatically saves each question whenever you move from one question to another.

**Question Content Area**

Content areas in the Questions Window that can contain text, graphics, and other objects are referred to as edit boxes. The number and size of edit boxes depend on question type and question layout.

The edit box in which you are entering or editing data is called the current, or active, edit box. The blinking I-beam (text insertion) cursor indicates an active edit box. Point and click any edit box to make it the current box. In LXR•TEST 6.0, there are no preset limits to the length of text, number of graphics, or embedded objects that can be placed in an edit box.

Note: You should be aware that more (or larger) objects placed in edit boxes will place a greater load on your computer and/or printer, and will possibly require more RAM, CPU speed, or hard disk storage for responsive display.

You can move from one edit box to another by pressing the TAB key. In order to move the cursor to a set TAB marker, press CTRL+TAB (if no other window is concurrently open) or CTRL+T.

Graphics can be pasted into an edit box. Graphics and other objects also can be inserted from a file. Objects can either be inserted as “inline” or “floating.” Inline objects have the feature of automatically wrapping to another line if question width changes. Floating objects stay at a fixed location (with respect to the upper left corner of the edit box) regardless of how the text may wrap beneath it. When you paste an object (rather than insert from a file), the object is always pasted “inline.” “Inline” graphics behave similarily to “inline” objects, and “floating” graphics behave similarly to “floating” objects.
The graphic formats supported by 6.0 are Windows Bitmap (BMP), Graphics Interchange Format (GIF), Joint Photographic Experts Group (JPEG or JPG), and Tagged Image File Format (TIFF or TIF). When creating web tests (to be discussed in Part II), all graphics are converted to JPEG format.

Tip! Graphics can be resized directly in LXR•TEST by right-clicking on the graphic (after the graphic has been selected first) and choosing Scale Image. Or, you could resize or resample your graphics prior to inserting into LXR•TEST.

Text that you type begins at the location of the blinking cursor. As with a word processor program, you can highlight, copy, cut, and paste text and other objects.

Note: **Tabled text cannot be cut-and-paste into the Question Content Area.** You will need to insert tabled text as an object (refer to page 162 for discussion on inserting objects). However, tabled text can be cut-and-paste into the Feedback Area, Notes Area, and Response Form Area.

The text ruler settings apply to individual paragraphs. A paragraph is a unit of text that is defined by pressing the Enter/Return key. Each paragraph can have its own set of TABs, margins, justification, and line spacing settings. If you have Invisible Characters enabled, you can actually cut a paragraph marker (¶) and paste the paragraph attributes from one paragraph to another.

You can apply subscript and superscript text styles by using the Baseline Settings button, located on the Questions Window Format Toolbar (see page 133). Or you could use the keyboard shortcuts: Ctrl-L (subscript) and Ctrl-H (superscript). Refer to Appendix G: Keyboard Shortcuts for more text-style keyboard shortcuts.

**Feedback Area**

The Feedback (sometimes referred to as "solution") area provides a place to enter and edit custom student feedback relating to the current question. The feedback can contain text, graphics, movies, or other OLE objects destined for use with online tests. Depending on the question type, you can specify feedback remediation for each individual choice or for the question in general.

Using the Print Test Reports option, instructors can print all questions’ feedback for class review of an exam. Feedback content also can be printed or presented on screen after an online exam for individual remediation via Individual Feedback Reports.

In the feedback edit box you would typically enter the correct answer. You could also enter any appropriate derivations, as well as specific references to the textbook or other sources of remediation.
If you want the correct answer displayed as feedback to a question, you should enter the answer substitution variable %answer% instead of a literal answer. That is to say, even if the correct answer to the question is “B,” you should enter: “The answer is %answer%” (instead of “The answer is B.”). When you use the substitution variable %answer% LXR•TEST automatically will substitute the correct answer choice (provided you’ve marked a correct answer to the question) whenever the feedback to this question is needed. Using the answer substitution variable is extremely helpful when you want LXR•TEST to generate different versions of a test automatically because LXR•TEST will automatically identify the correct answer in feedback.

Notes Area

The Notes area of the Questions Window allows you to enter personal notes relating to the current question. Notes can contain any content of your choice. Typically, you might enter information relating to who authored the question, specific reference sources, review comments and their dates, historical statistical data, etc.

Response Form Area

Response Form area in the Questions Window is where you enter and edit custom student response forms for the current question.

Enter content in the Response Form edit box only if a question requires a unique response format on an answer sheet. LXR•TEST will print any text or graphic that you have entered in the Response Form area when you choose Print → Test Reports → Response Booklet tab (File menu).

Tip! A typical use for the Response Form feature is to place a graph paper image or a ruled lines image for students to graph/draw a solution.

For conventional multiple choice, true/false, and matching questions, you should leave this area blank. LXR•TEST will generate response patterns that correspond to the question types. For example, for multiple choice questions, “A,B,C,D” will be printed. For true/false questions, “T F” will be printed. LXR•TEST will also generate the correct response form for matching questions.

Tip! If your paper-and-pencil test contains only discrete response questions (i.e., multiple choice, matching, true/false), then consider choosing the “Preceding underline” option, in the Print dialog box of Test Reports. This will enable students to mark directly on the test for each question, removing the need for separate response booklets.
Questions Window Toolbars

The Questions Window features a number of toolbars that give you quick access to frequently used controls for maintaining your questions. Most toolbars may be relocated and their positions are remembered when you next run the LXR•TEST program.

To relocate a toolbar:

- Double-click on any part of the toolbar that is **neither** a button nor a control.

- Notice how the toolbar is now a moveable window:

![Figure 9: Relocate Question Toolbar Window](image)

- Click on any part of the toolbar’s window that is **neither** a button nor a control, and drag the toolbar’s window to a new desired location.

- If the new location is suitable, the toolbar’s window will snap in place automatically. See below for example:
Figure 10: Questions Window With New Question Toolbar Location

Question Toolbar

The Question Toolbar provides controls to create and delete items, hide and display window areas, and other question tools.

Figure 11: Question toolbar

- New Question. Creates a new item.
- Duplicate Question. Duplicates the current item.
- Delete Question. Deletes the current item.
Revert. Restores the original state of the question item before any changes were made during the current edit session.

Note: The current edit session on the current item ends when you move to another item. Your changes are saved automatically when you leave the item. You will be unable to “revert.”

Select Questions. Brings up a Selection Window, allowing you to enter criteria for selecting questions that meet specific criteria. This button allows for a variety of user-defined selections based on any combination of criteria, using any question data. For a detailed discussion on the Selection Window, refer to page 170.

Show Links. Opens the Link Window for linking or excluding questions. For a detailed discussion on the Link Window, refer to page 165.

Check Spelling. Runs the spelling checker. For details refer to page 184.

Show/Hide Category Area. Opens (or closes) the Category area. (See page 131.)

Show/Hide Dates Area. Opens (or closes) the Date area. (See page 131.)

Show/Hide Answers Area. Opens (or closes) the Answer area. (See page 125.)

Show/Hide Statistics Area. Opens (or closes) the Statistics area. (See page 132.)

Maximize Question Area.

Maximize Feedback Area.

Maximize Notes Area.

Maximize Response Form Area.
Navigation Toolbar

The Navigation Toolbar provides a means for question classification, question navigation, and new question entry.

Figure 12: Navigation Toolbar

- **Question Slider.** Allows you to move quickly to a question in the bank that corresponds to the slider's position.
- **Previous Record and Next Record.** Allow you to move back or forward one question.
- **First Record and Last Record.** Allow you to jump to the first or last question in the bank.
- **New Question.** Creates a new question form.
- **Objective Drop-Down List Box.** Shows the current question's Objective name and allows you to navigate to any of the Objectives in the bank. You can also enter in a new objective name; you will be prompted to confirm you really want to rename the item.
- **Sequence number Drop-Down List Box.** Shows the current question's Sequence Number and allows you to navigate to any question within the chosen Objective.

The Objective identifies the question category and can be up to 20 characters in length. Every question must be assigned an Objective and Sequence.

**CAUTION!** A single space character is permitted, while consecutive spaces are **not** permitted. A question mark “?” character is also **not** permitted in an objective.

LXR•TEST assumes that any new question is to be classified under the same Objective as the previous question, that was displayed in the Questions Window. If you use the scoring features of LXR•TEST, the Objective Name plays an even more important role. The Objective becomes a primary classification for score reporting and is used in computing student mastery.
The number to the right of the Objective is called the Sequence Number. The Sequence Number identifies the order of a question within an Objective. When you enter new questions, LXR•TEST looks for the last Sequence Number assigned to a question within the current Objective and automatically assigns the next number for the Sequence. A single objective can contain up to 999 questions. In the event that you try to add more than 999 questions, LXR•TEST first verifies if you have deleted any questions within the Objective, whose Sequence Numbers could be re-used. If the search fails, the program will inform you that you are trying to enter too many questions in the Objective.

You can change the Objective and/or Sequence of any question by entering a new one. However, you will first be prompted to confirm the change to be made. You cannot change a Question ID to one that is already in use in your bank. Should you want to change the objective for multiple questions in your bank, refer to Global Changes » Reclassify (Utilities Menu) on page 178.

The Question Slider enables you to move quickly to other items in the questions file. For a more refined approach to navigating the bank, you can use the drop-down controls of both the Objective and Sequence drop boxes.

Tip! The following are several shortcuts for Question Slider operation:

Click, hold, and drag the Slider to move to a relative question location.

Click to the right or left of the Slider to jump to the next or previous Objective.

Hold down shift and click to the right or left of the Slider in the “Slider Channel” to jump to that relative location.

Hold down shift and click to the right or left of the Slider in an area other than the “Channel” to move +/- 5 questions from the current location.

The New Question button presents a blank form for creating a new question in the bank. The blank form is created with the same question layout as the question previously displayed in the Questions Window. As mentioned, the Objective for the new question also defaults to that of the previously displayed question; the Sequence number is the next number, following the previous question. Font characteristics and question width for the new question are governed by the settings in the Question Setup » Font/Size/Style tab (Utilities menu).

Tip! If you want to create a new question that is identical to the current question displayed, you should use the Duplicate button in the Question Toolbar. This duplicate method works great for rapidly creating similar questions when you want to make only minor changes, or to preserve special ruler and/or text settings from one question to another.
Selection Toolbar

The Selection Toolbar provides an easy method for identifying subsets of selected questions.

![Selection Toolbar](image)

**Figure 13: Selection Toolbar**

The “All” option button sets the Questions Window to access all bank questions. The number to the right is the total number of bank questions.

The “Selected” option button sets the Questions Window to access only selected questions. The number to the right is the number of selected questions.

“Select this one” checkbox indicates whether or not the current question is selected. You can select this control to select (or deselect) the current question.

Selected items not only affect which items are displayed in the Questions Window, but also control other tasks, such as specifying candidate items for test construction, printing, or exporting.

**Note:** Besides manually selecting individual questions, a much more powerful way of item selection involves the use of the Selection Window. Refer to the section entitled “Understanding Question Selection”, on page 85, for more information on using the Selection Window.
Layout Toolbar

The Layout Toolbar allows you to set/change the question type and the physical layout template for an item.

<table>
<thead>
<tr>
<th>Layout</th>
<th>Choices</th>
<th>ABC</th>
<th>Col 1</th>
<th>23</th>
<th>Col</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple choice: single</td>
<td>▼</td>
<td>4</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 14: Layout Toolbar**

**Layout types:** Ten different layout types are built-in:

- **Instruction**
  - An instruction item does not solicit a response. You would use an instruction item, for example, to enter test or student directions. You would also use instruction items to enter passages or graphics that are shared by multiple questions. Instruction items are different from other questions because they are not numbered when placed on a test. Also, unlike questions, instructions can be placed on a test multiple times.

- **Free format:**
  - **open-ended**
    - A question with an open-ended response is hand-graded by the instructor.
    - If the test is scored by optical mark reader, then the instructor may want to go back and mark the students' points on their mark response forms; only points in the range of -100 to +100 are acceptable.
  - **letter**
    - A question with a single letter response that does not conform to a standard multiple choice layout. With this question type, response choices range from A-Z.
  - **short answer**
    - A question that accepts a small amount of text response (e.g., fill-in-the-blank) and is graded by LXR•TEST by comparing student responses with an instructor-defined list of acceptable phrases.
  - **numeric**
    - A question with a numeric answer that is graded correct if the student's response falls within a specific numeric range.
  - **scientific**
    - A question with a numeric answer expressed in scientific notation. Each answer consist of a mantissa, an exponent and an unit of measurement.
Chapter 4: LXR•TEST Reference

**True False**
A true or false question. Note that ONLY FOR MARK READER inputs, if the response for a True/False item is A or B, then this is respectively assumed by LXR•TEST to be a “T” or “F” response.

**Multiple choice:**
- **single (response)**
  A multiple choice question with only one correct answer.
- **multiple (response)**
  A multiple choice question with more than one possible correct answer or with different point weights for different choices.

**Matching**
A matching question with a list of elements on the left to be correlated with a list of choices on the right. When the question type is set to Matching, Left and Right list boxes allow you to set how many matching elements go on the left and how many choices go on the right.

*Note: When a matching question is placed on a test, each element in the left list counts as a separate, numbered question (for scoring purposes). This enables LXR•TEST to automatically score matching questions when using optical mark readers.*

**ABC Col**
Specifies how many horizontal columns for the choices (i.e., choice columns) of a multiple choice question to be formatted in. The area beneath the question stem is divided into equal amounts and the choices are displayed horizontally, left to right, into the chosen number of horizontal columns.

**123 Col**
Specifies how many print columns (1, 2, or 3) for the question. Two and three column questions print in multiple columns on a page. When LXR•TEST prints multicolumn questions, it prints them down the column of a page until it encounters either the end of a page, a column break, or another question with a different print column setting.

*Note: You can achieve special page layouts for grouped questions by combining Column Break controls with Inclusive Hard Links (advanced feature).*
Answers Area

The Answers Area enables you to configure and view choices, point value(s), and correct answer(s) for the current question. The format and content of the Answers Area depends on the question type.

Note: The maximum time value allowed per item is 999 (minutes).

Instruction

An instruction type item does not have any fields in the Answers Area.

Free Format Questions

Free format questions can have a variety of response types: Open-ended, letter, short answer, numeric, and scientific.

Note: Open-ended, short answer, and scientific response questions are not compatible with scoring with an optical mark reader. However, all free format response items (except open-ended) are compatible with the LXR•TEST Online Testing Option.

For each free format question type, you can assign both the time and point values. Point values can range between –100 and +100, and are rounded to the nearest hundreth.

Free Format: Open-Ended Response

![Figure 15: Answers Area: Free Format, Open-Ended Response](image)

All open-ended response questions must be manually graded. For an online test, the student will have the opportunity to enter a text response for the item(s), but you will need to open the Scores Window and manually assign a point value for each open-ended item.

The open-ended response answer area has a text dialog box where you can enter in a scoring rubric to assist in grading the item. You could enter key phrases, topics, dates, concepts, etc. to assist you. This rubric will print for the %answer% substitution variable in any question content area.
CAUTION! When mark readers are reading OMR forms, LXR•TEST assumes that all numeric markings (values between -100 and +100) corresponding to free format, open-ended type questions are instructor-assigned grades. Therefore, you may want to keep an eye out for student’s numeric markings on such open-ended items.

Free Format: Letter Response

Figure 16: Answers Area: Free Format, Letter Response

Letter Response provides program support for scoring questions that have a single letter response. Enter in the correct letter answer.

Tip! You can use the letter response type to create a multiple-choice question that may have a different layout from the built-in multiple-choice templates.

Free Format: Short Answer Response

Figure 17: Answers Area: Free format, Short Answer Response

Short Answer Response provides program support for scoring “fill-in-the-blank” type questions. Enter the acceptable responses in the text dialog box. You can specify several acceptable forms of the response by separating each form by the vertical bar character (|).

The student’s response is compared with each acceptable answer form in the text dialog box. If there is a match, then points are awarded. If Match Case is checked, then the student’s response must also exactly match for capitalization.

Free Format: Numeric Response

Figure 18: Answers Area: Free Format, Numeric Response
Numeric Response provides program support for scoring items with a number answer. The Answer Range must be set. You can either enter a valid (ascending) range to be accepted, or enter the same value in both fields to require an exact numeric response match.

**Free Format: Scientific Response**

![Figure 19: Answers Area: Free Format, Scientific Response](image)

Scientific Response provides program support for scoring questions that require responses in scientific notation format. Such questions typically have very large or very small numeric answers.

- **Mantissa**: A number between 1 and 10.
- **Exp**: The power of ten exponent.
- **+/− Tol**: Percent (%) tolerance: the acceptable percent difference between a response and the correct answer.
- **Unit**: The unit of measurement.

Up to 3 correct responses can be entered in the Scientific Response table (as explained previously) for the purpose of accepting answers in different units of measurement. For example, if the question asks the student to give the approximate distance from the Earth to the Sun, then the first possible response could be in miles: $9.3 \times 10^7$. The other possible response is in kilometers: $1.488 \times 10^8$. Notice in the previous Figure of the Answers Area that the tolerance values are both set to 1%. That is to say, that as long as an student’s scientific answer comes within +/- 1% of either the miles or kilometers response version, the student will receive credit for this question.

**Note**: Scientific notation is not supported for use with optical mark readers.

**True / False**

![Figure 20: Answers Area: True / False](image)

Enter in “T” if the answer is true, and “F” if the answer is false.

**Note**: While there are often no “T” or “F” choices on a OMR form, LXR•TEST will read an “A” marked choice as “T,” and a “B” marked choice as “F.”
Multiple Choice, Single Response

The Scramble Choices checkbox determines whether the choices are to be scrambled for this question. In fact, if scramble choices is not selected, the correct answer for all versions of the test will be the same.

If you enable choice scrambling, you can also select which questions to scramble by configuring the (Scrambling) Range. You would typically use this feature for those questions whose last 1 or 2 choices (e.g., “All of the above.”) must always be in a fixed location. For example, for a three-choice multiple choice question, you could set a Range from A to B so that LXR•TEST would only swap choice A with choice B, but leave choice C in the same (last) position.

Each of the Answer fields indicates the correct answer for the corresponding version (indicated above the answer) - when choices are scrambled. For instance, if the correct answer was “D” for version “2,” then LXR•TEST would automatically place the content of the correct choice in the “D” position when either printing or displaying a question.

Notes: “Versions” refer to different copies of a test in which the exact same items are presented, except either the order of the choices and/or the order of the questions are scrambled.

If the correct answer is not in the (scrambled) Range, all variations of Answer will be the same as the correct answer.

Click the Randomize button to scramble the answers for versions 1 through 9 of a test. The answer for version “0” of a test will always be the same as it was originally selected. Each time you click on the Randomize button, you will be warned that scrambling answers can affect tests. To avoid seeing the warning, press the Control key while you click the Randomize button.

Note: You should be aware that the Randomize button will only be accessible when the scramble range includes the correct answer. That is to say, if the correct answer is C, but the scramble range is only set from A to B, then you will not be able to use the Randomize button.

CAUTION! If you use different versions of a test when scoring with an optical mark reader, you MUST have students indicate their test version on the answer forms so that they can be correctly graded.
Points is the field that holds the value of the question. Point values may range from -100 to +100. You are permitted to enter up to two decimal places for fractional point values.

The Time field is for setting the question administration time (in minutes). An instructor can use the time field to gauge approximate test length. Further, when you build an online test, the Time fields of all test items are added up by the program to determine a “default” length of time for test administration.

**Multiple Choice, Multiple Response**

![Figure 22: Answers Area: Multiple Choice, Multiple Response](image)

The multiple choice, multiple response questions may have more than one correct response or require a penalty for an incorrect response. For these types of questions, you can also set the maximum number of student responses permitted.

The Award Partial Points checkbox determines whether the item is either a “partial credit” item or an “all or nothing” item.

If Award Partial Points is checked, the question will be scored with the assigned positive and/or negative values corresponding to the marked choices. The student can mark any number of choices up to the “Maximum responses” value. If a student marks ZERO responses, no points will be awarded.

If Award Partial Points is unchecked, the student will receive zero points unless all of the instructor-designated correct responses are marked. In other words, the question is an “all or nothing” question.

**Note:** For an online version of the test, the program will not permit the student to enter more than the “Maximum responses” value. However, if a student marks more choices than the maximum on an OMR form, no points are assigned for the item and a “?” is displayed in the Reader Error column of the Scores Window.

**Tip!** The value you set for Maximum Responses can be referenced to the substitution variable %MaxResponses%. For example, you could enter the following warning into the item text: “Please choose exactly %MaxResponses% responses for this question.”
Point values again may range from -100 to +100. Any fractional point values will be rounded to two decimal places. **Any choice with an assigned point value greater than zero is considered to be a correct choice.** For example, in the above figure, choices B through I (each worth one point) are considered correct choices. The total point value of the item is the sum from the "n" largest point-valued choices (where "n" is the number of permitted responses). A correct choice, with an assigned positive point value, is indicated by a checkmark next to its choice letter. An incorrect choice, with an assigned negative point value, is indicated by an “X” mark next to its choice letter.

Note: Multiple response items provide tremendous flexibility for scoring. However, this flexibility requires you to properly communicate to the students about the types of responses you are soliciting for each and every multi-response item.

Time is the same type of field as previously described.

**Matching**

For Matching type questions, you will need to enter in the correct answer corresponding to each of the matching elements in the appropriate Answer fields. As for points, each matching element must have an equal point value as the others. When you enter in a point value in the field under “Each,” hit the Tab key. You should notice that the program automatically calculated the “Total” point value for the matching item.

Note: Partial (i.e., decimal) point values can be set for “Each” matching element. The “Total” points for the matching item will be automatically calculated.
Category Area

The Category Area provides a place to view and edit the categorical values of a question. Categories essentially label questions so that it’s easier to sort and select subsets of questions. Categories can also be used for generating score subtotals and creating mastery groupings. There are eight, user-definable category fields.

<table>
<thead>
<tr>
<th>Ret/Task</th>
<th>Difficulty</th>
<th>Topic</th>
<th>Subtopic</th>
<th>Grade/Pos</th>
<th>Cogal Lev</th>
<th>Type</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MEDIUM</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 24: Category Area

As you build your bank, think of ways you want to access your questions. For example, if you want to be able to select questions by grade level, then name one of your category fields "Grade Level" so you can assign a grade level to each question in your bank. Refer to page 177 for naming category fields. Each category field’s name can be up to 20 characters in length. To display a list of all entries of a category, either right click on the category title or print a Bank Information (question) report (refer to page 141).

CAUTION! A single space character is permitted, while consecutive spaces are not permitted. A question mark “?” character is also not permitted in a category.

Tip! You may also use the grading table to assign various grading parameters for each category.

Dates Area

The Dates Area displays summary date information for the current question.

<table>
<thead>
<tr>
<th>Created</th>
<th>Modified</th>
<th>Reviewed</th>
</tr>
</thead>
</table>

Figure 25: Dates Area

The “Created” and “Modified” dates are updated by LXR•TEST when you first enter a question or subsequently edit a question. The “Reviewed” date is intended to assist the user in annotating the last time the item was subject to content review. The date and file name of the test that last accessed the bank is updated only when you click the Post Test button, located in the Tests Window.
Statistics Area

The Statistics Area displays and allows editing of various statistical data for the current question. The Statistics Area is updated by test data recorded in a Scores file. Refer to the section “Update Question Statistics” on page 241. Formulas used in calculating the statistics are noted in Appendix A: Glossary. Statistics Area content will vary depending on question type.

The Statistics Area can store statistics for up to 5 administered tests. If there are more than 5 tests administered, then the next one will bump the least recent test out of the Statistics Area.

Note: The content and format of the Statistics Area varies depending on the item type.

![Figure 26: Statistics Area](image)

| User Values | These 4 fields allow the user to store up to 4 numeric values relevant to the item. These values may then be used as criteria when searching for questions (in the Specs Window). |
| Group (Name, Date) | Name and date of the associated test. The row of data contains statistics for each choice that (typically) have been computed, and posted, for the item from the Scores Window. However, these statistics can also be manually edited. |
| <Cumulative> | Arithmetic mean (weighted average) for all test entry column data. These cumulative values cannot be edited. |
| e | The “e” (equator) checkbox is a special control for identifying items that are used in the process for calibrating scores consistently between different tests. Unless your organization is involved with determining score scales you will not need this field. |
| Admins | Total number of test students. Admins is calculated by totaling the numbers of student responses for each choice. This field cannot be edited. |
| Avg | Average (in percent). This is the average overall test score (expressed as a percentage) for the group of students who correctly answered this item (or this choice of the item). |
| Omits | Number of students that did not respond to this item. For multi-response multiple-choice and matching items, this is the number of students who didn’t answer any part of the item. |
| % | Expresses the Omits as a percent. |
E.T. The "elapsed time," in minutes, that students spent on this item. This information is captured during online testing and totaled when question statistics are updated.

A, B, C... (1, 2, 3...) Indicates how many students selected this choice. However, for a matching item, this is the number of students who correctly answered this item part.

P Item difficulty. This is the percentage of students who correctly answered this item (or this part of the item). For example, a p-value of 0.30 on a single response, multiple-choice item means that 30% of the students marked the correct choice. For a multi-response item, a p-value of .30 means that 30% of the students marked the maximum number of greatest point value choices.

rpb Point-biserial correlation. This statistic describes the relationship between students’ performance on this item with their overall test performance. These values range from -1.0 to +1.0. The more positive the correlational value, the more closely associated item performance is to overall test performance, suggesting higher validity for this item. Refer to the Appendix A: Glossary for the formula used to compute rpb.

**Format Toolbar**

The Format Toolbar provides character and paragraph format controls.

![Format Toolbar](image)

**Figure 27: Format Toolbar**

- Font and Font Size Drop-Down List Boxes. Applies specified font and font size to selected text.
- Text Color. Applies color to the selected text.
- Bold, Italics, Underline, Strikeout. Applies bold, italic, underline, and strike-through character formatting to selected text.
- Baseline settings. Applies normal, superscript, and subscript attributes to selected text or object. When subscript or superscript are applied, the size of selected text is reduced 2 font points and the baseline is either lowered or raised, respectively, by 3 points.
- A fourth option allows for manual baseline setting.
- Paragraph Justification. Applies left, right, center, and block justification to selected paragraph(s).
Line Spacing. Applies single, space and a half, double, or user-specified line spacing to selected paragraph(s).

Tab Setting. Allows you to set left, center, right, or decimal tab(s) to your (horizontal) text ruler.

Note: To advance the cursor to a set tab marker, press CTRL+TAB (if no other windows are concurrently open) or press CTRL+T.

Show/Hide Text Ruler. Displays (or hides) text ruler with margin and tab stops. See additional information below.

Show/Hide Vertical Ruler. Displays (or hides) vertical ruler.

Show/Hide Invisible Characters. Displays (or hides) symbols for characters that are not normally shown (such as the carriage RETURN and SPACE characters).

Set Page Break. Applies page breaks (none, before, after, before & after) to the current item. Page break controls provide a method for ensuring that a question is the first (or last) question on a page. Once a page break has been set for a question, the page break will carry-over onto any test with the moved question. (If you want to set page breaks manually per individual test, refer to the discussion of the comparable control from the Tests Toolbar – Tests Toolbar discussion begins on page 192.)

If you set a page break before an item, then the item will become the first one on the following page. If you set a page break after an item, then will be the last item on the page. To ensure that an item is the only one on a page, use the before & after page break option.
Set Column Break. Applies column breaks (none, before, after, before & after) to the current item. Column break controls provide a method for ensuring that a question is the first (or last) question in a print column. Therefore, column breaks are only meaningful when you have test questions that have been set to 2 or 3 print columns (123 Col feature). Once a column break has been set for a question, the column break will carry-over onto any test with the moved question. (If you want to set column breaks manually per individual test, refer to the discussion of the comparable control from the Tests Toolbar - Tests Toolbar discussion begins on page 192.)

If you set a column break before an item, then the item will be the first one in a new print column. If you set a column break after an item, then the item will be the last one in the print column. And if you set a before & after column break, then the item will be the only one in the print column.

Tip! Column breaks-combined with inclusive hard links can be used to achieve a nice stationary layout (see below example) for a group of questions.

Set/Unset No Widow. Sets the “No widow” feature for the current item. This feature ensures that the current item will NOT be the last one on a test page; the item will automatically be placed at the beginning of the next page. The primary use for this “No widow” feature is to prevent separation of an instruction item from its follow-on question.

No widow is automatically set for new instruction questions.

Note: If consecutive items each have the “No widow” feature set, LXR•TEST will first determine which item is the “last item” that can actually fit (space-wise) on the current page. Then, the program will check to see if this “last item” has the “No widow” feature set. If it is set, then only this “last item” will be moved to the start of the next page; all previous items will remain on the current page, regardless of their “No widow” settings.
Text Ruler

Figure 28: Text Ruler

The Text Ruler allows you to view and set ruler controls for the current edit box. Ruler controls can be set for the question stem, choices, feedback, notes, and response form edit boxes of a question.

The Text Ruler facilitates custom text formatting. Paragraphs can be formatted just as they are in a word processor. The Text Ruler can be displayed in inches, centimeters, or points (set up in File > Preferences > Units).

Note: Text Ruler measurements indicate distance from the left margin—not the physical edge of the paper.

To understand Text Ruler measurement, it’s necessary to understand how page margins relate to text margins. Page margins are insets measured from the physical edge of the paper. The Text Ruler only displays the width of the printable area of the paper. If the left page margin was set (in Questions Setup) to zero, then the Text Ruler would actually indicate the distance from the paper’s edge. However, since most printers cannot print to the paper’s edge, you actually wouldn’t want this left page margin setting.

LXR•TEST factory settings reserve 0.60 inches for the left page margin, and 0.5 inches for what is known as a “number gutter:” the reserved width for printing numbers before each question. Thus, when you begin entering in a question, its text will actually be printed 1.10 inches from the paper’s left edge. In fact, the number gutter is responsible for the Text Ruler’s beginning at 0.5 inches.

The right Text Ruler margin for single print-column questions is determined automatically by the “number gutter” and “body width” settings found in Question Setup (Utilities menu). (For multiple print-column questions, the right margin’s position is affected by a number of factors: the number of print columns (2 or 3), the “between print columns” settings, and the “number gutter” settings.)

Every paragraph (any group of text ended by a carriage return) can have its own Text Ruler settings. By default, a new paragraph created in any edit box will inherit the Text Ruler settings of the preceding paragraph, unless otherwise specified. The Text Ruler displays the settings for the active paragraph (made active by the text insertion cursor).
The Text Ruler has three movable controls to set: first line indent, left text margin, and right text margin. These movable controls determine how text is positioned in an edit box. The first line indent control can be moved (to the left) to set the indentation of (only) the first line of a paragraph. The left text margin control can be moved (to the left) to set paragraph indentation. The right text margin control can be moved (to the right) to reduce the width of a paragraph.

Left, center, right, and decimal tabs can be set for column alignment of text and numbers. Choose the desired tab marker from the Tab Type button, then click on the desired tab placement location on the Ruler. To remove a tab, click-hold-and-drag it off the Ruler.

To quickly clear or reset all tab markers, right-click on the Ruler and choose from the pop-up menu.

Questions Window Menu Items

File Menu
New

The New menu item creates a new file of the type and name you specify using a standard new file dialog box. Long file names can contain any standard character except the following:

\ / : * ? < > | "

**LXR•TEST will not allow two different file types to have the same (prefix) name.** For example, the program will not allow a question bank to be named "MY STUFF.LXRbank" and a tests file to be named "MY STUFF.LXRtest". Even though the file extensions (.LXRbank and .LXRtest) are different, because the program’s database engine uses a special .LDB file extension, conflicts will arise when two files have the same (prefix) name. You will notice that LXR•TEST has therefore been programmed to warn/restrict you when you attempt to save multiple files with the same (prefix) name.

The question and scores files are “database” type files and are automatically updated when you move from one record to another. Thus, you don’t have to “save” these files after you are finished working with them; they are saved incrementally by LXR•TEST as you move through question or score data.

Other types of files in LXR•TEST can be saved when changes are made. LXR•TEST will prompt you to save after any changes have been made.

Open, Close, Close All

These menu items are standard Windows file commands for opening or closing files. When you open a file that depends on another file, LXR•TEST will automatically open the prerequisite file(s). For a discussion on Automatic File Saving, turn to page 109.

Tip! An easy way to delete a file is to use Open to locate the file, then right-click on the file name and choose delete.

Save, Save As

The Save menu item saves the current file (keeping the same name), while the Save As menu item prompts you to save the current file under a new name. As previously mentioned, question and scores files are (automatically) incrementally saved by the program.

Tip! To save files in a file format to be used by other programs, use the Export feature.
Print Setup...

The Print Setup... dialog box contains standard Windows printing controls. Refer to your Windows and printer documentation for details.

Print  ▶  Question Reports

The Print  ▶  Question Reports menu item presents five property pages for printing different question-related reports directly from your question bank. Click on the tab control corresponding to the desired page of preferences. A question bank must be open to access this menu item.

Note: Refer to Appendix D for screenshots of sample reports.

Print  ▶  Question Reports  ▶  Questions

View a sample of this report in Appendix D: Sample Reports.
Print Parts:
Number
Prints a sequential number before each item.
ID (CAT)
Prints the question ID on a line preceding each item. If CAT is also checked, the
question’s categorical information is printed on the same line as the question
ID.
Stem
Prints the first content edit box of each item. For multiple choice questions, you
can check printing the stem and uncheck printing choices and still effectively
print the question.
Choices
Prints edit boxes containing the choices.
Feedback
Prints any content entered into the feedback area of an item.
Notes
Prints any content entered into the notes area of an item.
Resp Form
Prints any content entered into the response form area of an item.
Statistics
Prints the statistics area content of an item.
Categories
Prints the categorical information assigned to an item.
Dates
Prints date fields stored with an item (created date, modified date, reviewed date,
and the dates of the last three tests that used the item (provided that you posted
the test dates from the Tests Window).
Answers
Prints the answers area of an item.
Numbering:
Starting page
Sets page number for the first printed page.
Starting question
Sets number for the first question.
Effects:
Mark correct answer
Prints a check mark by the correct choice on multiple choice questions.
Frame questions
Prints a border around each item.
Preceding underline
Prints a short underline before each question number (for the purpose of allowing
students to annotate correct responses on a paper-and-pencil test).
Separate pages
Prints each item on a separate page.
Area titles
Prints the label titles preceding the selected print parts, e.g., “Feedback” or
“Statistics”.
Output:
Preview
Sends report to the screen.
Printer
Sends report to the printer.
Selected:
This question Only  Prints the bank report ONLY for the current item.
All               Prints for all questions.
Selected          Prints only for selected questions.
Margins:          Sets print margins for the specific report, over-riding any others.
Top               Sets upper print margin.
Bottom            Sets bottom print margin.
Left              Sets left print margin.
Right             Sets right print margin.
Headers...        Sets the pages for header and footer printing on the Bank Listing Report.

Print » Question Reports » Bank Information

View a sample of this report in Appendix D: Sample Reports.

![Figure 30: Question Reports: Bank Information](image)

Summary listings:
Item type       Provides counts for each type of item (multiple choice, true/false, etc.)
Objective       Provides item counts for each type of objective.
Category 1 (.8) Provides item counts for each assigned category.
Effects:
Separate pages  Prints summaries on separate pages.

Print ▶ Question Reports ▶ Bank Listing

View a sample of this report in Appendix D: Sample Reports.

![Figure 31: Question Reports: Bank Listing](Image)

<table>
<thead>
<tr>
<th>Print Parts:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Prints question ID.</td>
</tr>
<tr>
<td>Type</td>
<td>Prints question type.</td>
</tr>
<tr>
<td>Points</td>
<td>Prints point value.</td>
</tr>
<tr>
<td>p(Diff)</td>
<td>Prints difficulty statistic.</td>
</tr>
<tr>
<td>rpb</td>
<td>Prints point-biserial correlation statistic.</td>
</tr>
<tr>
<td>Time</td>
<td>Prints time allocated for question administration.</td>
</tr>
<tr>
<td>Modify date</td>
<td>Prints date the question was last modified.</td>
</tr>
<tr>
<td>Review date</td>
<td>Prints date the question was last reviewed.</td>
</tr>
<tr>
<td>Graphics</td>
<td>Prints number of graphics imbedded within the question.</td>
</tr>
</tbody>
</table>
Print ➤ Question Reports ➤ Item Distribution

Printout of the classification/structure of the bank items.

View a sample of this report in Appendix D: Sample Reports.

![Question Reports: Item Distribution](image)

Figure 32: Question Reports: Item Distribution

- **Primary sort:**
  - Objective or Category 1 (.8)
  - Sets primary field to sort items.

- **Secondary sort:**
  - Objective or Category 1 (.8)
  - Sets secondary field to sort items.

- **Count field:**
  - Objective or Category 1 (.8)
  - Sets the field for counting the number of items that are within the primary and secondary sort fields.
View a sample of this report in Appendix D: Sample Reports.

Link reports:
- **Inclusive Soft Links**: Lists every item that has an inclusive soft link and displays (to the right) the lead-in item that must be included with it.
- **Inclusive Hard Links**: Lists every item that has an inclusive hard link and displays the linked items (below), and their order, that are to be included with it.
- **Exclusive Links**: Lists every item that has an exclusive link and displays the items (below) that must **not** be used with it.
Import

The import menu item provides a powerful set of wizards for transferring in data from other applications. This Import section specifically discusses importing question data. Other data types import similarly. For information on importing other types of data (scores, students, etc.), please refer to the other import discussions under the different databases. For example, if you are importing score data, refer to page 235.

CAUTION! You cannot “undo” an import. Before performing any import, you should ALWAYS make a backup copy of your questions file!

Overview of the Import Process

Import options vary depending on the type of import you choose. The following is step-by-step example of importing question data into a questions file.
Identify Source and Destination Files
Specify Delimiters
Choose Fields and Order
Begin the Import
Templates

Templates store sets of standard import (or export) procedures. Procedures will differ depending on the type of data being processed (and whether the data is being imported or exported). Refer to page 65 for an example of using a template.

Import File Types

Questions
Import questions into a question bank.

External Answer Key
Import externally created answer key data into automatically-created bank and tests files.

Test Specification
Import item selection criteria into a specs file.

Scores
Import score data into a scores file.

Grading Table
Import grading table specifications into a grading table file.

Students
Import student information into a student list file.

Import File Formats

Question data may be imported from several file formats, as discussed below:

CAUTION! You should be aware that, by default, LXR•TEST will consider an imported item to be a multiple-choice (single response) item unless specified by the Question Type field. You therefore should always specify Question Type when importing questions.

Native

The file format LXR•TEST internally uses. (Files in other formats must be converted to the native format before they can be processed by the program.) Native format is recommended when importing/exporting data within the LXR•TEST software. For example, choose this format when importing questions from one bank file into another. Since LXR•TEST question banks do not allow questions to have the same ID (Objective and Sequence), you will need to instruct the program on how to handle potential duplicate items during the import process: (a Selection Window, with the following choices, will pop up after you click Finish)
Replace existing item  If an incoming question’s ID matches an ID in the current questions file, the incoming item will replace the existing item in the current questions file.

Skip incoming item  If an incoming question’s ID matches an ID in the current questions file, the incoming item is not imported, leaving the existing item in the current questions file unchanged.

Resequence incoming item  If an incoming question’s ID matches an ID in the current questions file, the incoming item is assigned a new sequence number under the same objective. The existing item in the current questions file remains unchanged.

Merge

Merge format is a specially organized ASCII text file. Merge format provides an ordered method for mapping imported data to various fields within the LXR•TEST program. Thus, merge format must conform to strict formatting requirements. (For simple question import, use the Text file format.)

The first line of a merge file is called a “merge header line.” This line must contain valid names for the LXR•TEST data fields that will receive the mapped, imported data. Each field must be separated by a delimiter character, such as a TAB character. Refer to the “Questions file Merge Field Names” table in Appendix C: Merge Fields Names. The very first two fields should contain the question ID - both objective (OBJ) and sequence (SEQ). A record delimiter character, such as a return/line break, must end the merge header line. This record delimiter must also end the last field entry of every set of question data, in order to signify the beginning of the next question’s set of data.

**CAUTION!** The imported text itself must contain no delimiter characters.

You cannot have any objectives and sequences missing; import will not succeed if any are missing.

When you import from merge files, be careful to select the appropriate fields you want to include in your import. Otherwise, you may “lose” information, such as question type, during import. For a complete list of merge field names and permitted values refer to Appendix C: Merge Fields Names.
Here is an example of a merge file, as displayed in Word:

| OBJ → REQ → Q_TYPE → STEM → CHOICE_A → CHOICE_B → CHOICE_C → CHOICE_D → ANSWER |
|----|----|----|----|----|----|----|----|----|-----|
| MATH → 8 → MATH → It costs approximately $150 per week to feed a family of 4. What would it cost to feed a family of 7? $280 = $420 = $380 = Some of the above. |
| MATH → 9 → MATH → A diver, starting at the surface, is descending at a rate of 18 feet per minute. At the depth of 900 feet, how long has the diver been descending? → 10 minutes = 8.5 minutes = 9.5 minutes = 10 minutes. |
| MATH → 10 → MATH → If 5 computers are required for every 5 students and the school has 7th graders with an average enrollment of 321 students per class, approximately how many computers are needed for the entire school? → 35 → 50 → 150 → 1605 = 0 |
| MATH → 11 → MATH → Ken wants to tile his kitchen floor. The tiles are 9” x 9”, and cost $8.00 for a box of 45 tiles. Tile is only sold by the full box. The kitchen is rectangular and measures 12 feet by 16.5 feet. One gallon of adhesive costs $10.00 and will cover 150 square feet. Can Ken tile his kitchen for less than $600.00? → 0 → 1 → 18 |
| MATH → 12 → MATH → Any number divided by itself equals 1 → 1 → 1 → | 0 |

As you can see, the TAB characters (that display as right-arrows) separate the field entries. In this example, the merge header line contains nine different data fields: objective, sequence, question type, stem, choice A...D, and the correct answer. The carriage return symbol \n marks the end of the merge header line.

While it may be useful to create merge files via a word processor application, such as Word, it is often visually more useful to examine a merge file via a spreadsheet program, such as Excel:

As you can see, displaying a merge file in spreadsheet format makes the question data much more readable!

**Selection**

The Selection import format is a special subset of the merge format that allows for the external specification of questions to be selected from a bank. Selection is an alternative to use of the Selection Window. Selection is essentially a text file listing which questions LXR•TEST should select.
In order for a Selection import to select items, “OBJ” and “SEQ” (separated by a TAB) need to be specified in the merge header line. Each additional row would list an item to be selected from the currently opened bank. Here is an example of Selection import file content:

```
OBJ <tab> SEQ <enter>
INERT GAS <tab> 1 <enter>
INERT GAS <tab> 3 <enter>
INERT GAS <tab> 6 <enter>
PERIODIC TABLE <tab> 3 <enter>
PERIODIC TABLE <tab> 4 <enter>
PERIODIC TABLE <tab> 7 <enter>
```

The above Selection merge file would be used to select the following six items: Inert Gas 1, 3, 6; Periodic Table 3, 4, 7.

**Text**

Text format involves characters coded according to the ASCII standard. This format provides a simplified format for handling data, such as multiple-choice items, without the strict formatting requirements of Merge format. Text format also provides flexibility in creating data in or loading data from applications such as Word and Excel. However, **text format import is strictly limited to question content only**, i.e., stem and choices. Therefore, question types, text formatting, graphics, etc. will need to be manually added after text import has been completed.

Tip! Avoid importing matching-type questions under the text import format. Matching question imports are BEST handled by the native format and merge format (when Question Type field is included).

For proper import, files must conform to basic guidelines (discussion follows) and be saved as “Text only” format. When text import occurs, an input window asks for how the question numbers are punctuated (e.g., “1.” or “(1)” or “1”) and how a question’s choices are labeled (e.g., “A.” or “a.” or “a”). Therefore, import text files need each question to be sequentially numbered, and each choice to be consistently labeled.

During the import procedure, LXR•TEST will scan the text file, looking for the starting question number. Finding it, the accompanying text will be loaded into the question stem. When the program encounters the accompanying choice label “a”, the accompanying choice text will be loaded into the first choice edit box. Any additional text that may follow the last choice will be placed into the edit box for the last choice. The process then repeats.

If you want to import in a specified correct answer, then you must ensure that a colon immediately follows the label “answer.”
Here is an example of a properly formatted question for TEXT import:

1. Bill and ____ have decided to go for a boat ride on the river. <enter>
   A. me <enter>
   B. him <enter>
   C. her <enter>
   D. I <enter>
   Answer: D <enter>

Note: Imported questions under text format will default to the UNTITLED objective, unless you specify a different objective.

Export

The export menu item provides a powerful set of wizards for transferring data out to other applications. This Export section specifically discusses exporting question data. Other data types export similarly. For information on exporting other types of data (scores, students, etc.), please refer to the other export discussions under the different databases. For example, if you are exporting score data, refer to page 236.

Overview of Export Process

Very similar to that for the import process. See the Overview of Import Process for screenshot reference.

Templates

Templates store sets of standard export (or import) procedures. Procedures will differ depending on the type of data being processed (and whether the data is being exported or imported).

Selection

Choose whether to export all bank questions, or only the selected ones.

Export File Formats

Question data may be exported from several file formats: native, merge, text, html, and rich text.
Native

This is the file format LXR•TEST uses internally. (Files in other formats must be converted to the native format before they can be processed by the program.) Native format is recommended when exporting/importing data within the LXR•TEST software. For example, choose this format when exporting questions from one bank file into another.

Merge

This file format is a specially organized ASCII text file. Merge format provides an ordered method of mapping data to various fields within the LXR•TEST software. Thus, merge format must conform to strict formatting requirements. See Appendix C: Merge Fields Names. For simple question export, use the Text file format (discussed later).

When exporting in merge format, the first line (called a “merge header line”) of a merge import file will contain the valid names of the (data) fields to be imported, each field separated by a delimiter. Refer to the “Questions file Merge Field Names” table in Appendix C: Merge Fields Names. The first two fields selected should contain the question ID - both objective (OBJ) and sequence (SEQ).

When you export question data to merge files, be careful to select the appropriate fields you want to include in your export. Otherwise, you may “lose” information, such as question type, during export. For a complete list of merge field names and permitted values refer to Appendix C: Merge Fields Names.

Tip! To easily see the structure of an exported merge file, inspect it in your spreadsheet or word processor.

Text

Text format involves characters coded according to the ASCII standard. Text format provides a simplified format for handling data, such as multiple-choice items, without the strict formatting requirements of Merge format. Text format also facilitates use of question data in applications such as Word and Excel.

When text export occurs, you will first be asked to define the field and record delimiters to be used to separate the exported data. Then, an export window will ask for the fields - and their order - to be exported. The only fields that can be chosen for text export are: ID, Contents (Stem and Choices), Feedback, Notes, Response Form, and Answer. Since text format is simple in nature, only text itself can be exported under this method. Thus, question types, text formatting, categorical information, graphics, etc. will be lost during the export.

Therefore, it is recommended that you normally export question data via the merge file format. Merge file format should especially be used if you intend on later importing this data.
HTML

The wizard program for the Hypertext Markup Language (HTML) file format provides a convenient method for exporting data into a web-ready HTML file, which can be readily viewed by a web browser.

The exported questions are displayed in a single HTML file (with all selected field entries) in question ID alphabetical order.

Note: All question edit box text will be published to the export web document, including variable notation (%variable%). Thus, the export web document may need to be manually "tweaked" by the user before final presentation.

Rich Text (RTF)

This file format is used for transferring formatted text documents between applications, even those applications running on different platforms, such as between IBM compatibles and Apple Macintoshes. Data text will retain stylizing, such as bolding, italics, super and subscripting, etc.

Send...

Opens your default e-mail program and encloses the active database file as an e-mail attachment.

Recent

Lists your recently opened LXR•TEST (database) files for easy access.

Preferences

The Preferences menu calls up several pages of program settings, from editing controls to system-level security controls:
Editor settings:

Drag-and-drop text editing
Check to enable drag-and-drop of question text and graphics between edit boxes.

Default tab stops
Sets the distance between default tab stops on the text ruler. By default, this value is zero, meaning that no tabs are automatically set on the Text Ruler.

Question settings:

Confirm changes in correct answer
Check to enable answer change confirmation.

Create Instructions with "No Widow"
By default, this option is checked. Refer to the discussion of the “No Widow” control in the previous Format Toolbar section.

Scramble choices
By default, this option is checked. Enables the scrambling of choices for newly created multiple-choice questions. Refer to the discussion of the “Scrambling Choices” control in the Answers Area, on page 128.
Converter

Configures LXR•TEST 6.0’s handling of LXR•TEST version 5.1 (or 5.0) data files.

Automatic Conversion
If checked, LXR•TEST will automatically convert any encountered 5.1 file, without prompting the user.

Prompt before converting primary 5.1 file
If checked, LXR•TEST will prompt before automatically converting any 5.1 file that you open.

Prompt before converting secondary 5.1 files
If checked, LXR•TEST will prompt before automatically converting a secondary file. A secondary file is a prerequisite file. For example, a bank is a prerequisite file for a tests file; questions must be accessible for a test to be functional, since a tests file doesn’t contain a copy of the question data – it refers to the stored question data in the bank.

Prompt for new 6.0 filenames
If checked, LXR•TEST will prompt for a new file name to save the converted file under.

Look for any secondary files in same folder as primary 5.1 file
If checked, LXR•TEST will search for secondary files in the current folder of the launched primary 5.1 file. This feature is helpful in the event that both primary and secondary files have been moved to a different location than where they were created. (Ordinarily, a primary file will refer to the original location of a secondary file, even if the primary file was moved to a new location.)
Do not create log file  

By default, a log file will automatically be generated to track the conversion process.

Metafile Graphics:

Note: The following options only apply to Windows metafile graphics (WMF file extension).

All other supported graphic formats are inserted in inline format during file conversion.

Insert graphics inline  

Incoming WMF graphics from a 5.1 bank are treated just as a text character and will wrap from one line to the next as text is either inserted or deleted, or as the ruler size is changed.

Insert graphics floating  

Incoming WMF graphics from a 5.1 bank are placed at a specific location with respect to the upper left corner of the edit box. The graphic will remain at this fixed location even if text is inserted or deleted.

Note: If a 5.1 bank has objective descriptions, then a grading table will be created during the conversion process in order to store this information.

Headers

Configures the use of default headers for reports.

If header not open, use factory headers on reports

An open headers file will set the headers for all reports. If NO headers file is open AND this option IS checked, then LXR•TEST will use the specified default headers file to set report headers. If no headers file is open and this option is NOT checked, then no headers will appear on reports.

Misc.

Sets the base unit of measurement; allows for backward compatibility on Gradebook export.
Units  Inches, Points, or Centimeters. Default setting: inches. Adjusting the unit of measurement will adjust all other setups that involve measurement units, such as the “Default tab stops” option (Editor tab).

Gradebook  Check this box to enable Gradebook export file to be compatible with some older Gradebook programs.

Aux Files

Establishes the locations of additional files, such as where the export and import templates are stored.

![Figure 38: Preferences » Aux Files](image)

System Level Security

Enables system-level password protection. LXR•TEST 6.0 databases are compatible with Microsoft Access databases. To promote security, the system level security option writes an encrypted password to a database file. Anyone attempting to access a 6.0 database via Microsoft Access will be prompted to provide the password.

Note: The system level (external) password option is separate from the read/write (internal) password option (Utilities menu). Refer to page 187 for discussion of the internal password feature.
Enable system password control
Check box to activate system password protection.

System security controls

Automatically assign this password...
The entered password will be automatically assigned and encrypted for each new database file that will be created (e.g., bank, test, scores files). You must enter the password a second time for verification.

Prompt for system password...
This option allows you to set different passwords on different database files that will be created, by prompting each time for a password.

Create (or rebuild) database security key file
This option must be checked in order for a security key file to be created. Once a security key file has been created, you will not need to verify your system level password in LXR•TEST 6.0 whenever you open the database.

In the event that a security key file is missing, you will not be able to automatically access the corresponding database file, either internally with 6.0 or externally with Microsoft Access. This option also allows for the rebuilding of the missing key file, **but you will be prompted to enter the correct password**.

Tip! You should write down your passwords and store them in a secure place for future reference.

Exit
Choose to close all open LXR•TEST Windows and exit the program. Latest changes will automatically be saved before each window is closed.
Edit Menu

Undo
Undo enables you to undo previous text editing operation(s) within the item, as long as you did not leave the item before attempting to undo.

Redo
Redo enables you to redo some text editing operation(s), as long as you did not leave the item before attempting to redo.

Revert
Revert cancels all editing changes, going back to the last saved version of the item.

Note: Moving to another item will save any changes to the current item.

Cut
Cut removes the highlighted text (or highlighted object) and moves it to the Clipboard.

Copy
Copy places a copy of the highlighted text (or highlighted object) on the Clipboard.

Paste
Paste places a copy of the Clipboard contents (inline) at the cursor location, in the current edit box.
Clear
Deletes the highlighted text or object. (Same function as the Delete key.)

Select All
Selects all text and objects located within the current edit box.

Note: You can “select all” text in another area of the Questions Window (e.g., Feedback Area) while keeping all selected items of a previous area highlighted.
Insert Menu

Graphic Inline

Insert a graphic file in inline layout at the text insertion location. Inline graphics will behave like text characters – they will move with text as text is edited. Currently supported graphic formats include: BMP, GIF, JPEG, TIFF.

Tip! In order to move an inline graphic you need to double-click on it to highlight it, then click-hold-drag to the new location. “Drag-and-drop text editing” must first be selected (under Preferences).

If you also hold the CTRL key while dragging the graphic, a copy of the graphic will actually be dragged to the new location.

Graphic Floating

Insert a graphic file in floating layout at the text insertion location. Floating graphics will remain in stationary position; text will wrap around the object. Currently supported graphic formats include: BMP, GIF, JPEG, TIFF.

Tip! In order to move a floating graphic using your mouse, you need to click on the graphic to select it and then hold the ALT key while you click-hold-drag the graphic to a new location.

After you have selected the graphic, you can also move the graphic via the arrow keys on the keyboard; using the arrow keys will move the graphic 10 pixels in the given direction while holding the CTRL key while using the arrows will move the graphic 1 pixel in the given direction.
Object Inline

Note: Concerning online testing (see Part II), objects are only compatible with LAN-based tests.

Insert an object in inline layout at the text insertion location. Objects can be inserted as embedded or linked. Embedded objects contain the content of the object within the question. Any later changes made to the source file of the object will **not** be reflected in the object embedded in the LXR•TEST bank. Linked objects, however, contain a reference to the source file. Therefore, any later changes made to the source file **will** be reflected in the linked object in the LXR•TEST bank.

Both embedded and linked objects only can be edited by their source applications. Double-clicking on the inserted object will generally permit limited editing control from the source application. However, holding the CTRL key while double-clicking on the object will permit full editing control from the source application.

Note: Each source application will respond somewhat uniquely while being accessed from within LXR•TEST. For example, while AVI movies will play within the LXR•TEST Questions Window, MOV movies will launch and play within the Quicktime application. When inserting an equation object, such as MathType, the equation’s baseline will automatically be adjusted to match that of text in LXR•TEST.

**Example of Inserting an Inline Object**

- Choose **Object Inline** from the **Insert** menu.

- The **Insert Object** dialog box displays:
  
  ![Insert Object Dialog Box](image)

- You can either insert a newly created object (**Create New**) or one an existing object (**Create from File**). For this example, verify that **Create New** is selected and **Microsoft Excel Chart** is highlighted.
Click **OK**.

Click the cursor in front of the **Excel Chart** object.

Type in **This is an example of an inline object**. Notice how the object is moved along like a text character.

To move the object, simply click-hold-and-drag the object to a desired new location.

If you desire, you can have the object break up a word, since it is in **inline** format:

![Example of Inline Object](image)

*Figure 40: Example of Inline Object*
Object Floating

Note: Concerning online testing (see Part II), objects are only compatible with LAN-based tests.

Insert an object file in floating layout, to a fixed location with respect to the upper left corner of the Questions Window. The procedure for inserting a floating object is similar to inserting an inline object, as exampled above. **Similarly, to relocate a floating object simply click-hold-and-drag to a new location.**

Both embedded and linked objects only can be edited by their source applications. Double-clicking on the inserted object will generally permit limited editing control from the source application. However, holding the CTRL key while double-clicking on the object will permit full editing control from the source application.

Note: The location of an object in inline layout will move during text editing, because it resides “inline” with the text. However, an object in floating layout will not move during text editing, because it resides in a fixed location (with respect to the upper left corner of the Questions Window).

Variable

Allows you to choose a LXR•TEST variable to insert at the cursor location. Highlight the name of the desired variable to insert (in the right panel of the Substitution Variables dialog) and click the Insert Variable button. Click the Done button when finished inserting the variable(s). For a description of program variables, refer to Appendix B: Substitution Variables.
**View Menu**

![Menu View]

**Status Bar**

Description bar at the very bottom of the program's Main Window. Brief descriptions of various menu items will appear when scrolling over menu items. Also notes if Num Lock, Caps Lock, and Scroll Lock are turned on.

**Links**

Opens up the Link Window:

![Link Window]

**Figure 41: Link Window**

Question links are established relationships between two or more questions. There are three types of question links: inclusive soft links, inclusive hard links, and exclusive links.
Question links are established within the Link Window. Questions (displaying their linking status) are listed in the left panel, while the right panel is a reserved area for holding items to be linked or unlinked. For steps detailing how to link questions, refer to page 56.

Tip! Double-clicking on an item in the Link Window will display the item in the bank.

During test construction, when a linked question is moved to the test, LXR•TEST automatically will move the linked question(s) over to the test as well, respective to the linking relationship. In the Tests Window, linked items display in italics.

Note: While working within the Link Window, when you move any linked (inclusive or exclusive) items over to the Linking Area, the corresponding item(s) will also be brought over into the Linking Area.

Linking information can be printed by selecting Print ▶ Question Reports ▶ Links (File menu).

Note: For online tests, when the first item of an inclusive link group is an instruction, this instruction item will display on the screen with each linked question appearing below.

**Inclusive Soft Links**

An inclusive soft link normally relates two questions in the following manner: One question is usually an instruction or reference item that needs to precede a question item. The instruction would be the “lead-in” item, while the question would be the “dependent” item. Whenever the “dependent” item was moved over to a test, the “lead-in” item would automatically preceed, ensuring that an instruction preceeded the corresponding question (in this example).

Note: Multiple questions are permitted to soft link to the same “lead-in” (reference) item. Notice in the Questions panel of the Link Window that each soft linked “dependent” question stores the question ID of the associated “lead-in” item.

For detailed steps in establishing an inclusive soft link between questions, refer to the section on “Creating Links”, beginning on page 56.

**CAUTION!** When establishing inclusive soft links between questions, the “lead-in” item should be moved to the linking area first. However, with soft links, the placement of subsequent “dependent” questions in the linking area is not important.
Inclusive Hard Links

Inclusive hard links are similar to their soft link relatives, except that all hard linked items are bound together in a group, where item order is strictly maintained. During test construction, when any hard linked item is moved over to the test, the entire linked group is automatically moved over to the test, with the hard link item order strictly maintained. Therefore, the ordering of items in the linking area is important, since this is how the group of items will be bound together.

For detailed steps in establishing an inclusive hard link between a set of questions, refer to the section on “Creating Links”, beginning on page 56.

Exclusive Links

Exclusive links are the opposite of inclusive (soft) links. Exclusive links are established to specify which items cannot be used together on a test. Once exclusive links are set, LXR•TEST will prompt you if you try to move an exclusively linked item over to the test (because the other item to be excluded is already on the test). You can, however, override the warning and still place this item on the test.

For detailed steps in establishing an exclusive link between questions, refer to the section on “Creating Links”, beginning on page 56.

Figure 42: Exclusive Links
Question Menu

New

New creates a new question in the current bank.

Delete

Delete removes the current question from the open questions file. You are asked to confirm this delete.

Note: Although the item is deleted from the bank, the database space that it once occupied in the questions file is not automatically reclaimed. To recover space from deleted questions, use the Compact Database option (Utilities menu).

Delete Selected

Delete Selected removes all selected questions from the open questions file. You are asked to confirm this delete.

Duplicate

Duplicate creates a duplicate copy of the current question under the same objective and with the next available sequence number. The new duplicate question then becomes the current question.

First

Displays the first item in the questions file, or the first selected item if the view is restricted to selected questions.
Previous

Displays the item preceding the current question, or the selected item preceding the current
if the view is restricted to selected questions.

Next

Displays the item following the current question, or the selected item following the current if
the view is restricted to selected questions.

Last

Displays the last item in the questions file, or the last selected item if the view is restricted to
selected questions.

Resequence

Allows you to insert or remove a single item from an existing objective, and resequence the
items that follow the inserted or removed item. You are asked to confirm this change.

Tip! If you want to either re-sequence (or re-classify) multiple questions, then you should
consider using the Global Changes › Reclassify option (Utilities menu).

CAUTION! Be careful when resequencing! If you change a question ID for an item on a
test, then the test will no longer be able to locate the item!

Reminder: Tests only save the question IDs and bank locations, and NOT any
actual question content.

Resequence › Insert

Inserts a new question with the same objective and sequence number as the current question.
The current question and all subsequent questions in the objective are automatically re-
assigned a sequence number one greater. For example, if the current question is GEOMETRY
2 and you use this option, then the current question becomes GEOMETRY 3, and so forth. A
blank question GEOMETRY 2 will be ready for editing.

Resequence › Remove

Removes the current question and resequences all subsequent questions in the objective to
be a sequence number one less. For example, if the current question is GEOMETRY 002 and
you use this option, the current question is deleted and GEOMETRY 003 now becomes GEOMETRY 002, and so forth.

Select Menu

The Select menu provides operations for finding and selecting questions. Question selection can provide significant power and versatility for constructing tests, exporting question data, performing global question changes, printing, and more.

Select

Brings up the Selection Window, which enables you to automatically select items based on specified criteria:

**Figure 43: Selection Window**

<table>
<thead>
<tr>
<th>Selection type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New selection</td>
<td>Questions meeting the current selection criteria are chosen from the entire bank. (The previous selection is automatically cleared.)</td>
</tr>
<tr>
<td>In addition to those already selected</td>
<td>Additional questions meeting the current selection criteria are added to those questions that are already selected.</td>
</tr>
<tr>
<td>From within those already selected</td>
<td>Questions meeting the current selection criteria are chosen from the set of questions that are already selected.</td>
</tr>
</tbody>
</table>
### Field
Pop-up list of question parts that can serve as selection criteria.

**Tip!** Questions containing a graphic or object can be selected by selecting **# of Objects** for the **Field** value, and by setting the **Value** to 1 (representing either one graphic or one object).

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>contains:</td>
<td>field contains the value</td>
</tr>
<tr>
<td>equals:</td>
<td>field matches value exactly</td>
</tr>
<tr>
<td>not equal:</td>
<td>field does not match value</td>
</tr>
<tr>
<td>greater than:</td>
<td>field is greater than or equal to specified value</td>
</tr>
<tr>
<td>less than:</td>
<td>field is less than or equal to specified value</td>
</tr>
</tbody>
</table>

### Value
Either choose from pop-up, or enter, a value to be compared with the field.

### Action
- **or:** adds optional selection condition for current selection statement
- **and:** adds required selection condition for current selection statement
- **END:** done with selection criteria (you are ready to execute selection by pressing the Select button)

- ![Delete](image)
  - Deletes the current selection statement line.

- ![Insert](image)
  - Inserts a new selection line above the current selection line.

**Note:** Selection statements are always processed from left to right. For example, A AND B OR C is interpreted as ((A AND B) OR C) [not the same as (A AND (B OR C))].

### Select One
Select One adds the current question to those already selected. If the question is already selected, then Select One removes the question from those currently selected.

### Select All
Selects all items.

### Select Inverse
Unselects all items that are currently selected and selects the group that was not.

### Clear Selected
Deselects all items that were previously selected.
Recall Selection

This menu option will be unavailable unless a selection of questions was previously saved for the bank. See “Save Selection.”

Save Selection

This menu option will allow you to “remember” your selected questions after you close a bank. When you re-open the bank, you can “remember” the selected question in the bank, by using the “Recall Selection” option.

Note: This option will be unavailable unless questions have been selected in the bank.

Window Menu

The Windows menu lists all the open LXR•TEST files and provides options for working/displaying these files.

The currently active window has a checkmark next to it. When more than one file is open, you can change the file to be active by selecting it from the Window menu. Other display options are discussed below:

Cascade

Slightly offsets while overlapping open windows, placing the active window on top.

Tile

Tiles all open file windows.

Arrange Icons

Places all minimized windows at the bottom of the Main Window.

Note: Minimized windows are normally put at the bottom of the Main Window. However this option is useful if you move around minimized windows.
Utilities Menu

Reset

Restores the active window back on top and back to its original window size (when you opened the corresponding LXR•TEST file).

Utilities Menu

Question Setup

Question Setup allows you to configure a number of preferences that govern question layout, formatting, and content.

When creating a new questions file, it is highly recommended that all changes, if any, to factory settings be done before entering items. Once questions have been entered into the questions file, any changes to the Question Setup options marked with asterisks (see next Figure) will result in the reformatting of all questions. In this case, you may need to make adjustments in the preferred display of certain items - particularly those containing floating objects.

Tip! If you need to adjust the factory settings, it is highly recommended that you experiment with the adjustments on a small number of sample questions in a new bank.

Any changes made in Question Setup are stored both with the current bank and in the Windows registry.
Margins

Note: Text ruler units are determined by your preferred unit of measurement, as specified in File > Preferences > Units tab.

Question Spacing:

- **Body Width**: Sets the (screen) page width for one-column questions. Changes to this value will automatically reformat all questions.
- **Between Questions**: Sets the space between printed questions. This value only alters the printed display and can be changed at any time without reformatting any questions.
- **Between Stem & Choices**: Sets the space between question stem and choices for printed questions. This value only alters the printed display and can be changed at any time without reformatting any questions.
- **Between Print Columns**: Sets the column space between printed (multi-column) questions. Changes to this value will automatically reformat all questions.
- **Between Matching Lists**: Sets the space between list elements of matching questions. Changes to this value will automatically reformat all matching questions.
- **Label Gutter**: Sets the space reserved for printing choice labels for those questions that have labels (i.e., multiple choice, true/false, matching). Changes to this value will automatically reformat all questions.
Number Gutter

Sets the space reserved for printing question numbers. Changes to this value will automatically reformat all questions.

CAUTION! If the Number Gutter value is set too great, you may have to reduce column width in order to avoid question text from being truncated (during printing) on the right side of the page.

Restore factory settings

Restores all entry values to program original values.

Font/Size/Style

Access to configuring the font, font size, and font style for the different question parts. A standard Windows font dialog box will open when you click the “Select Font/Size/Style” button.

Figure 45: Question Setup ▶ Font/Size/Style

Note: All font settings adjustments will only apply to NEW items. (With the exception of labels font setting.)

To change the font settings of existing questions, use the Font/Size/Style option under Global Changes, as discussed on page 179.

Labels

Access to configuring the appearance of number and choice labels for multiple-choice, true/false, and matching questions. The edit boxes before and after the number configure the “punctuation” of question numbers, e.g. “(1)” or “1)“. There are 26 edit boxes for the question labels. By default, LXR•TEST will use the 26 letters of the alphabet (capitalized). Each edit box for the Labels and True/False sections can hold up to five characters.
Figure 46: Question Setup > Labels

Note: Label changes will immediately affect the displaying and printing of all questions in the bank.

The Uppercase and Lowercase buttons alter the case of the question labels (if alphabetic). The Numeric and Alphabetic buttons alter the labels between numbers and letters.

Use of “Restore factory settings” easily restores the default labels.

Note: The substitution variable %answer% borrows from these labels, with the punctuation removed. These choice labels are also used for response booklet (when a question’s response form area is left blank).
Category Titles

This option permits editing of category titles for question categories. There are eight available category titles, each holding up to 20 characters for category name. By default, the titles for these categories are Category 1…8. As with the other Question Setup preferences, category titles are stored with the currently open questions bank.

![Figure 47: Question Setup ▶ Category Titles](image)

**Tip!** If you set your Category Titles when no bank is currently open, then these labels will automatically be inherited whenever you create a new bank.

Copyright

Copyright allows bank copyright information to appear in the footer of each associated test. The print substitution variable %copyright% is required for the bank copyright to appear in the header, footer, or cover page. The factory setting places %copyright% in the footer.

![Figure 48: Question Setup ▶ Copyright](image)
Global Changes

This feature enables you to perform changes on the designated item(s): the current question, all questions, or selected questions.

Note: Any test must be closed before you can access Global Changes.

CAUTION! Global changes cannot be undone! It is highly recommended that you make a backup copy of the questions file before applying Global Changes.

Each Global Change feature allows you to designate the scope of the applied change:

Reclassify

Allows you to rename the objective for the designated question(s):

Figure 49: Global Changes  Reclassify
Change objective to: Enter the new objective name.

Resquence questions
When enabled, LXR•TEST will renumber the sequence numbers of the items being renamed. The renumbering will begin with the starting sequence number. If not enabled, the renamed questions will retain the same sequence numbers.

Starting sequence number

Note: When you reclassify questions from different objectives into a single, new objective, you should verify that this option is enabled. This will ensure that each reclassified question is given a unique sequence number; question overwriting will be avoided.

Tip! Reclassifying questions is typically reserved for use in changing multiple questions. You can rename a single question’s objective directly within the Questions Window.

CAUTION! If reclassified items are on existing tests, there could be problems when trying to work with such tests.

Font/Size/Style

Allows you to change the font characteristics of the various question parts, for one or more items. For setting font characteristics for new questions, you must use Question Setup, as discussed on page 175.

Exercise caution in making font changes. For example, if you change the font style to bold, other style attributes will be overwritten by the bold style.

Note: Subscript and superscript preempt other styles and will remain in effect during Global Changes.
Question Type

Allows for changing the question type of the designated item(s).

![Question Type Diagram]

Search & Replace

Enables text substitutions for the chosen question part(s) of the designated question(s).

![Search & Replace Diagram]

**Figure 51: Global Changes → Search & Replace**

**CAUTION!** If you leave the “Search for:” edit box blank, all existing text in the designated question part(s) will be selected and replaced with the replacement text, for the designated question(s). This will happen regardless of the setting of the “Equal to/Contains” option buttons.
Search for: Enter existing text to be replaced. See above cautionary note.

Equal to: If the “Equal to” option button is selected, the “Search for:" text will be replaced if it is the only text in the question part.

Contains If the “Contains” option button is selected, the “Search for:" text will be replaced if it is contained within the question part.

Replacement/Insertion text: Enter new text to replace the “Search for:" text.

Columns

Changes “ABC” (choice) column or “123” (print) column layouts for designated question(s).

Figure 52: Global Changes ▶ Columns

Scramble

Permits changes to the scramble status of the designated question(s). Also permits the reshuffling of version answers.
Figure 53: Global Changes  ▶ Scramble

**Scramble Choices:**

- **No change**: When selected, the scramble choice status of the designated question(s) will not be altered. Option must be selected to access “Randomize version answers.” (see the following “Randomize version answers”)
- **Enable choice scrambling**: Select to turn on “choice scrambling” for the designated question(s).
- **Disable choice scrambling**: Select to turn off “choice scrambling” for the designated question(s). Reminder: All version answers will be the same.
- **Randomize version answers**: Only accessible when “No change” is selected. Option will only reshuffle the version answers for the designated question(s). Note the visible changes in the version answers in the answers area of the designated question(s).

**Clear Statistics**

Allows the clearing (resetting) of statistics for the designated question(s).

Figure 54: Global Changes  ▶ Clear Statistics
Check:
User Values (1 to 4) When checked, LXR•TEST will clear out the user defined values for the designated question(s).

All Group Stats
  e (equator) When “All Group Stats” is checked, all of the listed statistics (below) will be cleared out for the designated question(s). You can also choose to target specific statistics to clear out.
  E.T. (Elapsed Time)
  rpb (Point Biserial)
  p (Difficulty)

Admins

Reformat

The Reformat option is for reformatting entire questions. Designated question(s) will be reformatted based on current text, ruler and margin settings.

Tip! It is generally a good idea to reformat questions that were converted from a 5.1 bank.

Figure 55: Global Changes ▶ Reformat
Spelling

Opens up the Spelling Window, from which all Spelling Checker options can be accessed.

![Figure 56: Spelling Window](image)

The Spelling Checker always begins with the location of the cursor.

Note: The Spelling Checker will stop at the end of the bank.

Even if the Selection view is set to display selected questions, the Spelling Checker will still check all questions for spelling errors.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suggestions</td>
<td>Must be checked to display suggestion words (for misspelled or unknown words) in the left list box.</td>
</tr>
<tr>
<td>Word Not Found:</td>
<td>Displays the misspelled or unknown word.</td>
</tr>
<tr>
<td>Replace It With:</td>
<td>Enter the replacement word (or phrase) here or have it automatically entered when you highlight a suggestion word (or phrase).</td>
</tr>
<tr>
<td>Select Misspelled Items</td>
<td>Any item that contains any misspelled or unknown words will be selected.</td>
</tr>
<tr>
<td>Check Only This Item</td>
<td>Spell check only within this particular question.</td>
</tr>
<tr>
<td>Go/Stop</td>
<td>Instructs LXR•TEST to begin spell checking from the beginning of the current question. During spell checking, the Go button becomes a Stop button, enabling you to stop spell checking at any time.</td>
</tr>
<tr>
<td>Skip Once</td>
<td>Ignores the current “word not found” and continues the spell checking.</td>
</tr>
<tr>
<td>Skip All</td>
<td>Ignores this occurrence and every future occurrence of the current “word not found” during the spell checking.</td>
</tr>
<tr>
<td>Replace</td>
<td>Replaces the misspelled word with the word provided in the “Replace It With:” edit box. You can either directly type a word (or short phrase) into this edit box or click on one of the words from the Suggestions list (on the left).</td>
</tr>
</tbody>
</table>
Add

Dictionaries

Adds the unknown word to the current dictionary.

**Dictionaries Window**

**Words:** When the chosen dictionary file is not “ignore.tlx,” the words within the dictionary’s lexicon will display in the list box. The currently highlighted word from this lexicon will display in the edit box. You can enter a new word (phrase) in the edit box.

**Add Word**

Adds the word displayed in the “Words” edit box to the currently selected dictionary file.

**Delete Word**

Deletes the currently selected word in the list box.

**Import**

Import new words to add to the dictionary from an ascii text file.

**Export**

Export currently selected dictionary’s lexicon to an ascii text file.

**Other word:**

Enter an associated word to suggest for the word currently displayed in the edit box.

**Action:**

Choose from a selection of actions to take when a word is not found in the dictionary.

**Files:**

Choose from within the drop down box which dictionary (lexicon) to use. Description of the types of available dictionaries follows.

**Add File**

Add a dictionary to the Spell Checker.

**New File**

Create a new dictionary file.

**Remove File**

Remove a dictionary file from use with Spell Checker.
Options

Enable desired spelling checking features:

LXR•TEST lexicons (dictionaries) are located in the `C:\Program Files\LXR\LXRTEST V6\Spelling` folder (or as otherwise specified in the Preferences ▶ Aux Files tab (File menu). If you do NOT want to include a specific dictionary for spelling check of your banks, you can remove it from this folder. The following files are referenced by the spelling checker. Additional dictionaries are available for other languages.

<table>
<thead>
<tr>
<th>Dictionary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMERICAN.TLX</td>
<td>American English Main Dictionary (text file)</td>
</tr>
<tr>
<td>AMERICAN.CLX</td>
<td>American English Main Dictionary (compiled file)</td>
</tr>
<tr>
<td>BRITISH.TLX</td>
<td>British English Main Dictionary (text file)</td>
</tr>
<tr>
<td>BRITISH.CLX</td>
<td>British English Main Dictionary (compiled file)</td>
</tr>
<tr>
<td>AMERICANMEDICAL.CLX</td>
<td>American Medical Main Dictionary (compiled file)</td>
</tr>
<tr>
<td>BRITISHMEDICAL.CLX</td>
<td>British Medical Main Dictionary (compiled file)</td>
</tr>
<tr>
<td>AMERICANLEGAL.CLX</td>
<td>American Legal Main Dictionary (compiled file)</td>
</tr>
<tr>
<td>BRITISHLEGAL.CLX</td>
<td>British Legal Main Dictionary (compiled file)</td>
</tr>
<tr>
<td>CORRECT.TLX</td>
<td>Contains several hundred common English misspellings and replacements.</td>
</tr>
<tr>
<td>Accent.TLX</td>
<td>Common English words containing accent or punctuation marks.</td>
</tr>
<tr>
<td>HTML.TLX</td>
<td>Common HTML words.</td>
</tr>
<tr>
<td>USER.TLX</td>
<td>User dictionary that stores (by default) added words.</td>
</tr>
<tr>
<td>IGNORE.TLX</td>
<td>Words to be ignored. Unlike the others, this file is NOT stored in the program folder, rather a separate ignore.tlx file is placed in each user’s profile directory. This enables each user to have his/her own list of words to be ignored by the Spell Checker.</td>
</tr>
<tr>
<td>LEGAL.TLX</td>
<td>Can be used by user to add legal terms.</td>
</tr>
<tr>
<td>MEDICAL.TLX</td>
<td>Can be used by user to add medical terms.</td>
</tr>
</tbody>
</table>
Security

The Security option allows you to change or clear a System Level password (see page 157), as well as to establish or change or clear internal database read/write passwords. While System Level passwords will prevent unwanted access of LXR•TEST databases in Microsoft Access 2000, internal read/write passwords will control access to databases within the LXR•TEST 6.0 program. Any user attempting to open a password-protected bank will be asked to enter the established password(s). If a read-access password is entered when opening the database in LXR•TEST, then the user will only be permitted to observe the database's contents. If a write-access password is entered when opening the database in LXR•TEST, then the user will be granted full access to the database (including the ability to make changes).

Note: LXR•TEST is case-sensitive in handling entered passwords. To LXR•TEST, "SNARF" is NOT the same as "snarf," for example. After entering or changing any passwords, you will be asked to confirm this.

CAUTION! Databases are inaccessible without the correct password(s). Be sure to write down your passwords and keep them in a safe place.
Compact Database

When editing and deleting item data in the LXR•TEST (question) database, the file can become fragmented and inefficiently use disk space. Using the Compact Database feature recovers wasted space by optimizing how the file is stored on your disk.

Tip! You will want to use this feature whenever you have deleted items from a database and when you have made significant editing changes to a database's content.

Repair Database

A (question) database file can become corrupt from a number of causes. These include hardware problems in writing to the file, accidental restart of the computer while a database is open, or a power failure before a database object is saved. Using the Repair Database feature attempts to rebuild the damaged LXR•TEST files.

Help Menu

Help Topics
Displays online help in HTML format.

About LXR... (LXRTEST)

About LXR•TEST will present the LXR•TEST logo screen, the program version number, the program copyright, the program software key, licensed user, company name, and the program expiration date (if a trial or evaluation copy).
**Tests Window**

The Tests Window is for constructing tests. In order to build a test, a question bank needs to be open. While it may be common practice for some users to build an entire test from a single question bank, LXR•TEST provides you with the flexibility of building a test from multiple question banks. In fact, as long as a question bank is open, you are able to choose questions from that bank to put on a test.

**Tests Window Description**

The Tests Window consists of two primary areas—referred to as panels. The panel on the left is the Questions Panel, and the panel on the right is the Test Panel. The process of building a test consists of moving chosen items from the Questions Panel to the Test Panel. Refer to the test building tutorial example, beginning of page 34, for assistance on building a test.

**Tip!** You may want to open a Tests Window even if you are not building a test. You can use the scrolling feature of the Tests Window to rapidly find any question in a bank. Double-click any item in the Tests Window to make it the current question in the Questions Window.

When you save a test, you are saving the order and IDs of the questions in the Test Panel, and not the actual content of the items themselves. When you open a test, LXR•TEST automatically opens the appropriate questions file(s) and retrieves the latest content of each question from the bank(s) when the program needs to print or display the test.

**Note:** There is only one copy of a question (located in a bank file), even though several tests may point to this item.
Question Bank(s):
Displays the name of the currently open questions file. If the test includes items from multiple banks, the additional bank names will appear in the drop down list. You can immediately open another associated bank by selecting its name from the drop down list. Right click on any listed question bank to access the “re-associate” option, allowing the test to be re-associated with a different bank.

Question View:
Used to set the view format for the currently open bank:

- **Item**: Lists each individual item, alphabetically by objective. Any item link dependencies can be displayed below each item.
- **Objective**: Lists all objectives, in alphabetical order, of the current bank. Individual items can be displayed beneath each objective.
- **Layout**: Lists all the question types, in alphabetical order, of the current bank. Individual items can be displayed beneath each type.
- **Category 1-8**: Lists all categorical entries, for the selected category, from the currently open bank. Individual items associated with these categorical entries can be displayed beneath each categorical entry.

**Note:** Category names are assigned in Question Setup Utilities Category Titles (Questions Window, Utilities menu).

Specification: Lists each selection statement of the current test specification associated with the test. Qualifying items for each selection statement are listed beneath each selection statement. (Specs Window must be open.)
All/Selected

Sets Question View to display for all items or only for previously selected items.

Test Date:

Test creation date. Date to be assigned to the "test date" substitution variable %testdate%.

Test Name:

Test name, to be assigned to the "test name" substitution variable %testname%.

Below the Test Name field are test statistic fields: items, time, difficulty, points. The items field counts the number of test questions; time counts the number of minutes needed to take the test; difficulty expresses the average question difficulty; points counts the number of points the test is worth.

Header 1:

Report headings for the currently displayed test. These headings are assigned to the substitution variables %testheading1% and %testheadings2% (Typically used in customized test report layouts.) Rather than creating a custom header for each tests file, you can simply type the heading text into this field and it will automatically print such text in any test report that has the "%testheading1%" or "%testheading2%" variable(s).

Header 2:

Items:

The number of test questions and test points automatically update as you move questions onto or off from the test. The amount of allocated time for online test administration also updates (refer to discussion of the Answers Area, beginning on page 125). The average difficulty and rpb values of all questions on the test are also calculated.

Points:

Number of items to be randomly chosen from the highlighted items (in left panel). Push the Pick button to randomly choose.

Time:

Note: Each part within a matching question will be counted as a separate item by the Pick function when a matching question is "picked" to put on a test. For example, if you specify to Pick five items and the program randomly picks a matching question with five parts, then only this matching question will be moved to the test.

Diff:

Pick

A test built from a specification (refer to the reference discussion of the Specs Window – page 203), can have up to 999 different forms (forms 1-999). If the currently open test has different forms, this control enables you to choose the form to be displayed in the test panel.

In order to remove a test form, choose the test form you want to delete, then right click on this form number. Choose "Delete form." For forms other than form zero, you will be asked to confirm if you really want to delete this form. For form zero, you will be asked if you really want to clear everything off from this form; form zero cannot be "deleted."

rpb:

Insertion Pointer. Sets the point of insertion of new test items, as they are moved from the questions panel onto the test panel.
Questions Panel

When you open a test, a list of all the questions in the current bank is displayed in the left panel, called the Questions Panel, of the Tests Window. This list displays the question IDs, initially, in alphabetical sort order by objective name and sequence. If you double-click any question ID, the item itself will be displayed in the Questions Window.

Tip! A shortcut to finding a bank item is to press the first letter of the item’s objective. For example, to quickly find a particular “MATH” item, press the “M” key to jump to the first “MATH” question. Before you use this shortcut, the Questions Panel must be made active by clicking on it.

Double-click on the item to display it in the Questions Window.

Test Panel

The right panel of the Tests Window is the Test Panel. This panel contains the identification and sequence of questions that have been put on the test. Unlike the alphabetical ordering in the Questions Panel, questions can be arranged in any order within the Test Panel.

Notice that two numbers precede each question in this panel. The first number is the Section Number of the test, and the second number is the actual question number that shows on a test. Test sections correspond with entry sections on OMR forms, and also are useful in generating subtest scores on certain score reports. Also, section breaks (explained shortly) are useful in renumbering a section of questions from “1.”

For detailed discussion on how to move questions from the Questions Panel over to the Test Panel, as well as on how to re-adjust question order within the Test Panel, refer to pages 71 and 78 respectively.

Tests Window Toolbars

Test Toolbar

Save Test. Saves the test. The test will need to be saved if changes have been made to the test arrangement and/or the content of the questions on the test.
Numbered Section Break. Inserts a section break on the test and the numbering of the next section’s questions begins again with the number “1.” You can remove a numbered section break by highlighting it and then either deleting it or moving it back towards the Questions Panel (i.e., use <<Move).

Section Break. Inserts a section break on the test. Items following the section break are under the new section for subtotalling purposes only; item numbering continues from the previous section. You can remove a section break by highlighting it and then either deleting it or moving it back towards the Questions Panel (i.e., use <<Move).

Page Break. Inserts a page break on the test. You can remove a page break by highlighting it and then either deleting it or moving it back towards the Questions Panel (i.e., use <<Move).

Column Break. Inserts a column break on the test. Column breaks are only useful for items with print column settings of either 2 or 3 (default is 1). Refer to page 124 for a description of how print columns work. You can remove a column break by highlighting it and then either deleting it or moving it back towards the Questions Panel (i.e., use <<Move).

Note: The difference between setting a Tests Window column break and a Questions Window column break is that setting a Tests Window column break is specific only to the test. Questions Window column break settings are stored with the corresponding items, and apply to all tests that contain the items.

Post Test. Records the test date and test name in the question bank for every item on the test.

Scramble Test Items. Scrambles the order of highlighted items. Exercise caution when scrambling items, since scrambling can override link ordering.

Lock Test. Prevents accidental changes to the test. Questions cannot be added, removed, or rearranged when a test is locked.

Check Exclusive Links. Verifies that no link conflicts exist; i.e., no items that should be “kept away” from each other by exclusive links should be on the same test. Normally, potential exclusive link conflicts are reported as items are moved to the test. However, this control allows you to double-check for link conflicts, since you may have overridden or changed linking relationships while building the test.

Expand. Expands question view associations. For instance, when question view is set to “item,” the expand feature will show links to each item (Questions Panel).

Collapse. Collapses question view associations. Only the top level is visible; i.e., associations are hidden.

Tests Window Menu Items

The following menu items become available with an active Tests Window. Menu items that are common between the Questions Window and the Tests Window are not discussed. Refer to the discussion of Questions Window menu items, starting on page 137.
File Menu

Print ➤ Test Reports

Opens up the following displayed Test Reports Window, from which various test-related reports can be printed.

Note: Refer to Appendix D: Sample Reports for a complete list of sample reports.

Print ➤ Test Reports ➤ Test

Use this option to print the test. Configure the content and style of printed test questions. You can also customize the headers, footers, and cover page for the test via the Headers Window; discussion begins on page 261.

![Test Reports Window]

**Figure 59: Test Reports: Test Setup**

Print Parts:

- **Number**: Prints a question number before (to the left of) each non-instruction-type item.
- **ID**: Prints the question ID on the line immediately preceding the item. When ID is checked, allows you to also enable CAT – category printing (on same line as question ID).
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stem</td>
<td>Prints the contents of the question stem, for all test items.</td>
</tr>
<tr>
<td>Choices</td>
<td>Prints the contents of the question choices, for all test items.</td>
</tr>
<tr>
<td>Feedback</td>
<td>Prints the contents of the Feedback Area, for all test items.</td>
</tr>
<tr>
<td>Notes</td>
<td>Prints the contents of the Notes Area, for all test items.</td>
</tr>
<tr>
<td>Resp Form</td>
<td>Prints the contents of the Response Form Area, for all test items.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Prints the contents of the Statistics Area, for all test items.</td>
</tr>
<tr>
<td>Effects:</td>
<td></td>
</tr>
<tr>
<td>Mark Correct Answer</td>
<td>Prints a check mark by the correct answer choice(s) of ONLY multiple choice and true/false questions.</td>
</tr>
<tr>
<td>Frame Questions</td>
<td>Prints a frame border around each question.</td>
</tr>
<tr>
<td>Preceding Underline</td>
<td>Prints a short line before every non-instruction item, so that students can indicate their choices directly on printed tests.</td>
</tr>
<tr>
<td>Separate Pages</td>
<td>Prints each question on a separate page (by inserting a temporary page break between each question).</td>
</tr>
<tr>
<td>Area titles</td>
<td>Prints the label titles preceding the selected print parts, e.g., “Feedback” or “Statistics”.</td>
</tr>
<tr>
<td>Multiple Tests:</td>
<td></td>
</tr>
<tr>
<td>Forms: X thru X</td>
<td>If the test has multiple test forms, you can print any form or range of forms of the test. (Multiple Test Forms can only be constructed through the Specs Window.) Otherwise, <strong>leave this setting at its default value of “Forms: 0 thru 0”</strong>.</td>
</tr>
<tr>
<td>Versions: X thru X</td>
<td>Allows printing any version or range of versions of the test. Every version of a test has the same items, but a different order of the item choices and/or the questions. If you only intend on printing the version displayed in the Questions Window, <strong>leave this setting at its default value of “Version: 0 thru 0”</strong>.</td>
</tr>
</tbody>
</table>

**CAUTION!** If you plan to use a mark reader to automatically score a version other than version “0,” then **you must ensure** that students correctly mark the version of their tests in the appropriate location of the mark reader forms.

<table>
<thead>
<tr>
<th>Numbering:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Page</td>
<td>Sets the starting page number.</td>
</tr>
<tr>
<td>Starting Question</td>
<td>Sets the starting question number.</td>
</tr>
<tr>
<td>Output:</td>
<td></td>
</tr>
<tr>
<td>Preview</td>
<td>Sends the test to print preview.</td>
</tr>
<tr>
<td>Printer</td>
<td>Sends the test to the printer.</td>
</tr>
</tbody>
</table>
Margins:

Top          Sets the top page margin.
Bottom       Sets the bottom page margin.
Left         Sets the left page margin.
Headers...   Sets headers, footers, and cover page for this report.

Print ➤ Test Reports ➤ Answer Key

Prints the answer key for any form or version of the test.

![Figure 60: Test Reports: Answer Key Setup](image)

Print Parts:

Number       Prints a number for each question.
ID           Prints the question ID.
Points       Prints the question point value.
Type         Prints the question type as indicated in the table below.

Effects:

Include instructions Includes instruction items on the report.
Summarize sections Provides a summary (number of items, number of points) at the end of each test section.
In the Answer Key Report, the following question-type codes are used:

<table>
<thead>
<tr>
<th>Type Codes</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LET</td>
<td>Free-format, letter response</td>
</tr>
<tr>
<td>NUM</td>
<td>Free-format, numeric response</td>
</tr>
<tr>
<td>OPN</td>
<td>Free-format, open-ended</td>
</tr>
<tr>
<td>SCI</td>
<td>Free-format, scientific</td>
</tr>
<tr>
<td>SHO</td>
<td>Free-format, short-answer</td>
</tr>
<tr>
<td>MAT</td>
<td>Matching</td>
</tr>
<tr>
<td>MCS</td>
<td>Multiple choice single-response</td>
</tr>
<tr>
<td>MCM</td>
<td>Multiple choice, multi-response</td>
</tr>
<tr>
<td>T/F</td>
<td>True/False</td>
</tr>
<tr>
<td>INS</td>
<td>Instruction</td>
</tr>
</tbody>
</table>

**Print ▶ Tests Reports ▶ Response Booklet**

Prints a custom form on which students can mark a response. Refer to page 116 for discussion of the Response Form Area in the Questions Window.

**Figure 61: Test Reports: Response Booklet Setup**

Effects:
- One column
- Two column
- Three column

Sets the number of columns for the response booklet’s print layout.

**CAUTION!** If your response form content is wide, avoid using a two or three column setting, since your response form content will be truncated to the set column width.
Mark correct answer  If the response form area of (non-free response) questions are blank (default setting), then circles are printed around each choice-letter. Checking this option will bold the choice-letter of the correct response.

**Print ➤ Test Reports ➤ Test Description**

Allows the printing of two different Test Description Reports: a statistical (overall) summary report and a detailed item summary report.

![Test Reports: Test Description Setup](image)

**Figure 62: Test Reports: Test Description Setup**

**Print Parts:**

- **Item cumulatives**: Check this to set the Test Description Report to a statistical summary format. The statistical report includes a summary of item count, test points, test time, and test difficulty.

- **Item detail**: Check this to set the Test Description Report to a detailed item summary format. The item report will list the individual questions and their categorical associations.

**Summarize by:**

- **Item type**
- **Item banks**
- **Objective**
- **Section break**
- **Category 1..8**

(ONLY functions when “Item cumulatives” is selected.)

**Note:** When both “Statistics summary” and “Detailed item listing” are checked, the statistical summary will follow the detailed item summary.
Effects: Prints each summary listing component (listed above) on a separate page.

Import

For a discussion of the import feature in general, refer to “Overview of the Import Process” on page 145.

Import External Answer Key

The Import External Answer Key option allows you to use answer key data from another database or word processing file.

In order for external answer keys to be compatible with LXR•TEST, upon import, the external file must be in merge file format - i.e., text only, with fields separated by tabs, and where the first line must contain the field names (to be imported). The table below summarizes the acceptable field names for the merge file:

<table>
<thead>
<tr>
<th>External Answer Key Import Field Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>NUM</td>
</tr>
<tr>
<td>ANSWER</td>
</tr>
<tr>
<td>POINTS</td>
</tr>
</tbody>
</table>

Export

For a discussion of the export feature in general, refer to the section on Export, beginning on page 151.
In the Export wizard, after the Template page, when you choose the “Test” file type, you have the option of exporting a test in one of four different formats. These formats are previously discussed on page 151.
Select Menu

Select Menu

Select Items on Test
Marks the items on the test as selected items in the Questions Window.

Select Highlighted Items in Left Panel
Marks all highlighted questions in the left (question) panel as selected items in the Questions Window.

Select Highlighted Items in Right Panel
Marks all highlighted questions in the right (test) panel as selected items in the Questions Window.

Utilities Menu

Utilities Menu

Highlight Link Conflicts
Highlights all items in the test panel that have exclusive link conflicts, and should not be used with one or more other items on the test.

Expand All
Same function as the Expand button in the Test Toolbar.
Collapse All

Same function as the Collapse button in the Test Toolbar.

Load Forms from Specs

Add/update the test forms from the open Specs file. To check/access a different test form, click on the “Forms” drop down list.
**Specs Window**

The Specs (Specifications) Window is for automatic construction of one or more “forms” of a test, based on specific qualification criteria.

**Note:** A test “form” is not to be confused with a test “version.” Different test “versions” share the same items and item order on a test; what differs between “versions” is the order of choices for questions. Different test “forms” essentially can look like different tests, but intrinsically be similar in content – this depends on the specifically chosen qualification criteria. For further discussion of “forms,” refer to the section What About “Forms?”, beginning on page 267.

A test specification (specs file) is constructed using a single (open) question bank. In the Specs Window, qualification statements are entered by configuring various fields, with the last statement set as “END.” When the qualifications have been set, you can have LXR•TEST build as many different test forms as possible.

**Specs Window Description**

![Figure 64: Specs Window](image)
Bank Displays the currently open bank. LXR•TEST will assume that you want to apply the specific qualification criteria to the items of the open bank. Only one bank at a time can be used by the Specs Window. Right click on this field to re-associate the specs with another bank.

Max Test Forms Specify the maximum number of test forms to construct.

Max Item Duplication Specify the maximum percentage of items that can be duplicated (item overlap) between any two forms of the test.

Total Forms Built Number of test forms automatically built.

Build Type: Progressive
Ordered
See discussion that follows.

Validate and Build Processes the specification statements against the open questions bank, according to the desired, maximum number of forms and percentage of permissible item overlap.

Update Test Writes the generated test forms to the test (in the open Tests Window). Each form will contain a list of qualified items to put on the test. Essentially, each test form is like a separate test, with the exception that all forms are stored within a single tests file.

To delete a particular test form, refer to page 192.

Note: When recording scores for a particular test form, the particular score set must be associated with the students’ test form.

Clear Clears all specification statements in the Specs Window.

Field Specifies the question field that is to be used as a criteria for item selection. “END” signifies that all criteria have been entered.

Operator Assigns one of the following comparison operators:
contains
equals
not equal
greater than
less than

Value Choose or enter the value you want to associate (via the “operator”) with the “field” entry.

Action Pick: Choose items from the preceeding criteria.
Or: Indicates optional, additional criteria before choosing items.
And: Indicates mandatory, additional criteria before picking items.
Pick

Specifyes the number of items that are to be chosen from the eligible items that meet the preceding set of criteria. The collection of all lines (field, operator, value) for a single “pick” is referred to as a “specification statement.”

#Avail

Indicates the number of candidate items that meet the criteria for the qualification statement.

CAUTION! If you attempt to apply your specifications to a different question bank, the category titles in the new bank must be the same as in the original bank or else you will get an error.

Note: Matching items are treated as one item even though a matching item may contain several numbered components. If your specification selects a matching item, the numbered items on your test may exceed your total pick count.

Theory of Operation

Specs is a facility for automating the generation of test forms according to specified requirements and constraints, including the maximum percentage of item overlap between any two forms.

Specs works by systematically generating all combinations of candidate questions which might provide a test satisfying all the qualification statements. Items are “proposed” inside the program one at a time, and as each new item is proposed, LXR•TEST checks for compatibility with other items before building a full combination.

As valid combinations are discovered, LXR•TEST has to further check all new possibilities against these combinations for overlap. Hence, the order of generated combinations helps determine what later combinations are allowed.

Certain fundamentals in theoretical computer science dictate that it is not feasible, within a reasonable length of time, to find the maximum number of test forms over all possible sets of combinations. Therefore, LXR•TEST must resort to various approaches for generating the combinations which generally produce acceptable test forms, at the expense of trying to generate the maximum amount of valid test forms.

Two methods for combination generation, available to the Specs user, are identified as “ordered” mode and “progressive” mode.

In ordered mode, LXR•TEST will systematically select items in a manner analogous to “alphabetical order.” As a result, the test forms generated may have pairwise overlap ratings near the specified limit.
In progressive mode, LXR•TEST will first generate a number of test forms with no overlap. Then, if possible, the program will gradually increase the allowed item overlap while continuing to generate Test Forms. As a result, the overlap ratings will be more diverse for progressive mode.

Progressive mode is not universally better than ordered mode. In fact, in some cases, ordered mode will generate more test forms. To see this, consider an inventory with the following specification, where 0, 1, 2, 3, 4, 5 are item numbers:

- choose 1 of {0, 1}
- choose 1 of {2, 3}
- choose 1 of {4, 5}

Suppose you want a maximum overlap of 1. Ordered mode will produce, through its systematic enumeration, four tests:

- 024, 035, 125, 134

each pair of which has item overlap of exactly 1.

Progressive mode will only produce:

- 024, 135

which have item overlap of 0. Using these two test forms as a beginning basis precludes 035, 125, 134, each of which has item overlap of more than 1 with the first two forms. It also precludes the remaining possibility 025 (there are eight total possibilities in all).

Here are things to keep in mind when using Specs: the less overlap you allow, the fewer possible test forms that can be generated that will still satisfy all spec requirements. Asking for more tests, or less overlap, will generally take longer. Hence it is a good idea to be willing to explore a few alternatives. A good approach is to specify a larger overlap than you are willing to tolerate and use progressive mode. Then you will get a diverse sampling of test forms and get an idea of how many generated forms to reasonably expect.
Specs Window Toolbars

Figure 65: Specs Toolbar

Insert Criteria. Insert a qualification statement line ahead of currently highlighted line.
Delete Criteria. Delete the currently selected, qualification statement line.

Specs Window Menu Items

The following menu items become available with an active Specs Window. Menu items that are common between the Questions Window and the Specs Window are not discussed. Refer to the discussion of Questions Window menu items, starting on page 137.

Print ➔ Spec Reports

Print ➔ Spec Reports ➔ Test Specification

Figure 66: Spec Reports: Test Specifications Setup
Print Parts:
Specs:
Qualification statements  Prints a list of all the qualification statements, that are the basis for constructing various test forms.
Item candidates  Prints a list of all items that meet the criteria of each qualification statement.

Tests:
All  Prints a listing of the test forms and all the items on each form.
Specify  Specify what form listing(s) to print (all, specify, or none).
None

Print ➔ Spec Reports ➔ Item Overlap

![Figure 67: Spec Reports: Item Overlap Setup]

Display:
Overlapping  Prints a maxtrix (test form x test form) identifying either the number of items, percentage of items, or question IDs of the overlapping items between any two test forms.
Count
Percent
ID’s

Import
Only test specification files in Merge Format can be imported.

Export
Test specification files can be exported in either Native or Merge Format.
Scores Window

The Scores Window is for maintaining student response data and generating score reports. Student response data can be manually entered, automatically collected from an online test, or read in from test forms via an optical mark reader.

Scores files, like questions files, use a database design that enables data from thousands of students to be stored. In LXR•TEST 6.0, scores files can store student response data from up to 999 different tests (or tests forms). However, response data can only be displayed in the Scores Window, one test (or test form) at a time. Further, each response data group must be associated with a particular test (or test form) in order for results to be evaluated.

Scores Window Description

![Figure 68: Scores Window](image)
Test ID Enables you to associate more than one test to the same scores file. Each scores file is capable of storing student responses for any number of students from up to 999 different tests or test forms. However, only the student responses for one test (or test form) can be displayed at a time. This score group is assigned a test ID, which will contain these student scores for a particular test. By default, student response data is written to test ID 1, unless either a different test ID is marked on the mark reader forms, or the online test designates that scores be written to a different test ID.

By right-clicking on Test ID, you will receive menu options allowing you to move selected students, or all students, from one test ID group to another. You can also "merge" the student(s) from one test ID group to another by right-clicking on a selected group of records and choosing "Merge".

Note: For conceptual discussion of test forms, refer to the section "What About "Forms?"", beginning on page 267.

Tests file(s) Indicates the tests file (and test form, if the tests file has multiple test forms) that contains the items and answers corresponding to the current, student response group (assigned a Test ID). Each set of scores can be associated with a specific tests file (and even with a particular test form, other than form 0). The default tests file is the currently open tests file. Opening a scores file will automatically open the associated tests file. If you want to associate a set of scores with a different tests file, right-click on the tests file field and choose to re-associate the test.

Test Date Test date for the currently displayed scores. This date is assigned to the substitution variable %testdate%. (Typically used in header or footer report layouts.)

Note: You can enter a new date if desired. Also, the displayed date is unique for each corresponding test form.

Test Name Test name for the currently displayed scores. This name is assigned to the substitution variable %testname%. (Typically used in header or footer report layouts.)

Heading 1 Report heading for the currently displayed scores. This heading is assigned to the substitution variable %header1%. (Typically used in header or footer report layouts.) Rather than creating a custom header for each scores file, you can simply type the heading text into this field and it will automatically print such text in any report that has the "%header1%" variable.

Note: Both heading lines are unique for each corresponding test form.

Heading 2 Report heading for the currently displayed scores. This heading is assigned to the substitution variable %header2%. (Typically used in header or footer report layouts.) See the previous discussion on Heading 1.

Items Number of questions on the test. If the Scores file is not associated with a test, you must manually assign the maximum number of test items.

Points Total (maximum) point value of all questions on the test.

Students Number of students assigned to the current test ID group.

Selected Number of students that are selected.
This is a selection column. By clicking here, you can highlight a single or multiple score records (when clicking in conjunction with either the SHIFT or CTRL keys). If you want to select (see below) all highlighted items, then you choose the “Select Highlighted” option from the Select menu.

**S (Selection boxes)** Check box indicates that a student is selected. You can select (or deselect) any student by clicking in this check box.

**ID** ID is a required field. A unique student number must be entered for/assigned to each student.

If score data is read into a scores file from an optical mark reader, and the OMR forms do not contain student IDs, then LXR•TEST will have to be configured to assign its own student ID numbers. Refer to the discussion on OMR Form setup, in Chapter 11.

**Tip!** If you want your students to sort in numerical order, you will need to ensure that all IDs contain the same number of digits and are zero-filled from the beginning. For example, if you elect to have 5-digit student IDs and your first student ID is “1,” you would actually want the ID to be entered as “00001.”

**Student Name** Student names can be entered from several sources:

- Student names can be read-in from mark reader forms that contain a student name field, otherwise,
- Student names can be “looked up” from a Students file. The Score menu has an option called “Lookup Student Info” for this purpose.
- Student names could also come from online tests. If IDs are primarily used in accessing online tests, in a similar fashion to the mark reader situation, LXR•TEST can “look up” student names (from the Students file) when given the corresponding student IDs.

**Tip!** For sorting purposes, you may want to enter all student last names before first names (e.g., Johnson, J.).

**Type** Type is a reserved field. Discussion of this score field corresponds with discussion of “type” in the Students Window; Students Window Discussion begins on page 251.

During online testing, if type values have been set in the Students file, LXR•TEST will “look up” these values as student IDs are entered and copy these type values to the scores file.

**Version** The test version that was administered to the student.

**Raw** Contains the student’s raw test score (in points).

**Percent** Contains the student’s test score (in percent).
Grade
Contains the student’s letter grade for test.

Note: Before a letter grade can be calculated and displayed, a grading table must be open. You will also have to press the "Score Test" button in the Scores Window Toolbar. (see next Figure)

[]
These symbols indicate a possible problem within the student’s data. Brackets indicate at least one missing response. A question mark indicates an invalid response for the item type (e.g., multiple marks read by an OMR when a single mark (answer) was expected). A bracket and a question mark indicate both missing response(s) and invalid response(s). When either a bracket or question mark is displayed in this column for students, it is recommended that you verify the students’ responses (see response that follows) against those on their mark reader forms.

C1..C8
Scoring code fields C1 to C8 are used in setting up classifications for sorting and selecting students. Each code field can hold up to four characters. Typical uses of these fields are assigning gender, school codes, grade levels, etc.

Many mark reader forms have fields that are designated to load into these code fields. Before using a form, you should confirm any mapping from a form field to a code field. A list of forms and supported code fields are shown on the LXR web site.

Code field values can also be loaded from a Students file.

Note: If you highlight any entry in the C1 to C8 fields, and right click, you will be presented with a menu option for selecting all students who have this particular field value. If you already had one or more students selected, then you will have additional options to add to the selected students or select from within the selected students.

Seq
This field shows the order students were entered into the Students file. This field cannot be edited.

Response
The student’s response to the item. By clicking on the item’s number (e.g., 1:1), the item will be displayed in the Questions Window.

For a multiple-choice multi-response (MCM) item, the item is NOT deemed correct unless the maximum possible item points are attained. For MCM items, multiple responses must have a separator (normally a comma) between each of the component responses, e.g., “A,B,D.” (The separator is determined by your settings in the Control Panel, under Regional Settings! Number! List Separator dialog box.)

Note: A shortcut for displaying the Response Window (Score menu) is to hold down the control key while left-clicking in the response field.

Points
The points awarded for the student’s response. Points are in red text for an incorrect response.
Scores Window Toolbar

Figure 69: Scores Toolbar

First Record. Moves to the first student’s score record. Details on the current student’s response data is displayed in the right panel of the Scores Window.

Previous Record. Sets the prior student’s record as the current record for display.

Next Record. Sets the next student’s record as the current record for display.

Last Record. Moves to the last student’s score record.

New Record. Inserts a new, blank student record at the end of the student record list.

Sort Direction. Sort in either descending or ascending fashion, respectively. When the dark arrow is pointing up, the smallest alphabetic-valued field value (e.g., “a”) will begin the sorted column. When the dark arrow is pointing down, the “largest” alphabetic-valued field value (e.g., “z”) will begin the sorted column.

Double-click the column heading to sort all the student records in the designated sort order.

Delete Student. Deletes the current student record.

Score Test. Scores all students against the currently open test and assigns grades using the currently open grading table, if present.

Refresh. Instructs the program to read all the data from the scores database. The main purpose for this function is to refresh the display of score records in the Scores Window after all OMR forms have been read.

CAUTION! When you move between student records or access a program function, changes to a student’s record will automatically be saved.
Scores Window Menu Items

The following menu items become available with an active Scores Window. Menu items that are common between the Questions Window and the Scores Window are not discussed. Refer to the discussion of Questions Window menu items, starting on page 137.

File Menu

Print > Score Reports

The following is a discussion of the available scoring reports and their print setup dialog boxes. The scoring reports are divided into three categories: Statistics, Student Scores and Student Mastery. Refer to Appendix D: Sample Reports to see a snapshot of each type of report.

Print > Score Reports > Statistics > Score Description

This report summarizes each Test ID, in terms of the test item count, points, number of students, test form, tests filename, and the headings. This description is especially useful when scores files contain multiple Test ID; i.e., the scores file covers multiple tests.

![Score Description Setup]

Figure 70: Score Reports: Score Description Setup
Output: Sends the report either to the print preview or to the printer.

Margins: Sets the print margins for the specific report, overriding any other margin settings.

Headers...

**Headers Dialog box**

Sets whether a cover page, headers or footers are printed for this specific report. These settings are saved and automatically recalled the next time this report is printed.

**Note:** The actual content of the headers and footers are entered in the Headers Window.

**Print  Score Reports  Statistics  Item Statistics**

---

**Figure 71: Score Reports: Item Statistics Setup**
Print parts:

Item Type  Item type. Will print out an item code for each item:
LET: letter answer
MAT: matching
MCM: multiple-choice, multi-response
MCS: multiple-choice, single-response
NUM: numeric
OPN: open-ended response
SCI: scientific notation
SHO: short answer
T/F: true/false

Points  Item point value. For multi-response items, this is the maximum attainable points for the item.

Response Time  Item response time. Average time (in minutes) the item was displayed. Response time is only available for online tests and should be used as an approximate performance gauge since students can linger on an item without actually considering the item itself.

Admins  Item administration. Report displays the number of times the item was administered (overall admins) or the number of times a particular choice was marked (item admins).

\( p \)  Item difficulty. Determined by the correct response average.

Average  Average overall test score (in percent) for those who correctly marked the item.

rpb  Point biserial correlation. A statistic that summarizes how well a particular item predicted overall test success. Refer to Appendix A: Glossary for a more detailed discussion of rpb.

Comments  Permits you to print a report of student feedback that was provided during an online exam. You can also include the student's ID for each comment.

ID

Output:

Preview  Either previews the report on the screen or sends the report to the printer.

Printer

Specify students:

All students  Report to be based on all students listed in the scores file, or only on selected students (one or more students need to be selected).

Selected students

Margins  Sets the print margins for the specific report, overriding any other margin settings.

Headers...  Sets whether a cover page, headers or footers are printed for this specific report. These settings are saved and automatically recalled the next time this report is printed.

Note: The actual content of the headers and footers are entered in the Headers Window.
Print ▶ Score Reports ▶ Statistics ▶ Test Statistics

![Image of Score Reports: Test Statistics Setup]

**Figure 72: Score Reports: Test Statistics Setup**

**Frequency:**
- Points
- Percent

Displays the student/score histogram graph, with either points or percent unit of measurement.
Print Score Reports Student Scores Individual Feedback

**Figure 73: Score Reports: Individual Feedback Setup**

Print parts:
- **Contents**: Print the question stems and choices.
- **Feedback**: Print the question feedback content.
- **Incorrect Only**: When selected, only content of missed items is printed.
- **All items**: When selected, content of all items – whether correct or not - is printed.

Effects:
- **Mark correct answer**: When “Contents” also selected, report will indicate the correct answer.
- **Show responses**: When “Contents” also selected, report will indicate the student’s answer.
Print ➤ Score Reports ➤ Student Scores ➤ Individual Scores

Provides in-depth reporting on an individual student’s test performance.

![Figure 74: Score Reports: Individual Scores Setup](image)

**Figure 74: Score Reports: Individual Scores Setup**

<table>
<thead>
<tr>
<th>Print parts:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Area</strong></td>
</tr>
<tr>
<td><strong>Classification</strong></td>
</tr>
<tr>
<td><strong>Items</strong></td>
</tr>
<tr>
<td><strong>Response</strong></td>
</tr>
<tr>
<td><strong>Student comments</strong></td>
</tr>
<tr>
<td><strong>Points of __ Total</strong></td>
</tr>
<tr>
<td><strong>Percent</strong></td>
</tr>
<tr>
<td><strong>Grade</strong></td>
</tr>
</tbody>
</table>
Summary
Letter grades
Scale scores
Pass/fail desc

Summaryize by:
Objective
Section break
Category 1..8

When checked (and Classification is also checked), prints a summary of the total points (if checked), percent average (if checked), and either letter grade average or scaled score for all the items in an area, such as objective.

At least one of these must be checked in order for this report to be generated.
Select all the areas you want to report on for the individual’s test performance.

Print ➤ Score Reports ➤ Student Scores ➤ Group Detail
Essentially reproduces the main Scores Window display (excluding the individual student’s response and points panel).

Figure 75: Score Reports: Group Detail Setup

Print parts:
ID
Print student IDs.
Name
Print student names.
Type
Print “type” field values; refer to discussion of this field in the Scores Window discussion, beginning on page 209.
Version
Print test versions that students took.
Points
Print raw test points of students.
Scores Window Menu Items

Percent
Print percent test scores of students.

Grade
Print letter grades of students.

Codes
Print code field (C1..C8) entries of students.

Print Score Reports Student Scores Group Summary

Whereas the Individual Scores Report provided in-depth analysis of a particular student’s test performance, the Group Summary Report allows for convenient comparison of student performance.

![Figure 76: Score Reports: Group Summary Setup](image)

Print parts:
- **Average**: When checked, an “Average” column displays on the rightmost part of the page. This column displays average student scores across areas, classifications, etc.
- **Area**: Provides a summary of the overall areas: objective, section break, category 1..8.
- **Classification**: The subareas: for objective, the classifications could be “FLAGS”, “MATH”, etc.
- **Summary**: When checked, prints a summary of the total points, percent average, and either a letter grade or scale score (to be selected) for each student.
- **Letter grades**
- **Scale scores**
Summarize by:

Objective
Section break
Category 1..8
Effects:
Student name
Student ID
Separate pages
Results Orientation:
Columns
Rows
Score display:
Points
Percent
Grade

At least one of these must be checked in order for this report to be generated. Select all the areas you want to report on for the group summary of test performance.

Choose to either have students labelled by name or ID.

When checked, each area’s group summary comparison is printed on a new page.

When “columns” is selected, student names/IDs are printed in columns at the top of the report. When “rows” is selected, student names/IDs are printed in a row along the left side of the report.

Choose to display student’s points, percentages, or letter grades for group summary comparison.

Print Score Reports Student Scores Score Distribution

Prints a score distribution break down of the percentages of students in each letter grade division.
Print parts:
Area
Classification
Summary

Summarize by:
Objective
Section break
Category 1..8

Effects:
Separate pages

Print ➤ Score Reports ➤ Student Scores ➤ Score Summary

Prints a score summary of students: possible points, high score, low score, average score (also expressed as a percent), across areas and classifications.
Print parts:

Area Provides a summary of the overall areas: objective, section break, category 1..8.
Classification The subareas: for objective, the classifications could be “FLAGS”, “MATH”, etc.
Summary When checked, prints a summary line for the particular area of the points for the summary columns: possible points, high score, low score, average score (and percent).

Summarize by:

Objective At least one of these must be checked in order for this report to be generated. Select all the areas you want to report on for the score summary report.
Section break
Category 1..8

Print Score Reports Student Scores Demographics

Test-administration demographical information is collected from online tests and from OMR forms when read through a mark reader. Program default fields include test date, elapsed time, and OMR form. User defined fields can be manually entered or automatically captured from OMR forms, if supported by the form model you are using.
Effects: Prints recorded test-administration demographics on a separate page for a new student.
Separate pages

Print ▶ Score Reports ▶ Mastery Reports

Note: Mastery thresholds are firm; there is no rounding up of students' scores. Therefore, if a student received an 89.99% and the threshold for an A was set for 90% (in the grading table), then the student would not receive the A.

Refer to page 245 for discussion on the features of the Grading Window, including mastery thresholds.
Figure 80: Score Reports: Mastery Specification Setup
Print parts:

**Description**
When checked, descriptions for the different areas and classifications are printed. Description text taken from the “Description” field of the Grading Window.

**Resources**
When checked, resource reference text is taken from the “Resources” field of the Grading Window and printed on this report.

**Area**
Needs to be checked for any of the summary areas, such as objective and category 1..8, to be displayed in this report.

**Classification**
The subareas: for objective, the classifications could be “FLAGS”, “MATH”, etc.

**Summary**
When checked, a summary of the total test points, total test items, and a count of the number of items in the area will be printed at the end of each area’s mastery specification summary.

**Summarize by:**
- **Objective**
- **Section break**
- **Category 1..8**

At least one of these must be checked in order for this report to be generated. Select all the areas you want to report on for the mastery specification report.

**Effects:**
Prints each area of the mastery specification report on a separate page.

**Separate pages**
Print ▶ Score Reports ▶ Mastery Reports ▶ Mastery Directory

![Mastery Directory Setup](image)

**Figure 81: Score Reports: Mastery Directory Setup**

Print parts:

- **Area**: When checked, includes a group mastery overall summary of the “area,” as the notion of “area” is defined in the Grading Window.

- **Summary**: When checked, includes a summary of student mastery for all classifications within the particular area.

Summarize by:

- **Objective**
- **Section break**
- **Category 1..8**

At least one of these must be checked in order for this report to be generated.

Select all the areas you want to report on for the mastery directory report.

**Effects:**

- **Separate pages**: Check this to ensure that a mastery directory analysis for a new area will begin on a new page.

- **Student Name**
- **Student ID**

Choose whether to list students by their names or IDs.
Figure 82: Score Reports: Mastery Summary Setup

Print parts:

Area
When checked, includes a summary line of mastery summary for the overall area.

Classification
When checked, all classifications within a particular area will display their mastery summary information.
For example, under the area “objective,” the classifications could be “FLAGS”, “MATH”, etc.

Summary
When checked, will include a summary of the mastery summary performance (numbers of and percentages of mastery and non-mastery) – see footnotes, to follow.

Summarize by:
Objective
Section break
Category 1..8
At least one of these must be checked in order for this report to be generated.
Select all the areas you want to report on for the mastery summary report.

Effects:
Separate pages
Check this to ensure that a mastery summary for a new area will begin on a new page.
Footnotes About the Report:

SUMMARY
All Objectives, #NM  The number of students who did NOT master any objective.
All Objectives, %NM  The percentage of students who did NOT master any objective.
All Areas, #NM      The number of students who did NOT master any area.
All Areas, %NM      The percentage of students who did NOT master any area.
Print ▶ Score Reports ▶ Mastery Reports ▶ Group Mastery

Print parts:

Area
When checked, includes a group mastery overall summary of the “area,” as the notion of area is defined in the Grading Window.

Classification
When checked, mastery summary (by symbol) will be displayed for the group of students for each of the area’s classifications.
For example, under the area “objective,” the classifications could be “FLAGS”, “MATH”, etc.

Summary
When checked, will display on the bottom of each page a number summary of the points each student earned, as well as the number of classification and areas that each student mastered, partially mastered, or did not master.

Symbol Key
When checked, will display a key of the mastery symbols used in this report. The mastery symbols are defined in the grading table.

Summarize by:
Objective
Section break
Category 1..8

Effects:

Figure 83: Score Reports: Group Mastery Setup
Separate pages Check this to ensure that a group mastery for a new area will begin on a new page.

Student Name Choose whether to list students by their names or IDs.

Student ID

Results Orientation:

Columns When “columns” is selected, student names/IDs are printed in columns at the top of the report. When “rows” is selected, student names/IDs are printed in a row along the left side of the report.

Rows

---

**Print ▶ Score Reports ▶ Mastery Reports ▶ Mastery Comparison**

![Image of Score Reports: Mastery Comparison Setup]

**Figure 84: Score Reports: Mastery Comparison Setup**

**Print parts:**

Area When checked, includes mastery comparison overall summary of the “area,” as the notion of “area” is defined in the Grading Window.

Classification When checked, mastery comparison between groups of students (as chosen by the comparison factor) will be displayed for the area’s classifications.

For example, under the area “objective,” the classifications could be “FLAGS”, “MATH”, etc.
Summary

See footnotes, to follow.

% Mastering
When checked, displays the percent of students (in respective comparison groups) who mastered the given area or classification.

% Partially Mastering
When checked, displays the percent of students (in respective comparison groups) who partially mastered the given area or classification.

% Not Mastering
When checked, displays the percent of students (in respective comparison groups) who did not master the given area or classification.

Effects:
Check this to ensure that a mastery comparison for a new area will begin on a new page.

Separate pages

Compare by:

Code 1..8
Essential drop-down list for this report. Choose which code field to base student mastery comparisons.

For further discussion on these fields, refer to the C1..C8 discussion in the “Scores Window Description”, beginning on page 209.

Footnotes About the Report:

SUMMARY

All Mastered
The percentage of students in their group who mastered ALL classifications.
% The percentage of all students who mastered ALL classifications.

None Mastered The percentage of students in their group who did NOT master any classification.

% The percentage of all students who did NOT master any classification.

All Areas Mastered The percentage of students in their group who mastered ALL areas.

% The percentage of all students who mastered ALL areas.

No Areas Mastered The percentage of students in their group who did NOT master any area.

% The percentage of all students who did NOT master any area.

Print Score Reports Mastery Reports Individual Mastery

Print parts:

Mastery Symbol When checked, includes the appropriate mastery symbol based upon the individual’s mastery for the particular area or classification.

Scores When checked, includes the number of points (score) the individual received for the particular area or classification.

Percent When checked, includes the percentage for the above-mentioned points (scores).
Chart
When checked, includes the 100 point scale chart that graphically summarizes an individual's mastery of the particular area or classification.

Area
When checked, includes individual mastery summary of the “area,” as the notion of “area” is defined in the Grading Window.

Description
When checked, includes the description text from the “Description” field of the grading table.

Resource
When checked, includes the description text from the “Resource” field of the grading table.

Classification
When checked, includes individual mastery summary for each of the classifications under the particular area. For example, under the area “objective,” the classifications could be “FLAGS”, “MATH”, etc.

Description
When checked, includes the description text from the “Description” field of the grading table.

Resource
When checked, includes the description text from the “Resource” field of the grading table.

Summary
When checked, will display on the bottom of each page a number summary of the points each student earned, as well as how many classifications and areas the student mastered, partially mastered, or did not master.

Symbol Key
When checked, will display a key of the mastery symbols used in this report. The mastery symbols are defined in the grading table.

Summarize by:
Objective
Section break
Category 1..8

Effects:
At least one of these must be checked in order for this report to be generated.
Select all the areas you want to report on for the individual mastery report.

Separate pages
Check this to ensure that an individual mastery report for a new area will begin on a new page.

Import (Scores)
Importing score data provides the capability to load data into a LXR•TEST scores file from an outside source. This option is typical for users who have scanned student responses on a remote scanning machine that is capable of generating response files. These response files can be later imported into LXR•TEST for further score analysis and report generation.

In order for outside score data to be compatible with LXR•TEST, the outside-generated scores file must be saved in merge format. For a discussion on the Merge format, refer to page 148.
Note: Use the native file format for importing score data from other LXR•TEST scores files. Refer to page 147 for a discussion on the Native format.

You want the scores file to be imported to look similar to the following sample:

<table>
<thead>
<tr>
<th>SID</th>
<th>SNAME</th>
<th>C1</th>
<th>C2</th>
<th>C3</th>
<th>C4</th>
<th>VERSION</th>
<th>RAW</th>
<th>RESPONSES</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>Swenson, S</td>
<td>M</td>
<td>EH</td>
<td>10</td>
<td>0</td>
<td>20</td>
<td>C</td>
<td>A E D T</td>
</tr>
<tr>
<td>02</td>
<td>Crosby, B</td>
<td>F</td>
<td>EH</td>
<td>9</td>
<td>0</td>
<td>13</td>
<td>C</td>
<td>A E C T</td>
</tr>
<tr>
<td>03</td>
<td>James, R</td>
<td>M</td>
<td>EJ</td>
<td>10</td>
<td>0</td>
<td>10</td>
<td>C</td>
<td>A E C T</td>
</tr>
</tbody>
</table>

Include only the columns that you want to import. **You must include the student ID** to provide unique access to student records. (For the above sample, tab characters would be placed in place of the vertical lines, when coding a file to import.)

**Export (Scores)**

Although LXR•TEST includes a variety of score reports, each with flexible select and sort options, you may find that you need to access scoring information with other programs. To do this, you need to export the score data into a format the other application(s) can understand.

LXR•TEST enables you to export data in three formats: native, merge (LXRMerge), and Gradebook (LXRGradebook). Merge and Gradebook formats are text-only and can be opened by word processor and spreadsheet programs. The Gradebook format contains much more than just names and test scores. It contains test characteristics and objective mastery information. The LXR•TEST gradebook format has been adopted by several popular gradebook manufacturers to facilitate importing into their gradebook programs. Refer to our website (www.lxr.com) for a listing of gradebook manufacturers. A sample gradebook export can be found in Appendix C: Merge Fields Names & Gradebook Format.
Export (Scores) Gradebook Format

When you choose to export scores data in Gradebook format, you receive the following “Fields” dialog box to choose the fields, and their order, to export:

![Figure 86: Gradebook Export (Scores) Fields](image)

**Grade Summary:**
- **Letter Grade**: Choose to include either a letter grade summary or a scale score summary, as determined in the Grading Table.
- **Scale Score**:          

**Student Responses:**
- **Student Responses**: Choose to include the either the student response data, or the points the students earned on their responses.
- **Response Points**:  

**Choose fields and order:**
- **File Header**: Contains overall test information: File Type, LXR•TEST version, Test Name, Test Date, Bank Name(s), Instructor Name, Class, # of Items, and # of Students
- **Test Info**: Contains the Question ID, Layout Type, Version Answers, and Maximum Point Values of test questions.
Student Detail Header | Contains headers for detail student information: ID, Student Name, Test Version, Items Correct, Percent Score, Raw Score, Letter or Scale Score, and Student Response Data (data or points).
---|---
Student Details | Contains detail student information for all students from the Scores file.
Mastery Info | Contains the mastery threshold percent for the “area” chosen - either Objective, Section Break, or Category (as set in “Summarize mastery by”) - as well as the number of items in each “classification”.
Mastery Detail Header | Contains headers for ID, Student Name, and Mastery Code.
Mastery Student Details | Contains detail student mastery, threshold information (mastery, partial mastery, non-mastery) for all students from the Scores file.
Mastery Points Header | Contains headers for ID, Student Name, and Points Received.
Mastery Student Points | Contains detail student mastery, point information.
Summarize mastery by: | Choose to summarize student mastery in Gradebook export either by Objective, Section Break, or Categories.
Display valid short field names | See the following figure. Summarizes the field name symbols used in the exported *.LXRGradebook file(s).

![Figure 87: Valid Short Field Names](image)
View Menu

Scores Toolbar
When selected, Scores Toolbar displays in Scores Window.

Status Bar
When selected, the status bar displays along the bottom of the Scores Window.

Refresh
Has the same function as the Refresh button (Scores Toolbar) – reloads the last saved version of the Scores file.

Select Menu

Select All
Selects all students.

Select Inverse
Unselects all students that are currently selected and selects the group of students that was not.

Clear Selected
Deselects all selected students. This option is not available until student records are selected.
Delete Selected
Delete all selected students. This option is not available until student records are selected.

Select Highlighted
Select all highlighted students. Student records are selected using the Grey boxes to the left of the Selection boxes. Refer to page 209 for discussion of Scores Window features.

Reader Menu
For discussion on these features, refer to Chapter 12.

Score Menu
Lookup Student Info
LXR•TEST collects student information into a scores file typically through online tests, or through reading OMR forms. However, when reporting student results, you may want more information (e.g., demographic information) to enhance report content and/or report generation flexibility. In such case, the “Lookup Student Info” option is useful in internally importing student information from the students file into the scores file. For discussion on how to use this option, refer to page 95.

Score (Grade)
This menu option functions the same as the Score Test button on the Score Toolbar:
LXR•TEST will grade every student response and check for blank responses. If a grading table is concurrently open, then each student’s grade will be compared with the grading table values and assigned a corresponding letter grade.
**Reload Student Responses**

When OMR forms are read by an optical mark reader, LXR•TEST stores a “snapshot” of the forms’ data. The Reload Student Responses option takes the stored “snapshot” data and reinterprets it according to the currently associated test before reloading this data into the Scores database.

**Note:** It is crucial for the associated test to have the proper section breaks in order for the OMR “snapshot” data to be properly interpreted, and therefore properly scored.

**Consequently, all existing data in the Scores Window will be overwritten - i.e., all instructor changes made to the Scores Window data after reading in OMR forms will be lost.**

You may find this option useful if the incorrect test was associated when reading in the OMR forms, or if you made changes to the associated test and want to update the student data without re-reading in the OMR forms.

**Update Question Statistics**

This option requires that the Question, Test, and Scores Windows all be open; if any of these are missing, LXR•TEST will automatically open the missing window. The purpose of this option is to update the Statistics Area (located in the questions file) of each test question (i.e., update the number of times each choice was picked, or omitted; update p and rpb values, etc.).

**CAUTION!** If you choose “Update Question Statistics” a second time, but with the same (now updated) Scores file, the test question statistics would become incorrect.

**Display Demographics Window**

Test-administration demographical information is collected from online tests and from OMR forms when read through a mark reader. Program default fields include (test) administration date, elapsed time, and OMR form. User defined fields can be manually entered or automatically captured from OMR forms, if supported by the form model you are using.
Figure 88: Demographics Window

Display Response Window

Choosing this menu item brings up a window for the currently highlighted student response. This window is helpful for displaying larger amounts of response text than can be readily displayed from the response column.

Figure 89: Response Window

Utilities Menu

Add Test

Adds another Test ID in the currently open scores file.
**Delete Test**

Deletes the currently selected Test ID of the currently open scores file.

**Re-associate Test**

Opens the above window, from which you can remove the test association for the current test form, browse or enter a new test association for the current test, or close the scores file.

**Merge Tests**

Opens the above window, from which you can move students (selected or all) from one test view to another (i.e., from one associated test or test form to another).

Click in the box of the test or test form you want to move students into and click on the Move button to carry out the student data exchange.
Grading Window

The Grading Window is for maintaining letter grade and mastery grade threshold information. Within this window, you provide grade settings so that LXR•TEST can automatically assign letter grades. It also maintains mastery specifications used in score reports.

Maintaining letter grades involves entering a two-column list matching test percentages with letter grades. The entered percentage is the minimum (or cut-off) percentage necessary to obtain the associated letter grade. For example, if 70 percent is associated with a C, then you must have a test score of at least 70 percent to have at least a C letter grade.

Note: An area is a group of “classifications.” “Classifications” will be defined at the end of this section. What is particularly unique about the Area in the Grading Window is that you can take objectives from different banks, and put them in the same Area. With this concept in mind, and depending on your needs, you might only have one Grading Window to handle all your grading needs.

Maintaining mastery grades involves setting two threshold point percentages: a Mastery percentage and a Partial (Mastery) percentage. While letter grade is firm, mastery grade is flexible. You can set the Mastery Threshold values for each individual classification (see this feature’s description in the “Grading Window Description”). Even though a student may score the same percentage in two different classifications, s/he may not have the same mastery values, depending on the established thresholds for the two classifications. You can also set these values for an entire area. For example, you could group all reading-related Objectives into an area entitled “Reading Mastery” and set global “Reading Mastery” Mastery Threshold values of 95% and 80% respectively. In this case, the Mastery Thresholds refer not to point percentages, but to classification percentages. In other words, if there are 10 classifications within the “Reading Mastery” area, then a student must master 8 of the 10 classifications in order to receive partial mastery for the area.

Note: A classification can be an Objective, Category, Code, or Section.
Grading Window Description

The Grading Window enables you to view and edit the Classification description and resource reference, mastery thresholds, letter grade assignments, and prescriptive information relating to specific Objectives or groups of Objectives.

**Grading Classification View:**
- Chooses the major area for display. For example, selecting Objective should display all Objectives on a Test to be graded.
- Will automatically load all objectives, categories, code fields, and sections found in an open bank, test or scores file. As these values are loaded, the Mastery Threshold values are set to default values.
Objective: Primary question classification scheme. Each question must have an Objective Name.

Category 1...8: Secondary question classification scheme. Each question can be assigned up to 8 different categories.

Code 1..8: Primary score classification scheme. Each student record in a scores file can be assigned an entry of up to 4 characters in length, in up to 8 different code fields.

Section: Organizational grouping of items on a test. A test may be divided into subtests defined by section breaks in the Tests Window.

An area is a grouping of Grading Classification View items. Click Insert Area to create a new area in the View.

Insert Objective enters a new (Bank) Objective (or other classification item depending on the View).

Deletes the highlighted item.

Indicates the Mastery Threshold values for the current selection within the Grading Classification View. Mastery (and Partial Mastery) can be based on:

Points: percentage of total points of the classification items, OR

Count: percentage of the total number of classification items.

For example: A mastery setting of 90% (in points) indicates that the student must score at least 90% of the total points available for all test questions on the objective/category/section, in order to achieve mastery. Meanwhile, a mastery setting of 80% (in count) indicates that if five questions from the objective/category/section were put on the test, then s/he would have to answer four correctly to achieve mastery.

Note: There is NO rounding up of students’ scores when determining mastery achievement.

Tip! To make global value changes, select the items within the Grading Classification View, then enter the desired threshold value(s) and click Apply.

Enter numeric values for determining an overall scaled score (if option used).

Note: Scale Score is typically employed by certification and licensing organizations.

Click Descriptions Button to enter text to be presented to an student, which is dependant on whether the student achieved the Cut score (i.e., passed) or fell below the Cut score (i.e., failed).

Scaled score mastery is present for certain reports located under Print ➔ Score Reports... ➔ Student Scores (File menu). Applies to the Individual Score Report and Group Summary Report.
You can enter or paste any symbol preferences for displaying mastery, partial mastery, or non-mastery on Mastery Reports.

**Note:** If the character or symbol to be entered (or pasted) are larger than these edit boxes, then they will be unable to be entered (or pasted).

Enter a percentage value (i.e., cut-off value) and the associated letter grade. The letter grade may be up to 4 characters long.

Right-click to open a drop-down menu. You are provided with the options to “clear the grid,” “refresh,” and “restore defaults.” Choose “clear the grid” to start from scratch. Choose “refresh” to restore values from prior save. Choose “restore defaults” to restore factory established values.

**Title**
An abbreviated Objective description (up to 35 characters in length). This “short description” prints on Mastery Reports. By default, the Objective Name is the title.

**Description**
Any descriptive text you need goes into this “long description.” This “long description” prints in the grading table and Individual Mastery reports.

**Resources**
For providing resource references (e.g., books, CD-ROMS) for areas and classifications.

**Tip!** When the Tests Window is viewed “By Objective”, and an objective is highlighted, the title is displayed at the bottom of the questions panel. If you prepare question banks for use by others, you may want to enter short descriptions that further assist in describing the questions during test construction.

### Grading Window Menu Items

The following menu items become available with an active Grading Window. Menu items that are common between the Questions Window and the Grading Window are **not** discussed. Refer to the discussion of Questions Window menu items, starting on page 137.
File Menu

- New
- Open
- Close
- Close All
- Save
- Save As...
- Print Setup...
- Print...
- Import...
- Export...
- Send...
- 1 Recent Questions
- 2 Recent Tests
- 2 Recent Specs
- 4 Recent Scores
- 5 Recent Grading Tables
- 6 Recent Student Lookup
- 7 Recent Headers
- 8 Recent Online Tests
- Preferences...
- Exit
Print

Print ▸ Grading Table Report

For a screen shot of a sample printout of this report, refer to Appendix D: Sample Reports.

Figure 91: Grading Table Report Setup

Print parts:
- Basic information: Check this to print out the basic areas of the Grading Window: Letter Grade area, Mastery Symbol area, etc.
- Title: Check this to include the text in the Title field of the Grading Window for each topic.
- Description: Check this to include the text in the Description field of the Grading Window for each topic.
- Resources: Check this to include the text in the Resources field of the Grading Window for each topic.

Classifications:
Objective
Category 1..8
Code 1..8
Section break
Effects:
Separate pages

When checked, includes the Mastery Thresholds for each classification within each area.

For example, under the area “objective,” the classifications could be “FLAGS”, “MATH”, etc.

When checked, the printing of the summary and each new classification will begin on a separate page.

Import (Grading Table)

With a Grading Window open, you can import external grading table from a merge file format. Refer to page 148 of the Import File Formats section for discussion of the merge file format.

CAUTION! Importing a grading table into an existing grading table will overwrite all data in the existing grading table.

Export (Grading Table)

With a Grading Window open, you can export the grading table information in either a native or merge format. Refer to page 152 of the Export File Formats section for discussion of native and merge formats.

Format Menu

Font, Size, Style

This option was desired to facilitate editing of the mastery symbols. This option is only accessible then. A standard Windows Font dialog allows you to set change the font, font style, and font size.
Students Window

The Students Window is for storing and referencing student demographic and address information.

Students Window Description

![Figure 92: Students Window](image)

(Grey boxes) This is a selection column. By clicking here, you can highlight a single or multiple score records (when clicking in conjunction with either the SHIFT or CTRL keys). If you want to select (see below) all highlighted items, then you choose the “Select Highlighted” option from the Select menu.

**S** Selection box. Click once in box to select a student, click again to unselect.

**ID** Student ID number. ID is either manually assigned by instructor or randomly assigned by LXR•TEST when scoring a test.

**Student Name** Student name.

**Tip!** Keep order of last and first names consistent among students.
Type
The type field is an LXR•TEST reserved field and currently provides an additional method to control student access to online tests and reports. The field works in the following manner:

If the field is blank, then no special actions occur.
If the field contains "T," then the student is allowed to take the test.
If the field contains "R," then the student is allowed to receive student reports.
If the field contains "TR," then the student is both allowed to take the test and to receive student reports.

Note: All other character inputs are ignored.

C1..C8
Eight code fields, designed to accommodate student demographic information, such as gender, grade level, school, etc. Each code field can hold up to 4 characters.

Password
Student password. When passwords are stored for students, and the online test is access controlled by the students file (refer to discussion of the Online Window, Access tab – page 304), then students can be required to enter their individually assigned passwords (in addition to their ID) to gain test access.

Start Date
The start date of when the student can take a test. If this field left blank, then LXR•TEST skips the verification of this date. The date entered must follow the date format as specified in the Windows’ Control Panel’s Regional Options. A start time can also be included, but is not required. Examples of acceptable entries for a start date of July 14, 2000 at 8 o’clock in the morning are:

7/14/2000 8a
7/14/2000 8:00:00
7/14/00 8:00
7/14/2000 8:00:00 AM

Note: If time is entered without any suffix, then it is assumed that the time is AM time, unless the time is entered in 24-hour format.

End Date
The end date of when the student can take a test. If this field left blank, then LXR•TEST skips the verification of this date. An end time can also be included, but is not required. See additional details provided in Start Date.

Note: If a student attempts to take a test before or after the test period, as defined by Start and End Dates, LXR•TEST will NOT grant the student test access.

E-mail
Student’s e-mail address. On Web tests, student performance reports can be sent to a student’s e-mail account. The students database will need to be accessed by the web test (see page 310), and you will need to indicate that reports are to be sent by e-mail (see page 312).

CC: E-mail
Carbon copy e-mail address. On Web tests, a carbon copy of student performance can also be sent to this e-mail address.
### Students Window Toolbar

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone</td>
<td>Student’s phone number.</td>
</tr>
<tr>
<td>Address 1</td>
<td>Line 1 of student’s postal address.</td>
</tr>
<tr>
<td>Address 2</td>
<td>Line 2 of student’s postal address.</td>
</tr>
<tr>
<td>City</td>
<td>City of student’s postal address.</td>
</tr>
<tr>
<td>State</td>
<td>State of student’s postal address.</td>
</tr>
<tr>
<td>Zip</td>
<td>Zip code of student’s postal address.</td>
</tr>
<tr>
<td>Country</td>
<td>Country of student’s postal address.</td>
</tr>
<tr>
<td>Notes</td>
<td>Any notes regarding the student.</td>
</tr>
<tr>
<td>Seq</td>
<td>Sequence number. This field shows the order of how students where entered into the Students file. This field cannot be edited.</td>
</tr>
</tbody>
</table>

**Note:** You can resize column widths by moving the cursor to the edge of a column header. The cursor becomes a left and right bi-directional arrow. Click, hold, and drag the column border to its new location. You can also double-click when you see the bi-directional arrow. Double-clicking will snap the column width to fit the longest field entry.

Also, you can sort records by double-clicking on the name of the field. See also “Sort Direction,” as mentioned below. And like the Scores window, you have right-click select options.

**Tip!** While establishing student passwords for test entry is a measure of test administration security, added measures are suggested. That is to say, controlling physical test access is also important and highly recommended.

#### Students Window Toolbar

**Figure 93: Students Toolbar**

- **First Record, Last Record.** Jump to the first or last student record, respectively.
- **Previous Record, Next Record.** Move to the previous or next student record, respectively. When on the last student record, you can click the next student record button to return to the first student record, and vice-versa.
- **New Record.** Add a new student record. The new student record will be added at the bottom of the students file.
Sort Direction. Sort in either descending or ascending fashion, respectively. When the dark arrow is pointing up, the “smallest” alphabetic-valued field value (e.g., “a”) will begin the sorted column. When the dark arrow is pointing down, the “largest” alphabetic-valued field value (e.g., “z”) will begin the sorted column.

Delete Student. Delete a student record. The currently selected student record, whose field is highlighted by the cursor, will be deleted. No confirmation message is issued, so be careful about using this delete button.

**Students Window Menu Items**

The following menu items are available when the Students Window is the active window. Menu items that are common between the Questions Window and the Students Window are not shown. Please refer to discussion of the Questions Window menu items, beginning on page 137.

**File Menu**

![File Menu](image-url)
Print ▶ Student Reports

Print out the selected fields of the Students file. For a sample of this report, refer to Appendix D: Sample Reports.

Print parts: Select the Students file fields that you want to print out on the Report.

Output: Select either to preview the report on screen or send the report to the printer.

Specify students: Active only when students have been selected within the Students Window. When active, you can choose to print the Report for either all students or for only the selected students.

Margins: Set the margins for the printed Report.

Figure 94: Student Reports: Student Listing Setup
Preslug Forms

**CAUTION!** Pre-slugging should **ONLY** be attempted on printers whose print alignments remain consistent; i.e., these printers do NOT offset the print from one copy to the next.

Print out student information, such as ID and demographic information, on OMR forms. **Currently, only LXR•TEST 20020 and 26133 forms support this preslug forms feature.**

![Preslug Forms Setup](image)

Figure 95: Student Reports: Preslug Forms Setup

Note: Your goal for pre-slugged forms should be to slug within 2/3 to 3/4 of the bubble space of the desired bubbles, without overlapping into neighboring bubbles; i.e., you should NOT expect to perfectly pre-slug your forms.

**CAUTION!** The first time you preslug OMR forms, you should do an “Alignment Check” of your printer. Check the box for “Alignment Check” and have several forms fed into the printer. See below for further description.

**Tip!** Before pre-slugging a batch of OMR forms, it is highly recommended that you experiment with the LXR•TEST and printer settings on single forms.
Slug fields: The available number of fields will depend on the current form selected. Choose the Students file fields that you want to preslug onto the OMR forms.

Effects: Printer setting effects.

Alignment Check When selected, LXR•TEST will print several full-page alignment check preslugs. This will assist you in determining if alignment adjustments and/or skew correction is needed.

You will need to have several OMR forms fed into the printer.

Skew Correction In running sample forms, if you notice that the printer skews as it prints from the top of the form to the bottom of the form, then you will use this option.

When you select the Skew Correction option, the following window appears:

Within this skew correction window, you can adjust by tracks and/or by columns. The entered values will be according to dots per inch, as set by your printer’s resolution. For example, if your printer has 300 dpi resolution, then entering a value of 300 would cause your printer to adjust by one inch.

Note: If you pre-slug both sides of a form on a single-sided printer, you can enter skew correction values for both sides 1 and 2, though you will have to manually turn over the form in order to pre-slug side 2.

Print side: Choose which side(s) to preslug. Only choose to preslug both sides if and only if you have a printer that supports duplex printing.

Output: Select either to print preview or directly preslug the form(s).
Specify students: Active only when students have been selected within the Students Window. When active, you can choose to preslug forms for either all students or for only the selected students.

Alignment adjustments: Allows you to manually adjust preslug printing from the top and left sides of the forms.

Current form: The currently selected form (from the Reader and Form Setup) is displayed.

**Import (Students)**

The two supported file formats when importing student data are native and merge. Using the native format, you can import student data from another LXR•TEST students file. Using the merge format, you can import student data from another database or word processing file, for example.

**Export (Students)**

The two supported file formats when exporting student data are native and merge. Using the native format, you can export student data to another LXR•TEST students file. Using the merge format, you can export student data for use in another database or word processing program, for example.
Utilities

Load Student Info

In order to use this feature, a scores file must also be open. This feature enables you to load the demographics information from the scores file into the students file. When you choose this option, the following Lookup window displays:

Just as with the “Student Lookup” feature with the scores file, you choose which fields you want to copy from the scores file into the students file.
Headers Window

The Headers Window is where the creation/maintenance of custom report header, footer, and cover pages takes place.

Note: A Headers Window must be open in order for existing, custom headers, footers, or cover page to be printed on a report. Also, you control the printing of headers, footers, or cover page within each report’s print dialog, via the “Headers...” button.

Headers Window Description

![Figure 96: Headers Window](image)

<table>
<thead>
<tr>
<th>Database</th>
<th>Choose the database type whose header/footer/cover page settings are to be adjusted.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>Once a database has been selected, choose the type of report whose header/footer/cover page settings are to be adjusted.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Headers can be unique for every report type.</td>
</tr>
<tr>
<td>Reset</td>
<td>See discussion below.</td>
</tr>
</tbody>
</table>
Select the tab of the content type for the chosen report. Enter the content that is to appear in the header, footer, or cover. When entering content, you can insert LXR•TEST substitution variables (Insert menu, or manually) in order to print test information, such as test date, time, pages numbers, etc..

For a detailed listing of available LXR•TEST substitution variables, refer to Appendix B: Substitution Variables.

Note: The “Test Report” is the only report with the available headers and footers for even, odd, and last pages.

Each Headers file contains a set of header, footer, and cover page content for each LXR•TEST report. You can create multiple headers files and reference a specific one (by having it open) when you print reports.

The Reset button brings up a selection window (shown above) where you choose which report headers, footers, and cover pages you want to reset to factory settings.

Note: Graphics can be inserted into headers, footers, or cover page in the same manner as within the Questions Window. For procedures, refer to page 51.
Headers Window Toolbar

Figure 97: Headers Layout Toolbar

Font drop-down list box and font size drop-down list box. Applies specified font and font size to selected text.

Text color. Applies color to the selected text.

Bold, Italics, Underline, Strikeout. Applies bold, italic, underline, and strike-through character formatting to selected text.

Baseline Setting. Applies superscript, normal and subscript attributes to selected text or object. When subscript or superscript are applied, the size of selected text is reduced 2 font points and the baseline is either lowered or raised, respectively, by 3 points.

A fourth option allows for manual baseline setting.

Paragraph Justification. Applies left, right, center, and block justification to selected paragraph(s).

Line Spacing. Applies single, space and a half, double, or user-specified line spacing to selected paragraph(s).

Tab Setting. Allows you to set left, center, right, or decimal tab(s) to your (horizontal) text ruler.

Note: To move the cursor to a tab marker, press CTRL-T.

Show/Hide Text Ruler. Displays (or hides) text ruler with margin and tab stops. See additional information below.

Note: For discussion on the text ruler and tab-setting, refer to page 136.

Show/Hide Vertical Ruler. Displays (or hides) vertical ruler.

Show/Hide Invisible Characters. Displays (or hides) symbols for characters that are not normally shown (such as the carriage RETURN and SPACE characters).
Headers Window Menu Items

File

Export

Headers can be exported in Native Format only.

Utilities

Header/ Footer/ Cover Setup

![Figure 98: Header/ Footer/ Cover Setup](image)

- **Body Width**: Configure the body width of your headers or footers or cover pages. The body width value is expressed in the units set under Preferences ➔ Units.
- **Headers**
- **Footers**
- **Covers**
- **All**: Highlight the desired page to set configurations.
- **Currently Selected Font/ Size/ Style**
  - **Font**
  - **Size**
  - **Style**: Displays the currently set font, font size, and font style for the highlighted page type.
Select Font/Size/Style

Clicking this button will open up a standard Windows Font menu to set font settings.

Restore factory settings

Click this button to restore the font settings for these pages to their factory default values.

**Online Window**

Refer to Chapter 8 for discussion of the Online Window.
What About ‘Forms?’

Difference Between Versions and Forms

As previously discussed in this part of the User’s Guide, a test “form” is not to be confused with a test “version.”

When you build a test, by default, there is only one version of the test – test version 0. A test version is determined by the choice order of the test questions. In order to create a different test version, the test question choices need to be scrambled. Therefore, test content between test versions is the same.

Note: In fact, a non-online test can still be considered a version of another test if having the same questions, but the question order is scrambled.

Scrambled choices will affect the correct answer’s position in the choices. For example, the correct answer to the question “What is the maximum number of choices for a multiple choice, single response question in LXR•TEST 6.07” is choice C: “26”. So the correct answer to test version 0 is choice C. If test version 1 is created, the correct answer may now be choice A, because the choices have been scrambled. In likewise fashion, test version 2 may have choice D as the correct answer, etc.. LXR•TEST allows for the construction of up to ten test versions, from version 0 through version 9.

Tip! Test versions can help deter student cheating on an examination. It is recommended that multiple test versions be used on single administration tests. For instance, students in different rows can be given a different test version, so that looking over at a neighbor’s test will not prove helpful.

In other words, you can interchange the use of these test forms to test for the same conceptual understanding.

Also by default, there is only one form when you build a test – test form 0. A test form is determined by the nature of the question content. One test form is considered to be the same as another test form when the question content matches the same testing criteria. For example, the testing criteria is to test students on all advanced topics from chapter 7 of the physics textbook. The two test forms can have entirely different questions, yet be statistically proven to test for the same content from chapter 7; i.e., the test forms have high inter-test reliability. In other words, you can interchange the use of these test forms to test for the same conceptual understanding.

As discussed in the Specs Windows section, LXR•TEST can automatically build multiple test forms from test specification criteria. In fact, up to 1000 different test forms can be built: form 0 through form 999.
Tip! Test forms can be useful in administering make-up exams, or in differentiating the tests between different academic semesters or years. Another use of test forms is to use different ones as pretests and posttests in order to assess student knowledge before and after teaching the curriculum.

## Associating Multiple Test Forms With a Single Scores File

While you could manually build a variety of different tests that have high inter-test reliability, LXR•TEST already provides this feature through use of its Specs Window. (Refer to the Specs Window discussion for more details - beginning on page 203.) And while you could associate different scores files for each of these high inter-test reliable tests, you would end up with a whole lot of test and scores files to keep track of.

An advanced feature of LXR•TEST is the ability to record scores from various tests and test forms in a single scores file. In such case, the scores file effectively serves as sort of like a "file cabinet," while the various associated tests and test forms act as "file folders." For instance, you could have a single scores file represent a particular class of students, for an academic semester. If you take advantage of this advanced feature, you could associate all the results from various tests and test forms for this class in this single scores file. See below figure for pictorial conceptualization.

**Note:** For details on how to actually configure the scores file to handle the multiple test and test form associations, refer to the discussion of the Test ID feature of the "Scores Window Description" - on page 209.
Multiple Test Forms Per Score File

Demonstrates How Multiple Tests and Test Forms Can Share a Single Score File

Below are screen shots of the different test form views a single scores file can have, when it has multiple test and test form associations:

Figure 99: Example of a Scores file Association with Test Form 0
Figure 100: Example of a Scores file Association with Test Form 1

Figure 101: Example of a Scores file Association with Test Form 2
Part II: Online Testing
Overview

Online tests are constructed from the same questions banks used to build paper-and-pencil tests. In LXR•TEST 6.0, there are now two types of online tests that users can create: LAN (Local Area Network) tests and Web (World Wide Web) tests.

These steps will lead to the creation of an online test:

- Configure the Project as either a LAN Project or a Web Project.
- Using LXR•TEST, build a tests file exactly as you would for a paper-and-pencil test. If you need assistance in building a LXR•TEST tests file, refer to page 34.
- Create a new online file, which will open the Online Window.
- Within the Online Window, set the features, including administration and reporting features, for the online test to be built.
- Instruct LXR•TEST to build your online test.

Once an online test has been built, test administration is relatively simple. For students to take a web test, only an HTML 4.0 compliant web browser is required. For students to take a LAN test, the additional Student LAN Client software will need to be installed on each student’s machine.
Chapter 6: Online Testing Installation

Chapter Overview:

System Requirements.............................. 277
Package Contents......................................277
Installing the Web Server
Extensions Software.............................. 277
Installing the Student LAN
Client Software.................................278

This installation chapter focuses largely on the steps to follow to install the Web Server Extensions software on your server machine, as well as the steps to follow to install the Student LAN Client software on your students’ machines. System requirements are the same as those for the LXR•TEST 6.0 Professional core software. An installation wizard program will facilitate the install process by automating many of the steps involved in installing the programs.

Note: If you purchased the Online Testing Option with the LXR•TEST 6.0 Professional core program, then the Online Testing Option will automatically be installed upon main program installation.
System Requirements

Refer to the System Requirements section in the beginning of Chapter 2.

Note: LXR•TEST incorporates Microsoft JET engine database technology which is intended for use by small workgroups. This is the same database engine used by Microsoft Access 2000. The actual number of users that can be supported by this engine depends on your network and computers. The maximum number of users is typically less than 20. If you need to support a larger number of users, you will need Microsoft’s SQL Server database technology. SQL Server database technology provides virtually unlimited scalability. All LXR•TEST databases can easily be upsized for use with SQL Server. Refer to Appendix J: Upsizing to SQL Server, for discussion of this process.

Package Contents

Refer to the Package Contents section in the beginning of Chapter 2.

Installing the Web Server Extensions Software

All software necessary for constructing online tests is installed and activated, during the installation of the core program software, when the Online Testing Option is purchased.

If you plan to create and administer web tests, you will need to install the Web Server Extensions software on the server machine that will host your web tests. This server must also have Microsoft’s Internet Information Server (IIS) running and support Active Server Pages. If you intend to use the automatic e-mail feature for sending test results and security messages, you will also need to have SMTP configured either on your web test server, or on a separate server.

Follow these steps to install the Web Server Extensions software:

- Start Windows.
- Insert the LXR•TEST program CD into your CD-ROM drive.
- Double-click on My Computer.
- Double-click on the CD-ROM drive icon to access the LXR•TEST program CD.
- Double-click on the WebServer folder.
Double-click on the Setup.exe program file.

When prompted, enter your software key exactly as indicated with your registration card. You will not be permitted to continue the installation without the correct software key.

Choose the IIS directory (e.g., C:\InetPub\WWW\Root\). An LXRWeb subdirectory will be created to host the web testing application files.

Enter a DNS or IP address for your SMTP mail server (e.g., mailserver.domain.com). This is the mail server that will be used to optionally send e-mail reports to students, instructor(s), and other recipients. Contact your e-mail administrator to determine the name or IP address of your mail server. If you don’t intend to use the e-mail features, you may leave this field blank.

Follow any remaining directions as presented.

Installing the Student LAN Client Software

In order for students to take online tests via a LAN, the LXR•TEST Student LAN Client software must, beforehand, be installed on each student's machine.

CAUTION! Do NOT install the LXR•TEST core software on student PCs, otherwise students will have authoring access/capabilities!

Follow these steps to install the client software.

Start Windows.

Insert the LXR•TEST program CD into your CD-ROM drive.

Double-click on My Computer.

Double-click on the CD-ROM drive icon to access the LXR•TEST program CD.

Double-click on the Student folder.

Double-click on the Setup.exe program file.

Follow any remaining directions as presented.
Chapter 7: Online Testing Tutorial

Chapter Overview:

Creating a LAN Test..........................281
Administering a LAN Test..................289
Creating a Web Test...........................289
Administering a Web Test....................293

This section provides both a tutorial for building and administering an Online LAN test, as well as a tutorial for building and administering an Online Web test.

Detailed information on program elements relating to each of these topics is included in Chapter 8 Reference.
Creating a LAN Test

An Online LAN (Local Area Network) test has the same content as a test administered by traditional paper-and-pencil method. The main difference is that the Online LAN test is administered by the LXR•TEST program on computers connected to a Local Area Network.

In order to create a LAN-based test, you must first build a test just as if you were making a paper-and-pencil test. For assistance in building a tests file, refer to discussion on page 34. Once you have a test built, you are ready to build a LAN version of this test.

Note: LXR•TEST incorporates Microsoft JET engine database technology which is intended for use by small workgroups. This is the same database engine used by Microsoft Access 2000. The actual number of users that can be supported by this engine depends on your network and computers. The maximum number of users is typically less than 20. If you need to support a larger number of users, you will need Microsoft’s SQL Server database technology. SQL Server database technology provides virtually unlimited scalability. All LXR•TEST databases can easily be upsized for use with SQL Server. Refer to Appendix J: Upsizing to SQL Server, for discussion of this process.

Set up the LAN Project:

- Click the Projects button on the LXR•TEST toolbar.
- Within the Projects Window, under the Project section, click on the drop-down arrow.
- Choose LAN Tests:

  ![Project window]

- Verify that Common Project Directory is specified and selected; this is the directory where you will save your work. By default, this directory is \Documents and Settings\User Name\My Documents\LXRData\.
- Click OK.
Create the online test:

- In order to create the online test, you will need to have the Tests file and corresponding Bank file(s) open. Open the Sample Test file from the folder: C:\Program Files\LXR\LXRTEST v6\Samples.

  Note: Opening a test file always opens any unopen associated bank file(s).

- Click the Online button on the LXR•TEST toolbar.

- Choose Create a new Online database. Click OK.

- Type in the name OnlineLAN.LXROnline. Click Save.

- The Online Window displays, and the Sample Test file is automatically associated with this Online file:

![Online Window](image)

You could build the LAN test right now, but it would be to your advantage to set up the record-keeping, test administration, and grading features.

Configure LAN test settings:

- Click the Scores button on the LXR•TEST toolbar.
Choose **Create a new Scores database.** Click **OK.**

Type in the name **LANScores.LXRScores.** Click **Save.**

The **Score/Test Association** dialog box appears:

Click **Yes, associate all forms.** (You are being prompted because the **Sample Tests** file, by default, is associated with the **Sample Scores** file.)

Your newly created scores file is now associated with the LAN test:

![Score/Test Association dialog box]

Click the **Admin** tab.

Under **Scramble**, select **Choices.**

Under **Time**, select **Specify** (default is 40 minutes) and select **Warning** (default is 20 minutes). Change the **Warning** value to 10 minutes.

Under **Question Grading**, select **None.**
Your **Online Window** now looks like this:

![Online Window](image)

- Click the **Report** tab.
- Click the **Grading** button on the **LXR•TEST** toolbar.
- Choose **Open existing Grading database**. Click **OK**.

- Select the **Sample Grading Table** file from the folder `C:\Program Files\LXR\LXRTEST\v6\Samples`. Click **Open**.

You will want to adjust the **Letter Grade** table values according to your preferences. Refer to the Grading Window reference discussion for assistance, beginning on page 244.

- Make the **Online Window** active.
- Notice that the grading table is associated with the LAN test:

  ![Support file locations](image)

- Within the **Report** tab, under **Student Reports**, select **Feedback**.

- The first time selected, the **Feedback Report Setup** displays. Verify that **Incorrect Only** is chosen under **Print parts**. Click **OK**.
Build the online test:

- Click the **Save and build online test** button on the **Online** toolbar. The online test builds. You are finished!

**Note:** When you save the Online LAN Test, you are including a copy of all test item content, so that the online test file itself can be administered with the Student LAN Client program.

## Administering a LAN Test

**Note:** LXR•TEST incorporates Microsoft JET engine database technology which is intended for use by small workgroups. This is the same database engine used by Microsoft Access 2000. The actual number of users that can be supported by this engine depends on your network and computers. The maximum number of users is typically less than 20. If you need to support a larger number of users, you will need Microsoft’s SQL Server database technology. SQL Server database technology provides virtually unlimited scalability. All LXR•TEST databases can easily be upsized for use with SQL Server. Refer to Appendix J: Upsizing to SQL Server, for discussion of this process.

As noted in chapter 6, in order to administer an Online LAN test to students, first you will have to install the Student LAN Client software on your student’s machines. Administering a LAN Test is simple:

- Run the Student LAN Client on the student’s machine.

- The **Select Online Test** dialog box appears:

- Choose the **OnlineLAN** file that you created in the previous section.
Chapter 7: Online Testing Tutorial

Note: If you do not see your Online LAN test in Select Online Test, then click the Browse button to locate your LAN test.

- Click **Take Test** to begin the test.

Note: If a LAN-based test has been **upized to SQL Server** format (see Appendix J: Upsizing to SQL Server), and a DSN has been created for the online database, then the students must be provided with permission to access the SQL Server. You will need to check with your SQL Server administrator concerning your students’ SQL Server access permissions. **You will also need to move the DSN of the online database into a shared folder that students can access on your server.** Students will need to enter the LAN-based test via the “ODBC; DSN” button (as shown in the previous graphic), where they will locate and select the DSN, which in turn will access the online LAN test.

- **The Log On to LXR•TEST** dialog box appears, with the name of your test displayed:

![Log On to LXR•TEST dialog box](image)

- At this point, either you (as Instructor) or the student can type in the student’s name. Click **Continue**.

Note: If the test is access controlled, then the student may be prompted to type in an ID and/or password to gain access to the test.

- **The Cover Page** for the test displays:

![Cover Page](image)
When the student is ready, s/he needs to click **Begin**.

The test’s first page of questions will display (see below). Since **OnlinELAN** is a timed test, the student may want to click on the **Time** button located near the bottom right corner of the screen. Clicking on the **Time** button will reveal the test’s countdown clock.

The student either can use the keyboard to type in the letters of her/his responses, or use the mouse to click the letters of the responses.

Once the student has completed answering a question, s/he needs to click the **right-direction arrow** to advance to the next question.
If the student uses the Navigation drop-down list, s/he will find the question numbers color-coded, as follows: **black** colored-questions are **answered** questions, **red** color-questions are questions **book-marked** for later answer, and **green** color-questions are **unanswered** questions. See the following example:

![Example of question color-coding](image)

At any time, the student can click the **Cover** button to return to the **Cover Page**:

![Cover Page](image)

Notice that the student has the choice to **Resume**, **Finish and Display Results**, or **Finish and Exit** (even if in the middle of a test!). Also notice that the test’s countdown clock is still running, since the student has not yet finished the test.

If the student resumes the test, s/he is taken to the first test page. Students can click the button to take them immediately to either a marked question or the next unanswered question.

If the student chooses **Finish and Display Results**, then the student report is displayed on screen. For **OnlineLAN**, the feedback report was selected. Refer to **Appendix D: Sample Reports**, for a sample image of an **Individual Feedback Report**.
Creating a Web Test

In order to create a Web-based test, you must first build a test just as if you were making a pencil-and-paper test. If you need assistance in building a LXR•TEST tests file, refer to page 34. Once you have done so, you are ready to begin building a Web version of the test.

Set up the Web Project:

- Click the Projects button on the LXR•TEST toolbar.
- Under Project, use the drop down box to choose WEB Tests:

![Project: WEB Tests]

- Notice that the Web Server Location edit box becomes available.
- You must either type in or Browse for the location of your web server, such as: \server\share

**CAUTION!** Before you can create a Web test, you must install the LXR•TEST Web Server Extensions on the server machine hosting your Microsoft Internet Information Server (IIS), AND you must configure file sharing and access security for web testing. If need be, do this first and then return to this tutorial. You are strongly encouraged to refer to Appendix H: Online Web Setup for assistance.

- For the Common Project Directory (CPD), enter in this folder: C:\Program Files\LXR\LXRTEST v6\Samples. Verify that the CPD is selected; this is where the Sample Test file is located.
- Click OK to exit the Projects Window.

Create the online test:

- Open the Sample Test file via the Tests button on the LXR•TEST toolbar.
Click the **Online** button on the **LXR•TEST** toolbar.

Choose **Create a new Online database**. Click **OK**.

The **New Online Web test name** window displays:

![New Online Web test name window](image)

Type in the name **OnlineWebTutorial** for the new online test. Click **OK**.

The **Online Window** displays; notice that the **Sample Tests** file is associated with the online test.

**Note:** While LXR•TEST does not impose a limit on the number of questions that can be on a web test, current Active Server Page (ASP) technology limits a **web test** to **200 questions**.

You could build the Web test right now, but it would be to your advantage to first configure its record-keeping and administration features.

Configure Web test settings:

- Click the **Scores** button on the **LXR•TEST** toolbar.
- Choose to **Create a new Scores database**. Click **OK**.
- Type in the name **WEBScores** for the new scores database. Click **Save**.
- If you have generated multiple test forms for **Sample Test**, then you will be asked if you want to associate the score file with all forms of the test. Answer yes.
Notice the newly created scores file is associated with the Web test (and located on the web server):

![Web Test Configuration](image)

**CAUTION!** When building an Online Web test, all files (except the bank and test) MUST be located in their respective web project subdirectories; e.g., Scores file must reside in the scores subdirectory of the server’s LXRWeb directory (as shown in the previous graphic).

- Click the **Admin** tab.
- Under **Scramble**, select **Choices**.
- Under **Time**, select **Specify** (default is 40 minutes) and **Warning** (default is 20 minutes).
- Change **Warning** to 10 minutes.
- Under **Question Grading**, select **None**.
The Online Window should display as follows:

- Click the Report tab.
- Click the Grading button on the LXR•TEST toolbar.
- Choose to Create a new Grading database. Click OK.
- Type in the name WebTutorialGrading for the new grading database. Click Save.
- Notice the grading table is associated with the Web test, and is located in the Grading subfolder of the web server's share directory:

  ![Support file locations]

- Under Student Reports, select Feedback. The first time you do this, the Feedback Setup Window displays. Click OK to keep the default settings (feedback only for incorrect answers).

Build the online test:

- Click the Save and build online test button within the Online Window. Notice that the online test builds. You are finished!
Administering a Web Test

As noted earlier, all students need to access an Online Web test is a computer with access to the Web, via an HTML 4.0 compliant web browser, such as Internet Explorer or Netscape Communicator. To begin Web test administration:

Note: Before you begin, you will need to know the URL of the Web test, i.e., the location of your Web-based test.

- Launch your web browser.
- Type in the **URL of the Web test**: e.g., the URL for the web test created in the previous section is `http://servername/lxrweb/online/onlinewebtutorial/webtest.asp`

**CAUTION!** When entering the URL, you must include:

//servername/lxrweb/online/yourwebtestname/webtest.asp

In fact, all Web tests are “executed” by a separate copy of the file “webtest.asp”

(located individually within each Web test directory)

Note: For Netscape Navigator users, you will have to type %20 to substitute for any space characters in the web test URL.

- The **Log On** window displays:

![Log On window](image)

- At this point, either you (as Instructor) or the student can type in the student’s name. When done, click the **Continue** button.
The Web test’s Cover Page now displays:

![Cover Page](image)

- When the student is ready, s/he needs to click the **Begin** button.

- The test’s first question appears (see below). Since this is a timed test, the student may want to click on the **Time** button located near the bottom right corner of the screen. Doing so will reveal the test’s countdown clock.
The student can either use the keyboard to type in the letters of his/her responses, or use the mouse to select the appropriate responses. For matching questions, answers for each matching part can be selected from the drop-down boxes that appear on the left side.

Once the student has entered in the answer(s), the student should click the right direction arrow to advance to the next question.
If the student uses the Navigation drop-down list, s/he will find the question numbers color-coded, as follows: black colored-questions are **answered** questions, red color-questions are questions **book-marked** for later review, and green color-questions are **unanswered** questions. See the following example:

> At any time, the student can click the **Cover** button to return to the **Cover Page**:

Notice that the student has the choice to **Resume**, **Finish and Display Results**, or **Finish and Exit** (even if in the middle of a test!). Also notice that the test’s **countdown clock** is still running, since the student has not yet finished the test.

If the student resumes the test, the test will resume with the last question s/he was on.

Note: Whenever the student wants to go to an unanswered question, the student can click the button to immediately display the next book-marked or unanswered question.
If the student chooses **Finish and Display Results**, then the **Report Menu** for student feedback is displayed (since the **Student Feedback** option was selected when building this Web test):

<table>
<thead>
<tr>
<th>Report Menu:</th>
<th>Feedback</th>
<th>Help</th>
<th>Exit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Congratulations on completing the test.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Click on the report item in the above menu for the report you would like to see.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• The Feedback report provides item content and/or feedback</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Click on <strong>Exit</strong> when you are finished.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>To print a report, click on the desired report in the above menu, then go to the File menu in your browser and choose Print.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: If the instructor has configured reports to be displayed on screen as well as to be sent by e-mail, then students must display reports on screen in order for the reports to be sent by e-mail; simply exiting the program will **not** cause reports to be sent by e-mail.

For further information related to the administration of Online Web tests, refer to the section entitled “Online Student Window for Web Tests”, beginning on page 317.
Chapter 8: Online Testing Reference

Chapter Overview:

Online Window Description..................301
Online Instructor Window for LAN Tests...301
Online Instructor Window for Web Tests...309
Item Conversion to HTML Format............314
Online Student Window for LAN Tests......315
Online Student Window for Web Tests......317

This Online Testing Option Reference section is designed to facilitate your access to each of the interactive testing functions, as provided by the LXR•TEST Online Testing Option software, and is organized as follows:
Online Window Description

This section describes the Online Window used by the instructor for constructing online tests. Online tests can be generated for running LAN-based, Windows 32-bit environments (i.e., Windows 98/NT/2000/XP PCs) or for running on any computer accessing the World Wide Web with a Microsoft Internet Explorer or Netscape Communicator browser, version 4.0 or later.

The Online Window is used for generating tests that will be administered on Windows-based computers, or for generating tests in HTML format that will be administered through a compatible browser. Each Online format has its own advantages.

LAN-based online tests provide the highest fidelity question representation since the items display identically to how the instructor views them within the Questions Window - provided that the student machines are of similar configuration to the instructor’s machine. An Online LAN test requires that each test - administrating computer have a LXR•TEST Student Run-time program installed.

Web-based online tests actually translate the question content into HTML for display and execution from a standard web browser. A significant advantage of web tests is that they can be administered on many different types of computers and from any location via the Internet. A major disadvantage of web tests is that their content may display differently on different computers. Also, there are limitations in the number of types of content objects that can be viewed on the web - i.e., graphic types are limited to GIF or JPEG.

Online Instructor Window for LAN Tests

Online LAN tests are ideal for use in a local area network (LAN) environment. When taking LAN tests, the student sees the questions exactly as the instructor authored them in the question bank (provided that the student’s computer has the same fonts installed).
Setup

![Online Window - Setup, LAN Test](image)

**Figure 102: Online Window ▶ Setup, LAN Test**

<table>
<thead>
<tr>
<th>Test Type:</th>
<th>LAN</th>
<th>Web</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Test Type:</strong></td>
<td>The type of test (LAN or Web) is determined by your Project settings when you first create the online test file. To build a LAN test, the “Is a Web Project” control in the Projects Window must be unchecked.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Once you create an online file that is a LAN test, you cannot later change it to a Web test simply by changing the project setting—you will need to create a new online test after changing the project setting.</td>
<td></td>
</tr>
<tr>
<td><strong>URL:</strong></td>
<td>If a Web test, the URL of the web test will display here.</td>
<td></td>
</tr>
<tr>
<td><strong>Associate Files:</strong></td>
<td>The location of the tests file that establishes the content for the online test. The online test defaults to using the currently open tests file. To override this setting, right-click in the Test edit box and reassociate to another test, then rebuild the LAN test to apply the content to the new online test.</td>
<td></td>
</tr>
<tr>
<td><strong>Test:</strong></td>
<td>The location of the tests file that establishes the content for the online test. The online test defaults to using the currently open tests file. To override this setting, right-click in the Test edit box and reassociate to another test, then rebuild the LAN test to apply the content to the new online test.</td>
<td></td>
</tr>
</tbody>
</table>
Online Instructor Window for LAN Tests: Setup

Record Scores To: Check to enable score recording. If checked, the online test defaults to using the currently open scores file. To override this setting, right-click and reassociate to another scores file and then rebuild the LAN test to apply to the online test. In LXR•TEST 6.0 you may record scores from more than one test to the same scores file, or you may choose to save each test's scores to a separate file.

CAUTION! When associating a scores file to an Online LAN test, the file path of the scores file MUST use a Universal Naming Convention (UNC); i.e. \servername\lxrscores\scorefilename.LXRScores.

The UNC will ensure that student client machines will be able to access and record scores to the online test’s scores file, which will be located on the server.

Exit Handling: This control enables you to link to an executable file, or to another online test.

Log off to: If you choose “Log off to,” you can either enter or browse for the name of the executable file (with file extension .EXE) you want run after the student finishes the LXR•TEST online test.

Go to test: If you choose “Go to test,” you can either enter or browse for the name of the online test you want the students to go to after they finish the current online test.

An example of exit handling usage would be if you created a demo test to acquaint students with the testing process and then linked the “real” test for them to take after they are familiar with taking an online test.

Note: When students exit to the cover page of the online test, upon test completion, they will have to manually select the next online test from the drop-down list.

Also, once students have exited a test, they may NOT return to the test UNLESS the “Restarts” setting (Admin tab) is set to ‘1’ or more.
Access

![Figure 103: Online Window ▶ Access](image)

**Student:**
- **Identification:**
  - Permit any ID/name: Anyone is permitted to take the test.
  - Require ID from Student database below: Only students who IDs are listed in the associated Students database are permitted to take the test. Selecting this option will activate the “Use Student database” option.
- **Password:**
  - No password required: The online test does not prompt for a password. Any ID entered will have access to the test.
  - Require this password: All students must enter this password to gain entry to the test. Enter the password in the edit box to the right.
  - Require password from Student database below: Unaccessible until “Require ID from Student database” is selected. Test is password protected by the passwords listed in the Students database.
  - Use Student database: Unaccessible until “Require ID from Student database” is selected. If no Student database is specified, you will automatically be prompted to locate a Students database. Access to the test is governed by the ID’s and/or passwords in the designated student database.

**Instructor:**
- **ID**
- **Password**

Establishes a “back door” access to any test for the instructor. Upon successful login, the instructor may further specify another ID and reset remaining test time (if any) for student recovery in continuing the test.
Admin

![Figure 104: Online Window ▶ Admin](image)

**Scramble:**

**Choices** Enables scrambling of the order of the item choices. All student responses are stored in the scores file along with a version number which indicates the scrambling order that was applied. (Questions that have OK to Scramble unchecked will NOT have choices scrambled regardless of the setting of this control.)

**Questions** Enables scrambling of the order of the questions. However, if there are any linked questions groups on the test, they will not be scrambled outside of the group. Also, if tests contain sections, then question scrambling will be within each section.

**Feedback:**

**Provide to students** Enables display of question feedback after the item has been graded. Feedback is the content entered in the Feedback area of the Questions Window for the specific item.

**Solicit from student** Places a “!” button in the Online Window which the student can click to enter comments regarding any item on the test. (E.g. “There is NO correct response to this item as stated!”)

**Question Grading:**

**None** Prohibits the student from grading any item.
### Instantly
Instantly grades any single-response item (multiple choice/true/false) as soon as one choice is clicked (or entered). This eliminates the student from having to click "Grade" after a response. However, if instant grading is set, the student is NOT able to alter a response after it has been entered.

### On Request
Each item may be selectively graded by the student by clicking the "Grade" button.

### Time:
Sets the restarting ability and administration time. Time does not begin until the student actually leaves the "cover page" and enters the test for the first time. Time then continues to accumulate until s/he exits the test.

### Restarts
Sets the number of times students can re-enter the test after exiting. If you enable students to re-enter a test, they can change their response to any ungraded item.

**CAUTION!** If you enable restarts, you would NOT normally want to enable the student to print certain reports since the student could determine which items were correct and re-enter the test to change his ungraded responses.

### Unlimited
Removes any time limits from the test.

### Default
Established the test time limit to be the sum of the administration times for each item on the test (as stored in the questions file.)

### Specify
Establishes the specific test time you enter (in minutes.)

### Warning
Enables a warning dialog box to be displayed at the number of specified minutes remaining for the test. The warning will remind the student of the limited amount of time remaining.

## Display

![Figure 105: Online Window](image)

### Figure 105: Online Window ➔ Display
Test Name: Sets the test name to be displayed on the cover page of the test.

Background Image: Enter the path to an existing image to be used as background for each question.

Supported graphic formats for LAN tests include:
- BMP (Bitmap)
- JPG (JPEG)
- GIF
- TIF (TIFF)

Tip! Teachers may want to use different background images to differentiate between practice tests and scored tests.

Also, when using a background image, the image resolution should be preset to match the screen resolution of the students’ computers.

### Report

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply Grading From</td>
<td>Enter a path to an existing grading table file to establish grading rules.</td>
</tr>
<tr>
<td>Header/Footer/Cover</td>
<td>Enter a path to an existing headers file to customize report headers and footers for this test.</td>
</tr>
<tr>
<td>Student Reports:</td>
<td>Designates the reports the student is eligible to receive.</td>
</tr>
<tr>
<td>Feedback</td>
<td>Check to enable the student to receive an individual feedback report.</td>
</tr>
</tbody>
</table>

![Figure 106: Online Window ➤ Report](image-url)
Score detail Check to enable the student to receive an individual score detail report. Click Setup to specify the report options. This report requires that you assign a grading table, referenced above.

Mastery Check to enable the student to receive an individual mastery report. Click Setup to specify the report options. This report requires that you assign a grading table, referenced above.

Send Reports To:
- Screen Specify the report destinations.
- Printer

Online Window Menu Items

There are no unique menu items for the Online Window. Refer to the Questions Window menu items discussion, beginning on page 137.

File

Export Online files can be exported in Native Format only.
Online Instructor Window for Web Tests

Online Web tests are ideal for use within a local intranet or across the Internet. Web tests can be administered to students anywhere, so long as they have Internet access. In fact, students can take Web tests on different kinds of computers, provided that up to date versions of Internet Explorer or Netscape Communicator are installed. When administering Web tests, you have the added option of sending e-mail copies of student reports to each student, as well as to other recipients.

CAUTION! Before you can create a Web test, you must install the LXR•TEST Server extensions on the machine hosting your Microsoft Internet Information Server (IIS), AND you must configure your current Project file settings to use this (or another) IIS with the properly installed extensions.

Note: While LXR•TEST does not impose a limit on the number of questions that can be on a web test, current Active Server Page (ASP) technology limits a web test to 200 questions.

Setup
Test Type:  
LAN  |  Web

The type of test (LAN or Web) is determined by your Project settings when you first create the online test file. You will need to choose a Project with “Is a Web Project” checked.

Note: Once you create an online that is a WEB test, you cannot later change it to a LAN test—you will need to create a new online test, after making the change in your Projects settings. Web tests require that dependent files (such as scores, grading table, and students) exist in a designated location on your web server as shown in the Projects window.

URL:  
The URL of the web test will display here.

Associate Files:  
Establishes the source for the online test and the destination for the scores.

Test:  
The location of the tests file that establishes the content for the online test. The online test defaults to using the currently open tests file. To override this setting, right-click and reassociate to another test and then rebuild the LAN test to apply the content to the new online test.

Record Scores To:  
Check to enable score recording. If checked, the online test defaults to using the currently open scores file. To override this setting, right-click and reassociate to another scores file and then rebuild the LAN test to apply to the online test. In LXR•TEST 6.0 you may record scores from more than one test to the same scores file, or you may choose to save each test's scores to a separate file. The scores file will need to be located in the ../lxrweb/online/scores/ directory where your LXR•TEST server software is installed.

Exit Handling:  
This control enables you to direct students to a logoff web page or to link them to another online test.

Log off URL:  
If you choose “Log off URL,” you can either enter or browse for the logoff web page.

Go to test:  
If you choose “Go to test,” you can either enter or browse for the name of the online test you want the students to go to after they finish the current online test.

An example of exit handling usage would be if you created a demo test to acquaint students with the testing process and then linked the “real” test for them to afterwards take.

Note: When students exit to the cover page of the online test, upon test completion, they will have to manually select the next online test from the drop-down list.

Also, once students have taken a test, they may NOT return to the test UNLESS the “Restarts” setting (Admin tab) is set to ‘1’ or more.

Access

(Same as for LAN test, refer to page 304.)
Admin

(Same as for LAN test, refer to page 305.)

Display

Display Properties:

<table>
<thead>
<tr>
<th>Test Name</th>
<th>Sets the test name to be displayed on the cover page of the test.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customized Web Display:</td>
<td>Customize your test by changing styles and pages. Refer to your HTML guide for instructions on style sheets. See below for further discussion.</td>
</tr>
</tbody>
</table>

Note: The logon, cover, and logoff pages are active server pages.

<table>
<thead>
<tr>
<th>Style Sheet</th>
<th>Check to use a custom style sheet that you designed, so that you can edit to globally change text and background styles for the test.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logon Page</td>
<td>Check to use a custom-designed test logon page.</td>
</tr>
<tr>
<td>Cover Page</td>
<td>Check to use a custom-designed test cover page.</td>
</tr>
<tr>
<td>Logoff Page</td>
<td>Check to use a custom-designed test logoff page.</td>
</tr>
</tbody>
</table>

How to Customize the Test Pages:

When you build the online web test, you can have the program create customized web pages for you. Click on the Display tab in the Online Window. Select each of the pages you would like created (Style Sheet, Logon Page, Cover Page, Logoff Page). When you select these pages, you will see the path of the location where the files will be created on your web server.
The following files will be created in the folder of the online test:

- LXRWEB.CSS
- LOGONPAGE.ASP
- COVERPAGE.ASP
- LOGOFFPAGE.ASP

CAUTION! There will also be a set of these files with the same name in the LXRWEB directory. These are the default web pages of the program. These files should never be modified, because they could be affected by any program updates you receive later on.

The custom, active-server-page files can be edited in any text editor or word processor. Only be sure these files are saved as text files when using a word processor.

**Report**

Apply Grading From:

Enter a path to an existing grading table file to establish grading protocol. If you enable a student report that prints a letter grade or mastery information, you will need to specify a grading table that provides the translation from percent to letter grade equivalent. This grading table will need to be located in the ..../lxrweb/grading/ directory where your LXR•TEST server software is installed.
Student Reports: Designates the reports the student is eligible to receive.

Note: Although you can customize the content of the student reports, you cannot use custom headers.

Feedback Check to enable the student to receive a feedback report. Click Setup to specify the report options.

Score detail Check to enable the student to receive a score detail report. Click Setup to specify the report options. This report requires that you assign a grading table, referenced above.

Mastery Check to enable the student to receive a mastery report. Click Setup to specify the report options. This report requires that you assign a grading table, referenced above.

Send Reports To:

Screen If checked, students will have the option of displaying reports on screen after a web test. **This option must be selected if you want students to be able to print reports.** They will use their web browser to control the printing process.

Note: If this option is selected, then students must display reports on screen if they want to have the reports sent to them by e-mail, when their instructor has set the e-mail option. However, if this option is not checked, e-mail reports (if configured) will automatically be sent when students exit the cover page.

Email:

To: Student If checked, sends designated (checked) reports to student’s e-mail address indicated in the associated students file. (Refer to Access tab.)

Use Logon ID as e-mail If checked, assumes that the student’s logon ID is his e-mail address and attempts to send designated reports to it.

CC: If checked, sends a copy of designated reports to this address.

BCC: If checked, sends a blind carbon copy of designated reports to this address.

From: If checked, sets the address of the e-mail indicating who it is from (otherwise blank).

Security: If checked, sends a security message to the indicated e-mail address if any student fails to logon after 5 attempts.
Item Conversion to HTML Format

When LXR•TEST prepares questions for a Web test, it reformats them to a HTML format suitable for display in a browser. As the content is converted from its native format, there will be display differences depending on the original format and how it can be displayed in HTML. Here are a few guidelines relating to display differences you can expect as font sizes are converted for web display.

<table>
<thead>
<tr>
<th>Proportional Fonts</th>
<th>Monospaced Fonts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font Size</td>
<td>HTML Size</td>
</tr>
<tr>
<td>4-7</td>
<td>1</td>
</tr>
<tr>
<td>8-9</td>
<td>2</td>
</tr>
<tr>
<td>10</td>
<td>3</td>
</tr>
<tr>
<td>11-12</td>
<td>4</td>
</tr>
<tr>
<td>14-16</td>
<td>5</td>
</tr>
<tr>
<td>18-24</td>
<td>6</td>
</tr>
<tr>
<td>26-72</td>
<td>7</td>
</tr>
</tbody>
</table>

Online Toolbar

- **Save and build online test**: Click this button to save and then generate an online test using the features set in each of the “tabbed” sections. All question content will be extracted from the questions file and written into the online tests file as self-contained data for the online test.

- **Lock Online Test**: Click Lock to prevent any accidental changes to an online test.

- **Take Test**: Click Take Test to launch the student online program (in the case of a LAN test) or your browser (in the case of a web test.)
Online Student Window for LAN Tests

There are actually a series of windows that the student views when taking an Online LAN test, including a Log On Dialog, a Cover Page, the Online Test, and a Log Off Dialog. The content of some of these windows can vary depending on the settings for the LAN test, and whether the student is re-entering the test (if permitted) or taking the test for the first time.

![Figure 107: Online LAN Logon Window](image)

Every student must log on to take a LAN test. If the test is access-controlled, the entered student ID and password (this option not pictured) is validated against the designated students file for the test.

![Figure 108: Online LAN Cover Page Window](image)

After the student has successfully logged in, s/he is taken to the Cover Page Window. The test does not officially “begin” until the student clicks the Begin button, and the time counter (if a timed test) is started.
When the student actually begins the test, the Testing Window is presented. If a question is linked to an instruction, the instruction will appear in a split window above the item, as displayed above.

**Online LAN Testing Window Toolbar**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cover</td>
<td>Returns to the Cover Page of the test where the student can look at test results before exiting the test.</td>
</tr>
<tr>
<td>Help</td>
<td>Brings up the Help Window which basically explains the functions of the test buttons, just as this section does.</td>
</tr>
</tbody>
</table>
Response Text Box

Indicates student’s response. The response can be typed or clicked depending upon the item type.

Grade Item Button. If the “On Request” option for Question Grading is enabled, the student can click the Grade Button after answering the question (or series of questions) on the screen and receive immediate feedback on whether the chosen response(s) was (were) correct; a checkmark for a correct response, an X-mark for an incorrect response.

Provide Feedback Button. If the “Solicit from student” option for Feedback is enabled, the student can click the “!” Button to open a window for entering feedback (student challenges) relating to a particular question item.

Note: Student feedback appears on the Individual Scores Report. The student feedback will be printed next to the question(s) for which the student provided feedback.

Time Button. Displays time remaining (if a timed test) or the current system time. The display can be selected on and off.

Toggle Bookmark. Check this box to bookmark the item for later return. (See the Next Button below.)

Navigate

Navigation Control. The left and right arrow buttons allow the student to move to the previous or next question, respectively. The drop down box allows the student to select and go to any question item within the test. The question numbers are color-coded:

GREEN means the question is still unanswered,

RED means the question has been (book)marked for later review, and

BLACK means the question has been answered.

Next Button. Moves to the next unanswered item. If all items have been answered, then moves to the next bookmarked item. If there are no more unanswered or bookmarked items, then the hand will point in the opposite direction and will go to the cover page when clicked.

Online Student Window for Web Tests

There are actually a series of windows that the student views when taking an online web test, including a Logon Window, a Cover Page Window, the Testing Window, and a Logoff Window. The content of these windows can vary depending on the settings for the Web test, and whether the student is re-entering the test (if permitted) or taking the test for the first time. Also, each of these windows may be further customized by an advanced LXR•TEST user by modifying the appropriate page, or style sheet, which uses standard HTML features.

Note: When remotely accessing the web test through a web browser, you will need to type in the URL of the constructed Web test in the following manner:
In general, when entering the URL, you must include:

```
//servername/lxrweb/online/yourwebtestname/webtest.asp
```

In fact, all Web tests are “executed” by a separate copy of the file “Webtest.Asp” (located individually within each Web test directory.)

---

**Figure 110: Online Web Logon Window (with Password Option)**

Every student must log on to take a Web test. If the test is access controlled, the ID and Password are validated against the designated students file for the test.

**Figure 111: Online Web Cover Page Window**

After the student has successfully logged in, s/he is taken to the Cover Page Window. The test does not officially “begin” until the student clicks the Begin button, and the time counter (if a timed test) is started.
When the student actually begins the test, the Testing Window is presented. There are many button features that are explained below:

### Online Web Testing Window Toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cover</td>
<td>Cover Button. Returns to the Cover Page of the test where the student can look at test results before exiting the test.</td>
</tr>
<tr>
<td>Help</td>
<td>Help Button. Brings up the Help Window which basically explains the functions of the test buttons, just as this section does.</td>
</tr>
<tr>
<td>Response Text Box</td>
<td>Indicates student's response. The response can be typed or clicked depending upon the item type.</td>
</tr>
</tbody>
</table>
**Grade Item Button.** If the “On Request” option for Question Grading is enabled, the student can click the Grade Button after answering the question (or series of questions) on the screen and receive immediate feedback on whether the chosen response(s) was (were) correct; a checkmark for a correct response, an X-mark for an incorrect response.

**Provide Feedback Button.** If the “Solicit from student” option for Feedback is enabled, the student can click the “!” Button to open a window for entering feedback (student challenges) relating to a particular question item.

Note: Student feedback appears on the Individual Scores Report. The student feedback will be printed next to the question(s) for which the student provided feedback.

**Time Button.** Displays time remaining (if a timed test) or the current system time. The display can be selected on and off.

**Toggle Bookmark.** Check this box to bookmark the item for later return. (See the “Hand” Button below.)

**Navigate**

**Navigation Control.** The left and right arrow buttons allow the student to move to the previous or next question, respectively. The drop down box allows the student to select and go to any question item within the test. The question numbers are color-coded:

GREEN means the question is still unanswered,

RED means the question has been (book)marked for later review, and

BLACK means the question has been answered.

**Next Button.** Moves to the next unanswered item. If all items have been answered, then moves to the next bookmarked item. If there are no more unanswered or bookmarked items, then moves to the Cover Page.
Part III: Using Mark Readers
Preparing for Automatic Scoring

Scoring tests and surveys using an optical mark reader involves proper operation and connectivity of multiple pieces of hardware and software. To optimize your productivity and success, a little time spent in planning can yield great dividends.

Before you can begin to automatically score tests, you first need several key ingredients:

- A compatible optical mark reader
- A quantity of compatible mark forms (sometimes called “bubble-sheets”). We recommend the LXR forms which are specially designed for use with LXR•TEST. These forms are available directly from LXR.
- A serial communications port (e.g. COM 1 or COM 2) not being used by any other device
- A proper cable to connect the reader to your computer

And, of course, you’ll need a Windows PC with the latest release of LXR•TEST with the Mark Reader option installed.

Choosing an Optical Mark Reader and Forms

There are several items to consider when selecting a reader and forms.
CAUTION! First and foremost, both the reader and forms you choose must be compatible with LXR•TEST! For the most recent listing of compatible readers and forms, refer to our web site at www.lxr.com. If you have a form that is currently not on our supported forms list, you may send several sample forms to LXR for a quote on whether LXR•TEST would be able to support your form.

You may wonder which reader and forms are “the best.” That’s somewhat like asking which car is best. What’s best for you depends on many factors.

Here are a few questions to consider:

**How many questions will you have on a test?** Some readers (and forms) only can accommodate a limited number of responses. Ensure the ones you choose accommodate a sufficient quantity of responses for the tests/surveys you’ll be administering.

**What is the maximum number of choices and types of responses?** LXR•TEST 6.0 can accommodate up to 26 responses for multiple choice and matching type items. It can also accommodate a numeric response item type. Be sure the forms you choose can accommodate the types of items you plan to have on your tests.

**How many students will be scored during a single “run”?** If you plan on automatic sheet feeding, consider how many forms can be handled by the reader in a single batch. Also, be aware of the reader’s maximum speed at which it can read forms (even though this speed is likely to be lower because of “overhead” in interfacing with your computer).

**How well does the reader accommodate imperfect forms?** Forms you get back from your respondents may be “less than flat.” Some readers are more forgiving in their treatment of “mangled” forms.

**Do you need to capture “demographic” data on your forms?** Decide exactly what type of information you’ll need filled-in on each form. Make sure your form accommodates that information. (Some will only need a student ID; others may need a complete name and classifications for grade-level, sex, school, test, etc.)

**Will you need to read both sides of a form?** If you plan to capture a lot of information or responses, you may need a two-sided form. If you do choose a two-sided form, consider getting a reader that can read both sides in a single pass. If you don’t get a two-sided reader, at least ensure that the two-sided forms you use have a field for Student Number (ID) on both sides of the form.

**How many "channels" are configured for your reader and form?** LXR•TEST only supports certain readers with 25, 40 or 48 channels. Be sure that the form and reader you choose match these numbers of channels. (Channels are the number of read positions across a page.)
Is a correct cable provided with your reader? Cables are required to connect the reader to your computer. Be sure the proper cable is provided or available.

Do you need pencil or ink read "heads"? Some readers only will read pencil marks. Others with special "ink" read heads are more sensitive and can read both pencil and ink marks, but will require special forms. Be sure that you match the type of form (pencil or ink) with the corresponding type of reader (pencil or ink).

Other factors: Who will support your reader equipment? How much does maintenance cost? How much do forms cost? Are there other similar equipment users in your area? A good reference from another user is perhaps one of the best aids in deciding which reader and form(s) to use.
Chapter 10: Mark Reader Installation

Chapter Overview:

System Requirements.......................... 329
Package Contents............................... 329
Installing the Mark Reader Option Software... 329
Reader Hardware and Forms Setup............. 329
Hardware and Software Verification.......... 330

As mentioned, the Mark Reader Option is extension software for LXR•TEST 6.0. The Mark Reader Option provides you with the additional capabilities of automatically reading and scoring response data from optical mark reader forms.
System Requirements

Refer to the System Requirements section in the beginning of Chapter 2.

Package Contents

Refer to the Package Requirements section in the beginning of Chapter 2.

Installing the Mark Reader Option Software

If you ordered the mark reader option, all necessary software will be automatically loaded when you installed the LXR•TEST program.

Reader Hardware and Forms Setup

To prepare for scoring your first test or survey, be sure to perform the following:

- Confirm compatibility and review any notes in Appendix E: Mark Reader Hardware, for your specific reader and forms.
- Follow the user/operator guide for your mark reader and set up according to the manufacturer’s guidelines.
- Observe switch settings (if any).
- Connect the power cable.
- Connect the data cable supplied with your reader to an unused serial port (COM 1 or COM 2) on your PC.

Note: Contact your vendor for questions regarding cabling.

- Connect the other end of the data cable to the reader. Some readers have multiple connectors. Ensure you connect the cable to the correct connector.
- Power the reader on.
Prepare several sample forms. “Bubble in” dummy data similar to that which you will be using. Two or three sample forms should suffice for initial testing.

**Hardware and Software Verification**

After your reader is physically connected to your computer, and you’ve prepared a few sample forms, you need to set up LXR•TEST to communicate with your reader and to verify that LXR•TEST and your reader are properly talking to each other.

- Launch LXR•TEST by double clicking the program icon.
- Click the **Scores** button on the **LXR•TEST** toolbar.
- Choose Create a new Scores database. Click OK.
- Type the name **Temp**. Click **Save**.
- The **Scores Window** is ready to receive response data:

Note: The examples shown in these steps are for illustrative purposes only. The settings you select may be different.
Before forms can be read, you must specify the type of reader and forms you are using from the Reader and Form Setup submenu, of the Reader menu. The proper communications settings must also be established at this time. Once the proper settings have been established, you should not need to change the Reader and Form Setup options unless you change readers and/or forms.

- From the Reader menu, choose Reader and Form Setup to initialize your reader and forms settings.

**Reader Setup**

- In the Reader Setup tab (see below), under Reader Selection, click on the name of the manufacturer of your mark reader. Now you have an expanded list of readers.

![Reader Setup](image)

- Select your reader from within the expanded list. (A brief description of the chosen reader will display under Reader Description.)

The first time you select a reader, Communications, Sensitivity, and Options are configured to LXR•TEST factory values. When you adjust these settings and save them by clicking OK, these values will be restored the next time you open Reader Setup.

The default (factory) settings for LXR•TEST have been set to match the settings of the reader as shipped from the factory. If your reader is set to the original settings, as in most cases, it will not require any changes in setup to work.
Note: Any settings that are grayed out (dimmed) are either not supported by the selected reader or are not changeable by the user.

You will next want to test the communications “handshaking” between your reader and the LXR•TEST software.

- Verify that your reader is connected to an unused serial port and is plugged in.
- Verify your reader is powered on.
- Click Test Current Settings.

LXR•TEST will now attempt to communicate with your reader to verify that the reader’s settings match with the software’s settings. If successful, LXR•TEST will automatically update its settings to match those of the reader. If unsuccessful, LXR•TEST will acknowledge the failure to communicate with the reader. You will have to manually set the correct settings. Refer to Mark Reader Troubleshooting, beginning on page 359.

Note: In the event that LXR•TEST is unable to automatically negotiate communications settings with the reader, or if you simply want to manually set the settings, instructions for proper communication settings should be in your reader’s manual. You may also want to make use of Appendix E: Mark Reader Hardware for our suggestions on the settings typically used by the various reader hardware manufacturers. LXR•TEST’s communications settings must be set to match those of your specific reader, in order for your reader to operate with your PC and LXR•TEST.

CAUTION! You should not change any of the “Sensitivity” or “Options” settings unless you know what the intended consequence(s) will be and/or that your reader will support the feature(s). Both of these settings will be discussed in depth in Chapter 12: Mark Reader Reference, page 346.

Note: After changing any settings in Reader Setup, you should use “Test Current Settings” to verify the settings. A detailed description on the “Test Current Settings” feature is provided in Chapter 12: Mark Reader Reference on page 346.

- After the settings have been correctly set up and verified, be sure to save your settings by clicking **Apply**.

Now that you have your reader setup, you will need to set up your form.
Form Setup

- Click on the **Form Setup** tab to set up the correct form.

- Select your form under **Form Selection**:  
  ![Form Selection](image)

Note: The list of forms displayed will vary depending on the reader model currently selected (from the Reader Setup tab). In fact, only the forms compatible with the currently selected reader will be shown.

- Verify the settings for **Student ID**, **Test Version Number**, and **Test ID Number**. Depending on how you intend to gather such information, make any necessary adjustments. Refer to page 348 for an explanation of these settings.

  **CAUTION!** The very first time you select a form, the default settings will be selected. However, if you alter these settings, these altered settings will become the new “default” settings for this form and will be restored the next time you choose this form.

- Click **OK** to save your form settings and to exit **Reader and Form Setup**.

- Now, load your forms into the reader’s input hopper.
If you’re using a manual feeder, be prepared to insert forms manually into the feeder. Automatic readers have specific instructions for loading the forms (e.g., you must press additional buttons or levers to load the forms). Follow the instructions provided with your reader.

- From the Reader menu, choose Read Response Forms. (If you have a manual feed reader, insert the forms - one at a time - into the reader.) LXR•TEST displays a status message as the forms are read.

- You can terminate reading at any time by clicking Cancel.

If LXR•TEST doesn’t receive a response from the reader within a few moments, it will terminate with an error message. The most likely cause of the problem is a reader, or communications setup error. Double check your settings according to the steps above. If after you have consulted your mark reader manual, and Appendix E: Mark Reader Hardware, and you are still unable to resolve the problem, please contact our support team.

If you suspect either a reader hardware problem, or a cabling problem, or need help running diagnostics on the reader, you should contact your hardware vendor for assistance.

- After all forms have been read, LXR•TEST will display a summary message of the reader session. Click OK to close the summary. The Scores Window now displays the data from all the forms read.

Now that you have successfully performed these initial setup procedures, you are encouraged to read through the following mark reader tutorial chapter.
Chapter Overview:

Reading for Internally Created Test........337
Reading for Externally Created Test........339

The Read Response Forms menu option initiates communication between LXR•TEST and your reader. This option is only available when you have an opened Scores file.

Note: If an Optical Mark Reader (OMR) form has different “sections” for groups of responses, and you use more than one section, you must have a corresponding section break on the test for each section on the form. For example, say you intend to use section 1 and section 3 areas of the form for recording answers (but not section 2). Then, when designing your test, you must include two section breaks between the questions in first section and next (last) section, since there are no questions (or responses) in the middle section.
Reading for Internally Created Test

If you are reading forms for a test that was created from a LXR•TEST bank file (i.e., an internally created test), you should normally have the corresponding Bank and Tests files both open (along with the Scores file) when you read your forms. This enables the Scores file to “associate” with a specific test and facilitates scoring the responses when all the forms are read.

Note: You must have a grading table open in order to have the program assign a letter grade to each student’s raw test score or to assign mastery levels.

If you have a reader with an automatic sheet feeder, you should place the to-be-read forms in the input bin. Refer to the user/operator guide provided with your reader.

Note: If your forms do not contain a student ID field, or you have a single-sided reader and will be reading both sides of two-sided forms, that do not have the student ID on both sides, you must first choose “Automatically assign ID” from the Forms Setup tab under Reader and Form Setup. Choosing “Automatically assign ID” disables capturing any student ID value marks on forms.

To read in forms:

If you have a reader with an automatic sheet feeder, you should place the to-be-read forms in the input bin. Refer to the user/operator guide provided with your reader.

- Verify that the Scores Window is the active window.
- Choose Reader and Form Setup from the Reader menu.
- Click the Form Setup tab.
- Under Student ID, select Automatically assign ID.
- Click the Apply button, then OK.
- Choose Read Response Forms from the Reader menu.
- LXR•TEST will look for the reader. If the reader or form (or both) is (are) not properly configured, then you will be prompted to do so.
If successful in finding the reader, then Assign Student ID displays:

![Assign Student ID dialog box]

- You must set a starting Student ID number. The first form will be assigned this starting number, and each remaining form will be assigned a consecutive ID number.

**CAUTION!** If you are reading new students’ test data into a Scores file that already contains some existing student data, make sure that the ID numbers you assign will not overlap any existing student IDs in the file. Otherwise, the program will overwrite the existing data for a student if there is an ID overlap.

- If you have a manual feed reader, you should begin to insert forms, one at a time. If you have a reader with an automatic sheet feeder, and forms have been loaded into the read tray, the reader should automatically begin to read the forms, so you should skip the next step.

![Reader Status dialog box]

- As shown above, the bottom line of the dialog box displays the current status of the reader. In this example, the manual feed reader is waiting for the next form to be fed.

- As each form is read, the student ID and name will be displayed. You can interrupt the reading process at any time by pressing the Cancel button.

- If your reader jams, you will receive an error message. Remove the jammed form and either re-insert it into the input bin, or put it aside to be read later. You may also have to use the control panel on the reader to resume its reading status. Refer to page 360 for discussion of other reader-related error messages.

When all forms have been read, LXR•TEST should display a short confirmation message summarizing how many student forms were read. In the event that on reading the last form
LXR•TEST seems to hang, give the program a few moments to time out on its own. This should ensure that the last form will be properly recorded into the Scores file.

Note: Unlike LXR•TEST 5.1, you will need to “Score” the results after all the responses are read.

**Reading for Externally Created Test**

If you are reading forms for a test that was not created from a LXR•TEST bank file, the first form you must insert is a form with all the correct answers marked (i.e., an answer key).

- Verify that the **Scores Window** is the active window.
- Choose **Read Answer Key** from the **Reader** menu.

![Read Answer Key Form](image)

- **Read Answer Key Form** displays (as shown above). The program will provide default names for the **synthetic bank and tests files** that are needed to read in an answer key form. You can specify new file names and directory paths, if so desired.

Note: The synthetic bank will only contain the correct answers and define each answer to be worth 1 point. The synthetic test will only contain the organization information of the test form, such as how many questions there are before a section break.

- Notice the default objective field at the bottom of the **Read Answer Key Form** dialog box. For this example, leave the objective as **ANSWER_KEY**.
- Click the **Read Form** button.
As the answer key is read, the synthetic files are created. Now you are ready to begin reading in forms:

Note: You must have a grading table open in order to have the program assign a letter grade to each student’s raw test score.

If you have a reader with an automatic sheet feeder, you should place the to-be-read forms in the input bin. Refer to the user/operator guide provided with your reader.

Note: If your forms do not contain a student ID field, or you have a single-sided reader and will be reading both sides of two-sided forms, that do not have the student ID on both sides, you must first choose “Automatically assign ID” from the Forms Setup tab under Reader and Form Setup. Choosing “Automatically assign ID” will not permit you to capture any student ID value marks on forms.

- Choose Read Response Forms from the Reader menu.
- LXR•TEST will look for the reader. If the reader or form (or both) is (are) not properly configured, then you will be prompted to do so.
- If you have a manual feed reader, you should begin to insert forms, one at a time. If you have a reader with an automatic sheet feeder, and forms have been loaded into the read tray, the reader should automatically begin to read the forms, so you should skip the next step.

As shown above, the bottom line of the dialog box displays the current status of the reader. In this example, the manual feed reader is waiting for the next form to be fed.

As each form is read, the student ID and name will be displayed. You can interrupt the reading process at any time by pressing the Cancel button.

If your reader jams, you will receive an error message. Remove the jammed form and either re-insert it into the input bin, or put it aside to be read later. You may also have to use the control panel on the reader to resume its reading status. Refer to page 360 for discussion of other reader-related error messages.
When all forms have been read, LXR•TEST should display a short confirmation message summarizing how many student forms were read. In the event that on reading the last form LXR•TEST seems to hang, give the program a few moments to time out on its own. This should ensure that the last form will be properly recorded into the Scores file.

Note: Unlike LXR•TEST 5.1, you will need to “Score” the results after all the responses are read.

Furthermore, after all forms have been read and scored, you can choose to print a variety of score reports.
Chapter Overview:

Mark Reader Menus............................... 345
Mark Reader Hardware......................... 350
Mark Reader Forms............................ 355
Mark Reader Troubleshooting.............. 359

This Mark Reader Reference section is designed to facilitate your access to each of the mark reader functions.
Mark Reader Menus

This section discusses each menu item in the order of its appearance in the Reader menu (the Scores Window must be the active window).

Reader Setup

Reader Setup enables you to select the reader you intend to use for reading your score forms, and to set up the reader’s communications settings. Also, you have the flexibility to change the OMR’s reading Sensitivity of the forms. You will only need to configure Reader Setup once (unless you change/reconfigure reader or form) since your chosen settings are saved in the Windows registry.
Explaining the Reader Concepts

**Reader Selection**
Lists all supported readers. Highlight the specific reader model you will use.

**Reader Description**
Displays descriptive information about the reader currently selected.

**Communications**
Allows you to configure the communications settings individually. In most cases, however, the easiest way to set up your reader communications is to click on the Test Current Settings button, and allow LXR•TEST attempt to determine the settings.

**Test Current Settings**
Will verify if the current settings are correct by attempting to connect to the reader. Upon failure, the program will negotiate with your reader the appropriate communications settings. The "Test Current Settings" process will attempt to:
- Verify that a reader is detected on the selected COM port
- Verify the necessary data communication signals are present
- Verify that the selected communication parameters (baud rate, etc.) match the reader’s
- Synchronize the communication parameters to those of the reader if they are not matched (not supported on all readers)
- Verify the options available on the reader are correct
- Notify the user of any problems found

**Reset to factory values**
Will reset the communications settings back to the factory, default values.

**Sensitivity**
Adjusts the sensitivity with which the reader detects marks on forms. This applies only to certain readers, and each reader has its own interpretation. Generally a reader’s sensitivity is comprised of two components:

Minimum Read Level is how “dark” a mark needs to be before it is interpreted as being a valid mark. The higher the number, the darker the mark must be in order to be read.

| CAUTION! Setting the read level either too high or too low can cause unexpected problems. |

Mark Difference is used to help distinguish an actual mark from another unintentional mark or smudge, such as a poor erasure. Setting the Mark Difference value to a low value will reduce the likelihood of lighter marks being picked up by the reader; increasing the value can cause lighter marks to be picked up.

(Mark Difference is only applicable to certain readers. In fact, the options available will vary depending on the reader. If the control is dimmed, it is either not available or it is not supported on the currently selected reader.)
Tip! Users should verify that the “Options” are correct for their reader; if not, then correct them.

- **Dual Sides**: Indicates that the reader has dual heads and can read both sides of a form in one pass.
- **Auto Feed**: Allows you to use a reader’s automatic form feeder.
- **Ink Read Heads**: Indicates that the reader is equipped with ink heads. Readers equipped with ink heads can only read forms printed in special colors of ink. Contact your forms supplier to verify that your form is ink-head compatible.
- **40 Chnl (200 in) Spacing**: Indicates that the reader is equipped with 40 channel read heads. (Only used by international reader models.)
- **Reject Bin**: Indicates that the reader is configured to separate forms that contained errors or met other reject criteria into the reader’s reject (output) bin.
- **Printer**: Indicates that the reader is equipped with an internal printer. (This feature is not currently supported.)

**Form Setup**

Form Setup enables you to choose the testing form you will be using, as well as to instruct LXR•TEST about how you want to handle Student ID, Test ID, and Test Version Number. You must first select a reader under Reader Setup before you can select a form.

![Figure 114: Form Setup](image)
Note: Form Setup gets its information from reader configuration files contained in the Forms directory, which by default lies within the LXR•TEST program directory. A new feature in 6.0 is that you can now specify a different location for these reader configuration files. You can change the location through Preferences (File menu). However, if the Forms directory has been deleted, is currently empty, or is misplaced elsewhere, you will not be able to read forms.

### Explaining the Form Concepts

<table>
<thead>
<tr>
<th>Form Selection</th>
<th>Lists all supported forms for the specific reader you highlighted. Highlight the specific form you intend to read.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form Description</td>
<td>Displays brief descriptions of the form currently selected.</td>
</tr>
<tr>
<td>Student ID</td>
<td>Gives you the option of either reading the student’s ID number from the form, or having LXR•TEST automatically assign a sequential number to every form that is read. Student ID number allows LXR•TEST to keep track of individual student performance in the Scores file.</td>
</tr>
</tbody>
</table>

You must select Automatically assign ID if:

- The form you have chosen does not have a student ID field, OR
- You are not using the student ID field on the form (e.g., surveys), OR
- You are reading multiple-sided forms, in multiple passes, through a single-sided reader (unless all sides of the form contain student ID fields).

When you select Automatically assign ID, you will be presented with a dialog box to assign an initial sequential ID number. This dialog box will not be presented if the Student ID is to be read from the form.

If you stop reading forms and then restart reading forms later, LXR•TEST will suggest a starting sequence number one higher than the last number it assigned on a read. This effectively adds the remaining students at the end of the existing scores file.

**Tip!** If you have a single-sided reader and are reading the second side of a stack of two-sided forms, when prompted you will want to reset the sequence number to the same sequence number you initially assigned the first student when reading the first side of the forms. Any time an incoming form’s student ID matches one already in the Scores file, LXR•TEST will update the data on the matched student ID.
Test Version Number

Gives you the option of either reading the test version number from the form or instructing LXR•TEST to assign the user-specified test version to each read form. Test version tells LXR•TEST which version of the test (only possible when test and its corresponding bank(s) were actually constructed in the LXR•TEST program) to use to score student responses.

Note: Many forms do not have a specific location on them to enter a test version number. In this case, if you indicate to the program to read the test version from the forms, LXR•TEST will interpret the last digit in the Student ID field as the test version number, and remove the last digit from the ID.

Test ID Number

Gives you the option of either reading a Test ID number from the OMR form, or having LXR•TEST automatically assign a number. A scores file can hold multiple Test ID numbers – i.e., response data for multiple tests. In fact, you can read OMR forms from several tests in one reading session – LXR•TEST will sort the response data to the appropriate test via the Test ID. Use of the Test ID is an advanced topic, and you should only use this feature when you fully understand it. For further discussion, consult the What About “Forms?” section, beginning on page 267.

If you choose to read the test ID from the form, a list of available fields will appear in the drop-down list. Choose the specific field to be used on your form. This feature is supported only on selected forms; refer to our web site for a current list.

Read Response Forms

Before choosing Read Response Forms, you should have:

- Connected your mark reader to your PC using the cable provided with the mark reader.
- Plugged in and turned on your mark reader.
- Configured your mark reader via its control panel/buttons/configuration form.
- Created and opened a LXR•TEST scores file.
- Properly configured the Reader and Form Setups as well as the reader’s internal, communication settings.

If you are scoring a test that was created in LXR•TEST, you should have:

- Opened the associated LXR•TEST bank and tests files.

If you are scoring a test that was not created in LXR•TEST, you should have:
LXR•TEST read the external test’s answer key (which would have instructed the program to create the corresponding synthetic bank and tests files). Refer to Read Answer Key in the Reader menu.

Now go ahead and select Read Response Forms. LXR•TEST will briefly “look” for your mark reader, using the communications settings you have selected. Once communications with the reader are established, LXR•TEST will begin reading forms and displaying the Student ID and Student Name (if marked) in a status window as each form is read. Once all forms have been read, the Scores Window will be updated.

If LXR•TEST cannot communicate with your mark reader, it will “time out” within 30 seconds approximately. Chances are the mark reader’s communication settings do not match those in LXR•TEST. For mark reader settings, refer to your mark reader’s manual or Appendix E: Mark Reader Hardware.

Read Answer Key

LXR•TEST features the ability to score “external” tests. Here, external means a test that was created outside of LXR•TEST, e.g. a purchased printed exam. When you are reading in an answer key from an OMR form, LXR•TEST makes some assumptions: each test item has a point value of one, and there is only one correct answer for each item. If you create all your tests within LXR•TEST, you will not need to read an answer key because LXR•TEST has the answers to the test questions stored in the bank(s).

LXR•TEST must have both a bank file and a tests file open before a test can be scored. When you read the answer key off an OMR form, synthetic question and tests files are created. While the synthetic bank file certainly does not have content for each question, it does serve as a repository for the correct answer and point for each test item. The synthetic bank can be edited: i.e., you may go in and change settings such as “points,” “time,” etc. The synthetic tests file that is created only serves to establish the order of the bank items that are on the test.

Mark Reader Hardware

LXR•TEST supports a wide variety of optical mark readers from the following manufacturers:

- Chatsworth Data Corporation
- National Computer Systems
- Scanning Systems
- Scantron Corporation
Each optical mark reader supported by LXR•TEST must have a LXR•TEST configuration file which describes the capabilities and characteristics of the reader. The reader configuration files corresponding to the various supported readers are located in the “Forms” subdirectory of the LXR•TEST program directory. Only these readers will be available for use.

The optical mark reader’s communications interface must be set so that both the reader and computer have identical settings. Many readers have one or more sets of switches which control the communications settings (baud rate, parity, stop bits, data bits, etc.) and communications protocol (end of form, etc.). Other readers come with a special configuration form which needs to be scanned by the reader in order to set the reader’s settings. Regardless of the method used, the communications settings and protocol of the reader and of the computer must exactly match. Refer to your reader manual or consult your dealer if you are unable to determine the information for how your reader should be set up. Specifics on how you might set up your reader follow in Appendix E: Mark Reader Hardware. The following section provides overview information on LXR•TEST supported OMRs:

**Chatsworth Data Corporation Readers**

For detailed Chatsworth OMR configuration specifications, see Appendix E: Mark Reader Hardware.

Supported readers include:

- Chatsworth OMR 1000 & 2000 with RS232C interface

**Chatsworth 1000/2000 Models**

The Chatsworth OMR 1000 and OMR 2000 family of readers use a card-stock paper form. Forms for these readers are 12 channels wide. Only one side of the form is read per pass. The OMR 1000 model is a manual feed reader, the OMR 2000 is automatic feed.

**National Computer Systems Readers**

For detailed NCS OMR configuration specifications, see Appendix E: Mark Reader Hardware.

Supported readers include:

- NCS Sentry 3000
- NCS 3051 and 3061
- NCS OpScan 2, 3, 4, 4XP, 5, 6, 7, 8
NCS Sentry 3000

The NCS Sentry 3000 is a full page reader. Forms for this reader are based upon 48 channel spacing width. The Sentry 3000 reads full width forms using an optical translucence technology, reading both sides of the form in a single pass. An automatic feed mechanism is optional.

NCS Sentry 3051 and Sentry 3061

The NCS Sentry 3051 and 3061 are half page readers. Forms for this reader are based upon 48 channel spacing width, but only half the page is read (24 channels). These models, like the Sentry 3000, read forms using an optical translucence technology, reading both sides of the form in a single pass. An automatic feed mechanism is optional.

NCS OpScan 2, 3, 4, 4XP, 5, 6, 7, 8

These OpScan readers are full page readers. Forms for these readers are based upon 48 channel spacing width. The readers read full width forms using a reflective technology to read each side of the form separately. An automatic feed mechanism is available. These readers are available with one or two read heads.

Scanning Systems Readers

For detailed Scanning Systems OMR configuration specifications, see Appendix E: Mark Reader Hardware. Scanning Systems SR-360 and HEI360 are identical in function and operation. All references to the SR-360 also apply to the HEI360.

Forms for the SR-360, SR-380, SR-601, and SR-607 are 48 channels wide and use a reflective technology to read the forms. The SR-360 reads one side per pass while the SR-380 reads both sides in one pass. Both models are equipped with an automatic form feeder.

Supported readers include:

- SR-360, SR-360V
- SR-380, SR-380V
- SR-601, SR-607, SR-700
Scantron Corporation Readers

For detailed Scantron Corporation OMR configuration specifications, see Appendix E: Mark Reader Hardware.

Supported readers include:

- Scantron 1200, 1300, 1400, 2100, 5100, 5200, 5200S (25 channel only)
- Scantron 8000, 8200, 8400, 8600 (25, 40, or 48 channel)
- Scanmark 2000, 2010, 2250, 2260, 2500 (25, 40, or 48 channel)

Scantron 1200, 1300, 1400, 2100, 5100, 5200, 5200S

The setup and operation of each of these models is similar, so they will all be discussed in this one section with differences noted where appropriate. These readers are available, from the manufacturer, to handle 27 channel spacing (Option 1) or 25 channel spacing (Option 2). Only 25 channel spacing (Option 2) readers are supported by LXR•TEST. A label on the reader next to the serial number will identify whether your reader is Option 1 or Option 2. Readers sold to the educational community are almost always Option 2 machines. Confirm your reader is an Option 2 reader when in doubt.

Scantron models 1200, 1300, 2100 and 5100 are half-page readers based upon 25 channel spacing width, but they only read 12 channels or half the physical page per pass. Models 1400, 5200, and 5200S read the full 25 channels per pass and can also read the half page forms used by the half page models. All of these readers use an optical reflective technology to read one side or section of the form per pass.

Scantron 8000, 8200, 8400, 8600 & Scanmark 2000, 2250, 2500...

The Scantron 8000 series (8000/8200/8400/8600) reader is a full page reader supported in 25 channel, 40 channel, and 48 channel options. The Scanmark 2000 series (2000/22xx/2500) is a full page reader supported in 25, 40, and 48 channels. The 25 channel option is available with one read head only. The 40 channel and 48 channel option are available with either one or two read heads. Readers with two heads will read an entire form in one pass. Readers with only one read head will read one side of the form per pass and may require multiple passes to read the complete form.

Note: Special considerations are necessary if you choose to use a multi-sided form with a single-sided reader. See the “Special Form Considerations” subsection of the following “Mark Reader Forms” section.
Mark Reader Forms

Compatibility Table

The following table provides a list of the currently supported scanner forms and their compatibility to supported readers. **The information is provided for your convenience and should be verified with your reader and forms vendor(s).** For the lastest information, please refer to our web site at www.lxr.com. The LXR web site contains additional information regarding these and other forms for use with LXR•TEST. Before purchasing forms, we strongly suggest you obtain sample forms from your supplier to determine the forms that will indeed meet your needs and are fully compatible with LXR•TEST.

Note: Some readers are available with ink-sensitive read heads. If your reader has ink-sensitive heads, be sure and verify with your form vendor that the form you have chosen will work with your ink read heads.

Table 1: Reader and Forms Compatibility.

<table>
<thead>
<tr>
<th>Reader</th>
<th>Form Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reader 1</td>
<td>Chatsworth 1000</td>
</tr>
<tr>
<td>Reader 2</td>
<td>Chatsworth 2000</td>
</tr>
<tr>
<td>Reader 3</td>
<td>Scanning Systems 360, 601, 700 single head</td>
</tr>
<tr>
<td>Reader 4</td>
<td>Scanning Systems 380, 607, 700 dual head</td>
</tr>
<tr>
<td>Reader 5</td>
<td>NCS 3051/3061</td>
</tr>
<tr>
<td>Reader 6</td>
<td>NCS 3000</td>
</tr>
<tr>
<td>Reader 7</td>
<td>NCS OpScan 2, 3, 4, 4XP, 5, 6, 7 and 8</td>
</tr>
<tr>
<td>Reader 8</td>
<td>Scantron 1200, 1300, 2100, and 5100</td>
</tr>
<tr>
<td>Reader 9</td>
<td>Scantron 1400, 5200, and 5200S</td>
</tr>
<tr>
<td>Reader 10</td>
<td>Scantron 8000, 8200, 8400, 8600 &amp; Scanmark 2000, 2010, 2250, 2260, 2500 (25 channel option)</td>
</tr>
<tr>
<td>Reader 11</td>
<td>Scantron 8000, 8200, 8400, 8600 &amp; Scanmark 2000, 2010, 2250, 2260, 2500 (48 channel option)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Forms</th>
<th>Readers (See legend above.)</th>
<th>Items</th>
<th>Sides</th>
</tr>
</thead>
<tbody>
<tr>
<td>LXR-20020</td>
<td>N N Y Y N N Y N N N Y 220</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>LXR-26133</td>
<td>N N Y Y N N Y N N N Y 133</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>06-2UP</td>
<td>Y Y N N N N N N N N 50</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>102936</td>
<td>N N N N N Y Y N N N Y 200</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>105965</td>
<td>N N Y Y N N Y N N N Y 54</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>156-12</td>
<td>N N Y Y N N Y N N N Y 40</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>156-13</td>
<td>N N Y Y N N Y N N N Y 100</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>156-9</td>
<td>N N Y Y N N Y N N N Y 200</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Forms</td>
<td>Readers</td>
<td>Items</td>
<td>Sides</td>
</tr>
<tr>
<td>-------</td>
<td>----------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>156-9V</td>
<td>N N N Y N Y N N N N N</td>
<td>200</td>
<td>1</td>
</tr>
<tr>
<td>16418</td>
<td>N N N N N Y Y N N N N</td>
<td>60</td>
<td>2</td>
</tr>
<tr>
<td>16432</td>
<td>N N N Y Y N Y N N N N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>16482</td>
<td>N N N N N N N N N N N</td>
<td>120</td>
<td>2</td>
</tr>
<tr>
<td>16485</td>
<td>N N Y Y N Y Y N N N N</td>
<td>240</td>
<td>2</td>
</tr>
<tr>
<td>16504</td>
<td>N N Y Y N Y Y N N N N</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>19541</td>
<td>N N N N N Y Y N N N N</td>
<td>36</td>
<td>2</td>
</tr>
<tr>
<td>19542</td>
<td>N N N N N N N N N N N</td>
<td>40</td>
<td>2</td>
</tr>
<tr>
<td>19543</td>
<td>N N Y Y N Y Y N N N N</td>
<td>196</td>
<td>2</td>
</tr>
<tr>
<td>19626</td>
<td>N N Y Y N Y Y N N N N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>19642</td>
<td>N N Y Y N Y Y N N N N</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>20052</td>
<td>N N N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>20450-FES</td>
<td>N N N N N N N N Y Y N N</td>
<td>50</td>
<td>2</td>
</tr>
<tr>
<td>2050-C</td>
<td>N N N N N N N N Y Y Y N</td>
<td>50</td>
<td>1</td>
</tr>
<tr>
<td>2052</td>
<td>N N N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>2052-N</td>
<td>N N N N N N N N Y Y N N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>2054</td>
<td>N N N N N N N N Y Y Y N</td>
<td>200</td>
<td>4</td>
</tr>
<tr>
<td>2054N</td>
<td>N N N N N N N Y Y Y N</td>
<td>200</td>
<td>4</td>
</tr>
<tr>
<td>207740</td>
<td>N N N N N N N Y Y N N N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>207745</td>
<td>N N N N N N N N Y Y Y N</td>
<td>50</td>
<td>2</td>
</tr>
<tr>
<td>20874-E</td>
<td>N N N N N N N N Y Y Y N</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>20778-E</td>
<td>N N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>2097-C</td>
<td>N N N N N N N N Y Y Y N</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>2100-5</td>
<td>N N Y Y N Y Y N N N Y</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>2135-C</td>
<td>N N N N N N N N Y Y Y N</td>
<td>50</td>
<td>1</td>
</tr>
<tr>
<td>21577-E</td>
<td>N N N N N N N N Y Y Y N</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>21790-SF</td>
<td>N N N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>21889</td>
<td>N N N N N N N N Y Y Y N</td>
<td>50</td>
<td>2</td>
</tr>
<tr>
<td>21957-SF</td>
<td>N N N N N N N N Y Y Y N</td>
<td>320</td>
<td>2</td>
</tr>
<tr>
<td>21999</td>
<td>N N N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>22000</td>
<td>N N N N N N N N Y Y Y N</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>221681</td>
<td>N N Y Y N Y Y N N N Y</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>22185</td>
<td>N N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>22187</td>
<td>N N N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>22250</td>
<td>N N N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>22889-SF</td>
<td>N N N N N N N N Y Y Y N</td>
<td>48</td>
<td>2</td>
</tr>
<tr>
<td>23357-E</td>
<td>N N N N N N N Y Y Y N</td>
<td>20</td>
<td>1</td>
</tr>
<tr>
<td>23520</td>
<td>N N N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>23639-25</td>
<td>N N N N N N N N Y Y Y N</td>
<td>50</td>
<td>1</td>
</tr>
<tr>
<td>24000</td>
<td>N N N N N N N N Y Y Y N</td>
<td>200</td>
<td>1</td>
</tr>
<tr>
<td>2888</td>
<td>N N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>30243</td>
<td>N N Y Y N Y Y N N N Y</td>
<td>240</td>
<td>2</td>
</tr>
<tr>
<td>30515</td>
<td>N N Y Y N Y Y N N N Y</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>4521</td>
<td>N N Y Y N N Y Y N N N Y</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>52000-S2</td>
<td>N N N N N N N Y Y Y N</td>
<td>200</td>
<td>1</td>
</tr>
<tr>
<td>62000-S2</td>
<td>N N N N N N N Y Y N N</td>
<td>120</td>
<td>2</td>
</tr>
<tr>
<td>70921</td>
<td>N N Y Y N Y Y N N N Y</td>
<td>40</td>
<td>2</td>
</tr>
<tr>
<td>7123</td>
<td>N N Y Y N Y Y N N N Y</td>
<td>240</td>
<td>2</td>
</tr>
<tr>
<td>74593</td>
<td>N N Y Y N Y Y N N N Y</td>
<td>400</td>
<td>2</td>
</tr>
<tr>
<td>7473</td>
<td>N N Y Y N Y Y N N N Y</td>
<td>80</td>
<td>1</td>
</tr>
<tr>
<td>76250</td>
<td>N N N N Y Y Y N N N Y</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>76257</td>
<td>N N N N Y Y Y N N N Y</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>76656</td>
<td>N N Y Y N Y Y N N N Y</td>
<td>36</td>
<td>2</td>
</tr>
<tr>
<td>815</td>
<td>N N N N N N N Y Y Y N</td>
<td>15</td>
<td>1</td>
</tr>
<tr>
<td>81788</td>
<td>N N Y Y N Y N N N Y</td>
<td>112</td>
<td>2</td>
</tr>
<tr>
<td>Forms</td>
<td>Readers</td>
<td>Items</td>
<td>Sides</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>B1789</td>
<td>N Y Y N N Y N N Y N</td>
<td>112</td>
<td>2</td>
</tr>
<tr>
<td>B3739</td>
<td>N Y N Y Y N N N Y N N</td>
<td>40</td>
<td>2</td>
</tr>
<tr>
<td>B5849</td>
<td>N Y Y N Y N N N Y N</td>
<td>112</td>
<td>2</td>
</tr>
<tr>
<td>B6278</td>
<td>N Y N N N Y N N Y N</td>
<td>112</td>
<td>2</td>
</tr>
<tr>
<td>B82</td>
<td>N N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>B82-E</td>
<td>N N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>B84</td>
<td>N N N N N N N Y Y N</td>
<td>200</td>
<td>4</td>
</tr>
<tr>
<td>B84-E</td>
<td>N N N N N N N Y Y N</td>
<td>200</td>
<td>4</td>
</tr>
<tr>
<td>B8483</td>
<td>N Y Y N Y Y N N N Y</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>B88-E</td>
<td>N N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>B887-E</td>
<td>N N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>B979E</td>
<td>N Y Y N Y Y Y N N Y</td>
<td>80</td>
<td>2</td>
</tr>
<tr>
<td>93329</td>
<td>N Y Y N N N Y N N Y</td>
<td>120</td>
<td>2</td>
</tr>
<tr>
<td>94047</td>
<td>N Y Y N Y Y Y N N Y</td>
<td>40</td>
<td>2</td>
</tr>
<tr>
<td>95677</td>
<td>N N N N N Y Y Y N N Y</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>95679</td>
<td>N N N N N Y Y Y N N Y</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>B550010</td>
<td>Y Y N N N N N N N Y</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>B550050</td>
<td>Y Y N N N N N N N N</td>
<td>50</td>
<td>1</td>
</tr>
<tr>
<td>CP4807</td>
<td>Y Y N N N N N N N N</td>
<td>50</td>
<td>1</td>
</tr>
<tr>
<td>F-10283</td>
<td>N Y Y N Y N N N</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>F-11075</td>
<td>N Y N N N N Y N</td>
<td>50</td>
<td>1</td>
</tr>
<tr>
<td>F-1187</td>
<td>N Y Y N Y Y Y N N Y</td>
<td>200</td>
<td>1</td>
</tr>
<tr>
<td>F-158</td>
<td>N Y Y N N Y N N Y</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>F-165</td>
<td>N Y Y N N Y N N Y</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>F-166</td>
<td>N Y Y N N Y N N Y</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>F-1712-E0</td>
<td>N Y Y N N Y N N Y</td>
<td>200</td>
<td>1</td>
</tr>
<tr>
<td>F-1780</td>
<td>N Y Y N Y N N N</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>F-2024-6</td>
<td>Y N N N N N N N Y</td>
<td>24</td>
<td>1</td>
</tr>
<tr>
<td>F-262</td>
<td>N Y Y N N N N N Y</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>F-267Y</td>
<td>N Y Y N N Y N N Y</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>F-289</td>
<td>N N Y N N N N N Y</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>F-343</td>
<td>N Y Y N N Y N N Y</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>F-4000-9</td>
<td>Y Y N N N N N N</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>F-491</td>
<td>N N N N N N N Y</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>F-949</td>
<td>N N N N N Y N N Y</td>
<td>50</td>
<td>2</td>
</tr>
<tr>
<td>F-949-1</td>
<td>N N Y Y N Y N N N</td>
<td>50</td>
<td>2</td>
</tr>
<tr>
<td>F-949-2</td>
<td>Y N N N N N N N N</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>H45050-0</td>
<td>Y N N N N N N N N</td>
<td>50</td>
<td>1</td>
</tr>
<tr>
<td>H55070-0</td>
<td>Y Y N N N N N N N N</td>
<td>50</td>
<td>1</td>
</tr>
<tr>
<td>L30771R</td>
<td>Y N N N N N N N N</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>P098</td>
<td>N N Y Y N N N N</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>SCN-156-9</td>
<td>N Y Y N Y Y N Y</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>SCN-156-13</td>
<td>N Y Y N Y N N N</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>SS-10521</td>
<td>N N Y Y N Y N N</td>
<td>200</td>
<td>2</td>
</tr>
<tr>
<td>SSA10-25</td>
<td>Y N N N N N N N N</td>
<td>25</td>
<td>1</td>
</tr>
<tr>
<td>SWT90459</td>
<td>N Y Y N N Y N N Y</td>
<td>150</td>
<td>1</td>
</tr>
<tr>
<td>T2500-6V</td>
<td>Y N N N N N N N N</td>
<td>25</td>
<td>1</td>
</tr>
<tr>
<td>T4887</td>
<td>Y Y N N N N N N N</td>
<td>120</td>
<td>2</td>
</tr>
<tr>
<td>TFI-0933</td>
<td>Y Y N N N N N N N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>TRADOC 560</td>
<td>N Y Y N Y Y N N N Y</td>
<td>250</td>
<td>2</td>
</tr>
<tr>
<td>UPS-70-60</td>
<td>N N Y N N Y N</td>
<td>150</td>
<td>2</td>
</tr>
<tr>
<td>X-101864</td>
<td>N N N Y Y N Y N N Y</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>X-101B84</td>
<td>N N Y Y N Y N N N</td>
<td>50</td>
<td>1</td>
</tr>
<tr>
<td>X-101B89-25</td>
<td>N N N N N N Y Y Y N</td>
<td>100</td>
<td>2</td>
</tr>
<tr>
<td>X-101B89-48</td>
<td>N N Y Y N N Y N N N</td>
<td>100</td>
<td>2</td>
</tr>
</tbody>
</table>
Form Description Files

Each scan form supported by LXR•TEST must have a corresponding form description which the LXR•TEST program uses to interpret the marks on the form as it is read. The form descriptions are contained in individual files which are located in the LXR•TEST “Forms” directory. LXR does not currently support end-user generation of form configuration files. If you need to use a particular form, you should verify that the form is LXR•TEST compatible or contact LXR for a custom form quotation (see below).

Custom Forms

If you have a special scoring form or survey form that is not currently supported by LXR•TEST, you may request a quotation for implementing the form. In order for us to provide the quotation, you will need to first send us a copy of the form for a quote, and if the quote is acceptable, then several copies (at least six) of the form for testing. Also include any supplemental information on how you want to use the form. Please allow 2 weeks after approval of a quote for programming of custom forms. You may want to contact us before completing the design of the form to ensure that the form you design will work as intended with LXR•TEST.

Standard Form Fields Supported by LXR•TEST:

- **Student ID**: Up to 10 digits (recommended)
- **Name**: 1-30 characters (optional)
- **Test Version**: 1 digit, value from 0-9 (optional)
- **Code Fields**: Up to 8 fields, 1-4 characters each (optional)
- **Response Fields**: 900 Maximum items, up to 26 possible responses: letters A-Z
- **Test ID Number**: Values 0-999 (optional)
Special Form Considerations

Several special considerations need to be employed when a multi-sided form is read with a reader capable of reading only one side per pass. Forms designed specifically for multiple passes will have a student identification entry block on each side of the form. Since the student ID uniquely identifies each form, it is necessary to ensure that an identification code is entered on each side of the form being used so that each side of the form can be matched with the other (previously read) side(s). If the side of a form being read does not have a student ID entry block on it, it is necessary to use the “Automatically assign ID” option in Form Setup so that the ID numbers are assigned for all read sides of the form. Use of forms without ID entry blocks, on all sides of the form, on a single sided reader is not recommended. Further, when reading multiple-sided forms through a single sided reader, it is absolutely imperative that all sides of the forms be read in the exact same order as the forms are stacked at the beginning of the first pass through the reader.

If a form does not have a student ID entry block on any side, the program will automatically enable the Automatically assign ID option. When you choose “Read Response Forms” you will be prompted to enter the starting ID number to be assigned.

When a multi-sided form is read with some single sided readers, an additional dialog on the reader’s panel will ask which side of the form is to be read. Enter the side number you intend to read for the current read cycle. When finished reading the side indicated, use Read Response Forms to read the additional sides. (For some readers the side is determined in the LXR•TEST program and not in the reader hardware.)

When a multi-sided form with a student ID entry block on each side is read with a two sided reader, the ID from both sides of the form are read. In this case, the ID marked on both sides must be identical, or you should consider only using the ID from side one. If the IDs are marked differently, an error is reported as the form is read.

Mark Reader Troubleshooting

The most frequent cause of mark reader related problems is a mismatch in communications settings between the reader and LXR•TEST program; the reader and program are not able to communicate with each other. Verify the settings in both “Reader Setup” and “Form Setup” before considering the error messages discussed later. (We suggest you annotate the reader’s communications settings onto the reader for easy reference.)
Also, be sure that the form configuration files are installed in the Forms directory specified in Preferences (File menu). The reader configuration files and form description files corresponding to the reader and forms you intend to use must be located in this “Forms” subdirectory. (You may safely remove any reader or form configuration/description file from this subdirectory for any reader or forms which you will not be using.)

Mark Reader Error Messages

The following error messages are the most common that occur when using an optical mark reader with the LXR•TEST program:

**No Response was Received from the Reader:**

```
OMR Scoring Message

Read: OpScan 3
Port: COM1:38400,0,7,2
No response was received from the reader.

No device can be detected on the port specified.
Verify that the reader has been installed and configured properly.
Use the Test Current Settings button on the Reader Setup dialog
to help troubleshoot the problem.

[OK]
```

This message occurs when choosing **Read Response Forms**. The reader did not respond to LXR•TEST. There are several possible reasons: the reader is either not powered on, or is offline, or is not cabled, etc.. Best recommendation is to try **Test Current Settings**, which provides more diagnostic information.
In Reader Setup, when Test Current Settings is chosen, LXR•TEST looks for a reader but cannot find one. The last line indicates all control signals are off, meaning that the reader may not be powered on, or that one or more items listed above are incorrect.

This message indicates that a modem is installed on the selected port (Com1). Choose another port for the reader.
In this scenario, LXR•TEST determines that a device is connected to COM1 because all the control signals are present, but that the device is not responding. There are many possible reasons for this error. Please check all of the listed, aforementioned items for a possible cause.

**Access is Denied:**

This message indicates that the selected port (COM1) is not available because another device is using COM1, or because the port is disabled in BIOS. The other device could be a serial mouse, or a UPS power system.
The System Cannot Find the File Specified:

This message indicates that the selected port (COM3) does not exist on this computer. Choose another COM port that exists and is not being used.

Reader is Responding, but Side Count is not Correct:

This error will result when a 2-sided reader is selected in LXR•TEST, but your reader only scans with 1 head. You will have to choose another reader within LXR•TEST to match your reader’s configuration.
Chapter 12: Mark Reader Reference

Reader is Responding, but is not Set Up Properly:

![OMR Scoring Message]

Reader: SR-601
Port: COM1:9600,N,7,2
The reader is responding but is not setup properly.

Current mode is SR-360.
Reader must be set in SR-600 compatible mode
or use Reader Setup dialog to choose a different mode.

Incorrectly configuring LXR•TEST to expect SR-360 mode causes this error.
Form Identification Error:

![OMR Scoring Message]

This indicates that perhaps the wrong form was fed. In this example, the reader only read 39 tracks on side one while LXR•TEST was expecting to read 51 tracks. A skewed or misfed form can also result in this error message.

![OMR Scoring Message]

This situation is slightly different from the previous. LXR•TEST expected to read form LXR20020, in this example. However, a different form with the same number of tracks was read instead. This error can also occur if the reader is expecting a specific side and the wrong side was fed.
No Data Received from Reader:

For some readers, you will receive this message if a form is fed incorrectly.

Didn't Receive Expected Data:

Usually caused by an incorrectly fed form or a blank sheet fed on a SR-xxx reader.
Reader Jam:

The reader has a form jam. You are recommended to first clear the jam in the reader, and then press the OK button to continue. On Scantron readers, you may have to press the CONT button on the reader to restart the reader.

Student ID's from Side 1/Side 2 are not Identical:

You are warned that the entered ID's on both sides of the form do not match!
Missing Answers on Answer Key:

An answer key was read. Some of the questions didn’t have an answer marked. LXR•TEST will warn you if there is one or more missing answers within a group of questions. When the test/bank are built, the corresponding questions won’t have answers to grade correctly the student forms. You are recommended to answer NO to correct the answer key.

Invalid Student ID:

This error indicates that the ID on this form had multiple marks in the 2nd column of the ID field.
**Missing Student ID on Form:**

This form did not have any bubbles marked for the Student ID.

**Missing or Invalid Test ID:**

In **Form Setup** a Test ID was specified to be read from the form. However, no Test ID number was marked on the form.

**Other Error Considerations**

**No Reader Configuration Files Found**

When the "Form Setup" tab in Reader and Form Setup attempts to display the available readers an forms, the program looks for the forms directory as specified in the Aux tab of Preferences. If the form configuration files are not present in this directory, then no forms display in the "Form Selection" panel.
**Excessive Read Errors**

These can result from several causes:

An incorrectly setup reader can be the cause. Verify the reader is set up according to suggested settings.

Dirty read heads can cause read errors. Clean the read heads according to the manufacturer’s directions and try reading again.

Poorly marked forms. Verify the marks are plainly marked with the marking device specified, usually a number 2 pencil.

If forms are consistently misread, (particularly if the forms are from a vendor other than the manufacturer of the reader), you may need to adjust the sensitivity values in “Form Setup” to compensate, if your reader supports this option.

**Faulty hardware**

A problem in the reader can cause either misreads of forms – either reading extra marks or missing marks. Sometimes the problem can be isolated to one faulty channel which is consistently read wrong. Contact your reader provider for hardware troubleshooting.

**Vendor Information**

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Sales</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chatsworth Data Corporation</td>
<td>(818) 341-9200</td>
<td>(818) 341-9200</td>
</tr>
<tr>
<td>National Computer Systems</td>
<td>(800) 447-3269</td>
<td>(800) 338-5544</td>
</tr>
<tr>
<td>Scantron Corporation</td>
<td>(800) 722-6876</td>
<td>(800) 445-3141</td>
</tr>
</tbody>
</table>
Appendix Overview:

Appendix A: Glossary.........................373
Appendix B: Substitution Variables....379
Appendix C: Merge Fields Names &
Gradebook Format..........................383
Appendix D: Sample Reports............393
Appendix E: Mark Reader Hardware....425
Appendix F: Sample Forms..............479
Appendix G: Keyboard Shortcuts.......483
Appendix H: Online Web Setup.........485
Appendix I: Error Handling............491
Appendix J: Upsizing to SQL Server..493
Appendix K: Licensing.......................497
Appendix A:
Glossary

The following are descriptions of terms and expressions used in the User’s Guide:

administration time  The estimated time (in minutes) needed to answer a question. This value is entered in the Statistics Area of the Questions Window.

bank  Also known as “questions file.” This database file stores the questions, from which to create tests.

category  A label that further defines the nature of a question. For instance, a question could have “LONG DIVISION” as its objective (see definition of “objective”), and a category value of MEDIUM for the “Difficulty” category (label). Each bank can customize eight categories. Refer to page 131 for discussion on what characters are permissible in a category value.

choice  A possible answer to a question. For instance, a true/false question has two choices while a multiple-choice question can have up to 26 choices, one for each letter of the alphabet.

cover page  The page before the first page of a test, or before the first page of a report. This page will usually display the name of the test as well as other pertinent testing information.

current edit box  The edit box which you have clicked with the text cursor. This active box is indicated by the flashing cursor. Any text you type, or graphic you insert, will be placed in this box.

current picture  The picture which you have selected with a single click. This active picture is surrounded by a dashed-line, rectangular border.

current window  The window which is in front of all other windows. The active window is the only window for which the title bar is highlighted.

database  Can be used interchangeably with the word “file”. Thus, a tests database is the same as a tests file.

default  An assumed setting. For example, when you first create a bank, the default questions font will be Arial 12 (plain) unless you change the default font within Question Setup.

dialog box  A standard box which requests or reports information.

difficulty  The percent of students who answered the question correctly out of the total number of students. Also known as the “p-value” of a question.

DSN  Stands for “Data Source Name”.

exporting  Extracting data from an LXR•Tests file to place into either another LXR•Tests file or for use with another application.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>field</td>
<td>A specific type of data placeholder in a collection of data. For example, a questions file is a collection of questions - each question contains many types of data, or fields (e.g., answer field, category field, etc.). In fact, such a structured collection is called a database with each question referred to as an individual record.</td>
</tr>
<tr>
<td>footer</td>
<td>Common text and/or pictures for display at the bottom of the printed page.</td>
</tr>
<tr>
<td>form</td>
<td>Could either mean test form or mark reader form.</td>
</tr>
<tr>
<td>free format</td>
<td>A numbered question type which has a stem, but no choices.</td>
</tr>
<tr>
<td>header</td>
<td>Common text and/or pictures for display at the top of the printed page.</td>
</tr>
<tr>
<td>highlighted</td>
<td>Means that an object (e.g., question, graphic, etc.) is selected.</td>
</tr>
<tr>
<td>importing</td>
<td>Bringing data from another LXR•Tests file or from files of other applications into either the current or a new LXR•Tests file for use.</td>
</tr>
<tr>
<td>item</td>
<td>Use interchangeably with the word “question.”</td>
</tr>
<tr>
<td>LAN</td>
<td>Stands for “Local Area Network”.</td>
</tr>
<tr>
<td>mark reader form</td>
<td>The bubble-sheet that is marked by students and scanned through (optical) mark readers.</td>
</tr>
<tr>
<td>mean</td>
<td>The average of a list of test scores. The sum of the scores divided by the number of scores.</td>
</tr>
<tr>
<td>median</td>
<td>The test score in the middle of the score distribution, after the scores have been arranged in ascending order.</td>
</tr>
<tr>
<td>merge</td>
<td>A special, text file format for importing or exporting data. The first line of text, called the “header,” identifies the exact names of the data elements (i.e., field names) to be imported (or exported). This is similar to column headings for a table. The actual data is contained in each additional row with each data element separated by a field delimiter (usually a tab character) and each row ending with a record delimiter (usually a return character).</td>
</tr>
<tr>
<td>multi-response</td>
<td>A multiple-choice question that can have more than one correct choice. Each choice can have a different point value.</td>
</tr>
<tr>
<td>numeric answer type</td>
<td>A free-format question type that allows for the entry of a numeric response. A response is correct if it falls within a pre-defined numeric range.</td>
</tr>
<tr>
<td>objective</td>
<td>Also known as “objective name.” The subject name of the question, such as “math.” Refer to page 120 for discussion on what characters are permissible in an objective.</td>
</tr>
<tr>
<td>ODBC</td>
<td>Stands for “Open Database Connectivity”.</td>
</tr>
<tr>
<td>OLE</td>
<td>Stands for “Object Linking and Embedding”.</td>
</tr>
<tr>
<td>OMR</td>
<td>Optical Mark Reader.</td>
</tr>
<tr>
<td>percent score</td>
<td>The raw score divided by the possible test score, multiplied by 100.</td>
</tr>
<tr>
<td>picture</td>
<td>Use interchangeably with the word “graphic.”</td>
</tr>
</tbody>
</table>
point-biserial
A statistical measure of the discrimination power of a question; i.e., how closely related success on a question is to success on the test. The formula used is:

\[ r_{pb} = \frac{\bar{Y}_1 - \bar{Y}}{s} \sqrt{\frac{n_1n}{(n-n_1)(n-1)}} \]

where:
- \( n \) total number of students
- \( n_1 \) number who answered the question correctly
- \( \bar{Y} \) mean score for all students
- \( \bar{Y}_1 \) mean score for those who answered the question correctly
- \( s \) standard deviation

questions file
Use interchangeably with “questions bank” or “bank.”

question ID
A unique identifier for each question in the bank. A question ID consists of an objective and a sequence.

response index
The ratio of the number of times a particular choice is selected to the total number of students. Possible values fall between (and including) 0 and 1. In LXR•TEST, response indices print in the Item Statistics Report (under Score Reports).

scaled scores
A method for assigning student performance based on a score transformation that depends on whether the student is at or above an established cut score, or less than an established cut score. The score transformation depends on either of the following equations:

If \( \text{Raw Score} < \text{Raw Cut Score} \), then assign a failing score:

\[ \text{Scale Score} = \frac{(\text{Raw Score} \times (\text{Scale Cut Score} - 1))}{(\text{Raw Cut Score} - 1)} \]

If \( \text{Raw Score} = \text{or} > \text{Raw Cut Score} \), then assign a passing score:

\[ \text{Scale Score} = \frac{((\text{Raw Score} - \text{Raw Cut Score}) \times (100 - \text{Scale Cut Score} - 1))}{(\text{Maximum # Items} - \text{Raw Cut Score})} + \text{Scale Cut Score} \]

scrambling choices
Rearranging the display order of choices for a multiple-choice question when displayed in an online test or printed on a test. Also see version.

scrambling question order
Rearranging the display order of questions on a test.

sequence
Also known as “sequence number.” The position of the question in an objective. For example, a sequence of “3” would indicate the third question in an objective.

serial number
The first set of six digits following the two letter prefix in the software key. For example, in the software key LX-999999-XXXXXX-XXXXXX-XXXXXX, 999999 is the serial number.

single-response
A multiple-choice question that has one correct response.
short answer response A free-format question type that allows for a short, text answer. Typical uses are for single-word or short phrase answers in online testing.

software key The code required during installation in order for the software to install. See the previous “serial number” entry for an example of a software key.

specs Stands for “test specifications”. Specs can be entered into the Specs database to automate the creation of test forms. See also test form.

standard deviation A statistical number used to summarize the distribution of student scores on a particular test. The formula used is:

\[ S = \sqrt{\frac{\sum_{i=1}^{n} (X_i - \bar{X})^2}{n-1}} \]

where:

- \( n \) number of students
- \( X_i \) student’s score
- \( \bar{X} \) test mean

A large standard deviation indicates a wide spread of scores.

standard error of measurement A statistical estimate of the probable difference between a student’s score on a test score and his/her true performance. The formula used is:

\[ SEM = s \sqrt{1 - \text{test reliability}} \]

stem The part of the question that states the question (as opposed to choices) and other pertinent information.

students file This file contains demographic and personal information of students.

student lookup file Also known as the “students file.”

test form A test form is an alternate test layout where there are different items on the test but the item selection is considered to be equivalent in nature to other test forms. Essentially, a test form is a different test, but one with high content reliability to the original test. Refer to the section “What About ‘Forms?’” in Chapter 4 for further discussion. See also test version.

test ID The test ID determines which set of scores are displayed when multiple test administrations are associated with a scores file. Refer to the reference section on the Scores Window in Chapter 4 for further discussion.
test reliability  
A measure of how reliable a test is in differentiating student achievement.  
LXR•TEST calculates test reliability using the Cronbach-Alpha formula (also  
known as the coefficient alpha formula).  The formula used is:  
\[
a = \frac{b}{b-1} \left[ 1 - \frac{\sum_{i=1}^{b} S_i^2}{S^2} \right]
\]

where:  
a  
coefficient alpha (estimated internal consistency reliability)

b  
total number of questions on the test

or  
\[
S_i^2 = \frac{1}{n-1} \sum_{j=1}^{n} (x_{ij} - \overline{x}_i)^2 \quad S^2 = \frac{1}{n-1} \sum_{j=1}^{n} (t_j - \overline{t})^2
\]

where:  
n  
number of students

tj  
test score for each student

j  
a particular student

t  
test mean

X  
student’s score on an question

\overline{X}  
student average

test version  
A test version is an alternate test layout where the same items are on the test,  
but the order of items, and/or item choices, are arranged differently.  Refer to  
the section “What About ‘Forms?’” in Chapter 4 for further discussion.  See also  
test form.

type (of question)  
Questions can be either instructions, true/false, matching, multiple-choice, etc.  
questions.

URL  
Stands for “Universal Resource Locator”.  For example:  
http://www.lxr.com

version  
See test version.

web  
Shorthand for “World Wide Web.”
Appendix B: Substitution Variables

The following program variables can be used in either question or header/footer/cover page content; some can be used in both. These variables allow for program values to be displayed on screen (for online tests) or printed on tests. You can either manually enter these variables or use the “Insert Variable” function found in the Insert menu, or when right-clicking in an edit box.

Note: These program variables are NOT case sensitive.

<table>
<thead>
<tr>
<th>Variable</th>
<th>(5.1)</th>
<th>For use in...</th>
<th>Translation</th>
</tr>
</thead>
<tbody>
<tr>
<td>%AdminTime%</td>
<td>:</td>
<td>Stem, choices</td>
<td>Question’s allotted administration time</td>
</tr>
<tr>
<td>%Answer%</td>
<td>\a</td>
<td>Stem, choices, feedback</td>
<td>Correct answer, as indicated in the Questions Window’s Answers Area. For multiple choice questions, the label (A, B, C ...) corresponding to the correct answer for the current test version will be printed (or displayed). For free format: letter, short answer, or numeric, the content of the answer box (or answer range) will be printed (or displayed). For matching questions, the correct answer for each subquestion will be printed.</td>
</tr>
<tr>
<td>%Copyright%</td>
<td>\b</td>
<td>Header, footer, cover</td>
<td>Copyright notice as entered in Utilities &gt; Question Setup &gt; Copyright.</td>
</tr>
<tr>
<td>%CurrentDate%</td>
<td>\d</td>
<td>Feedback, notes, header, footer, cover</td>
<td>Today’s date in long-hand format, as configured in Windows Regional Settings.</td>
</tr>
<tr>
<td>%CurrentTime%</td>
<td>\t</td>
<td>Feedback, notes, header, footer, cover</td>
<td>Current time in the format configured in Windows Regional Settings.</td>
</tr>
<tr>
<td>%LinkFirst%</td>
<td>\f Stem, choices</td>
<td>Question number of the first linked question in a link set. For example, if an instruction item was the first item in a link set, then the following (second) item would be the first linked question. The question number of this second item in a link set would be the value of %LinkFirst%.</td>
<td></td>
</tr>
<tr>
<td>%LinkCount%</td>
<td>\g Stem, choices</td>
<td>Number of linked (non-instruction) questions in the current link set, including the question that contains the variable.</td>
<td></td>
</tr>
<tr>
<td>%LinkLast%</td>
<td>\l Stem, choices</td>
<td>Question number of the last linked question in a link set.</td>
<td></td>
</tr>
<tr>
<td>%MaxResponses%</td>
<td>NEW Stem, choices, feedback</td>
<td>Maximum number of responses permitted for the item.</td>
<td></td>
</tr>
<tr>
<td>%PageNumber%</td>
<td>\p Feedback, notes, response, header, footer, cover</td>
<td>Page number.</td>
<td></td>
</tr>
<tr>
<td>%PointValue%</td>
<td>. Stem, choices, header, footer, cover</td>
<td>Question’s point value.</td>
<td></td>
</tr>
<tr>
<td>%QuestionFile%</td>
<td>\q Header, footer, cover</td>
<td>Questions file’s name. (*.LXRbank.)</td>
<td></td>
</tr>
<tr>
<td>%QuestionPath%</td>
<td>NEW Header, footer, cover</td>
<td>Full questions file name, including path.</td>
<td></td>
</tr>
<tr>
<td>%ReportName%</td>
<td>\k Feedback, notes, response, header, footer, cover</td>
<td>Report name as indicated in the Print menu.</td>
<td></td>
</tr>
<tr>
<td>%StudentName%</td>
<td>\s Header, footer, cover</td>
<td>Student’s name.</td>
<td></td>
</tr>
<tr>
<td>%StudentID%</td>
<td># Header, footer, cover</td>
<td>Student’s ID.</td>
<td></td>
</tr>
<tr>
<td>%ScoresFile%</td>
<td>\z Header, footer, cover</td>
<td>Scores file’s name. (*.LXRscores)</td>
<td></td>
</tr>
<tr>
<td>%ScoresHeading1%</td>
<td>\c</td>
<td>Header, footer, cover</td>
<td>“Heading 1” text, as entered in the Scores Window.</td>
</tr>
<tr>
<td>------------------</td>
<td>----</td>
<td>----------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>%ScoresHeading2%</td>
<td>\i</td>
<td>Header, footer, cover</td>
<td>“Heading 2” text, as entered in the Scores Window.</td>
</tr>
<tr>
<td>%ScoresPath%</td>
<td>NEW</td>
<td>Header, footer, cover</td>
<td>Full scores file’s name, including path.</td>
</tr>
<tr>
<td>%ScoresTestName%</td>
<td>NEW</td>
<td>Header, footer, cover</td>
<td>“Test Name” text, as recorded in the Scores Window.</td>
</tr>
<tr>
<td>%ScoresTestId%</td>
<td>NEW</td>
<td>Header, footer, cover</td>
<td>“Test ID” value, as recorded in the Scores Window, as read from the optical mark form.</td>
</tr>
<tr>
<td>%ScoresTestDate%</td>
<td>NEW</td>
<td>Header, footer, cover</td>
<td>“Test Date” info., as recorded in the Scores Window.</td>
</tr>
<tr>
<td>%SpecQuestionFile%</td>
<td>NEW</td>
<td>Header, footer, cover</td>
<td>Questions file’s name, as recorded in the Specs Window.</td>
</tr>
<tr>
<td>%SpecQuestionPath%</td>
<td>NEW</td>
<td>Header, footer, cover</td>
<td>Questions file’s path, as recorded in the Specs Window.</td>
</tr>
<tr>
<td>%StudentPoints%</td>
<td>\r</td>
<td>Header, footer, cover</td>
<td>Student’s total raw score.</td>
</tr>
<tr>
<td>%StudentPercent%</td>
<td>%</td>
<td>Header, footer, cover</td>
<td>Student’s overall percent score.</td>
</tr>
<tr>
<td>%StudentGrade%</td>
<td>NEW</td>
<td>Header, footer, cover</td>
<td>Student’s overall letter grade.</td>
</tr>
<tr>
<td>%TestDate%</td>
<td>\e</td>
<td>Header, footer, cover</td>
<td>“Test Date” value, in Windows Regional Settings format, as recorded in Tests Window.</td>
</tr>
<tr>
<td>%TestFile%</td>
<td>\n</td>
<td>Header, footer, cover</td>
<td>Tests file’s name.</td>
</tr>
<tr>
<td>%TestForm%</td>
<td>NEW</td>
<td>Header, footer, cover</td>
<td>Test form.</td>
</tr>
<tr>
<td>%TestName%</td>
<td>NEW</td>
<td>Header, footer, cover</td>
<td>“Test Name” text, as recorded from the Tests Window.</td>
</tr>
<tr>
<td>%TestPath%</td>
<td>NEW</td>
<td>Header, footer, cover</td>
<td>Full tests file's name, including path.</td>
</tr>
<tr>
<td>---------------</td>
<td>-----</td>
<td>-----------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>%TestPoints%</td>
<td>\m</td>
<td>Header, footer, cover</td>
<td>Maximum possible raw test score.</td>
</tr>
<tr>
<td>%TestVersion%</td>
<td>\v</td>
<td>Header, footer, cover</td>
<td>Test version.</td>
</tr>
</tbody>
</table>
Appendix C: Merge Fields Names & Gradebook Format

This appendix contains tables of field names that are used for importing from and exporting to merge files of different LXR•TEST databases. There is also a table display of the Gradebook export format for the Scores database.
# Questions File Merge Field Names

<table>
<thead>
<tr>
<th>Merge Field Name</th>
<th>Description</th>
<th>Permitted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>OBJ</td>
<td>Objective name</td>
<td>Up to 20 characters, may not contain 2 or more consecutive spaces</td>
</tr>
<tr>
<td>SEQ</td>
<td>Sequence number</td>
<td>0…999</td>
</tr>
<tr>
<td>Q_TYPE</td>
<td>Question type</td>
<td>Instruction (INS), FF: Open-Ended (OPN), FF: Letter (LET), FF: Short Answer (SHO), FF: Numeric (NUM), FF: Scientific (SCI), True False (T/F), Multiple-Choice: Single (MCS), Multiple-Choice: Multiple (MCM), Matching (MAT)</td>
</tr>
<tr>
<td>STEM</td>
<td>Stem text</td>
<td>Text</td>
</tr>
<tr>
<td>CHOICE_A…Z</td>
<td>Choice A…Z text</td>
<td>Text</td>
</tr>
<tr>
<td>MATCH_1…26</td>
<td>Matching choice 1…26</td>
<td>Text</td>
</tr>
<tr>
<td>FEEDBACK_ALL</td>
<td>All feedback text fields</td>
<td>Text</td>
</tr>
<tr>
<td>FEEDBACK_A…Z</td>
<td>Feedback fields for choices A…Z</td>
<td>Text</td>
</tr>
<tr>
<td>NOTES</td>
<td>Notes text</td>
<td>Text</td>
</tr>
<tr>
<td>RFORM</td>
<td>Response form text</td>
<td>Text</td>
</tr>
<tr>
<td>CAT_1…8</td>
<td>Category 1…8</td>
<td>Up to 20 characters</td>
</tr>
<tr>
<td>ANSWER</td>
<td>Correct answer, version 0</td>
<td>A…Z</td>
</tr>
<tr>
<td>ANS_1…9</td>
<td>Correct answers for versions 1…9</td>
<td>A…Z</td>
</tr>
<tr>
<td>NUMERIC_LOW</td>
<td>Numeric answer low threshold</td>
<td>Any number</td>
</tr>
<tr>
<td>NUMERIC_HIGH</td>
<td>Numeric answer high threshold</td>
<td>Any number</td>
</tr>
<tr>
<td>TIME</td>
<td>Time</td>
<td>Positive integer</td>
</tr>
<tr>
<td>DIFF</td>
<td>Difficulty</td>
<td>0.00 to 1.00</td>
</tr>
<tr>
<td>RPB</td>
<td>rpb</td>
<td>-1.00 to +1.00</td>
</tr>
<tr>
<td>POINTS</td>
<td>Point value</td>
<td>-100.00 to +100.00</td>
</tr>
<tr>
<td>POINTS_A…Z</td>
<td>Point value A…Z</td>
<td>-100.00 to +100.00</td>
</tr>
<tr>
<td>ADM_A…Z</td>
<td>Respondents choosing A…Z</td>
<td>Positive integer</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>ADM_OMIT</td>
<td>Respondents omitting the question</td>
<td>Positive integer</td>
</tr>
<tr>
<td>ADM_TOT</td>
<td>Respondents total</td>
<td>Positive integer</td>
</tr>
<tr>
<td>F1...4</td>
<td>User value 1...4</td>
<td>Any number</td>
</tr>
<tr>
<td>NBR_CHOICES</td>
<td>Number of choices</td>
<td>1...26</td>
</tr>
<tr>
<td>NBR_MATCHING</td>
<td>Number of matching</td>
<td>1...26</td>
</tr>
<tr>
<td>COLS_CHOICE</td>
<td>Columns for choices</td>
<td>1...6</td>
</tr>
<tr>
<td>COLS_PRINT</td>
<td>Columns for printing</td>
<td>1...3</td>
</tr>
<tr>
<td>OK_TO_SCRAMBLE</td>
<td>Scramble choices enabled</td>
<td></td>
</tr>
<tr>
<td>SCRAMBLE_RANGE</td>
<td>Choices to scramble</td>
<td>A...Z</td>
</tr>
</tbody>
</table>
### Specifications File Merge Field Names

<table>
<thead>
<tr>
<th>Merge Field Name</th>
<th>Description</th>
<th>Permitted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIELD</td>
<td>Field box</td>
<td>Refer to discussion on Specs Window</td>
</tr>
<tr>
<td>OPERATOR</td>
<td>Operator box</td>
<td>“contains, equal, not equal, greater than, less than”</td>
</tr>
<tr>
<td>VALUE</td>
<td>Value box</td>
<td>Depends on field, refer to discussion on Specs Window</td>
</tr>
<tr>
<td>ACTION</td>
<td>Action box</td>
<td>“pick, or, end”</td>
</tr>
<tr>
<td>PICK</td>
<td>Pick box</td>
<td>Positive integer</td>
</tr>
<tr>
<td>AVAIL</td>
<td>Available number of items</td>
<td>Program defined, cannot edit</td>
</tr>
</tbody>
</table>

### Scores File Merge Field Names

<table>
<thead>
<tr>
<th>Merge Field Name</th>
<th>Description</th>
<th>Permitted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>SID</td>
<td>Student identification number</td>
<td>10 digit maximum</td>
</tr>
<tr>
<td>SNAME</td>
<td>Student name</td>
<td>Any alpha-numeric text</td>
</tr>
<tr>
<td>TYPE</td>
<td>A reserved field</td>
<td>Refer to “type” discussion in Students Window Description</td>
</tr>
<tr>
<td>C1…8</td>
<td>Code fields for student demographic information</td>
<td>4 alpha-numeric character maximum</td>
</tr>
<tr>
<td>VERSION</td>
<td>Test version</td>
<td>0…9</td>
</tr>
<tr>
<td>RAW</td>
<td>Raw score</td>
<td>Any number greater than 0 (up to two decimals)</td>
</tr>
<tr>
<td>PCENT</td>
<td>Percent score</td>
<td>0…100 (up to two decimals)</td>
</tr>
<tr>
<td>GRADE</td>
<td>Letter grade</td>
<td>A…Z (refer to grading table)</td>
</tr>
<tr>
<td>RESPONSES</td>
<td>Responses</td>
<td>A…Z (multiple responses seperated by commas)</td>
</tr>
</tbody>
</table>

### External Answer Key (Import) Merge Field Names

<table>
<thead>
<tr>
<th>Merge Field Name</th>
<th>Description</th>
<th>Permitted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>NUM</td>
<td>Question number (Optional)</td>
<td>Positive integers</td>
</tr>
<tr>
<td>ANSWER</td>
<td>Correct answer</td>
<td>A…Z</td>
</tr>
<tr>
<td>POINTS</td>
<td>Point value for the question (Optional)</td>
<td>Any number greater than 0 (up to two decimals)</td>
</tr>
</tbody>
</table>
### Grading Table Merge Field Names

<table>
<thead>
<tr>
<th>Merge Field Name</th>
<th>Description</th>
<th>Permitted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>AREA</td>
<td>Area name (grouping of grading classifications)</td>
<td>By objective, category, coded field, section break. Refer to grading table discussion.</td>
</tr>
<tr>
<td>CLASS</td>
<td>Classification</td>
<td>Refer to grading table discussion</td>
</tr>
<tr>
<td>TYPE</td>
<td>Classification type</td>
<td>Whole numbers, corresponds to each classification set</td>
</tr>
<tr>
<td>SDESC</td>
<td>Short description</td>
<td>Alpha-numeric text</td>
</tr>
<tr>
<td>LDESC</td>
<td>Long description</td>
<td>Alpha-numeric text</td>
</tr>
<tr>
<td>FEEDBACK</td>
<td>Resources text field</td>
<td>Alpha-numeric text</td>
</tr>
<tr>
<td>MPCENT</td>
<td>Percentage of points required to achieve mastery</td>
<td>0…100</td>
</tr>
<tr>
<td>PPCENT</td>
<td>Percentage of points required to achieve partial mastery</td>
<td>0…100</td>
</tr>
</tbody>
</table>

### Students File Merge Field Names

<table>
<thead>
<tr>
<th>Merge Field Name</th>
<th>Description</th>
<th>Permitted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>SID</td>
<td>Student identification number</td>
<td>10 digit maximum</td>
</tr>
<tr>
<td>SNAME</td>
<td>Student name</td>
<td>Any alpha-numeric text</td>
</tr>
<tr>
<td>TYPE</td>
<td>A reserved field</td>
<td>Refer to “type” discussion in Students Window Description</td>
</tr>
<tr>
<td>C1…8</td>
<td>Code fields for student demographic information</td>
<td>4 alpha-numeric character maximum</td>
</tr>
<tr>
<td>PSWRD</td>
<td>Student password</td>
<td>Any alpha-numeric text</td>
</tr>
<tr>
<td>SDATE</td>
<td>Start date of when student can take test</td>
<td>MM/DD/YYYY format</td>
</tr>
<tr>
<td>EDATE</td>
<td>End date of when student can take test</td>
<td>MM/DD/YYYY format</td>
</tr>
<tr>
<td>EMAIL</td>
<td>Student e-mail address</td>
<td>Any alpha-numeric text</td>
</tr>
<tr>
<td>CCEMAIL</td>
<td>Carbon copy e-mail address</td>
<td>Any alpha-numeric text</td>
</tr>
<tr>
<td>PHONE</td>
<td>Student phone number</td>
<td>Any alpha-numeric text</td>
</tr>
<tr>
<td>ADD1</td>
<td>Student home address</td>
<td>Any alpha-numeric text</td>
</tr>
<tr>
<td>ADD3</td>
<td>Second mailing address</td>
<td>Any alpha-numeric text</td>
</tr>
<tr>
<td>CITY</td>
<td>City of student home</td>
<td>Any alpha-numeric text</td>
</tr>
<tr>
<td>STATE</td>
<td>State of student home</td>
<td>Any alpha-numeric text</td>
</tr>
<tr>
<td>ZIP</td>
<td>Zip code of student home</td>
<td>Any alpha-numeric text</td>
</tr>
<tr>
<td>COUNTRY</td>
<td>Country of student home</td>
<td>Any alpha-numeric text</td>
</tr>
<tr>
<td>NOTES</td>
<td>Notes</td>
<td>Any alpha-numeric text</td>
</tr>
</tbody>
</table>
Scores File Export Gradebook Format

<table>
<thead>
<tr>
<th>FH1 record contains overall test information.</th>
<th>File Info</th>
<th>File Type</th>
<th>LXR Version</th>
<th>Test Name</th>
<th>Test Date</th>
<th>Bank Name(s)</th>
<th>Instructor Name</th>
<th>Class</th>
<th># of Items</th>
<th># of Students</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>FH</td>
<td>Gradebook</td>
<td>6.0</td>
<td>Sample Test</td>
<td>4/1/98</td>
<td>Sample Bank</td>
<td>Smith</td>
<td>Period 3</td>
<td>20</td>
<td>25</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SH1 record contains question ID information for each item.</th>
<th>File Info</th>
<th>Question ID:</th>
<th>Item 1 ID</th>
<th>Item 2 ID</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SH2 record contains question type information for each item.</th>
<th>File Info</th>
<th>Item Type:</th>
<th>Item 1 Type</th>
<th>Item 2 Type</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SH3..SH12 records contain answers for different test versions 0 to version 9, respectively.</th>
<th>File Info</th>
<th>Item 1 Answer</th>
<th>Item 2 Answer</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SH13 record contains the maximum point value for each item.</th>
<th>File Info</th>
<th>Item 1 Points</th>
<th>Item 2 Points</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SH14 record contains labels that describe the score data in the rows that follow it.</th>
<th>File Info</th>
<th>ID</th>
<th>Student Name</th>
<th>Test Version</th>
<th>Items Correct</th>
<th>Percent Score</th>
<th>Raw Score</th>
<th>Grade or Scale Scores</th>
<th>R1</th>
<th>R2</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SD records contain one row of score detail for each student.</th>
<th>File Info</th>
<th>Student n Response to Item 1</th>
<th>Student n Response to Item 2</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DD records contain one row of demographic detail for each student.</th>
<th>File Info</th>
<th>ID</th>
<th>Student Name</th>
<th>Demographic Data</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MH1 record contains labels that describe each objective on the test.</th>
<th>File Info</th>
<th>Summarize Mastery (Title) Desc.</th>
<th>Summarize Mastery Desc.</th>
<th>Summarize Mastery Desc.</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MH2 record contains the percentage required for mastery of each objective.</th>
<th>File Info</th>
<th>Obj. 1 %</th>
<th>Obj. 2 %</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MH3 record contains the item count for each objective on the test.</th>
<th>File Info</th>
<th>Total Area Item Count</th>
<th>Obj. 1 Item Count</th>
<th>Obj. 2 Item Count</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MH4 record contains labels that describe the mastery status in the rows that follow it.</th>
<th>File Info</th>
<th>ID</th>
<th>Student Name</th>
<th>Mastery Code</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MD records contain one row of mastery data for each student that indicate mastery status for each objective on the test.</th>
<th>File Info</th>
<th>Y or N</th>
<th>Y or N</th>
<th>Y or N</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MH5 record contains labels that describe the points received for each objective on the test in the rows that follow it.</th>
<th>File Info</th>
<th>ID</th>
<th>Student Name</th>
<th>Mastery</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MP records contain one row for each student that indicate points received for each objective on the test.</th>
<th>File Info</th>
<th>ID</th>
<th>Student Name</th>
<th>Mastery</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix D: Sample Reports

The following contain a list of sample reports produced by LXR•TEST. For a review of the print options for these reports, refer to the Print menu items for the corresponding databases – see Chapter 4: LXR•TEST Reference.
Figure 115: Questions Report

**QUESTIONS REPORT**

for SAMPLE QUESTIONS

Match the flag on the left by choosing the correct letter of your choice on the right:

1. North Carolina
2. South Carolina
3. Georgia
4. Kansas
5. Missouri
6. Tennessee
7. California
8. New York
9. Ohio
10. Rhode Island

**Feedback**

**Answer is B.**

This is one of the oldest flag designs still in use. Its basic design goes back to 1765 when three white crescents were used on a blue flag by opponents of the Stamp Act. Ten years later, a flag with a single crescent, or new moon, was hoisted in the Revolutionary War. The Palmetto tree later was added to the flag when the people of Charleston built a fort of Palmetto logs on Sullivan’s Island and defeated the British at the Battle of Fort Moultrie, fought on June 28, 1776.

**Feedback**

**Answer is F.**

Ohio’s flag is the only state flag in the shape of a burgee. It was designed by John Eisenmann, an architect and engineer. There are seventeen stars to indicate that it was the seventeenth state to join the Union. The large O suggests the first letter in Ohio.

**Feedback**

**Answer is D.**

The Kansas state flag, adopted by the Kansas Legislature as the official state flag in 1927, is a rectangle of dark-blue silk with the state seal at its center. Above the seal is the state crest, a sunflower resting on a twisted bar of blue and gold. The word “Kansas,” added in 1961, is below the seal in gold, block lettering.

**Feedback**

**Answer is G.**

Called the Bear Flag, the Grizzly Bear symbolizes courage. California was governed by Mexico until 1846 when a small group from the United States marched on the town of Sonoma and took the Mexican officials as prisoners. While California was admitted to the Union in 1850, its flag was not adopted until 1912.

**Feedback**

**Answer is C.**

On a blue field the Georgia flag showcases the state seal, a ribbon expresses Georgia’s flag history and the words “In God We Trust”. Thirteen stars surrounding the seal denotes Georgia’s position as one of the original thirteen colonies. On the seal three pillars supporting an arch represent the three branches of government; legislative, judicial and executive. A man with sword drawn is defending the Constitution, whose principles are wisdom, justice and moderation. The date 1776 represents the signing of the Declaration of Independence. A ribbon displays the thirteen star U.S. flag (1777-1795), Georgia’s first flag (1876), Georgia’s 1920-1956 flag, Georgia’s 1956 flag and the 50 star U.S. flag.

Adopted January 30, 2001

**Answers**

<table>
<thead>
<tr>
<th>MAT</th>
<th>Pt. Each</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>Total</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>1.00</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5.00</td>
<td>B 1 D G C</td>
</tr>
</tbody>
</table>

Wednesday, May 30, 2001 4:13:32 PM  © Logic eXtension Resources
## BANK INFORMATION REPORT

**for Sample Questions**

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Items</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>INS</td>
<td>5</td>
<td>Instruction</td>
</tr>
<tr>
<td>LRT</td>
<td>1</td>
<td>Free format: letter</td>
</tr>
<tr>
<td>MAT</td>
<td>4</td>
<td>Matching</td>
</tr>
<tr>
<td>MCM*</td>
<td>1</td>
<td>Multiple choice: multiple</td>
</tr>
<tr>
<td>MCS</td>
<td>52</td>
<td>Multiple choice: single</td>
</tr>
<tr>
<td>SHO</td>
<td>2</td>
<td>Free format: short answer</td>
</tr>
<tr>
<td>T/F</td>
<td>12</td>
<td>True False</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Objective</th>
<th>Items</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLAGS</td>
<td>2</td>
<td>FLAGS</td>
</tr>
<tr>
<td>LANGUAGE ARTS</td>
<td>10</td>
<td>LANGUAGE ARTS</td>
</tr>
<tr>
<td>LXR*TEST</td>
<td>20</td>
<td>LXR*TEST</td>
</tr>
<tr>
<td>MATH</td>
<td>10</td>
<td>MATH</td>
</tr>
<tr>
<td>PHYSICS</td>
<td>10</td>
<td>PHYSICS</td>
</tr>
<tr>
<td>REAL ESTATE</td>
<td>10</td>
<td>REAL ESTATE</td>
</tr>
<tr>
<td>REFERENCE</td>
<td>5</td>
<td>REFERENCE</td>
</tr>
<tr>
<td>RESPIRATORY CARE</td>
<td>10</td>
<td>RESPIRATORY CARE</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Category 1 (Ref/Task)</th>
<th>Items</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>1215.6</td>
<td>2</td>
<td>1215.6</td>
</tr>
<tr>
<td>IB</td>
<td>4</td>
<td>IB</td>
</tr>
<tr>
<td>ID</td>
<td>1</td>
<td>ID</td>
</tr>
<tr>
<td>IF1</td>
<td>1</td>
<td>IF1</td>
</tr>
<tr>
<td>2D</td>
<td>1</td>
<td>2D</td>
</tr>
<tr>
<td>ACCELERATE</td>
<td>2</td>
<td>ACCELERATE</td>
</tr>
<tr>
<td>APPENDIX B</td>
<td>2</td>
<td>APPENDIX B</td>
</tr>
<tr>
<td>CHAPTER 01</td>
<td>6</td>
<td>CHAPTER 01</td>
</tr>
<tr>
<td>CHAPTER 02</td>
<td>7</td>
<td>CATI AREA 01</td>
</tr>
<tr>
<td>CHAPTER 03</td>
<td>8</td>
<td>CHAPTER 03</td>
</tr>
<tr>
<td>CHAPTER 04</td>
<td>10</td>
<td>CHAPTER 04</td>
</tr>
<tr>
<td>CHAPTER 05</td>
<td>3</td>
<td>CHAPTER 05</td>
</tr>
<tr>
<td>CHAPTER 06</td>
<td>1</td>
<td>CHAPTER 06</td>
</tr>
<tr>
<td>CHAPTER 07</td>
<td>1</td>
<td>CHAPTER 07</td>
</tr>
<tr>
<td>CHAPTER 08</td>
<td>2</td>
<td>CHAPTER 08</td>
</tr>
<tr>
<td>CHAPTER 09</td>
<td>5</td>
<td>CHAPTER 09</td>
</tr>
<tr>
<td>CHAPTER 10</td>
<td>1</td>
<td>CHAPTER 10</td>
</tr>
<tr>
<td>CHAPTER 11</td>
<td>2</td>
<td>CHAPTER 11</td>
</tr>
<tr>
<td>CHAPTER 12</td>
<td>3</td>
<td>CHAPTER 12</td>
</tr>
<tr>
<td>CHAPTER 13</td>
<td>1</td>
<td>CHAPTER 13</td>
</tr>
<tr>
<td>DYNAMICS</td>
<td>5</td>
<td>DYNAMICS</td>
</tr>
<tr>
<td>MOMENTUM</td>
<td>1</td>
<td>MOMENTUM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Category 2 (Difficulty)</th>
<th>Items</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>EASY</td>
<td>20</td>
<td>EASY</td>
</tr>
<tr>
<td>HARD</td>
<td>18</td>
<td>HARD</td>
</tr>
<tr>
<td>MEDIUM</td>
<td>34</td>
<td>MEDIUM</td>
</tr>
</tbody>
</table>
### BANK LISTING REPORT

for Sample Questions

<table>
<thead>
<tr>
<th>ID</th>
<th>Type</th>
<th>Points</th>
<th>pDif</th>
<th>Time</th>
<th>Modify</th>
<th>Reviewed</th>
<th>Graphics</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>MAT</td>
<td>5.00</td>
<td>0.91</td>
<td>0.48</td>
<td>5/9/2000</td>
<td>3/17/1996</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>MAT</td>
<td>5.00</td>
<td>0.95</td>
<td>0.22</td>
<td>5/4/2000</td>
<td>3/17/1999</td>
<td>5</td>
</tr>
<tr>
<td>3</td>
<td>MCS</td>
<td>1.00</td>
<td>0.95</td>
<td>0.55</td>
<td>5/4/2000</td>
<td>3/19/1999</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>MCS</td>
<td>1.00</td>
<td>0.91</td>
<td>0.50</td>
<td>6/20/2000</td>
<td>3/19/1999</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>MCS</td>
<td>1.00</td>
<td>0.79</td>
<td>0.40</td>
<td>6/20/2000</td>
<td>3/19/1999</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>MCS</td>
<td>1.00</td>
<td>0.88</td>
<td>0.56</td>
<td>6/20/2000</td>
<td>3/19/1999</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>MCS</td>
<td>1.00</td>
<td>0.97</td>
<td>0.55</td>
<td>6/20/2000</td>
<td>3/19/1999</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>T/F</td>
<td>1.00</td>
<td>0.88</td>
<td>0.27</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>T/F</td>
<td>1.00</td>
<td>0.88</td>
<td>0.21</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>T/F</td>
<td>1.00</td>
<td>0.88</td>
<td>0.40</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>T/F</td>
<td>1.00</td>
<td>0.90</td>
<td>0.24</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>T/F</td>
<td>1.00</td>
<td>0.97</td>
<td>0.29</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>MCS</td>
<td>1.00</td>
<td>0.95</td>
<td>0.37</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>MCS</td>
<td>1.00</td>
<td>0.91</td>
<td>0.56</td>
<td>6/28/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>MCS</td>
<td>1.00</td>
<td>0.98</td>
<td>-0.05</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>MCS</td>
<td>1.00</td>
<td>0.93</td>
<td>0.80</td>
<td>6/28/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>MCS</td>
<td>1.00</td>
<td>0.93</td>
<td>0.24</td>
<td>6/28/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>MCS</td>
<td>1.00</td>
<td>0.91</td>
<td>0.42</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>MCS</td>
<td>1.00</td>
<td>0.91</td>
<td>0.21</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>MCS</td>
<td>1.00</td>
<td>0.95</td>
<td>0.37</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>MCS</td>
<td>1.00</td>
<td>0.90</td>
<td>0.00</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>MCS</td>
<td>1.00</td>
<td>0.88</td>
<td>0.51</td>
<td>6/28/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>T/F</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>T/F</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>T/F</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>6/28/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>T/F</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>6/28/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>SHO</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>SHO</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>MCS</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>LET</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>MAT</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>MAT</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>5/4/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>MCS</td>
<td>1.00</td>
<td>0.90</td>
<td>0.42</td>
<td>5/4/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>MCS</td>
<td>1.00</td>
<td>0.91</td>
<td>0.48</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>MCS</td>
<td>1.00</td>
<td>0.88</td>
<td>0.43</td>
<td>6/28/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>MCS</td>
<td>1.00</td>
<td>0.84</td>
<td>0.59</td>
<td>6/28/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>MCS</td>
<td>1.00</td>
<td>0.88</td>
<td>0.45</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>T/F</td>
<td>1.00</td>
<td>0.97</td>
<td>-0.06</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>MCS</td>
<td>1.00</td>
<td>0.93</td>
<td>0.36</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>T/F</td>
<td>1.00</td>
<td>0.95</td>
<td>-0.08</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>MCS</td>
<td>1.00</td>
<td>0.95</td>
<td>0.66</td>
<td>6/28/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>T/F</td>
<td>1.00</td>
<td>0.91</td>
<td>0.43</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>MCS</td>
<td>1.00</td>
<td>0.95</td>
<td>0.31</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>MCS</td>
<td>1.00</td>
<td>0.91</td>
<td>0.34</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>MCS</td>
<td>1.00</td>
<td>0.88</td>
<td>0.99</td>
<td>6/28/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>MCS</td>
<td>1.00</td>
<td>0.91</td>
<td>0.57</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>MCS</td>
<td>1.00</td>
<td>0.91</td>
<td>0.52</td>
<td>6/20/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>MCS</td>
<td>1.00</td>
<td>0.86</td>
<td>0.47</td>
<td>6/28/2000</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>MCS</td>
<td>2.00</td>
<td>0.81</td>
<td>0.41</td>
<td>6/28/2000</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 117: Bank Listing Report**
<table>
<thead>
<tr>
<th>Objective</th>
<th>Category 1 (Ref Task)</th>
<th>Category 2 (Difficulty)</th>
<th>EASY</th>
<th>HARD</th>
<th>MEDIUM</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLAGS</td>
<td>CHAPTER 05</td>
<td></td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FLAGS</td>
<td>CHAPTER 06</td>
<td></td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FLAGS</td>
<td></td>
<td></td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>LANGUAGE ARTS</td>
<td>CHAPTER 01</td>
<td></td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LANGUAGE ARTS</td>
<td>CHAPTER 02</td>
<td></td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LANGUAGE ARTS</td>
<td>CHAPTER 09</td>
<td></td>
<td>1</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>LANGUAGE ARTS</td>
<td></td>
<td></td>
<td>6</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>LXR*TEST</td>
<td>APPENDIX B</td>
<td></td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LXR*TEST</td>
<td>CHAPTER 01</td>
<td></td>
<td>1</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>LXR*TEST</td>
<td>CHAPTER 02</td>
<td></td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>LXR*TEST</td>
<td>CHAPTER 04</td>
<td></td>
<td>4</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>LXR*TEST</td>
<td>CHAPTER 08</td>
<td></td>
<td>1</td>
<td>1</td>
<td>5</td>
</tr>
<tr>
<td>LXR*TEST</td>
<td>CHAPTER 05</td>
<td></td>
<td>2</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>MATH</td>
<td>CHAPTER 02</td>
<td></td>
<td>7</td>
<td>4</td>
<td>9</td>
</tr>
<tr>
<td>MATH</td>
<td>CHAPTER 05</td>
<td></td>
<td>1</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>MATH</td>
<td>CHAPTER 04</td>
<td></td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>MATH</td>
<td>CHAPTER 12</td>
<td></td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>MATH</td>
<td></td>
<td></td>
<td>2</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>PHYSICS</td>
<td>12BB6</td>
<td></td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>PHYSICS</td>
<td>ACCELERATEI</td>
<td></td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PHYSICS</td>
<td>DYNAMICS</td>
<td></td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PHYSICS</td>
<td>MOMENTUM</td>
<td></td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PHYSICS</td>
<td></td>
<td></td>
<td>1</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>REAL ESTATE</td>
<td>CHAPTER 02</td>
<td></td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REAL ESTATE</td>
<td>CHAPTER 05</td>
<td></td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REAL ESTATE</td>
<td>CHAPTER 07</td>
<td></td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REAL ESTATE</td>
<td>CHAPTER 08</td>
<td></td>
<td>1</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>REAL ESTATE</td>
<td>CHAPTER 10</td>
<td></td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REAL ESTATE</td>
<td>CHAPTER 11</td>
<td></td>
<td>1</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>REAL ESTATE</td>
<td>CHAPTER 12</td>
<td></td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REAL ESTATE</td>
<td>CHAPTER 16</td>
<td></td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REAL ESTATE</td>
<td></td>
<td></td>
<td>1</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>RESPIRATORY CARE</td>
<td>1B</td>
<td></td>
<td>2</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>RESPIRATORY CARE</td>
<td>1D</td>
<td></td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>RESPIRATORY CARE</td>
<td>1F1</td>
<td></td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>RESPIRATORY CARE</td>
<td>2D</td>
<td></td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RESPIRATORY CARE</td>
<td></td>
<td></td>
<td>3</td>
<td>3</td>
<td>4</td>
</tr>
</tbody>
</table>

Figure 118: Item Distribution Report
<table>
<thead>
<tr>
<th>Inclusive Soft Links</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>LANGUAGE ARTS 6</td>
<td>REFERENCE 5</td>
</tr>
<tr>
<td>LANGUAGE ARTS 7</td>
<td>REFERENCE 5</td>
</tr>
<tr>
<td>LANGUAGE ARTS 8</td>
<td>REFERENCE 5</td>
</tr>
<tr>
<td>LANGUAGE ARTS 9</td>
<td>REFERENCE 5</td>
</tr>
<tr>
<td>LANGUAGE ARTS 10</td>
<td>REFERENCE 5</td>
</tr>
<tr>
<td>LXRP*TEST 1</td>
<td>REFERENCE 2</td>
</tr>
<tr>
<td>LXRP*TEST 2</td>
<td>REFERENCE 2</td>
</tr>
<tr>
<td>LXRP*TEST 3</td>
<td>REFERENCE 2</td>
</tr>
<tr>
<td>LXRP*TEST 4</td>
<td>REFERENCE 2</td>
</tr>
<tr>
<td>LXRP*TEST 5</td>
<td>REFERENCE 2</td>
</tr>
<tr>
<td>LXRP*TEST 6</td>
<td>REFERENCE 2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Inclusive Hard Links</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>MATH 3</td>
<td>REFERENCE 1</td>
</tr>
<tr>
<td>MATH 3</td>
<td>REFERENCE 1</td>
</tr>
<tr>
<td>MATH 4</td>
<td>REFERENCE 1</td>
</tr>
<tr>
<td>MATH 4</td>
<td>MATH 3</td>
</tr>
<tr>
<td>PHYSICS 1</td>
<td>REFERENCE 3</td>
</tr>
<tr>
<td>PHYSICS 1</td>
<td>PHYSICS 2</td>
</tr>
<tr>
<td>PHYSICS 2</td>
<td>REFERENCE 3</td>
</tr>
<tr>
<td>PHYSICS 2</td>
<td>PHYSICS 2</td>
</tr>
<tr>
<td>PHYSICS 3</td>
<td>REFERENCE 4</td>
</tr>
<tr>
<td>PHYSICS 3</td>
<td>PHYSICS 4</td>
</tr>
<tr>
<td>PHYSICS 4</td>
<td>REFERENCE 4</td>
</tr>
<tr>
<td>PHYSICS 4</td>
<td>PHYSICS 4</td>
</tr>
<tr>
<td>REFERENCE 1</td>
<td>REFERENCE 1</td>
</tr>
<tr>
<td>MATH 3</td>
<td>MATH 4</td>
</tr>
</tbody>
</table>

*Figure 119: Bank Link Report*
Match the flag on the left by choosing the correct letter of your choice on the right:

1. A. North Carolina
   B. South Carolina
   C. Georgia
   D. Kansas
   E. Missouri
   F. Tennessee
   G. California
   H. New York
   I. Ohio
   J. Rhode Island

2. Match the flag on the left by choosing the correct letter of your choice on the right:
   A. United States
   B. Mexico
   C. Canada
   D. Australia
   E. Singapore
   F. China
   G. United Kingdom
   H. Germany
   I. Thailand
   J. Switzerland

11. An interrogative sentence
   A. identifies a thought.
   B. asks a question.
   C. presents a statement.
   D. gives a command.

12. Bill and ___ have decided to go for a boat ride on the river.
   A. me
   B. him
   C. her
   D. I

13. ________ fashions are always changing.
   A. Women’s
   B. Women’s
   C. Woman’s
   D. Women’s

© Logic eXtension Resources

Wednesday, May 30, 2001 4:15:38 PM
## Figure 121: Answer Key Report

**ANSWER KEY REPORT**
for Sample Test Test Form: 0

<table>
<thead>
<tr>
<th>ID</th>
<th>Points</th>
<th>Type</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FLGs 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>2</td>
<td>FLGs 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>3</td>
<td>FLGs 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>4</td>
<td>FLGs 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>5</td>
<td>FLGs 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>6</td>
<td>FLGs 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>7</td>
<td>FLGs 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>8</td>
<td>FLGs 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>9</td>
<td>FLGs 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>10</td>
<td>FLGs 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>11</td>
<td>LANGUAGE ARTS 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>12</td>
<td>LANGUAGE ARTS 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>13</td>
<td>LANGUAGE ARTS 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>14</td>
<td>LANGUAGE ARTS 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>15</td>
<td>LANGUAGE ARTS 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>16</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>17</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>18</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>19</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>20</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>21</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>22</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>23</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>24</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>25</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>26</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>27</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>28</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>29</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>30</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>31</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>32</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>33</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>34</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>35</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>36</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>37</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>38</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>39</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>40</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>41</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>42</td>
<td>REFERENCE 1</td>
<td>1.00</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
</tbody>
</table>

Tuesday, May 09, 2000 10:15:57 AM
Figure 122: Response Booklet Report
## TEST DESCRIPTION REPORT

for Sample Test Test Form: 0

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Items</th>
<th>Points</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAT</td>
<td>10</td>
<td>10.00</td>
<td>Matching</td>
</tr>
<tr>
<td>MCM</td>
<td>1</td>
<td>8.00</td>
<td>Multiple-choice: multiple</td>
</tr>
<tr>
<td>MCS</td>
<td>31</td>
<td>34.00</td>
<td>Multiple-choice: single</td>
</tr>
<tr>
<td>T/F</td>
<td>8</td>
<td>8.00</td>
<td>True False</td>
</tr>
</tbody>
</table>

### Question Bank

<table>
<thead>
<tr>
<th>Items</th>
<th>Points</th>
<th>Puts</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>50</td>
<td>60.00</td>
<td>Sample Questions, LXR Bank</td>
</tr>
</tbody>
</table>

### Objective

<table>
<thead>
<tr>
<th>Items</th>
<th>Points</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLANS</td>
<td>10</td>
<td>10.00</td>
</tr>
<tr>
<td>LANGUAGE ARTS</td>
<td>10</td>
<td>10.00</td>
</tr>
<tr>
<td>LXR*TEST</td>
<td>10</td>
<td>17.00</td>
</tr>
<tr>
<td>MATH</td>
<td>10</td>
<td>10.00</td>
</tr>
<tr>
<td>PHYSICS</td>
<td>10</td>
<td>13.00</td>
</tr>
<tr>
<td>REFERENCE</td>
<td>0</td>
<td>0.00</td>
</tr>
</tbody>
</table>

### Category 1 (Ref Task)

<table>
<thead>
<tr>
<th>Items</th>
<th>Points</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>12BB6</td>
<td>2</td>
<td>2.00</td>
</tr>
<tr>
<td>ACCELERATE</td>
<td>2</td>
<td>5.00</td>
</tr>
<tr>
<td>CHAPTER 01</td>
<td>6</td>
<td>6.00</td>
</tr>
<tr>
<td>CHAPTER 02</td>
<td>5</td>
<td>5.00</td>
</tr>
<tr>
<td>CHAPTER 03</td>
<td>4</td>
<td>4.00</td>
</tr>
<tr>
<td>CHAPTER 04</td>
<td>7</td>
<td>14.00</td>
</tr>
<tr>
<td>CHAPTER 05</td>
<td>6</td>
<td>6.00</td>
</tr>
<tr>
<td>CHAPTER 06</td>
<td>5</td>
<td>5.00</td>
</tr>
<tr>
<td>CHAPTER 09</td>
<td>5</td>
<td>5.00</td>
</tr>
<tr>
<td>CHAPTER 12</td>
<td>2</td>
<td>2.00</td>
</tr>
<tr>
<td>DYNAMICS</td>
<td>5</td>
<td>5.00</td>
</tr>
<tr>
<td>MOMENTUM</td>
<td>1</td>
<td>1.00</td>
</tr>
</tbody>
</table>

### Category 2 (Difficulty)

<table>
<thead>
<tr>
<th>Items</th>
<th>Points</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>EASY</td>
<td>10</td>
<td>10.00</td>
</tr>
<tr>
<td>HARD</td>
<td>14</td>
<td>21.00</td>
</tr>
<tr>
<td>MEDIUM</td>
<td>26</td>
<td>29.00</td>
</tr>
</tbody>
</table>

### Category 3 (Topic)

<table>
<thead>
<tr>
<th>Items</th>
<th>Points</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAPACITY</td>
<td>1</td>
<td>1.00</td>
</tr>
<tr>
<td>CIRCUMFIR</td>
<td>2</td>
<td>2.00</td>
</tr>
<tr>
<td>COMPLEX</td>
<td>1</td>
<td>1.00</td>
</tr>
<tr>
<td>DIVISION</td>
<td>3</td>
<td>3.00</td>
</tr>
<tr>
<td>DYNAMICS</td>
<td>2</td>
<td>2.00</td>
</tr>
<tr>
<td>ENGLISH</td>
<td>4</td>
<td>4.00</td>
</tr>
<tr>
<td>FEATURE</td>
<td>2</td>
<td>2.00</td>
</tr>
<tr>
<td>FLAGS</td>
<td>10</td>
<td>10.00</td>
</tr>
<tr>
<td>FORCE</td>
<td>1</td>
<td>1.00</td>
</tr>
<tr>
<td>GRAPHICS</td>
<td>2</td>
<td>9.00</td>
</tr>
<tr>
<td>INERTIA</td>
<td>1</td>
<td>2.00</td>
</tr>
</tbody>
</table>

---

Figure 123: Test Description Report
Figure 124: Test Specification Report
### SPECIFICATION OVERLAP REPORT
for Sample Questions

<table>
<thead>
<tr>
<th>Tests</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>*</td>
<td>PHYSICS 10 PHYSICS 30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>*</td>
<td>MATH 7 MATH 6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>PHYSICS 10 MATH 7 * PHYSICS 30</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>PHYSICS 10 MATH 6 PHYSICS 10 *</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 125: Specification Overlap Report
<table>
<thead>
<tr>
<th>Test ID</th>
<th>Item Points</th>
<th>Form Date</th>
<th>Test File</th>
<th>Heading 1</th>
<th>Heading 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>50</td>
<td>0</td>
<td>C:\LRDATA\SAMPLE TEST LRTEST</td>
<td>Performance scores</td>
<td>Performance scores</td>
</tr>
<tr>
<td></td>
<td>00.00</td>
<td>12:00 AM</td>
<td></td>
<td>Sample Test</td>
<td>Sample Test</td>
</tr>
</tbody>
</table>

**Figure 126: Score Description Report**
## Figure 127: Item Statistics Report

### Item Statistics Report

**Performance scores for Sample Test from SAMPLE SCORES**

<table>
<thead>
<tr>
<th>Second term</th>
<th>Test form: 0</th>
<th>Test version: 0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Overall</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phs.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avg</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E.T.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>p</td>
<td></td>
<td></td>
</tr>
<tr>
<td>np</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Adorns</th>
<th>p</th>
<th>np</th>
<th>51</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAT</td>
<td>0.88</td>
<td>0.02</td>
<td>0.02</td>
<td>0.88</td>
<td>0.05</td>
<td>0.05</td>
</tr>
<tr>
<td>100</td>
<td>92.65</td>
<td>95.00</td>
<td>80.00</td>
<td>92.65</td>
<td>60.00</td>
<td>80.00</td>
</tr>
<tr>
<td>-</td>
<td>-0.496</td>
<td>-0.054</td>
<td>-0.133</td>
<td>-0.496</td>
<td>-0.545</td>
<td>-0.235</td>
</tr>
<tr>
<td>I:2</td>
<td>58</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>MAT</td>
<td>0.95</td>
<td>0.02</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>100</td>
<td>91.99</td>
<td>95.00</td>
<td>80.00</td>
<td>91.99</td>
<td>60.00</td>
<td>80.00</td>
</tr>
<tr>
<td>-</td>
<td>-0.149</td>
<td>-0.054</td>
<td>-0.174</td>
<td>-0.149</td>
<td>-0.133</td>
<td>-0.101</td>
</tr>
<tr>
<td>I:3</td>
<td>58</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>0</td>
</tr>
<tr>
<td>MAT</td>
<td>0.90</td>
<td>0.00</td>
<td>0.00</td>
<td>0.05</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>100</td>
<td>91.39</td>
<td>95.00</td>
<td>80.00</td>
<td>91.39</td>
<td>60.00</td>
<td>80.00</td>
</tr>
<tr>
<td>-</td>
<td>-0.137</td>
<td>-0.013</td>
<td>-0.017</td>
<td>-0.137</td>
<td>-0.010</td>
<td>-0.003</td>
</tr>
<tr>
<td>I:4</td>
<td>58</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>MAT</td>
<td>0.91</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>100</td>
<td>91.91</td>
<td>95.00</td>
<td>80.00</td>
<td>91.91</td>
<td>60.00</td>
<td>80.00</td>
</tr>
<tr>
<td>-</td>
<td>-0.174</td>
<td>-0.003</td>
<td>-0.012</td>
<td>-0.174</td>
<td>-0.112</td>
<td>-0.174</td>
</tr>
<tr>
<td>I:5</td>
<td>58</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>54</td>
</tr>
<tr>
<td>MAT</td>
<td>0.93</td>
<td>0.00</td>
<td>0.00</td>
<td>0.03</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>100</td>
<td>92.67</td>
<td>95.00</td>
<td>80.00</td>
<td>92.67</td>
<td>60.00</td>
<td>80.00</td>
</tr>
<tr>
<td>-</td>
<td>-0.476</td>
<td>-0.042</td>
<td>-0.076</td>
<td>+0.476</td>
<td>-0.202</td>
<td>-0.249</td>
</tr>
<tr>
<td>I:6</td>
<td>58</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>MAT</td>
<td>0.95</td>
<td>0.00</td>
<td>0.00</td>
<td>0.02</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>100</td>
<td>91.99</td>
<td>95.00</td>
<td>80.00</td>
<td>91.99</td>
<td>60.00</td>
<td>80.00</td>
</tr>
<tr>
<td>-</td>
<td>+0.283</td>
<td>-0.133</td>
<td>-0.361</td>
<td>+0.283</td>
<td>-0.202</td>
<td>-0.283</td>
</tr>
<tr>
<td>I:7</td>
<td>58</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>57</td>
</tr>
<tr>
<td>MAT</td>
<td>0.98</td>
<td>0.00</td>
<td>0.00</td>
<td>0.02</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>100</td>
<td>96.58</td>
<td>95.00</td>
<td>80.00</td>
<td>96.58</td>
<td>60.00</td>
<td>80.00</td>
</tr>
<tr>
<td>-</td>
<td>-0.074</td>
<td>-0.042</td>
<td>-0.074</td>
<td>-0.074</td>
<td>-0.042</td>
<td>-0.074</td>
</tr>
<tr>
<td>I:8</td>
<td>58</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>55</td>
<td>2</td>
</tr>
<tr>
<td>MAT</td>
<td>0.95</td>
<td>0.00</td>
<td>0.00</td>
<td>0.03</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>100</td>
<td>91.67</td>
<td>95.00</td>
<td>80.00</td>
<td>91.67</td>
<td>60.00</td>
<td>80.00</td>
</tr>
<tr>
<td>-</td>
<td>+0.393</td>
<td>-0.093</td>
<td>-0.590</td>
<td>+0.393</td>
<td>-0.093</td>
<td>-0.393</td>
</tr>
<tr>
<td>I:9</td>
<td>58</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>3</td>
<td>54</td>
</tr>
<tr>
<td>MAT</td>
<td>0.93</td>
<td>0.00</td>
<td>0.00</td>
<td>0.05</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>100</td>
<td>91.33</td>
<td>95.00</td>
<td>80.00</td>
<td>91.33</td>
<td>60.00</td>
<td>80.00</td>
</tr>
</tbody>
</table>

Tuesday, May 09, 2000 10:38:21 AM
Figure 128: Test Statistics Report
Appendix D  |  409

INDIVIDUAL FEEDBACK REPORT
for Williamson, S. 4011

Test: Sample Test
Grade: B
Score: 81.67% (49.00 of 60.00)

40. T ✓ F ✗ Any number divided by itself equals 1

Feedback
Answer is T.

44. What is the tension on the string connecting the two masses?
A. 5.5 N
B. 11.25 N
C. 34.5 N
D. 22.5 N
E. None of the above

Feedback
Answer is D.
\( a = \frac{mg}{m_{\text{total}}} \)
Use the 5 kg mass
\( T = ma + m_{\text{a}}g \)
\( T = m(a + g) \)
\( T = 5(2.34 + 0.22 \times 9.81) \)
Tension = 22.5 N

45. If frictional forces are considered minimal, what is the tension in the string system shown below?

A. 76 N
B. 17 N
C. 17 N
D. 25 N

Feedback
Answer is C.
\( a = \frac{mg}{m_{\text{total}}} \)
\( a = \frac{2.6 \times 9.8}{7.8} \)
\( a = 3.27 \text{ m/s}^2 \)
\( T = mg - ma \)
\( T = (2g - a) \)
\( T = 16.9 \text{ N} \)
### INDIVIDUAL SCORES REPORT

for Bates, H. 1014

<table>
<thead>
<tr>
<th>Objective</th>
<th>Points</th>
<th>%</th>
<th>Grade</th>
<th>Response [Correct Answer]</th>
<th>Student Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OMI AREA 01</td>
<td>59.00 of 60.00</td>
<td>98.33</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>FLAGS</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.1 FLAGS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.2 FLAGS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3 FLAGS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.4 FLAGS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>G</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.5 FLAGS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.6 FLAGS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.7 FLAGS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.8 FLAGS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.9 FLAGS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.10 FLAGS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>LANGUAGE ARTS</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.11 LANGUAGE ARTS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.12 LANGUAGE ARTS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.13 LANGUAGE ARTS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.14 LANGUAGE ARTS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.15 LANGUAGE ARTS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.16 LANGUAGE ARTS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.17 LANGUAGE ARTS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.18 LANGUAGE ARTS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.19 LANGUAGE ARTS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.20 LANGUAGE ARTS 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>T</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>LRP*TEST</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.21 LRP*TEST 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.22 LRP*TEST 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.23 LRP*TEST 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.24 LRP*TEST 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.25 LRP*TEST 1</td>
<td>0.00 of 1.00</td>
<td>0.00</td>
<td>C [E]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.26 LRP*TEST 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.27 LRP*TEST 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.28 LRP*TEST 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.29 LRP*TEST 1</td>
<td>0.00 of 0.00</td>
<td>0.00</td>
<td>RLCEI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.30 LRP*TEST 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MATH</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.31 MATH 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.32 MATH 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.33 MATH 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.34 MATH 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.35 MATH 1</td>
<td>1.00 of 1.00</td>
<td>100.00</td>
<td>A</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Tuesday, May 03, 2002 10:48:12 AM

---

Figure 130: Individual Scores Report
### GROUP DETAIL REPORT
for Sample Test from SAMPLE SCORES

Test form: 0

<table>
<thead>
<tr>
<th>ID</th>
<th>Student Name</th>
<th>Type</th>
<th>Points</th>
<th>% Grade</th>
<th>Grade</th>
<th>C1</th>
<th>C2</th>
<th>C3</th>
<th>C4</th>
<th>C5</th>
<th>C6</th>
<th>C7</th>
<th>C8</th>
</tr>
</thead>
<tbody>
<tr>
<td>1001</td>
<td>Crosby, B.</td>
<td>6</td>
<td>57.00</td>
<td>95.06 A</td>
<td>M</td>
<td>EJ</td>
<td>9</td>
<td>CIUD</td>
<td>16</td>
<td>3</td>
<td>CP</td>
<td>LSP</td>
<td></td>
</tr>
<tr>
<td>1011</td>
<td>Donaldson, S.</td>
<td>4</td>
<td>54.00</td>
<td>90.06 A</td>
<td>M</td>
<td>EJ</td>
<td>9</td>
<td>CIUD</td>
<td>15</td>
<td>1</td>
<td>RM</td>
<td>AAD</td>
<td></td>
</tr>
<tr>
<td>1014</td>
<td>Bates, H.</td>
<td>2</td>
<td>59.00</td>
<td>98.33 A</td>
<td>F</td>
<td>EJ</td>
<td>10</td>
<td>CIUD</td>
<td>15</td>
<td>2</td>
<td>ST</td>
<td>LSP</td>
<td></td>
</tr>
<tr>
<td>1018</td>
<td>Young, C.</td>
<td>5</td>
<td>58.00</td>
<td>96.67 A</td>
<td>F</td>
<td>EJ</td>
<td>9</td>
<td>CIUD</td>
<td>14</td>
<td>1</td>
<td>RM</td>
<td>LSP</td>
<td></td>
</tr>
<tr>
<td>1019</td>
<td>Parker, A.</td>
<td>7</td>
<td>56.00</td>
<td>93.33 A</td>
<td>M</td>
<td>EJ</td>
<td>9</td>
<td>CIUD</td>
<td>16</td>
<td>4</td>
<td>RM</td>
<td>AAD</td>
<td></td>
</tr>
<tr>
<td>1029</td>
<td>Reeves, C.</td>
<td>8</td>
<td>55.00</td>
<td>91.67 A</td>
<td>F</td>
<td>EJ</td>
<td>12</td>
<td>CIUD</td>
<td>19</td>
<td>1</td>
<td>RM</td>
<td>AAD</td>
<td></td>
</tr>
<tr>
<td>1032</td>
<td>Kramer, M.</td>
<td>1</td>
<td>57.00</td>
<td>95.00 A</td>
<td>F</td>
<td>EJ</td>
<td>10</td>
<td>CIUD</td>
<td>17</td>
<td>2</td>
<td>RM</td>
<td>AAD</td>
<td></td>
</tr>
<tr>
<td>1049</td>
<td>Weston, T.</td>
<td>4</td>
<td>48.00</td>
<td>80.06 B</td>
<td>F</td>
<td>EJ</td>
<td>11</td>
<td>CIUD</td>
<td>17</td>
<td>3</td>
<td>CP</td>
<td>AAD</td>
<td></td>
</tr>
<tr>
<td>1053</td>
<td>Thompson, D.</td>
<td>1</td>
<td>56.00</td>
<td>93.33 A</td>
<td>M</td>
<td>EJ</td>
<td>9</td>
<td>CIUD</td>
<td>14</td>
<td>2</td>
<td>ST</td>
<td>AAD</td>
<td></td>
</tr>
<tr>
<td>1074</td>
<td>Lindsey, H.</td>
<td>0</td>
<td>54.00</td>
<td>90.06 A</td>
<td>M</td>
<td>EJ</td>
<td>12</td>
<td>CIUD</td>
<td>19</td>
<td>2</td>
<td>RM</td>
<td>LSP</td>
<td></td>
</tr>
<tr>
<td>1079</td>
<td>Swenson, S.</td>
<td>9</td>
<td>58.00</td>
<td>96.67 A</td>
<td>F</td>
<td>EJ</td>
<td>10</td>
<td>CIUD</td>
<td>15</td>
<td>3</td>
<td>RM</td>
<td>AAD</td>
<td></td>
</tr>
<tr>
<td>1460</td>
<td>Braungart, L.</td>
<td>1</td>
<td>59.00</td>
<td>98.33 A</td>
<td>M</td>
<td>EJ</td>
<td>12</td>
<td>CIUD</td>
<td>19</td>
<td>3</td>
<td>CP</td>
<td>LSP</td>
<td></td>
</tr>
<tr>
<td>1466</td>
<td>Everson, C.</td>
<td>0</td>
<td>26.00</td>
<td>43.33 F</td>
<td>M</td>
<td>EJ</td>
<td>11</td>
<td>CIUD</td>
<td>16</td>
<td>1</td>
<td>ST</td>
<td>LSP</td>
<td></td>
</tr>
<tr>
<td>1743</td>
<td>Eveson, V.</td>
<td>0</td>
<td>48.00</td>
<td>80.06 B</td>
<td>M</td>
<td>EJ</td>
<td>12</td>
<td>CIUD</td>
<td>18</td>
<td>2</td>
<td>CP</td>
<td>LSP</td>
<td></td>
</tr>
<tr>
<td>2004</td>
<td>Morris, M.</td>
<td>9</td>
<td>56.00</td>
<td>93.33 A</td>
<td>M</td>
<td>FB</td>
<td>9</td>
<td>ALSD</td>
<td>14</td>
<td>3</td>
<td>ST</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>2015</td>
<td>Chang, C.</td>
<td>6</td>
<td>60.00</td>
<td>100.00 A</td>
<td>M</td>
<td>FB</td>
<td>12</td>
<td>ALSD</td>
<td>17</td>
<td>4</td>
<td>RM</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>2039</td>
<td>Wilson, H.</td>
<td>7</td>
<td>59.00</td>
<td>98.33 A</td>
<td>M</td>
<td>FB</td>
<td>11</td>
<td>ALSD</td>
<td>17</td>
<td>1</td>
<td>ST</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>2044</td>
<td>Williams, A.</td>
<td>3</td>
<td>54.00</td>
<td>90.06 A</td>
<td>M</td>
<td>FB</td>
<td>12</td>
<td>ALSD</td>
<td>18</td>
<td>3</td>
<td>ST</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>2047</td>
<td>Lowell, S.</td>
<td>0</td>
<td>49.00</td>
<td>81.67 B</td>
<td>F</td>
<td>FB</td>
<td>12</td>
<td>ALSD</td>
<td>19</td>
<td>4</td>
<td>RM</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>2057</td>
<td>Sun, T.</td>
<td>1</td>
<td>58.00</td>
<td>96.67 A</td>
<td>F</td>
<td>FB</td>
<td>10</td>
<td>ALSD</td>
<td>16</td>
<td>2</td>
<td>CP</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>2069</td>
<td>Smith, P.</td>
<td>1</td>
<td>49.00</td>
<td>81.67 B</td>
<td>M</td>
<td>FB</td>
<td>11</td>
<td>ALSD</td>
<td>18</td>
<td>4</td>
<td>RM</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>2087</td>
<td>Eaton, A.</td>
<td>9</td>
<td>59.00</td>
<td>98.33 A</td>
<td>F</td>
<td>FB</td>
<td>10</td>
<td>ALSD</td>
<td>15</td>
<td>4</td>
<td>ST</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>2097</td>
<td>Albert, B.</td>
<td>2</td>
<td>52.00</td>
<td>86.67 B+</td>
<td>M</td>
<td>FB</td>
<td>9</td>
<td>ALSD</td>
<td>15</td>
<td>1</td>
<td>CP</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>2132</td>
<td>Faust, E.</td>
<td>2</td>
<td>59.00</td>
<td>98.33 A</td>
<td>F</td>
<td>FB</td>
<td>9</td>
<td>ALSD</td>
<td>16</td>
<td>3</td>
<td>ST</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>2220</td>
<td>Miller, J.</td>
<td>4</td>
<td>55.00</td>
<td>91.67 A</td>
<td>F</td>
<td>FB</td>
<td>10</td>
<td>ALSD</td>
<td>16</td>
<td>4</td>
<td>CP</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>2285</td>
<td>Lee, L.</td>
<td>5</td>
<td>58.00</td>
<td>96.67 A</td>
<td>M</td>
<td>FB</td>
<td>11</td>
<td>ALSD</td>
<td>17</td>
<td>3</td>
<td>ST</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>2094</td>
<td>Balbucke, M.</td>
<td>8</td>
<td>57.00</td>
<td>95.06 A</td>
<td>M</td>
<td>FB</td>
<td>10</td>
<td>ALSD</td>
<td>15</td>
<td>2</td>
<td>RM</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>2096</td>
<td>Eje, C.</td>
<td>6</td>
<td>57.00</td>
<td>95.06 A</td>
<td>F</td>
<td>FB</td>
<td>12</td>
<td>ALSD</td>
<td>18</td>
<td>1</td>
<td>ST</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>2947</td>
<td>Pen, I.</td>
<td>8</td>
<td>53.00</td>
<td>88.33 B+</td>
<td>M</td>
<td>FB</td>
<td>11</td>
<td>ALSD</td>
<td>16</td>
<td>1</td>
<td>RM</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>3011</td>
<td>Martinez, O.</td>
<td>0</td>
<td>44.00</td>
<td>73.33 C-</td>
<td>M</td>
<td>CN</td>
<td>11</td>
<td>ALSD</td>
<td>18</td>
<td>2</td>
<td>ST</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>3034</td>
<td>Dawkins, W.</td>
<td>7</td>
<td>55.00</td>
<td>91.67 A</td>
<td>M</td>
<td>CN</td>
<td>12</td>
<td>ALSD</td>
<td>19</td>
<td>1</td>
<td>CP</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>3040</td>
<td>Rogers, W.</td>
<td>9</td>
<td>53.00</td>
<td>88.33 B+</td>
<td>F</td>
<td>CN</td>
<td>9</td>
<td>ALSD</td>
<td>16</td>
<td>2</td>
<td>ST</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>3045</td>
<td>Marlo, J.</td>
<td>8</td>
<td>58.00</td>
<td>96.67 A</td>
<td>M</td>
<td>CN</td>
<td>10</td>
<td>ALSD</td>
<td>17</td>
<td>4</td>
<td>CP</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>3067</td>
<td>Black, J.</td>
<td>6</td>
<td>56.00</td>
<td>93.33 A</td>
<td>F</td>
<td>CN</td>
<td>9</td>
<td>ALSD</td>
<td>15</td>
<td>3</td>
<td>CP</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>3077</td>
<td>Lovern, E.</td>
<td>5</td>
<td>60.00</td>
<td>100.00 A+</td>
<td>F</td>
<td>CN</td>
<td>10</td>
<td>ALSD</td>
<td>16</td>
<td>5</td>
<td>RM</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>3207</td>
<td>Garcia, M.</td>
<td>9</td>
<td>37.00</td>
<td>61.67 C-</td>
<td>F</td>
<td>CN</td>
<td>11</td>
<td>ALSD</td>
<td>17</td>
<td>1</td>
<td>RM</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>3243</td>
<td>Segil, J.</td>
<td>2</td>
<td>56.00</td>
<td>93.33 A</td>
<td>M</td>
<td>CN</td>
<td>10</td>
<td>ALSD</td>
<td>15</td>
<td>4</td>
<td>RM</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>3285</td>
<td>Yeo, A.</td>
<td>3</td>
<td>59.00</td>
<td>98.33 A</td>
<td>M</td>
<td>CN</td>
<td>10</td>
<td>ALSD</td>
<td>17</td>
<td>2</td>
<td>ST</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>3347</td>
<td>Backus, B.</td>
<td>3</td>
<td>94.00</td>
<td>98.33 A</td>
<td>F</td>
<td>CN</td>
<td>11</td>
<td>ALSD</td>
<td>16</td>
<td>4</td>
<td>ST</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>3527</td>
<td>Kudorn, H.</td>
<td>8</td>
<td>46.00</td>
<td>76.67 B+</td>
<td>M</td>
<td>CN</td>
<td>12</td>
<td>ALSD</td>
<td>18</td>
<td>3</td>
<td>RM</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>3557</td>
<td>Servidio, D.</td>
<td>5</td>
<td>60.00</td>
<td>100.00 A+</td>
<td>M</td>
<td>CN</td>
<td>12</td>
<td>ALSD</td>
<td>17</td>
<td>3</td>
<td>RM</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>3757</td>
<td>Harrison, M.</td>
<td>0</td>
<td>58.00</td>
<td>96.67 A</td>
<td>F</td>
<td>CN</td>
<td>9</td>
<td>ALSD</td>
<td>16</td>
<td>1</td>
<td>CP</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>3779</td>
<td>Harrison, B.</td>
<td>6</td>
<td>58.00</td>
<td>96.67 A</td>
<td>F</td>
<td>CN</td>
<td>11</td>
<td>ALSD</td>
<td>16</td>
<td>2</td>
<td>RM</td>
<td>JET</td>
<td></td>
</tr>
<tr>
<td>3879</td>
<td>Tanaka, R.</td>
<td>5</td>
<td>57.00</td>
<td>95.06 A</td>
<td>F</td>
<td>EH</td>
<td>9</td>
<td>CIUD</td>
<td>14</td>
<td>1</td>
<td>CP</td>
<td>LSP</td>
<td></td>
</tr>
<tr>
<td>3985</td>
<td>Coughlin, W.</td>
<td>3</td>
<td>55.00</td>
<td>91.67 A</td>
<td>F</td>
<td>CN</td>
<td>9</td>
<td>ALSD</td>
<td>15</td>
<td>1</td>
<td>ST</td>
<td>MSB</td>
<td></td>
</tr>
<tr>
<td>4001</td>
<td>Jensen, R.</td>
<td>2</td>
<td>52.00</td>
<td>86.67 B+</td>
<td>M</td>
<td>EH</td>
<td>10</td>
<td>CIUD</td>
<td>16</td>
<td>3</td>
<td>CP</td>
<td>AAD</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 131: Group Detail Report**
### GROUP SUMMARY REPORT
for Sample Test from SAMPLE SCORES

**Test form: 0**

<table>
<thead>
<tr>
<th>Objective</th>
<th>Score</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>Avg</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OBD AREA 01</strong></td>
<td>57.00</td>
<td>54.00</td>
<td>59.00</td>
<td>58.00</td>
<td>56.00</td>
<td>55.00</td>
<td>57.00</td>
<td>48.00</td>
<td>56.00</td>
<td>54.41</td>
<td></td>
</tr>
<tr>
<td>FLAGS</td>
<td>10.00</td>
<td>10.00</td>
<td>10.00</td>
<td>10.00</td>
<td>10.00</td>
<td>10.00</td>
<td>9.00</td>
<td>10.00</td>
<td>6.00</td>
<td>9.31</td>
<td></td>
</tr>
<tr>
<td>LANGUAGE ARTS</td>
<td>8.00</td>
<td>7.00</td>
<td>10.00</td>
<td>8.00</td>
<td>10.00</td>
<td>5.00</td>
<td>6.00</td>
<td>9.00</td>
<td>10.00</td>
<td>8.97</td>
<td></td>
</tr>
<tr>
<td>LRRT/TEST</td>
<td>16.00</td>
<td>17.00</td>
<td>16.00</td>
<td>17.00</td>
<td>17.00</td>
<td>17.00</td>
<td>17.00</td>
<td>17.00</td>
<td>9.00</td>
<td>17.00</td>
<td>15.67</td>
</tr>
<tr>
<td>MATH</td>
<td>10.00</td>
<td>10.00</td>
<td>10.00</td>
<td>10.00</td>
<td>7.00</td>
<td>10.00</td>
<td>10.00</td>
<td>9.00</td>
<td>10.00</td>
<td>9.12</td>
<td></td>
</tr>
<tr>
<td>PHYSICS</td>
<td>13.00</td>
<td>12.00</td>
<td>13.00</td>
<td>13.00</td>
<td>12.00</td>
<td>13.00</td>
<td>15.00</td>
<td>11.00</td>
<td>13.00</td>
<td>11.54</td>
<td></td>
</tr>
</tbody>
</table>

**SUMMARY:**

| Points | 57.00 | 54.00 | 59.00 | 58.00 | 56.00 | 55.00 | 57.00 | 48.00 | 56.00 | 54.41 |
| % | 95.00 | 90.00 | 98.33 | 96.67 | 93.33 | 91.67 | 95.00 | 90.00 | 93.33 | 96.69 |

---

<table>
<thead>
<tr>
<th>Category 1 (Ref/Task)</th>
<th>Score</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>Avg</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OBD AREA 01 (Reference/Task)</strong></td>
<td>57.00</td>
<td>54.00</td>
<td>59.00</td>
<td>58.00</td>
<td>56.00</td>
<td>55.00</td>
<td>57.00</td>
<td>48.00</td>
<td>56.00</td>
<td>54.41</td>
<td></td>
</tr>
<tr>
<td>12BB.6</td>
<td>2.00</td>
<td>1.00</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>1.96</td>
</tr>
<tr>
<td>ACCELERATE</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>4.01</td>
</tr>
<tr>
<td>CHAPTER 01</td>
<td>5.00</td>
<td>6.00</td>
<td>5.00</td>
<td>6.00</td>
<td>5.00</td>
<td>6.00</td>
<td>5.00</td>
<td>6.00</td>
<td>6.00</td>
<td>6.00</td>
<td>5.69</td>
</tr>
<tr>
<td>CHAPTER 02 (CAT1 AREA 01)</td>
<td>3.00</td>
<td>3.00</td>
<td>5.00</td>
<td>4.00</td>
<td>5.00</td>
<td>4.00</td>
<td>4.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>4.31</td>
</tr>
<tr>
<td>CHAPTER 03</td>
<td>4.00</td>
<td>3.00</td>
<td>4.00</td>
<td>4.00</td>
<td>3.00</td>
<td>4.00</td>
<td>4.00</td>
<td>3.00</td>
<td>4.00</td>
<td>4.00</td>
<td>3.62</td>
</tr>
<tr>
<td>CHAPTER 04</td>
<td>14.00</td>
<td>14.00</td>
<td>14.00</td>
<td>14.00</td>
<td>13.00</td>
<td>14.00</td>
<td>14.00</td>
<td>14.00</td>
<td>14.00</td>
<td>12.88</td>
<td></td>
</tr>
<tr>
<td>CHAPTER 05</td>
<td>6.00</td>
<td>6.00</td>
<td>6.00</td>
<td>6.00</td>
<td>6.00</td>
<td>6.00</td>
<td>6.00</td>
<td>6.00</td>
<td>6.00</td>
<td>6.00</td>
<td>4.00</td>
</tr>
<tr>
<td>CHAPTER 06</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>4.74</td>
</tr>
<tr>
<td>CHAPTER 09</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>4.47</td>
</tr>
<tr>
<td>CHAPTER 12</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>1.00</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>1.86</td>
</tr>
<tr>
<td>DYNAMICS</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>4.00</td>
<td>5.00</td>
<td>5.00</td>
<td>4.00</td>
<td>5.00</td>
<td>4.00</td>
<td>4.36</td>
</tr>
<tr>
<td>MOMENTUM</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>0.00</td>
<td>1.00</td>
<td>0.01</td>
<td>0.81</td>
</tr>
</tbody>
</table>

**SUMMARY:**

| Points | 57.00 | 54.00 | 59.00 | 58.00 | 56.00 | 55.00 | 57.00 | 48.00 | 56.00 | 54.41 |
| % | 95.00 | 90.00 | 98.33 | 96.67 | 93.33 | 91.67 | 95.00 | 90.00 | 93.33 | 96.69 |

---

Figure 132: Group Summary Report
### Appendix D  |  413

#### Figure 133: Score Distribution Report

**SCORE DISTRIBUTION REPORT**  
for Sample Test from **SAMPLE SCORES**  

<table>
<thead>
<tr>
<th>Objective</th>
<th>Possible</th>
<th>A+</th>
<th>A-</th>
<th>A-+</th>
<th>B+</th>
<th>B-</th>
<th>C+</th>
<th>C-</th>
<th>C-+</th>
<th>D+</th>
<th>D-</th>
<th>D-+</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OBJ AREA 01</strong></td>
<td>60.00</td>
<td>9%</td>
<td>40%</td>
<td>24%</td>
<td>10%</td>
<td>9%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>0%</td>
<td>0%</td>
</tr>
<tr>
<td>FLAGS</td>
<td>10.00</td>
<td>72%</td>
<td>0%</td>
<td>9%</td>
<td>0%</td>
<td>7%</td>
<td>0%</td>
<td>2%</td>
<td>0%</td>
<td>5%</td>
<td>0%</td>
<td>2%</td>
<td>0%</td>
</tr>
<tr>
<td>LANGUAGE ARTS</td>
<td>10.00</td>
<td>82%</td>
<td>0%</td>
<td>9%</td>
<td>0%</td>
<td>12%</td>
<td>0%</td>
<td>2%</td>
<td>0%</td>
<td>5%</td>
<td>0%</td>
<td>2%</td>
<td>0%</td>
</tr>
<tr>
<td>LMR TEST</td>
<td>17.00</td>
<td>59%</td>
<td>0%</td>
<td>14%</td>
<td>5%</td>
<td>12%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>3%</td>
<td>3%</td>
<td>3%</td>
<td></td>
</tr>
<tr>
<td>MATH</td>
<td>10.00</td>
<td>59%</td>
<td>0%</td>
<td>9%</td>
<td>0%</td>
<td>12%</td>
<td>0%</td>
<td>2%</td>
<td>0%</td>
<td>5%</td>
<td>0%</td>
<td>2%</td>
<td>0%</td>
</tr>
<tr>
<td>PHYSICS</td>
<td>13.00</td>
<td>60%</td>
<td>0%</td>
<td>9%</td>
<td>0%</td>
<td>14%</td>
<td>0%</td>
<td>2%</td>
<td>3%</td>
<td>0%</td>
<td>3%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td><strong>SUMMARY:</strong></td>
<td>60.00</td>
<td>9%</td>
<td>40%</td>
<td>24%</td>
<td>10%</td>
<td>9%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>0%</td>
<td>0%</td>
</tr>
<tr>
<td><strong>Category 1 (Ref/Task)</strong></td>
<td>60.00</td>
<td>9%</td>
<td>40%</td>
<td>24%</td>
<td>10%</td>
<td>9%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>0%</td>
<td>0%</td>
</tr>
<tr>
<td><strong>CAT1 AREA 01</strong></td>
<td>6.00</td>
<td>100%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>12IB6</td>
<td>2.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>ACCELERATE</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>CHAPTER 01</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>CHAPTER 02 (CATI AREA)</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>CHAPTER 01</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>CHAPTER 02</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>CHAPTER 03</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>CHAPTER 04</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>CHAPTER 05</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>CHAPTER 06</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>CHAPTER 09</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>CATEGORY 12</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>DYNAMICS</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>MOMENTUM</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td><strong>SUMMARY:</strong></td>
<td>60.00</td>
<td>9%</td>
<td>40%</td>
<td>24%</td>
<td>10%</td>
<td>9%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>0%</td>
<td>0%</td>
</tr>
<tr>
<td><strong>Category 2 (Difficulty)</strong></td>
<td>60.00</td>
<td>9%</td>
<td>40%</td>
<td>24%</td>
<td>10%</td>
<td>9%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>0%</td>
<td>0%</td>
</tr>
<tr>
<td><strong>CAT2 AREA 02</strong></td>
<td>6.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>EASY</td>
<td>10.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>HARD</td>
<td>10.00</td>
<td>54%</td>
<td>24%</td>
<td>14%</td>
<td>9%</td>
<td>2%</td>
<td>0%</td>
<td>2%</td>
<td>3%</td>
<td>3%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MEDIUM</td>
<td>10.00</td>
<td>22%</td>
<td>39%</td>
<td>24%</td>
<td>12%</td>
<td>3%</td>
<td>7%</td>
<td>2%</td>
<td>3%</td>
<td>3%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td><strong>SUMMARY:</strong></td>
<td>60.00</td>
<td>9%</td>
<td>40%</td>
<td>24%</td>
<td>10%</td>
<td>9%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>0%</td>
<td>0%</td>
</tr>
<tr>
<td><strong>Category 3 (Topic)</strong></td>
<td>60.00</td>
<td>9%</td>
<td>40%</td>
<td>24%</td>
<td>10%</td>
<td>9%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>2%</td>
<td>0%</td>
<td>0%</td>
</tr>
<tr>
<td><strong>CAT3 AREA 03</strong></td>
<td>6.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>CIRCUMFER</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>COMPLEX</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>DIVISION</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>DYNAMICS</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>ENGLISH</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>FEATURE</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>フラクス</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>FORCE</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>GRAPHICS</td>
<td>1.00</td>
<td>84%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
</tbody>
</table>

Tuesday, May 09, 2000 10:53:52 AM
# SCORE SUMMARY REPORT

## Performance scores

<table>
<thead>
<tr>
<th>Objective</th>
<th>Possible</th>
<th>High</th>
<th>Low</th>
<th>Avg</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>OBJ AREA 01</td>
<td>60.00</td>
<td>60.00</td>
<td>26.00</td>
<td>54.41</td>
<td>98.69</td>
</tr>
<tr>
<td>FLAVORS</td>
<td>10.00</td>
<td>10.00</td>
<td>4.00</td>
<td>9.31</td>
<td>90.10</td>
</tr>
<tr>
<td>LANGUAGE ARTS</td>
<td>10.00</td>
<td>10.00</td>
<td>4.00</td>
<td>8.97</td>
<td>89.66</td>
</tr>
<tr>
<td>LXR/TBE TEST</td>
<td>17.00</td>
<td>17.00</td>
<td>9.00</td>
<td>15.67</td>
<td>92.19</td>
</tr>
<tr>
<td>MATH</td>
<td>10.00</td>
<td>10.00</td>
<td>4.00</td>
<td>9.12</td>
<td>91.21</td>
</tr>
<tr>
<td>PHYSICS</td>
<td>13.00</td>
<td>13.00</td>
<td>0.00</td>
<td>11.34</td>
<td>87.27</td>
</tr>
</tbody>
</table>

**SUMMARY:**

<table>
<thead>
<tr>
<th></th>
<th>Possible</th>
<th>High</th>
<th>Low</th>
<th>Avg</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>40.00</td>
<td>60.00</td>
<td>26.00</td>
<td>54.41</td>
<td>98.69</td>
</tr>
</tbody>
</table>

## Category 1 (Ref/Task)

<table>
<thead>
<tr>
<th>Objective</th>
<th>Possible</th>
<th>High</th>
<th>Low</th>
<th>Avg</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAT1 AREA 01 (Reference)</td>
<td>60.00</td>
<td>60.00</td>
<td>26.00</td>
<td>54.41</td>
<td>98.69</td>
</tr>
<tr>
<td>123456</td>
<td>2.00</td>
<td>2.00</td>
<td>0.00</td>
<td>1.86</td>
<td>93.10</td>
</tr>
<tr>
<td>ACCELERATE</td>
<td>5.00</td>
<td>5.00</td>
<td>0.00</td>
<td>4.31</td>
<td>86.21</td>
</tr>
<tr>
<td>CHAPTER 01</td>
<td>6.00</td>
<td>6.00</td>
<td>2.00</td>
<td>5.69</td>
<td>94.83</td>
</tr>
<tr>
<td>CHAPTER 02 (CAT1 AREA 01)</td>
<td>5.00</td>
<td>5.00</td>
<td>0.00</td>
<td>4.31</td>
<td>86.21</td>
</tr>
<tr>
<td>CHAPTER 03</td>
<td>4.00</td>
<td>4.00</td>
<td>1.00</td>
<td>3.62</td>
<td>90.52</td>
</tr>
<tr>
<td>CHAPTER 04</td>
<td>14.00</td>
<td>14.00</td>
<td>6.00</td>
<td>12.88</td>
<td>92.00</td>
</tr>
<tr>
<td>CHAPTER 05</td>
<td>6.00</td>
<td>6.00</td>
<td>1.00</td>
<td>5.50</td>
<td>91.67</td>
</tr>
<tr>
<td>CHAPTER 06</td>
<td>5.00</td>
<td>5.00</td>
<td>3.00</td>
<td>4.74</td>
<td>94.83</td>
</tr>
<tr>
<td>CHAPTER 09</td>
<td>5.00</td>
<td>5.00</td>
<td>2.00</td>
<td>4.47</td>
<td>89.31</td>
</tr>
<tr>
<td>CHAPTER 12</td>
<td>2.00</td>
<td>2.00</td>
<td>1.00</td>
<td>1.86</td>
<td>93.10</td>
</tr>
<tr>
<td>DYNAMICS</td>
<td>5.00</td>
<td>5.00</td>
<td>0.00</td>
<td>4.36</td>
<td>87.24</td>
</tr>
<tr>
<td>MOMENTUM</td>
<td>1.00</td>
<td>1.00</td>
<td>0.00</td>
<td>0.81</td>
<td>81.03</td>
</tr>
</tbody>
</table>

**SUMMARY:**

<table>
<thead>
<tr>
<th></th>
<th>Possible</th>
<th>High</th>
<th>Low</th>
<th>Avg</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>40.00</td>
<td>60.00</td>
<td>26.00</td>
<td>54.41</td>
<td>98.69</td>
</tr>
</tbody>
</table>

## Category 2 (Difficulty)

<table>
<thead>
<tr>
<th>Objective</th>
<th>Possible</th>
<th>High</th>
<th>Low</th>
<th>Avg</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAT2 AREA 01 (Difficulty)</td>
<td>60.00</td>
<td>60.00</td>
<td>26.00</td>
<td>54.41</td>
<td>98.69</td>
</tr>
<tr>
<td>EASY</td>
<td>10.00</td>
<td>10.00</td>
<td>2.00</td>
<td>9.00</td>
<td>90.00</td>
</tr>
<tr>
<td>HARD</td>
<td>21.00</td>
<td>21.00</td>
<td>13.00</td>
<td>19.53</td>
<td>93.02</td>
</tr>
<tr>
<td>MEDIUM</td>
<td>29.00</td>
<td>29.00</td>
<td>10.00</td>
<td>25.88</td>
<td>89.24</td>
</tr>
</tbody>
</table>

**SUMMARY:**

<table>
<thead>
<tr>
<th></th>
<th>Possible</th>
<th>High</th>
<th>Low</th>
<th>Avg</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>40.00</td>
<td>60.00</td>
<td>26.00</td>
<td>54.41</td>
<td>98.69</td>
</tr>
</tbody>
</table>

## Category 3 (Topic)

<table>
<thead>
<tr>
<th>Objective</th>
<th>Possible</th>
<th>High</th>
<th>Low</th>
<th>Avg</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAT3 AREA 01 (Topic)</td>
<td>60.00</td>
<td>60.00</td>
<td>26.00</td>
<td>54.41</td>
<td>98.69</td>
</tr>
<tr>
<td>CAPACITY</td>
<td>1.00</td>
<td>1.00</td>
<td>0.00</td>
<td>0.91</td>
<td>91.38</td>
</tr>
<tr>
<td>CIRCUMFIR</td>
<td>2.00</td>
<td>2.00</td>
<td>0.00</td>
<td>1.72</td>
<td>86.21</td>
</tr>
<tr>
<td>COMPLEX</td>
<td>1.00</td>
<td>1.00</td>
<td>0.00</td>
<td>0.95</td>
<td>94.83</td>
</tr>
<tr>
<td>DIVISION</td>
<td>3.00</td>
<td>3.00</td>
<td>0.00</td>
<td>2.74</td>
<td>91.38</td>
</tr>
<tr>
<td>DYNAMICS</td>
<td>2.00</td>
<td>2.00</td>
<td>0.00</td>
<td>1.86</td>
<td>93.10</td>
</tr>
<tr>
<td>ENGLISH</td>
<td>4.00</td>
<td>4.00</td>
<td>0.00</td>
<td>3.55</td>
<td>88.79</td>
</tr>
<tr>
<td>FEATURE</td>
<td>2.00</td>
<td>2.00</td>
<td>1.00</td>
<td>1.91</td>
<td>95.69</td>
</tr>
<tr>
<td>FIGURS</td>
<td>10.00</td>
<td>10.00</td>
<td>4.00</td>
<td>9.31</td>
<td>93.10</td>
</tr>
<tr>
<td>FORCE</td>
<td>1.00</td>
<td>1.00</td>
<td>0.00</td>
<td>0.79</td>
<td>79.31</td>
</tr>
<tr>
<td>GRAPHICS</td>
<td>9.00</td>
<td>9.00</td>
<td>1.00</td>
<td>8.22</td>
<td>91.38</td>
</tr>
</tbody>
</table>

---

Figure 134: Score Summary Report
### Figure 135: Demographics Report

**DEMOGRAPHICS REPORT**
for Test: MathTest,
MathScores
C:\LXRDATA\MathScores\LXRScores

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Administration date (start)</th>
<th>Administration date (end)</th>
<th>Starting time</th>
<th>Elapsed time</th>
<th>System start time</th>
<th>Restart count</th>
<th>Finish Test</th>
<th>Remap</th>
<th>OMR Form</th>
<th>Source</th>
<th>Results given</th>
</tr>
</thead>
<tbody>
<tr>
<td>1001</td>
<td>Crosby, B.</td>
<td>2000/03/27</td>
<td>2000/03/27</td>
<td>14:43:11</td>
<td>00:00:47</td>
<td>954196991</td>
<td>1</td>
<td>Y</td>
<td></td>
<td></td>
<td>LAN 0.9.2.2</td>
<td></td>
</tr>
<tr>
<td>1011</td>
<td>Donaldson, S.</td>
<td>2000/03/27</td>
<td>2000/03/27</td>
<td>14:44:06</td>
<td>00:00:37</td>
<td>954197046</td>
<td>1</td>
<td>Y</td>
<td></td>
<td></td>
<td>LAN 0.9.2.2</td>
<td></td>
</tr>
<tr>
<td>1014</td>
<td>Bates, H.</td>
<td>2000/03/27</td>
<td>2000/03/27</td>
<td>14:44:52</td>
<td>00:00:59</td>
<td>954197092</td>
<td>1</td>
<td>Y</td>
<td></td>
<td></td>
<td>LAN 0.9.2.2</td>
<td></td>
</tr>
</tbody>
</table>

Monday, March 27, 2000 02:48:44 PM
## MASTERY SPECIFICATION REPORT
for Sample Test from Sample Scores
Performance scores
Second term

<table>
<thead>
<tr>
<th>Objective</th>
<th>Obj Count</th>
<th>Item Count</th>
<th>Possible Points</th>
<th>Mastery</th>
<th>Partial Mastery</th>
</tr>
</thead>
<tbody>
<tr>
<td>OBJ AREA 01 (Objective Area 01) Overall mastery level of all objectives.</td>
<td>5</td>
<td>50</td>
<td>57.00</td>
<td>51.30 (90%)</td>
<td>39.90 (70%)</td>
</tr>
<tr>
<td>FLAGS Identify the U.S. state or nation corresponding to the displayed flag.</td>
<td>10</td>
<td>10.00</td>
<td>9.00 (90%)</td>
<td>7.00 (70%)</td>
<td></td>
</tr>
<tr>
<td>LANGUAGE ARTS Demonstrate both grammatical and reading analysis proficiency.</td>
<td>10</td>
<td>10.00</td>
<td>9.00 (90%)</td>
<td>7.00 (70%)</td>
<td></td>
</tr>
<tr>
<td>LXR<em>TEST Demonstrate proficient knowledge of LXR</em>TEST 6.0 features and functionality.</td>
<td>10</td>
<td>14.00</td>
<td>12.60 (90%)</td>
<td>9.80 (70%)</td>
<td></td>
</tr>
<tr>
<td>MATH Demonstrate proficient understanding of elementary through beginning algebra mathematics.</td>
<td>10</td>
<td>10.00</td>
<td>9.00 (90%)</td>
<td>7.00 (70%)</td>
<td></td>
</tr>
<tr>
<td>PHYSICS Demonstrate proficiency in understanding of mechanical physics.</td>
<td>10</td>
<td>13.00</td>
<td>11.70 (90%)</td>
<td>9.10 (70%)</td>
<td></td>
</tr>
</tbody>
</table>

Refer to resource references of each objective.


Refer to the LXR*TEST 6.0 User's Guide.


Friday, August 11, 2000 9:38:30 AM

Figure 136: Mastery Specification Report
### MASTERY DIRECTORY REPORT

for Sample Test from SAMPLE SCORES

Performance scores

**Second term**

<table>
<thead>
<tr>
<th>Objective</th>
<th>Score Area 01</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mastery: 42 Individuals mastered 90% or better (by Points)</td>
<td></td>
</tr>
<tr>
<td>Crosby, B.</td>
<td>Donaldson, S.</td>
</tr>
<tr>
<td>Parker, A.</td>
<td>Reeves, C.</td>
</tr>
<tr>
<td>Lindsey, H.</td>
<td>Swenson, S.</td>
</tr>
<tr>
<td>Chang, C.</td>
<td>Wilson, H.</td>
</tr>
<tr>
<td>Eaton, A.</td>
<td>Faust, E.</td>
</tr>
<tr>
<td>Bulbette, M.</td>
<td>Fye, C.</td>
</tr>
<tr>
<td>Black, J.</td>
<td>Leventhal, E.</td>
</tr>
<tr>
<td>Buckus, B.</td>
<td>Servidio, D.</td>
</tr>
<tr>
<td>Tanka, R.</td>
<td>Coughlin, W.</td>
</tr>
<tr>
<td>Daniels, O.</td>
<td>Jordan W.</td>
</tr>
<tr>
<td>Loh, D.</td>
<td>Beantor, W.</td>
</tr>
</tbody>
</table>

| Partial Mastery: 13 Individuals mastered 70% - 89% (by Points) | |
| Westerl, T. | Everson, V. | Lowell, S. | Smith, P. |
| Albert, B. | Pina, I. | Martinez, O. | Rogers, W. |
| Kadota, H. | James, R. | Mitchell, M. | Williamson, S. |
| Armstrong, J. | | | |

| Non-Mastery: 1 Individuals mastered less than 70% (by Points) | |
| Everson, C. | Garcia, M. | Jackson, N. | |

### FLAWS

Mastery: 48 Individuals mastered 90% or better (by Points) | |
| Crosby, B. | Donaldson, S. | Bates, H. | Young, C. |
| Parker, A. | Reeves, C. | Krane, M. | Westerl, T. |
| Lindsey, H. | Swenson, S. | Boerger, L. | Morris, M. |
| Chang, C. | Wilson, H. | Williams, A. | Sun, T. |
| Smith, P. | Eaton, A. | Albert, B. | Faust, E. |
| Lee, J. | Bulbette, M. | Fye, C. | Pina, I. |
| Martinez, O. | Dowkins, W. | Rogers, W. | Marks, J. |
| Black, J. | Leventhal, E. | Segal, J. | Yen, A. |
| Buckus, B. | Servidio, D. | Harrison, B. | Tanka, R. |
| Coughlin, W. | James, R. | Mitchell, M. | Porter, J. |
| Williamson, S. | Kelly, S. | Armstrong, J. | Jordan W. |
| Boone, S. | Collins, N. | Loh, D. | Beantor, W. |

Partial Mastery: 5 Individuals mastered 70% - 89% (by Points) | |
| Everson, C. | Miller, J. | Harrison, M. | Jackson, N. |
| Daniels, O. | | | |

Non-Mastery: 5 Individuals mastered less than 70% (by Points) | |
| Thompsons, D. | Everson, V. | Lowell, S. | Garcia, M. |
| Kadota, H. | | | |
## MASTERY SUMMARY REPORT

for Sample Test from SAMPLE SCORES
Performance scores

| Objective | # M | # PM | # NM | % M | % PM | % NM | PTS | Possible Points
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>OBJ AREA 01</td>
<td>42</td>
<td>13</td>
<td>3</td>
<td>72.41</td>
<td>22.41</td>
<td>5.17</td>
<td>40.00</td>
<td>40.00</td>
</tr>
<tr>
<td>FLAGS</td>
<td>48</td>
<td>5</td>
<td>5</td>
<td>82.76</td>
<td>8.62</td>
<td>8.62</td>
<td>10.00</td>
<td>10.00</td>
</tr>
<tr>
<td>LANGUAGE ARTS</td>
<td>41</td>
<td>11</td>
<td>6</td>
<td>70.69</td>
<td>18.97</td>
<td>10.34</td>
<td>10.00</td>
<td>10.00</td>
</tr>
<tr>
<td>LXR TEST</td>
<td>42</td>
<td>10</td>
<td>6</td>
<td>72.41</td>
<td>17.24</td>
<td>10.34</td>
<td>17.00</td>
<td>10.00</td>
</tr>
<tr>
<td>MATH</td>
<td>45</td>
<td>10</td>
<td>3</td>
<td>77.59</td>
<td>17.24</td>
<td>5.17</td>
<td>10.00</td>
<td>10.00</td>
</tr>
<tr>
<td>PHYSICS</td>
<td>38</td>
<td>11</td>
<td>9</td>
<td>65.52</td>
<td>18.97</td>
<td>15.52</td>
<td>13.00</td>
<td>13.00</td>
</tr>
</tbody>
</table>

**SUMMARY:**

- All Objectives: 15 - 0 - 25.86 - 0.00 - 40.00 - 40.00 - 26.00 - 54.41
- All Areas: 42 - 3 - 72.41 - 5.17 - 40.00 - 40.00 - 26.00 - 54.41

### Category 1 (Reference/Task)

| Objective | # M | # PM | # NM | % M | % PM | % NM | PTS | Possible Points
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CAT1 AREA 01 (Reference/Task)</td>
<td>42</td>
<td>13</td>
<td>3</td>
<td>72.41</td>
<td>22.41</td>
<td>5.17</td>
<td>40.00</td>
<td>40.00</td>
</tr>
<tr>
<td>U2BB 6</td>
<td>51</td>
<td>0</td>
<td>7</td>
<td>87.93</td>
<td>0.00</td>
<td>12.07</td>
<td>2.00</td>
<td>2.00</td>
</tr>
<tr>
<td>ACCELERATE</td>
<td>46</td>
<td>0</td>
<td>12</td>
<td>79.31</td>
<td>0.00</td>
<td>20.69</td>
<td>5.00</td>
<td>5.00</td>
</tr>
<tr>
<td>CHAPTER 01</td>
<td>44</td>
<td>12</td>
<td>2</td>
<td>75.86</td>
<td>26.09</td>
<td>3.85</td>
<td>6.00</td>
<td>6.00</td>
</tr>
<tr>
<td>CHAPTER 01 (CAT1 AREA 01)</td>
<td>26</td>
<td>12</td>
<td>10</td>
<td>62.07</td>
<td>26.09</td>
<td>17.24</td>
<td>5.00</td>
<td>5.00</td>
</tr>
<tr>
<td>CHAPTER 03</td>
<td>44</td>
<td>8</td>
<td>6</td>
<td>75.86</td>
<td>13.79</td>
<td>10.34</td>
<td>4.00</td>
<td>4.00</td>
</tr>
<tr>
<td>CHAPTER 04</td>
<td>44</td>
<td>9</td>
<td>5</td>
<td>75.86</td>
<td>15.52</td>
<td>8.62</td>
<td>14.00</td>
<td>14.00</td>
</tr>
<tr>
<td>CHAPTER 05</td>
<td>44</td>
<td>5</td>
<td>9</td>
<td>75.86</td>
<td>8.62</td>
<td>15.52</td>
<td>6.00</td>
<td>6.00</td>
</tr>
<tr>
<td>CHAPTER 06</td>
<td>47</td>
<td>7</td>
<td>4</td>
<td>81.03</td>
<td>12.07</td>
<td>6.90</td>
<td>5.00</td>
<td>5.00</td>
</tr>
<tr>
<td>CHAPTER 09</td>
<td>40</td>
<td>9</td>
<td>9</td>
<td>68.97</td>
<td>15.52</td>
<td>15.52</td>
<td>5.00</td>
<td>5.00</td>
</tr>
<tr>
<td>CHAPTER 12</td>
<td>50</td>
<td>0</td>
<td>8</td>
<td>86.21</td>
<td>0.00</td>
<td>13.79</td>
<td>2.00</td>
<td>2.00</td>
</tr>
<tr>
<td>DYNAMICS</td>
<td>40</td>
<td>10</td>
<td>8</td>
<td>68.97</td>
<td>17.24</td>
<td>13.79</td>
<td>5.00</td>
<td>5.00</td>
</tr>
<tr>
<td>MOMENTUM</td>
<td>47</td>
<td>0</td>
<td>11</td>
<td>81.03</td>
<td>0.00</td>
<td>18.97</td>
<td>1.00</td>
<td>1.00</td>
</tr>
</tbody>
</table>

**SUMMARY:**

- All Category 1 (Ref/Task): 8 - 0 - 13.79 - 0.00 - 40.00 - 40.00 - 26.00 - 54.41
- All Areas: 42 - 3 - 72.41 - 5.17 - 40.00 - 40.00 - 26.00 - 54.41

### Category 2 (Difficulty)

| Objective | # M | # PM | # NM | % M | % PM | % NM | PTS | Possible Points
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CAT2 AREA 01 (Difficulty)</td>
<td>42</td>
<td>13</td>
<td>3</td>
<td>72.41</td>
<td>22.41</td>
<td>5.17</td>
<td>40.00</td>
<td>40.00</td>
</tr>
<tr>
<td>EASY</td>
<td>45</td>
<td>10</td>
<td>3</td>
<td>77.59</td>
<td>17.24</td>
<td>5.17</td>
<td>10.00</td>
<td>10.00</td>
</tr>
<tr>
<td>HARD</td>
<td>47</td>
<td>7</td>
<td>4</td>
<td>81.03</td>
<td>12.07</td>
<td>6.90</td>
<td>21.00</td>
<td>21.00</td>
</tr>
<tr>
<td>MEDIUM</td>
<td>38</td>
<td>14</td>
<td>6</td>
<td>65.52</td>
<td>24.14</td>
<td>10.34</td>
<td>20.00</td>
<td>20.00</td>
</tr>
</tbody>
</table>

**SUMMARY:**

- All Category 2 (Difficulty): 30 - 2 - 51.72 - 3.45 - 40.00 - 40.00 - 26.00 - 54.41
- All Areas: 42 - 3 - 72.41 - 5.17 - 40.00 - 40.00 - 26.00 - 54.41

---

Figure 138: Mastery Summary Report
### MASTERY GROUP REPORT

for Sample Test from Sample Scores

*Performance scores*

**Second term**

<table>
<thead>
<tr>
<th>Objective</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>OBJ AREA 01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>72.41</td>
</tr>
<tr>
<td>FLAGS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>82.76</td>
</tr>
<tr>
<td>LANGUAGE ARTS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>72.41</td>
</tr>
<tr>
<td>LXR*TEST</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>72.41</td>
</tr>
<tr>
<td>MATH</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>77.59</td>
</tr>
<tr>
<td>PHYSICS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>65.52</td>
</tr>
</tbody>
</table>

**SUMMARY:**

<table>
<thead>
<tr>
<th>Points Earned</th>
<th>59.00</th>
<th>35.00</th>
<th>60.00</th>
<th>58.00</th>
<th>58.00</th>
<th>58.00</th>
<th>57.00</th>
<th>58.00</th>
<th>57.00</th>
<th>90.75</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mastered</td>
<td>5</td>
<td>0</td>
<td>5</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>74.14</td>
</tr>
<tr>
<td>Partially Mastered</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>15.86</td>
</tr>
<tr>
<td>Not Mastered</td>
<td>0</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>10.00</td>
</tr>
<tr>
<td>Areas Mastered</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>72.41</td>
</tr>
<tr>
<td>Areas Partially Mastered</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>22.41</td>
</tr>
<tr>
<td>Areas Not Mastered</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>5.17</td>
</tr>
</tbody>
</table>

*Key:*

- Mastered
- Partially Mastered
- Not Mastered

---

Figure 139: Mastery Group Report
## MASTERY COMPARISON REPORT

for Sample Test from SAMPLE SCORES
Performance scores
Second term

<table>
<thead>
<tr>
<th>Objective</th>
<th>F</th>
<th>M</th>
<th>% Mastering</th>
<th>% Partially Mastering</th>
<th>% Not Mastering</th>
</tr>
</thead>
<tbody>
<tr>
<td>OBJ AREA 01</td>
<td>82.14</td>
<td>63.33</td>
<td>72.41</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FLAGS</td>
<td>78.57</td>
<td>86.67</td>
<td>82.76</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LANGUAGE ARTS</td>
<td>64.29</td>
<td>76.67</td>
<td>70.69</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LXR*TEST</td>
<td>75.00</td>
<td>70.00</td>
<td>72.41</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MATH</td>
<td>85.71</td>
<td>70.00</td>
<td>77.59</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PHYSICS</td>
<td>75.00</td>
<td>56.67</td>
<td>68.82</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OBJ AREA 01</td>
<td>10.71</td>
<td>33.33</td>
<td>22.41</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FLAGS</td>
<td>14.29</td>
<td>3.33</td>
<td>8.62</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LANGUAGE ARTS</td>
<td>17.86</td>
<td>20.00</td>
<td>18.97</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LXR*TEST</td>
<td>14.29</td>
<td>20.00</td>
<td>17.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MATH</td>
<td>10.71</td>
<td>23.33</td>
<td>17.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PHYSICS</td>
<td>17.86</td>
<td>20.00</td>
<td>18.97</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OBJ AREA 01</td>
<td>7.14</td>
<td>3.33</td>
<td>5.17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FLAGS</td>
<td>7.14</td>
<td>10.00</td>
<td>8.62</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LANGUAGE ARTS</td>
<td>17.86</td>
<td>3.33</td>
<td>10.34</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LXR*TEST</td>
<td>10.71</td>
<td>10.00</td>
<td>10.34</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MATH</td>
<td>3.57</td>
<td>6.67</td>
<td>5.17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PHYSICS</td>
<td>7.14</td>
<td>23.33</td>
<td>15.52</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**SUMMARY:**
- All Mastered: 28.57%
- None Mastered: 0.00%
- All Areas Mastered: 82.14%
- No Areas Mastered: 7.14%

Figure 140: Mastery Comparison Report
Appendix D | 421

Figure 141: Individual Mastery Report
## GRADING TABLE REPORT
for Sample Grading Table

<table>
<thead>
<tr>
<th>Letter Grades</th>
<th>Scale Scores</th>
<th>Mastery Symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>%</td>
<td>Raw</td>
<td>Scale</td>
</tr>
<tr>
<td>100</td>
<td>A+</td>
<td>Max: 0 99</td>
</tr>
<tr>
<td>95</td>
<td>A</td>
<td>Cut: 0 75</td>
</tr>
<tr>
<td>90</td>
<td>A-</td>
<td>Min: 0 0</td>
</tr>
<tr>
<td>85</td>
<td>B+</td>
<td></td>
</tr>
<tr>
<td>80</td>
<td>B</td>
<td>Pass phrase: You have passed this exam.</td>
</tr>
<tr>
<td>75</td>
<td>B</td>
<td>Fail phrase: You have failed this exam.</td>
</tr>
<tr>
<td>70</td>
<td>C+</td>
<td></td>
</tr>
<tr>
<td>65</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>C-</td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>D+</td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>D</td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>D-</td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>F</td>
<td></td>
</tr>
</tbody>
</table>

### Classification: Objective

<table>
<thead>
<tr>
<th>Mastery %</th>
<th>Partial %</th>
<th>Classification</th>
</tr>
</thead>
<tbody>
<tr>
<td>90</td>
<td>70</td>
<td>OBJ AREA 01</td>
</tr>
<tr>
<td>90</td>
<td>70</td>
<td>LANGUAGE ARTS</td>
</tr>
<tr>
<td>90</td>
<td>70</td>
<td>LXR*TEST</td>
</tr>
<tr>
<td>90</td>
<td>70</td>
<td>MATH</td>
</tr>
<tr>
<td>90</td>
<td>70</td>
<td>PHYSICS</td>
</tr>
</tbody>
</table>

### Description:
- General knowledge of multiple subjects.
- Representative flags of various states and nations.
- General assessment of items that test students' understanding of various components of language arts.
- Knowledge of the functions and capability of LXR*TEST.
- Elementary and secondary math questions to determine student status.
- Secondary level questions involved in the understanding of momentum and mass.

### Classification: Category 1

<table>
<thead>
<tr>
<th>Mastery %</th>
<th>Partial %</th>
<th>Classification</th>
</tr>
</thead>
<tbody>
<tr>
<td>90</td>
<td>70</td>
<td>CATI AREA 01</td>
</tr>
<tr>
<td>90</td>
<td>70</td>
<td>APPENDIX B</td>
</tr>
<tr>
<td>90</td>
<td>70</td>
<td>CHAPTER 01</td>
</tr>
<tr>
<td>90</td>
<td>70</td>
<td>CHAPTER 02</td>
</tr>
<tr>
<td>90</td>
<td>70</td>
<td>CHAPTER 03</td>
</tr>
<tr>
<td>90</td>
<td>70</td>
<td>CHAPTER 04</td>
</tr>
<tr>
<td>90</td>
<td>70</td>
<td>CHAPTER 05</td>
</tr>
<tr>
<td>90</td>
<td>70</td>
<td>CHAPTER 06</td>
</tr>
</tbody>
</table>

### Reference/Task
- 12B:6
- 1B
- 1D
- 1F1
- 2D

Friday, February 11, 2000 01:18:25 PM

**Figure 142: Grading Table Report**
### STUDENT LISTING REPORT

<table>
<thead>
<tr>
<th>ID</th>
<th>Student Name</th>
<th>C1</th>
<th>C2</th>
<th>C3</th>
<th>C4</th>
<th>C5</th>
<th>C6</th>
<th>C7</th>
<th>C8</th>
</tr>
</thead>
<tbody>
<tr>
<td>1001</td>
<td>Crosby, B.</td>
<td>M</td>
<td>EJ</td>
<td>9</td>
<td>CJJD</td>
<td>16</td>
<td>3</td>
<td>CP</td>
<td>LSP</td>
</tr>
<tr>
<td>1011</td>
<td>Donaldson, S.</td>
<td>M</td>
<td>EJ</td>
<td>9</td>
<td>CJJD</td>
<td>15</td>
<td>1</td>
<td>RM</td>
<td>AAD</td>
</tr>
<tr>
<td>1014</td>
<td>Bates, H.</td>
<td>F</td>
<td>EJ</td>
<td>10</td>
<td>CJJD</td>
<td>15</td>
<td>2</td>
<td>ST</td>
<td>LSP</td>
</tr>
<tr>
<td>1018</td>
<td>Yeung, C.</td>
<td>F</td>
<td>EJ</td>
<td>9</td>
<td>CJJD</td>
<td>14</td>
<td>1</td>
<td>RM</td>
<td>LSP</td>
</tr>
<tr>
<td>1019</td>
<td>Parker, A.</td>
<td>M</td>
<td>EJ</td>
<td>9</td>
<td>CJJD</td>
<td>16</td>
<td>4</td>
<td>RM</td>
<td>AAD</td>
</tr>
<tr>
<td>1029</td>
<td>Reeves, C.</td>
<td>F</td>
<td>EJ</td>
<td>12</td>
<td>CJJD</td>
<td>19</td>
<td>1</td>
<td>RM</td>
<td>AAD</td>
</tr>
<tr>
<td>1032</td>
<td>Kremer, M.</td>
<td>F</td>
<td>EJ</td>
<td>10</td>
<td>CJJD</td>
<td>17</td>
<td>2</td>
<td>RM</td>
<td>AAD</td>
</tr>
<tr>
<td>1049</td>
<td>Wentzel, T.</td>
<td>F</td>
<td>EJ</td>
<td>11</td>
<td>CJJD</td>
<td>17</td>
<td>3</td>
<td>CP</td>
<td>AAD</td>
</tr>
<tr>
<td>1053</td>
<td>Thompson, D.</td>
<td>M</td>
<td>EJ</td>
<td>9</td>
<td>CJJD</td>
<td>14</td>
<td>2</td>
<td>ST</td>
<td>AAD</td>
</tr>
<tr>
<td>1074</td>
<td>Lindsey, H.</td>
<td>M</td>
<td>EJ</td>
<td>12</td>
<td>CJJD</td>
<td>19</td>
<td>2</td>
<td>RM</td>
<td>LSP</td>
</tr>
<tr>
<td>1079</td>
<td>Swenson, S.</td>
<td>F</td>
<td>EJ</td>
<td>10</td>
<td>CJJD</td>
<td>15</td>
<td>3</td>
<td>RM</td>
<td>AAD</td>
</tr>
<tr>
<td>1460</td>
<td>Baarngarten, L.</td>
<td>M</td>
<td>EJ</td>
<td>12</td>
<td>CJJD</td>
<td>19</td>
<td>3</td>
<td>CP</td>
<td>LSP</td>
</tr>
<tr>
<td>1666</td>
<td>Everson, C.</td>
<td>M</td>
<td>EJ</td>
<td>11</td>
<td>CJJD</td>
<td>16</td>
<td>1</td>
<td>ST</td>
<td>LSP</td>
</tr>
<tr>
<td>1743</td>
<td>Everson, V.</td>
<td>M</td>
<td>EJ</td>
<td>12</td>
<td>CJJD</td>
<td>18</td>
<td>2</td>
<td>CP</td>
<td>LSP</td>
</tr>
<tr>
<td>2004</td>
<td>Morris, M.</td>
<td>M</td>
<td>FB</td>
<td>9</td>
<td>ALSD</td>
<td>14</td>
<td>3</td>
<td>ST</td>
<td>MSB</td>
</tr>
<tr>
<td>2015</td>
<td>Chang, C.</td>
<td>M</td>
<td>FB</td>
<td>12</td>
<td>ALSD</td>
<td>17</td>
<td>4</td>
<td>RM</td>
<td>MSB</td>
</tr>
<tr>
<td>2019</td>
<td>Wilson, H.</td>
<td>M</td>
<td>FB</td>
<td>11</td>
<td>ALSD</td>
<td>17</td>
<td>1</td>
<td>ST</td>
<td>JET</td>
</tr>
<tr>
<td>2044</td>
<td>Williams, A.</td>
<td>M</td>
<td>FB</td>
<td>12</td>
<td>ALSD</td>
<td>18</td>
<td>3</td>
<td>ST</td>
<td>JET</td>
</tr>
<tr>
<td>2047</td>
<td>Lowell, S.</td>
<td>F</td>
<td>FB</td>
<td>12</td>
<td>ALSD</td>
<td>19</td>
<td>4</td>
<td>RM</td>
<td>JET</td>
</tr>
<tr>
<td>2057</td>
<td>Sun, T.</td>
<td>F</td>
<td>FB</td>
<td>10</td>
<td>ALSD</td>
<td>16</td>
<td>2</td>
<td>CP</td>
<td>MSB</td>
</tr>
<tr>
<td>2069</td>
<td>Smith, P.</td>
<td>M</td>
<td>FB</td>
<td>11</td>
<td>ALSD</td>
<td>18</td>
<td>4</td>
<td>CP</td>
<td>JET</td>
</tr>
<tr>
<td>2087</td>
<td>Eaton, A.</td>
<td>F</td>
<td>FB</td>
<td>10</td>
<td>ALSD</td>
<td>15</td>
<td>4</td>
<td>ST</td>
<td>MSB</td>
</tr>
<tr>
<td>2097</td>
<td>Albert, B.</td>
<td>M</td>
<td>FB</td>
<td>9</td>
<td>ALSD</td>
<td>15</td>
<td>1</td>
<td>CP</td>
<td>JET</td>
</tr>
<tr>
<td>2099</td>
<td>Williams, M.</td>
<td>F</td>
<td>FB</td>
<td>10</td>
<td>ALSD</td>
<td>17</td>
<td>2</td>
<td>CP</td>
<td>JET</td>
</tr>
<tr>
<td>2132</td>
<td>Fristoe, E.</td>
<td>F</td>
<td>FB</td>
<td>9</td>
<td>ALSD</td>
<td>16</td>
<td>3</td>
<td>ST</td>
<td>JET</td>
</tr>
<tr>
<td>2259</td>
<td>Miller, J.</td>
<td>F</td>
<td>FB</td>
<td>10</td>
<td>ALSD</td>
<td>16</td>
<td>4</td>
<td>CP</td>
<td>JET</td>
</tr>
<tr>
<td>2285</td>
<td>Lee, J.</td>
<td>M</td>
<td>FB</td>
<td>11</td>
<td>ALSD</td>
<td>17</td>
<td>3</td>
<td>ST</td>
<td>MSB</td>
</tr>
<tr>
<td>2394</td>
<td>Bulbelle, M.</td>
<td>M</td>
<td>FB</td>
<td>10</td>
<td>ALSD</td>
<td>15</td>
<td>2</td>
<td>RM</td>
<td>MSB</td>
</tr>
<tr>
<td>2399</td>
<td>Yee, C.</td>
<td>F</td>
<td>FB</td>
<td>12</td>
<td>ALSD</td>
<td>18</td>
<td>1</td>
<td>ST</td>
<td>MSB</td>
</tr>
<tr>
<td>2947</td>
<td>Pina, J.</td>
<td>M</td>
<td>FB</td>
<td>11</td>
<td>ALSD</td>
<td>16</td>
<td>1</td>
<td>RM</td>
<td>MSB</td>
</tr>
<tr>
<td>3011</td>
<td>Martinez, O.</td>
<td>M</td>
<td>CN</td>
<td>11</td>
<td>ALSD</td>
<td>18</td>
<td>2</td>
<td>ST</td>
<td>JET</td>
</tr>
<tr>
<td>3034</td>
<td>Dawkins, W.</td>
<td>M</td>
<td>CN</td>
<td>12</td>
<td>ALSD</td>
<td>19</td>
<td>1</td>
<td>CP</td>
<td>JET</td>
</tr>
<tr>
<td>3040</td>
<td>Rogers, W.</td>
<td>F</td>
<td>CN</td>
<td>9</td>
<td>ALSD</td>
<td>16</td>
<td>2</td>
<td>ST</td>
<td>JET</td>
</tr>
<tr>
<td>3045</td>
<td>Marks, J.</td>
<td>M</td>
<td>CN</td>
<td>10</td>
<td>ALSD</td>
<td>17</td>
<td>4</td>
<td>CP</td>
<td>MSB</td>
</tr>
<tr>
<td>3067</td>
<td>Black, J.</td>
<td>F</td>
<td>CN</td>
<td>9</td>
<td>ALSD</td>
<td>15</td>
<td>3</td>
<td>CP</td>
<td>MSB</td>
</tr>
<tr>
<td>3077</td>
<td>Leventhal, E.</td>
<td>F</td>
<td>CN</td>
<td>10</td>
<td>ALSD</td>
<td>16</td>
<td>3</td>
<td>RM</td>
<td>MSB</td>
</tr>
<tr>
<td>3207</td>
<td>Garcia, M.</td>
<td>F</td>
<td>CN</td>
<td>11</td>
<td>ALSD</td>
<td>17</td>
<td>1</td>
<td>RM</td>
<td>JET</td>
</tr>
<tr>
<td>3243</td>
<td>Segi, J.</td>
<td>M</td>
<td>CN</td>
<td>10</td>
<td>ALSD</td>
<td>15</td>
<td>4</td>
<td>RM</td>
<td>JET</td>
</tr>
<tr>
<td>3285</td>
<td>Yen, A.</td>
<td>M</td>
<td>CN</td>
<td>10</td>
<td>ALSD</td>
<td>17</td>
<td>2</td>
<td>ST</td>
<td>MSB</td>
</tr>
<tr>
<td>3347</td>
<td>Backon, B.</td>
<td>F</td>
<td>CN</td>
<td>11</td>
<td>ALSD</td>
<td>16</td>
<td>4</td>
<td>ST</td>
<td>JET</td>
</tr>
<tr>
<td>3357</td>
<td>Kudina, H.</td>
<td>M</td>
<td>CN</td>
<td>12</td>
<td>ALSD</td>
<td>18</td>
<td>3</td>
<td>RM</td>
<td>MSB</td>
</tr>
<tr>
<td>3357</td>
<td>Sardina, D.</td>
<td>M</td>
<td>CN</td>
<td>12</td>
<td>ALSD</td>
<td>17</td>
<td>3</td>
<td>RM</td>
<td>JET</td>
</tr>
<tr>
<td>3577</td>
<td>Harrison, M.</td>
<td>F</td>
<td>CN</td>
<td>9</td>
<td>ALSD</td>
<td>16</td>
<td>1</td>
<td>CP</td>
<td>MSB</td>
</tr>
<tr>
<td>3779</td>
<td>Harrison, B.</td>
<td>F</td>
<td>CN</td>
<td>11</td>
<td>ALSD</td>
<td>16</td>
<td>2</td>
<td>RM</td>
<td>JET</td>
</tr>
<tr>
<td>3879</td>
<td>Tanaka, R.</td>
<td>F</td>
<td>EH</td>
<td>9</td>
<td>CJJD</td>
<td>14</td>
<td>1</td>
<td>CP</td>
<td>LSP</td>
</tr>
</tbody>
</table>

Figure 143: Student Listing Report
This appendix contains setup and operation notes for various optical mark reader devices currently supported by LXR•TEST. Refer to our web site at www.lxr.com for the most recent information concerning supported optical mark readers.

CAUTION! Before changing any reader switch setting, please ensure that the reader's power switch is turned OFF or that the reader is unplugged. The settings provided here are intended only as a convenience, you should ALWAYS refer to and give preference to the instructions provided with your reader hardware.
Chatsworth 1000

Hardware Setup

There are 4 DIP switches inside the reader. Set them as follows (listed from left to right):

<table>
<thead>
<tr>
<th>Position</th>
<th>Label</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 = UP</td>
<td>(On)</td>
<td>Binary mode</td>
</tr>
<tr>
<td>2 = UP</td>
<td>(On)</td>
<td>Baud Rate = 9600</td>
</tr>
<tr>
<td>3 = UP</td>
<td>(On)</td>
<td>Baud Rate = 9600</td>
</tr>
<tr>
<td>4 = UP</td>
<td>(On)</td>
<td>Baud Rate = 9600</td>
</tr>
</tbody>
</table>

Operation Notes

For the Chatsworth 1000, the user must manually feed each form into the reader. Begin feeding forms into the reader immediately after choosing the “Read Response Forms” menu option while “Looking for Reader” message is displayed. Feed each form separately into the reader with the side to be read face up. The program will automatically terminate approximately 30 seconds after the last form is read or you may signal the reader that the last form has been read by clicking “Cancel”.

As soon as the “Read Response Forms” menu option is selected, the forms will begin being read. After the last form is read with this reader, it will signal the program and automatically terminate the read process. The white lamp of the “Card Feed” button will begin flashing, which indicates the last card has been fed.
LXR•TEST Software Setup

Under Reader and Form Setup (Reader menu), select the Reader Setup tab to choose your reader and to configure LXR•TEST to properly communicate with your reader. Select the Form Setup tab to select your form and to configure LXR•TEST to properly read your form. Refer to Chapter 10: “Mark Reader Installation” on stepping through the Reader and Form set up process.

The reader sensitivity control is not used with this reader. In the Reader Setup tab, start with the settings as follows (unless your hardware manual or current configuration is different):

Table 3: Chatsworth 1000 Communications Settings

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port</td>
<td>COM1</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9,600</td>
</tr>
<tr>
<td>Data Bits</td>
<td>7</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Parity</td>
<td>Even</td>
</tr>
<tr>
<td>Minimum Read Level</td>
<td>N/A</td>
</tr>
<tr>
<td>Mark Difference</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Chatsworth 2000

Hardware Setup

There are 4 DIP switches inside the reader. Set them as follows (listed from left to right):

**Table 4: Chatsworth 2000 Top Switch Bank Settings**

<table>
<thead>
<tr>
<th>Position</th>
<th>Label</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 = Left</td>
<td>(0)</td>
<td>Feed Char = 17</td>
</tr>
<tr>
<td>6 = Left</td>
<td>(0)</td>
<td>Feed Char = 17</td>
</tr>
<tr>
<td>5 = Right</td>
<td>(1)</td>
<td>Feed Char = 17</td>
</tr>
<tr>
<td>4 = Left</td>
<td>(0)</td>
<td>Feed Char = 17</td>
</tr>
<tr>
<td>3 = Left</td>
<td>(0)</td>
<td>Feed Char = 17</td>
</tr>
<tr>
<td>2 = Left</td>
<td>(0)</td>
<td>Feed Char = 17</td>
</tr>
<tr>
<td>1 = Right</td>
<td>(1)</td>
<td>Feed Char = 17</td>
</tr>
</tbody>
</table>

**Table 5: Chatsworth 2000 Bottom Switch Bank Settings**

<table>
<thead>
<tr>
<th>Position</th>
<th>Label</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 = Right</td>
<td>(Off)</td>
<td>Continuous feed = Off</td>
</tr>
<tr>
<td>6 = Left</td>
<td>(On)</td>
<td>Binary Mode = On</td>
</tr>
<tr>
<td>5 = Left</td>
<td>(Off)</td>
<td>Line Feed = Off</td>
</tr>
<tr>
<td>4 = Left</td>
<td>(1)</td>
<td>Stop Bits = 1</td>
</tr>
<tr>
<td>3 = Left</td>
<td>(0)</td>
<td>Baud Rate = 9600</td>
</tr>
<tr>
<td>2 = Left</td>
<td>(0)</td>
<td>Baud Rate = 9600</td>
</tr>
<tr>
<td>1 = Left</td>
<td>(0)</td>
<td>Baud Rate = 9600</td>
</tr>
</tbody>
</table>

**Operation Notes**

For the Chatsworth 2000, place the forms to be read into the hopper face up. Ensure the “Power” button/indicator is illuminated (Green) and the “Card Feed” button/indicator is depressed and illuminated (White) indicating the cards are ready to be fed. If the “Card Feed” lamp is flashing, depress it to release it, then depress it again until it remains illuminated, but not flashing.
As soon as the “Read Response Forms” menu option is selected, the forms will begin being read. After the last form is read with this reader, it will signal the program and automatically terminate the read process. The white lamp of the “Card Feed” button will begin flashing, which indicates the last card has been fed.

LXR•TEST Software Setup

Under Reader and Form Setup (Reader menu), select the Reader Setup tab to choose your reader and to configure LXR•TEST to properly communicate with your reader. Select the Form Setup tab to select your form and to configure LXR•TEST to properly read your form. Refer to Chapter 10: “Mark Reader Installation” on stepping through the Reader and Form set up process.

The reader sensitivity control is not used with this reader. In the Reader Setup tab, start with the settings as follows (unless your hardware manual or current configuration is different):

<table>
<thead>
<tr>
<th>Table 6: Chatsworth 2000 Communications Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Minimum Read Level</td>
</tr>
<tr>
<td>Mark Difference</td>
</tr>
</tbody>
</table>
National Computer Systems Sentry 3000

Hardware Setup

This reader is programmed by scanning a special configuration sheet supplied with the reader which contains the communications setting and data transmission protocol. Program the reader using the Sentry 3000 Asynchronous Communications Configurator Sheet with settings as indicated below:

Table 7: NCS Sentry 3000 Configuration Sheet Settings

<table>
<thead>
<tr>
<th>Label</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start of Record</td>
<td>Leave blank</td>
</tr>
<tr>
<td>End of Record</td>
<td>0D0A</td>
</tr>
<tr>
<td>End of Document</td>
<td>Leave blank</td>
</tr>
<tr>
<td>Compress</td>
<td>15</td>
</tr>
<tr>
<td>Record length</td>
<td>Leave blank</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>2</td>
</tr>
<tr>
<td>Character Bit Length</td>
<td>7</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Check Character</td>
<td>Leave blank</td>
</tr>
<tr>
<td>Aux Port Echo</td>
<td>Leave blank</td>
</tr>
<tr>
<td>Init Code</td>
<td>11 (also mark &quot;CPU&quot; but leave &quot;SCAN&quot; unmarked)</td>
</tr>
<tr>
<td>Positive Response</td>
<td>11</td>
</tr>
<tr>
<td>Release Document</td>
<td>12</td>
</tr>
<tr>
<td>Negative Response</td>
<td>1A</td>
</tr>
<tr>
<td>Select Aux Port</td>
<td>13</td>
</tr>
<tr>
<td>Select Scanner (host)</td>
<td>14</td>
</tr>
<tr>
<td>Select Scanner (aux)</td>
<td>OD</td>
</tr>
<tr>
<td>Stop Scanner</td>
<td>OE</td>
</tr>
<tr>
<td>Print Position</td>
<td>31</td>
</tr>
<tr>
<td>Print Data Code</td>
<td>32</td>
</tr>
<tr>
<td>Aux Port Data Code</td>
<td>19</td>
</tr>
<tr>
<td>Digit Data Code</td>
<td>07</td>
</tr>
<tr>
<td>End of Info</td>
<td>04</td>
</tr>
<tr>
<td>Checksum</td>
<td>7</td>
</tr>
</tbody>
</table>
**Operation Notes**

When using the NCS 3000 with LXR•TEST, only the “communications” mode of the scanner is used. The display value on the reader should indicate “.c” if the reader is in communications mode. If “.c” is not displayed, press the SELECT button until “.c” is shown, then press the START button. The reader can be configured so the communications mode is always enabled at start-up.

Make sure the reader is connected to the computer and powered on before choosing “Read Response Forms” so LXR•TEST can program the reader. If the reader is powered off while reading forms, the programming commands sent to the reader are lost and the read cycle must be restarted by choosing “Read Response Forms” again.

If an automatic feed is used, fill the hopper with the forms before using the “Read Response Forms” menu item. If manual feed is used choose “Read Response Forms” from the Reader menu and then begin feeding the forms into the reader as soon as the “looking for Reader” message appears. (If the feed motor is not running, the first form must be fed into the input chute far enough to activate the microswitch which informs the reader a form is waiting to be read. The feed motor should grab the next sheet without needing to force the form into the reader to activate the switch.)

Forms are loaded so that they enter the reader with the side to be read face-up and the timing marks on the forms are aligned as shown on the reader tray diagram.

This reader does not notify the program after the last form is read. You can wait until the time limit for the next form expires (about 20 seconds) or you can click Cancel to signal the program that reading is complete.

Because this scanner reads through the form, any stray marks on one side of the form can affect the mark interpretation of the opposite side. Forms for the NCS 3000 readers are specially printed so that no response field overlaps a response area on the reverse side. If mis-marks show up, verify that a mark on the other side is not the cause of the problem.
LXR•TEST Software Setup

Under Reader and Form Setup (Reader menu), select the Reader Setup tab to choose your reader and to configure LXR•TEST to properly communicate with your reader. Select the Form Setup tab to select your form and to configure LXR•TEST to properly read your form. Refer to Chapter 10: "Mark Reader Installation" on stepping through the Reader and Form setup process.

In the Reader Setup tab, start with the settings as follows (unless your hardware manual or current configuration is different):

<table>
<thead>
<tr>
<th>Table 8: NCS Sentry 3000 Communications Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Minimum Read Level</td>
</tr>
<tr>
<td>Mark Difference</td>
</tr>
</tbody>
</table>
National Computer Systems Sentry 3051 & Sentry 3061

Hardware Setup

These readers are programmed by scanning a special configuration sheet supplied with the reader which contains the communications settings and data transmission protocol. Fill out the appropriate configuration form as shown below:

Table 9: NCS Sentry 3051 & Sentry 3061 Configuration Sheet Settings

<table>
<thead>
<tr>
<th>Label</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start of Record</td>
<td>Leave blank</td>
</tr>
<tr>
<td>End of Record</td>
<td>0D0A</td>
</tr>
<tr>
<td>End of Document</td>
<td>Leave blank</td>
</tr>
<tr>
<td>Compress</td>
<td>15</td>
</tr>
<tr>
<td>Record length</td>
<td>Leave blank</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>2</td>
</tr>
<tr>
<td>Character Bit Length (Data Bits)</td>
<td>7</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Check Character</td>
<td>Leave blank</td>
</tr>
<tr>
<td>Check Sum (Side 1)</td>
<td>0</td>
</tr>
<tr>
<td>Init Code</td>
<td>11 (also mark &quot;HOST&quot; but leave &quot;SCAN&quot; unmarked)</td>
</tr>
<tr>
<td>Positive Response</td>
<td>11</td>
</tr>
<tr>
<td>Negative Response</td>
<td>1A</td>
</tr>
<tr>
<td>X-OFF</td>
<td>Leave blank</td>
</tr>
<tr>
<td>X-OFF</td>
<td>Leave blank</td>
</tr>
<tr>
<td>Release Document</td>
<td>12</td>
</tr>
<tr>
<td>Stop Scanner</td>
<td>0E</td>
</tr>
<tr>
<td>Status Request</td>
<td>Leave blank</td>
</tr>
<tr>
<td>Print Position</td>
<td>31</td>
</tr>
<tr>
<td>Print Data Code</td>
<td>32</td>
</tr>
<tr>
<td>End of Info</td>
<td>04</td>
</tr>
<tr>
<td>Check Sum (Side 2)</td>
<td>7</td>
</tr>
</tbody>
</table>
If your reader is not already configured as shown above, reconfigure the scanner using the configuration form, following the directions in your scanner’s manual.

**Operation Notes**

Make sure the reader is connected to the computer and powered on before choosing “Read Response Forms.” If the reader is powered off while reading forms, the programming commands sent to the reader are lost and the read cycle must be restarted by choosing “Read Response Forms” again.

If automatic feed is used, fill the hopper with the forms before using the “Read Response Forms” menu item. If manual feed is used, choose “Read Response Forms” from the Reader menu, the press the start button and then begin feeding the forms into the reader. If the feed motor is not running, the first form must be fed into the input chute far enough to activate the micro switch which informs the reader a form is waiting to be read. Now the feed motor should grab the next sheet without you having to activate the switch.

Forms are loaded so that they enter the reader with the side to be read face-up and with the timing marks aligned as shown on the reader tray diagram.

**Note:** These readers do not notify the program after the last form is read. You can either wait until the time limit for the next form expires (about 20 seconds) or you can click Cancel to signal to the program that reading is complete.

Because these scanners read through the form, any stray marks on one side of the form can affect mark interpretation of the opposite side. Forms for these readers are specially printed so that no response area overlaps a response area on the reverse side. If mis-marks show up, hold the form up to the light to see if a mark on the other side is the cause of the problem.
LXR•TEST Software Setup

Under Reader and Form Setup (Reader menu), select the Reader Setup tab to choose your reader and to configure LXR•TEST to properly communicate with your reader. Select the Form Setup tab to select your form and to configure LXR•TEST to properly read your form. Refer to Chapter 10: “Mark Reader Installation” on stepping through the Reader and Form set up process.

In the Reader Setup tab, start with the settings as follows (unless your hardware manual or current configuration is different):

Table 10: NCS Sentry 3051 & Sentry 3061 Communications Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port</td>
<td>COM1</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9,600</td>
</tr>
<tr>
<td>Data Bits</td>
<td>7</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>2</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Minimum Read Level</td>
<td>3</td>
</tr>
<tr>
<td>Mark Difference</td>
<td>2</td>
</tr>
</tbody>
</table>
National Computer Systems OpScan 2, 3, 4, 4XP

Hardware Setup

These readers are programmed from the supplier with the communications setting and data transmission protocol.

If your OpScan reader is not already configured properly, reconfigure the scanner using the configuration settings and instructions below. In most cases, LXR•TEST will be able to work with your reader without any changes.

Plug the reader into the power supply and the power supply into a power source. Turn the reader "ON". The display on the reader should display "Not Ready" on the top line of the display within a few seconds of turning the power "ON". Under the display are 2 buttons. The function of each button corresponds to the text which is displayed on the lower line of the display.

Press and hold both buttons until the display changes to "Background Menu". Release both buttons to set the scanner into setup (Background) mode. Follow each question below to configure the reader. This only needs to be performed one time. For each prompt, press the button corresponding to the text in the Entry column below.

Note: Depending on how your scanner is currently configured, you may not see all of these prompts. Ignore any that do not appear.

Table 11: NCS OpScan 2, 3, 4, 4XP Switch Settings

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ops</td>
<td>Continue</td>
</tr>
<tr>
<td>Sheet Count</td>
<td>Continue</td>
</tr>
<tr>
<td>Utilities</td>
<td>No</td>
</tr>
<tr>
<td>Defaults</td>
<td>Yes</td>
</tr>
<tr>
<td>Display Comm Status</td>
<td>Yes</td>
</tr>
<tr>
<td>Reverse Printing</td>
<td>No</td>
</tr>
<tr>
<td>Image Scan</td>
<td>YES</td>
</tr>
<tr>
<td>3000 Emulation Scan</td>
<td>No</td>
</tr>
<tr>
<td>Aux Port Mode</td>
<td>No</td>
</tr>
<tr>
<td>Scanner Mode</td>
<td>Yes</td>
</tr>
<tr>
<td>Exit Defaults Menu</td>
<td>Yes</td>
</tr>
</tbody>
</table>
This completes the reader configuration. Power the OpScan "OFF" then back "ON".

**Operation Notes**

Make sure the reader is connected to the computer and powered on before choosing “Read Response Forms”, so LXR•TEST can program the reader. If the reader is powered off while reading forms, the programming commands sent to the reader are lost and the read cycle must be restarted by choosing “Read Response Forms” again.

If an automatic feed is used, fill the hopper with the forms before using the “Read Response Forms” menu item. The program will automatically raise the hopper and begin reading forms after the “Read Response Forms” menu is invoked. If manual feed is used, choose “Read Response Forms” from the Reader menu; then begin feeding the forms into the reader.

Forms are loaded so that they enter the reader with the side to be read face-up, and the timing marks on the forms are aligned as shown on the reader tray diagram.

If the reader stops or you reload additional forms during the read cycle, you must manually raise the hopper with the “Start” button.

On manual feed readers, to signal to the reader that the last form is read, you can hold down the reader’s right button until “Send End of Batch?” is displayed; then response “YES”. On auto feed readers, the program can detect when the hopper is empty and will automatically stop.
You can also wait until the time limit for the next form expires (about 20 seconds), or you can click Cancel to signal to the program that reading is complete.

**LXR•TEST Software Setup**

Under Reader and Form Setup (Reader menu), select the Reader Setup tab to choose your reader and to configure LXR•TEST to properly communicate with your reader. Select the Form Setup tab to select your form and to configure LXR•TEST to properly read your form. Refer to Chapter 10: "Mark Reader Installation" on stepping through the Reader and Form set up process.

In the Reader Setup tab, start with the settings as follows (unless your hardware manual or current configuration is different):

<table>
<thead>
<tr>
<th>Table 12: NCS OpScan 2, 3, 4, 4XP Communications Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Minimum Read Level</td>
</tr>
<tr>
<td>Mark Difference</td>
</tr>
</tbody>
</table>

Note: For these OpScan models, a STD Communications Card needs to be installed on the reader in order for LXR•TEST to be able to communicate with the reader.
National Computer Systems OpScan 5, 6, 7, 8

Hardware Setup

These readers are programmed by scanning a special configuration sheet supplied with the reader which contains the communications setting and data transmission protocol. Program the OpScan reader with the configuration form supplied with your reader.

Table 13: OpScan 5, 6, 7, 8 Programmed Configuration Sheet Settings

<table>
<thead>
<tr>
<th>Label</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start of Record</td>
<td>Leave Blank</td>
</tr>
<tr>
<td>End of Record</td>
<td>ODOA</td>
</tr>
<tr>
<td>End of Document</td>
<td>Leave Blank</td>
</tr>
<tr>
<td>Compress</td>
<td>15</td>
</tr>
<tr>
<td>Record Length</td>
<td>Leave Blank</td>
</tr>
<tr>
<td>Check Character</td>
<td>Leave Blank</td>
</tr>
<tr>
<td>Init Code</td>
<td>11 (also mark &quot;CPU&quot; but leave &quot;SCAN&quot; unmarked)</td>
</tr>
<tr>
<td>Positive Response</td>
<td>11</td>
</tr>
<tr>
<td>Negative Response</td>
<td>1A</td>
</tr>
<tr>
<td>X-ON</td>
<td>Leave Blank</td>
</tr>
<tr>
<td>X-OFF</td>
<td>Leave Blank</td>
</tr>
<tr>
<td>Start</td>
<td>72</td>
</tr>
<tr>
<td>Stop</td>
<td>OE</td>
</tr>
<tr>
<td>Release Document</td>
<td>12</td>
</tr>
<tr>
<td>Select Stacker</td>
<td>Leave Blank</td>
</tr>
<tr>
<td>Download</td>
<td>1C</td>
</tr>
<tr>
<td>Runtime</td>
<td>1D</td>
</tr>
<tr>
<td>Status</td>
<td>73</td>
</tr>
<tr>
<td>Scanner Control</td>
<td>65</td>
</tr>
<tr>
<td>Print Position</td>
<td>31</td>
</tr>
<tr>
<td>Print Data Code</td>
<td>32</td>
</tr>
<tr>
<td>Display Data</td>
<td>07</td>
</tr>
<tr>
<td>End of Info</td>
<td>04</td>
</tr>
<tr>
<td>End of Batch</td>
<td>01</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>2</td>
</tr>
<tr>
<td>Parity</td>
<td>ODD</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
</tbody>
</table>
In most cases, LXR•TEST will be able to work with your reader without making any changes.

*Note: The checksum value may vary depending on which configuration form is used.

The auxiliary port is not used. Leave side 2 blank.

The OpScan should be configured to operate in native OpScan mode, not in 3000 emulation mode. In the “Defaults” menu when the reader is powered on, enter NO to the “3000 Emulation Mode?” prompt, YES to the “Image Mode?” prompt, and SCAN to the “Power-Up Mode?” prompt.

Note: If you must use the OpScan in 3000 emulation, respond to the “3000 Emulation Mode” prompt with YES, and setup the reader as shown under NCS Sentry 3000 instead of using the OpScan 5 setup.

Connect the cable to the reader using the connector labelled MAIN.

Note: After the reader is connected and powered on, if the motor continues to run after the self-test has completed, this usually indicates that the wrong type of cable is being used.

**Operation Notes**

Make sure the reader is connected to the computer and powered on before choosing “Read Response Forms”, so LXR•TEST can program the reader. If the reader is powered off while reading forms, the programming commands sent to the reader are lost and the read cycle must be restarted by choosing “Read Response Forms” again.

If an automatic feed is used, fill the hopper with the forms before using the “Read Response Forms” menu item. The program will automatically raise the hopper and begin reading forms after the “Read Response Forms” menu is invoked. If manual feed is used, choose “Read Response Forms” from the Reader menu; then begin feeding the forms into the reader.

Forms are loaded so that they enter the reader with the side to be read face-up, and the timing marks on the forms are aligned as shown on the reader tray diagram.

If the reader stops or you reload additional forms during the read cycle, you must manually raise the hopper with the “Start” button.
Although these OpScan readers use 48 channel forms, only 47 channels are actually read. Some forms are designed with response fields in all 48 channels and those forms cannot be read on these readers.

**LXR•TEST Software Setup**

Under Reader and Form Setup (Reader menu), select the Reader Setup tab to choose your reader and to configure LXR•TEST to properly communicate with your reader. Select the Form Setup tab to select your form and to configure LXR•TEST to properly read your form. Refer to Chapter 10: "Mark Reader Installation" on stepping through the Reader and Form set up process.

In the Reader Setup tab, start with the settings as follows (unless your hardware manual or current configuration is different):

*Table 14: NCS OpScan 5, 6, 7, 8 Communications Settings*

<table>
<thead>
<tr>
<th>Com Port</th>
<th>COM1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud Rate</td>
<td>38,400</td>
</tr>
<tr>
<td>Data Bits</td>
<td>7</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>2</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Minimum Read Level</td>
<td>5</td>
</tr>
<tr>
<td>Mark Difference</td>
<td>3</td>
</tr>
</tbody>
</table>
Scanning Systems SR-360 & SR-360V

Hardware Setup

There are eight DIP switches and one rotary switch on the reader.

Set the DIP switches as follows (listed from top to bottom):

<table>
<thead>
<tr>
<th>Position</th>
<th>Label</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 = Left</td>
<td>(On)</td>
<td>Character bit length = 7</td>
</tr>
<tr>
<td>2 = Left</td>
<td>(On)</td>
<td>Parity = None</td>
</tr>
<tr>
<td>3 = Left</td>
<td>(On)</td>
<td>Parity</td>
</tr>
<tr>
<td>4 = Left</td>
<td>(On)</td>
<td>Stop Bits = 1</td>
</tr>
<tr>
<td>5 = Right</td>
<td>(Off)</td>
<td>Control codes ignored = Yes</td>
</tr>
<tr>
<td>6 = Right</td>
<td>(Off)</td>
<td>STX ignored = No</td>
</tr>
<tr>
<td>7 = Right</td>
<td>(Off)</td>
<td>Not used</td>
</tr>
<tr>
<td>8 = Right</td>
<td>(Off)</td>
<td>Not used</td>
</tr>
</tbody>
</table>

The SR-360V is equipped with ink read heads. Otherwise, the two readers are identical. Readers with ink heads will have a label near the serial number indicating “Visual Light Head.”

Operation Notes

Ensure the forms are loaded in the hopper with the side to be read face-up and the timing marks on the forms are aligned as shown on the reader tray diagram.

Set the Hopper Release Lever to the “feed” position to secure the forms.

Make sure the reader is connected to the computer and powered on before choosing “Read Response Forms”, so LXR•TEST can program the reader. If the reader is powered off while reading forms, the programming sent to the reader is lost and the read cycle must be restarted by choosing “Read Response Forms” menu again.

This reader will automatically notify the program after the last form is read to terminate the read process.
The ability to automatically negotiate the communications settings is not supported on these readers. You must ensure the communications settings entered in the Reader Setup match those of the reader. If you attempt to communicate with these readers using incorrect communications settings, the reader may lock-up. In such case, either press the Reset button or power off the reader to unlock the reader.

**LXR•TEST Software Setup**

Under Reader and Form Setup (Reader menu), select the Reader Setup tab to choose your reader and to configure LXR•TEST to properly communicate with your reader. Select the Form Setup tab to select your form and to configure LXR•TEST to properly read your form. Refer to Chapter 10: “Mark Reader Installation” on stepping through the Reader and Form set up process.

Note: Special considerations are necessary if you choose to use a multi-sided form with a single-sided reader. See the section “Special Form Considerations” in the Mark Reader Reference chapter.

In the Reader Setup tab, start with the settings as follows (unless your hardware manual or current configuration is different):

<table>
<thead>
<tr>
<th>Table 16: SR-360/ SR-360V Communications Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Minimum Read Level</td>
</tr>
<tr>
<td>Mark Difference</td>
</tr>
</tbody>
</table>
Scanning Systems SR-380 & SR-380V

Hardware Setup

There are eight DIP switches and one rotary switch on the reader.

Set the DIP switches as follows (listed from top to bottom):

<table>
<thead>
<tr>
<th>Position</th>
<th>Label</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 = Right (Off)</td>
<td></td>
<td>Character bit length = 7</td>
</tr>
<tr>
<td>2 = Left (On)</td>
<td></td>
<td>Parity = None</td>
</tr>
<tr>
<td>3 = Right (Off)</td>
<td></td>
<td>Parity</td>
</tr>
<tr>
<td>4 = Right (Off)</td>
<td></td>
<td>Stop Bits = 2</td>
</tr>
<tr>
<td>5 = Right (Off)</td>
<td></td>
<td>Not used</td>
</tr>
<tr>
<td>6 = Left (On)</td>
<td></td>
<td>380 Mode</td>
</tr>
<tr>
<td>7 = Right (Off)</td>
<td></td>
<td>Not used</td>
</tr>
<tr>
<td>8 = Right (Off)</td>
<td></td>
<td>Command mode = A</td>
</tr>
</tbody>
</table>

Rotary Switch  
Set the rotary switch so the arrow points to the letter “E” (9600 baud rate).

The SR-380V is equipped with ink read heads. Otherwise, the two readers are identical. Readers with ink heads will have a label near the serial number indicating “Visual Light Head.”

Operation Notes

Ensure the forms are loaded in the hopper with the side to be read face-up and the timing marks on the forms are aligned as shown on the reader tray diagram.

Set the Hopper Release Lever to the “feed” position to secure the forms.

Make sure the reader is connected to the computer and powered on before choosing “Read Response Forms”, so LXR•TEST can program the reader. If the reader is powered off while reading forms, the programming sent to the reader is lost and the read cycle must be restarted by choosing “Read Response Forms” menu again.

This reader will automatically notify the program after the last form is read to terminate the read process.
The ability to automatically negotiate the communications settings is not supported on these readers. You must ensure the communications settings entered in the Reader Setup match those of the reader. If you attempt to communicate with these readers using incorrect communications settings, the reader may lock-up. In such case, either press the Reset button or power off the reader to unlock the reader.

LXR•TEST Software Setup

Under Reader and Form Setup (Reader menu), select the Reader Setup tab to choose your reader and to configure LXR•TEST to properly communicate with your reader. Select the Form Setup tab to select your form and to configure LXR•TEST to properly read your form. Refer to Chapter 10: “Mark Reader Installation” on stepping through the Reader and Form set up process.

In the Reader Setup tab, start with the settings as follows (unless your hardware manual or current configuration is different):

Table 18: SR-380/SR-380V Communications Settings

<table>
<thead>
<tr>
<th></th>
<th>COM1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port</td>
<td>COM1</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9,600</td>
</tr>
<tr>
<td>Data Bits</td>
<td>7</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>2</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Minimum Read Level</td>
<td>1</td>
</tr>
<tr>
<td>Mark Difference</td>
<td>0</td>
</tr>
</tbody>
</table>
Scanning Systems SR-601

Hardware Setup

The SR-601 is supported in the default SR-360 mode as shipped from the factory, and also in native SR-600 mode. SR-360 mode is useful if you have other software that requires SR-360 reader compatibility. Native SR-600 mode can utilize the more advanced features of the reader not available in the SR-360 mode. **Native SR-600 is the recommended mode.** Depending on the mode you will be using, set up the reader to match the mode selected.

3 sets of DIP switches and 1 rotary switch control the communications settings and operating mode. Only the switches on switch panel 3 will vary between SR-360 and SR-600 modes.

**ROTARY Switch** (applies to both SR-360 and SR-600 modes): The arrow points to E for 9600 baud (factory default) setting, or F for 19200 baud.

**DIP Switch 1** (applies to both SR-360 and SR-600 modes):

<table>
<thead>
<tr>
<th>Switch Control</th>
<th>Position</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1 Character bits</td>
<td>Off</td>
<td>7</td>
</tr>
<tr>
<td>1-2 Parity</td>
<td>On</td>
<td>No</td>
</tr>
<tr>
<td>1-3 Parity (if active)</td>
<td>Off</td>
<td>Even</td>
</tr>
<tr>
<td>1-4 Stop bits</td>
<td>Off</td>
<td>2</td>
</tr>
<tr>
<td>1-5 Control Codes</td>
<td>On</td>
<td>No</td>
</tr>
<tr>
<td>1-6 Dual heads</td>
<td>Off</td>
<td>No</td>
</tr>
<tr>
<td>1-7 Command Set B</td>
<td>On</td>
<td>Default</td>
</tr>
<tr>
<td>1-8 Handshaking</td>
<td>Off</td>
<td>RTS/CTS</td>
</tr>
</tbody>
</table>

**DIP Switch 2** (applies to both SR-360 and SR-600 modes): Factory sealed – do not change.

**DIP Switch 3** (for **SR-360** mode only):

<table>
<thead>
<tr>
<th>Switch Control</th>
<th>Position</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-1 Operating Mode</td>
<td>Off</td>
<td>SR-360</td>
</tr>
<tr>
<td>3-2 Operating Mode</td>
<td>Off</td>
<td>SR-360</td>
</tr>
<tr>
<td>3-3 Operating Mode</td>
<td>Off</td>
<td>SR-360</td>
</tr>
<tr>
<td>3-3 Skew Detection</td>
<td>On</td>
<td>Enabled</td>
</tr>
</tbody>
</table>
DIP Switch 3 (for SR-600 mode only):

<table>
<thead>
<tr>
<th>Switch Control</th>
<th>Position</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-1 Operating Mode</td>
<td>On</td>
<td>SR-600</td>
</tr>
<tr>
<td>3-2 Operating Mode</td>
<td>On</td>
<td>SR-600</td>
</tr>
<tr>
<td>3-3 Operating Mode</td>
<td>Off</td>
<td>SR-600</td>
</tr>
<tr>
<td>3-3 Skew Detection</td>
<td>On</td>
<td>Enabled</td>
</tr>
</tbody>
</table>

After making any changes to the reader’s switch settings, either power the reader on or press the RESET button to activate the new settings.

The connection from the computer’s serial port goes to the connector labeled HOST on the reader.

LXR•TEST Software Setup

If the reader is being used in SR-360 mode, choose the reader name in the Reader Setup dialog of “SR-601 (360 mode)”. If native SR-600 mode is being used, choose the reader name of “SR-601”.

In the Reader Setup tab, start with the settings as follows unless your hardware manual or current configuration is different:

<table>
<thead>
<tr>
<th>Table 19: SR-601 Communications Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Minimum Read Level</td>
</tr>
<tr>
<td>Mark Difference</td>
</tr>
</tbody>
</table>

Note: *Use baud rate of 19200 if ROTARY Switch is set to position F for better performance. ** If using native SR-600 mode, the minimum read level and mark difference values will be higher since there are 16 levels of sensitivity in this mode.

LXR•TEST supports automatic negotiation of the communication settings for the SR-601 reader using the Test Current Settings button. In addition to determining the communications settings, this can detect the presence of dual heads, ink read heads, automatic feeder, and printer options and will indicate the presence of these options in the Reader Setup dialog.
Scanning Systems SR-607

Hardware Setup

The SR-607 is supported in the default SR-380 mode as shipped from the factory, and also in native SR-600 mode. SR-380 mode is useful if you have other software that requires SR-380 reader compatibility. Native SR-600 mode can utilize the more advanced features of the reader not available in the SR-380 mode. **Native SR-600 is the recommended mode.** Depending on the mode you will be using, setup the reader to match the mode selected.

3 sets of DIP switches and 1 rotary switch control the communications settings and operating mode. Only the switches on switch panel 3 will vary between SR-380 and SR-600 modes.

**ROTARY Switch** (applies to both SR-380 and SR-600 modes): The arrow points to E for 9600 baud (factory default) setting, or F for 19200 baud

**DIP Switch 1** (applies to both SR-380 and SR-600 modes):

<table>
<thead>
<tr>
<th>Switch Control</th>
<th>Position</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1 Character bits</td>
<td>Off</td>
<td>7</td>
</tr>
<tr>
<td>1-2 Parity</td>
<td>On</td>
<td>No</td>
</tr>
<tr>
<td>1-3 Parity (if active)</td>
<td>Off</td>
<td>Even</td>
</tr>
<tr>
<td>1-4 Stop bits</td>
<td>Off</td>
<td>2</td>
</tr>
<tr>
<td>1-5 Control Codes</td>
<td>On</td>
<td>No</td>
</tr>
<tr>
<td>1-6 Dual heads</td>
<td>On</td>
<td>Yes</td>
</tr>
<tr>
<td>1-7 Command Set B</td>
<td>On</td>
<td>Default</td>
</tr>
<tr>
<td>1-8 Handshaking</td>
<td>Off</td>
<td>RTS/CTS</td>
</tr>
</tbody>
</table>

**DIP Switch 2** (applies to both SR-380 and SR-600 modes): Factory sealed – do not change.

**DIP Switch 3** (for **SR-380** mode only):

<table>
<thead>
<tr>
<th>Switch Control</th>
<th>Position</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-1 Operating Mode</td>
<td>On</td>
<td>SR-380</td>
</tr>
<tr>
<td>3-2 Operating Mode</td>
<td>Off</td>
<td>SR-380</td>
</tr>
<tr>
<td>3-3 Operating Mode</td>
<td>Off</td>
<td>SR-380</td>
</tr>
<tr>
<td>3-3 Skew Detection</td>
<td>On</td>
<td>Enabled</td>
</tr>
</tbody>
</table>
### DIP Switch 3 (for SR-600 mode only):

<table>
<thead>
<tr>
<th>Switch Control</th>
<th>Position</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-1 Operating Mode</td>
<td>On</td>
<td>SR-600</td>
</tr>
<tr>
<td>3-2 Operating Mode</td>
<td>On</td>
<td>SR-600</td>
</tr>
<tr>
<td>3-3 Operating Mode</td>
<td>Off</td>
<td>SR-600</td>
</tr>
<tr>
<td>3-3 Skew Detection On</td>
<td>On</td>
<td>Enabled</td>
</tr>
</tbody>
</table>

After making any changes to the reader’s switch settings, either power the reader on or press the RESET button to activate the new settings.

The connection from the computer’s serial port goes to the connector labeled HOST on the reader.

### LXR•TEST Software Setup

If the reader is being used in SR-380 mode, choose the reader name in the Reader Setup dialog of “SR-607 (380 mode)”. If native SR-600 mode is being used, choose the reader name of “SR-607”.

In the Reader Setup tab, start with the settings as follows unless your hardware manual or current configuration is different):

#### Table 20: SR-607 Communications Settings

<table>
<thead>
<tr>
<th>Com Port</th>
<th>COM1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud Rate</td>
<td>9,600*</td>
</tr>
<tr>
<td>Data Bits</td>
<td>7</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>2</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Minimum Read Level</td>
<td>1**</td>
</tr>
<tr>
<td>Mark Difference</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Note:  
*Use baud rate of 19200 if ROTARY Switch is set to position F for better performance.  
** If using native SR-600 mode, the minimum read level and mark difference values will be higher since there are 16 levels of sensitivity in this mode.

LXR•TEST supports automatic negotiation of the communication settings for the SR-607 reader using the Test Current Settings button. In addition to determining the communications settings, this can detect the presence of dual heads, ink read heads, automatic feeder, and printer options and will indicate the presence of these options in the Reader Setup dialog.
Scanning Systems SR-700

Hardware Setup

The SR-700 is supported in the native SR-700 mode as shipped from the factory, and also in SR-360 emulation mode for a single-head reader; SR-380 emulation mode for dual head readers. SR-360/380 mode is useful if you have other software that requires SR-360/380 reader compatibility. **Native SR-700 mode** can utilize the more advanced features of the reader not available in the emulation modes and is the recommended mode. Depending on the mode you will be using, setup the reader to match the mode selected.

3 sets of DIP switches and 1 rotary switch control the communications settings and operating mode.

**ROTARY Switch** (applies to all modes): The arrow points to E for 9600 baud (factory default) setting, F for 19200 baud, or 0 (zero) for 38400 baud.

**DIP Switch 1** (applies to both SR-360/380 and SR-700 modes):

<table>
<thead>
<tr>
<th>Switch Control</th>
<th>Position</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1 Character bits</td>
<td>Off</td>
<td>7</td>
</tr>
<tr>
<td>1-2 Parity</td>
<td>On</td>
<td>No</td>
</tr>
<tr>
<td>1-3 Parity (if active)</td>
<td>Off</td>
<td>Even</td>
</tr>
<tr>
<td>1-4 Stop bits</td>
<td>Off</td>
<td>2</td>
</tr>
<tr>
<td>1-5 Control Codes</td>
<td>On</td>
<td>No</td>
</tr>
<tr>
<td>1-6 Dual heads</td>
<td>On*</td>
<td>Yes*</td>
</tr>
<tr>
<td>1-7 Command Set B</td>
<td>On</td>
<td>Default</td>
</tr>
<tr>
<td>1-8 Handshaking</td>
<td>Off</td>
<td>RTS/CTS</td>
</tr>
</tbody>
</table>

**DIP Switch 2** (applies to both SR-360/380 and SR-700 modes): Factory sealed - do not change.

**DIP Switch 3** (for **SR-360** mode on single-head reader):

<table>
<thead>
<tr>
<th>Switch Control</th>
<th>Position</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-1 Operating Mode</td>
<td>Off</td>
<td>SR-360</td>
</tr>
<tr>
<td>3-2 Operating Mode</td>
<td>Off</td>
<td>SR-360</td>
</tr>
<tr>
<td>3-3 Operating Mode</td>
<td>Off</td>
<td>SR-360</td>
</tr>
<tr>
<td>3-3 Skew Detection</td>
<td>On</td>
<td>Enabled</td>
</tr>
</tbody>
</table>
DIP Switch 3 (for SR-380 mode on dual-head reader):

<table>
<thead>
<tr>
<th>Switch Control</th>
<th>Position</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-1 Operating Mode</td>
<td>On</td>
<td>SR-380</td>
</tr>
<tr>
<td>3-2 Operating Mode</td>
<td>Off</td>
<td>SR-380</td>
</tr>
<tr>
<td>3-3 Operating Mode</td>
<td>Off</td>
<td>SR-380</td>
</tr>
<tr>
<td>3-3 Skew Detection</td>
<td>On</td>
<td>Enabled</td>
</tr>
</tbody>
</table>

Note*: Switch 1-6 must be OFF for single-head readers.

Switch 1-6 must be ON for dual-head readers.

DIP Switch 3 (for SR-700 mode on single or dual-head reader):

<table>
<thead>
<tr>
<th>Switch Control</th>
<th>Position</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-1 Operating Mode</td>
<td>On</td>
<td>SR-700</td>
</tr>
<tr>
<td>3-2 Operating Mode</td>
<td>On</td>
<td>SR-700</td>
</tr>
<tr>
<td>3-3 Operating Mode</td>
<td>Off</td>
<td>SR-700</td>
</tr>
<tr>
<td>3-3 Skew Detection</td>
<td>On</td>
<td>Enabled</td>
</tr>
</tbody>
</table>

After making any changes to the reader’s switch settings, either power the reader on or press the RESET button to activate the new settings.

The connection from the computer’s serial port goes to the connector labeled HOST on the reader.
LXR•TEST Software Setup

If the reader is being used in SR-360 mode, choose the reader name in the Reader Setup dialog box of “SR-700 (360 mode)”. If the reader is being used in SR-380 mode, choose the reader name of “SR-700 (380 mode)”. If native SR-700 mode is being used, choose the reader name of “SR-700”.

In the Reader Setup tab, start with the settings as follows unless your hardware manual or current configuration is different:

<table>
<thead>
<tr>
<th>Table 21: SR-700 Communications Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Minimum Read Level</td>
</tr>
<tr>
<td>Mark Difference</td>
</tr>
</tbody>
</table>

Note: *Use baud rate of 38400 if ROTARY Switch is set to position 0 (zero) for better performance.
** If using native SR-700 mode, the minimum read level and mark difference values will be higher since there are 16 levels of sensitivity in this mode.

LXR•TEST supports automatic negotiation of the communication settings for the SR-700 reader using the Test Current Settings button. In addition to determining the communications settings, this can detect the presence of dual heads, ink read heads, automatic feeder, reject stacker and printer options and will indicate the presence of these options in the Reader Setup dialog. The optional reject stacker is supported in SR-700 mode.
Scantron Corporation 1200, 2100, and 5100

Hardware Setup

These models are half-page readers, based upon 25-channel (option 2) spacing, but read only 12-channels – or half of the physical page – per pass. Settings for these models are set internally by banks of DIP switches. The settings are listed below, but the exact location of the corresponding switches within the reader varies from model to model and has changed at times during production. Most of the switch settings are labeled on the circuit boards; you should refer to your manual, your dealer, or your Scantron Representative if you have any questions, or need help making the switch settings. (Some models won’t have all these switches or they may be disabled.) Be sure to remove power to the unit if you open the machine to observe the settings or make any changes. Most of the settings are the factory default settings, so your machine may already be setup correctly.

<table>
<thead>
<tr>
<th>Table 22: Scantron 1200/ 2100/ 5100 Switch Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Location</strong></td>
</tr>
<tr>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Upper Logic Board:</td>
</tr>
<tr>
<td>SW1 1</td>
</tr>
<tr>
<td>SW1 2</td>
</tr>
<tr>
<td>SW2 1 ON</td>
</tr>
<tr>
<td>SW2 2 ON</td>
</tr>
<tr>
<td>SW2 3 ON</td>
</tr>
<tr>
<td>SW2 4 OFF</td>
</tr>
<tr>
<td>SW2 5 OFF</td>
</tr>
<tr>
<td>SW2 6 OFF</td>
</tr>
<tr>
<td>SW2 7 OFF</td>
</tr>
<tr>
<td>SW2 8 OFF</td>
</tr>
<tr>
<td>SW2 9 ON</td>
</tr>
<tr>
<td>SW2 10 ON</td>
</tr>
<tr>
<td>Lower Logic Board:</td>
</tr>
<tr>
<td>2F 1 ON</td>
</tr>
<tr>
<td>2 ON</td>
</tr>
<tr>
<td>3 ON</td>
</tr>
<tr>
<td>3F 1 ON</td>
</tr>
</tbody>
</table>
Operation Notes

Forms are to be loaded so they enter the reader with the side to be read facing out (toward the front), and the timing marks on the forms are on the bottom. Unless your reader has an automatic feeder, only load one form at a time into the form input queue. The form will wait in the input queue until the program instructs the reader to release the form. As each form is read, another can be placed in the input queue.

The three position rocker switch labeled “Standby” or “Aux”, “On”, and “End of Batch” should be in the “On” position to allow forms to be read. The “Online” lamp should be illuminated, and the “Aux” lamp off.

Some readers with scoring features have additional switches. If your reader has a rocker switch labeled “Score Only”, “Score and Transmit”, and “Transmit Only”, place this switch in the “Transmit Only” position so the results are transmitted to the program.

After the last form has been read, press the “End of Batch” switch to indicate to the program the last form has been read to terminate the read process. You can also click Cancel to signal to the program that reading is complete. The “End of Batch” switch is only active when the “Feed Form” lamp is on. If the program continues polling the reader for forms, wait for the “Feed Form” to go on; then press “End of Batch”.

Some forms may require multiple passes through the reader as only one side of the form is read each pass through the reader. Follow the direction on the form for multi-pass forms.
LXR•TEST Software Setup

Under Reader and Form Setup (Reader menu), select the Reader Setup tab to choose your reader and to configure LXR•TEST to properly communicate with your reader. Select the Form Setup tab to select your form and to configure LXR•TEST to properly read your form. Refer to Chapter 10: “Mark Reader Installation” on stepping through the Reader and Form set up process.

The reader sensitivity control is not implemented with these model readers.

In the Reader Setup tab, start with the settings as follows (unless your hardware manual or current configuration is different):

<table>
<thead>
<tr>
<th>Table 23: Scantron 1200/ 2100/ 5100 Communications Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Minimum Read Level</td>
</tr>
<tr>
<td>Mark Difference</td>
</tr>
</tbody>
</table>
Scantron Corporation 1300

Hardware Setup

This is a half-page reader, based upon 25-channel (option 2) spacing, that reads only 12-channels – or half of the physical page – per pass.

This reader is programmed by scanning a special configuration sheet supplied with the reader which contains the communications setting and data transmission protocol. Program the 1300 with the configuration form “Scantron Form 4011-STC: marked in chart below:

<table>
<thead>
<tr>
<th>Table 24: Scantron 1300 Programmed Configuration Sheet Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Label</strong></td>
</tr>
<tr>
<td>Save</td>
</tr>
<tr>
<td>Report</td>
</tr>
<tr>
<td>Mode of Operation</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Bit 8</td>
</tr>
<tr>
<td>Control</td>
</tr>
<tr>
<td>Unlock Reader</td>
</tr>
<tr>
<td>End of Form</td>
</tr>
<tr>
<td>End of Batch</td>
</tr>
<tr>
<td>Clear to Send</td>
</tr>
<tr>
<td>Reply</td>
</tr>
<tr>
<td>Reply Time</td>
</tr>
<tr>
<td>Reply Time-out</td>
</tr>
<tr>
<td>Error Character</td>
</tr>
<tr>
<td>Delete Character</td>
</tr>
<tr>
<td>Command Prefix</td>
</tr>
<tr>
<td>Command Term.</td>
</tr>
<tr>
<td>Delay between Character</td>
</tr>
<tr>
<td>Time Delay</td>
</tr>
<tr>
<td>Protocol</td>
</tr>
<tr>
<td>Block Size</td>
</tr>
<tr>
<td>Last Block Character</td>
</tr>
</tbody>
</table>
Most of the settings are the factory default settings, so your reader may already be set up correctly. Follow the directions in your scanner’s manual to reprogram using the configuration sheet.

### Operation Notes

Forms are to be loaded so they enter the reader with the side to be read facing out (toward the front), and the timing marks on the forms are on the bottom. Unless your reader has an automatic feeder, only load one form at a time into the form input queue. The form will wait in the input queue until the program instructs the reader to release the form. As each form is read, another can be placed in the input queue.

The three position rocker switch labeled “Standby”, “On”, and “End of Batch” should be in the “On” position to allow forms to be read. The “Online” lamp should be illuminated, and the “Aux” lamp off.

Some readers with scoring features have additional switches. If your reader has a rocker switch labeled “Score Only”, “Score and Transmit”, and “Transmit Only”, place this switch in the “Transmit Only” position so the results are transmitted to the program.

After the last form has been read, press the “End of Batch” switch to indicate to the program the last form has been read to terminate the read process. You can also click Cancel to signal to the program that reading is complete. The “End of Batch” switch is only active when the “Feed Form” lamp is on. If the program continues polling the reader for forms, wait for the “Feed Form” to go on; then press “End of Batch”.

Some forms may require multiple passes through the reader as only one side of the form is read each pass through the reader. Follow the direction on the form for multi-pass forms.

### LXR•TEST Software Setup

Under Reader and Form Setup (Reader menu), select the Reader Setup tab to choose your reader and to configure LXR•TEST to properly communicate with your reader. Select the Form Setup tab to select your form and to configure LXR•TEST to properly read your form. Refer to Chapter 10: “Mark Reader Installation” on stepping through the Reader and Form set up process.

The reader sensitivity control is not implemented with this reader.
In the Reader Setup tab, start with the settings as follows (unless your hardware manual or current configuration is different):

**Table 25: Scantron 1300 Communications Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port</td>
<td>COM1</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9,600</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>2</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Minimum Read Level</td>
<td>N/A</td>
</tr>
<tr>
<td>Mark Difference</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Scantron Corporation 1400, 5200, 5200S

Hardware Setup

These models are full-page readers based upon 25-channel (option 2) spacing. Settings for all models are set internally by banks of DIP switches. The settings are listed below, but the exact location of the corresponding switches within the reader varies from model to model and has changed at times during production. Most of the switch settings are labeled on the circuit boards; you should refer to your manual, your dealer, or your Scantron Representative if you have any questions, or need help making the switch settings. (Some models won’t have all these switches or they may be disabled.) Be sure to remove power to the unit if you open the machine to observe the settings or make any changes. Most of the settings are the factory default settings, so your machine may already be setup correctly.

Table 26: Scantron 1400/5200/5200S Switch Settings

<table>
<thead>
<tr>
<th>Location</th>
<th>Switch</th>
<th>Setting</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upper Logic Board:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SW1</td>
<td>1</td>
<td>RS232</td>
<td></td>
</tr>
<tr>
<td>SW1</td>
<td>2</td>
<td>ASYNC</td>
<td></td>
</tr>
<tr>
<td>SW2</td>
<td>1</td>
<td>ON</td>
<td>9600 Baud</td>
</tr>
<tr>
<td>SW2</td>
<td>2</td>
<td>ON</td>
<td>9600 Baud</td>
</tr>
<tr>
<td>SW2</td>
<td>3</td>
<td>ON</td>
<td>9600 Baud</td>
</tr>
<tr>
<td>SW2</td>
<td>4</td>
<td>OFF</td>
<td>9600 Baud</td>
</tr>
<tr>
<td>SW2</td>
<td>5</td>
<td>OFF</td>
<td>2 stop bits</td>
</tr>
<tr>
<td>SW2</td>
<td>6</td>
<td>OFF</td>
<td>Parity enabled</td>
</tr>
<tr>
<td>SW2</td>
<td>7</td>
<td>OFF</td>
<td>Even parity disabled</td>
</tr>
<tr>
<td>SW2</td>
<td>8</td>
<td>OFF</td>
<td>8 bit Word Length (Data Bits)</td>
</tr>
<tr>
<td>SW2</td>
<td>9</td>
<td>ON</td>
<td>Bit 8=0</td>
</tr>
<tr>
<td>SW2</td>
<td>10</td>
<td>ON</td>
<td>Option 2</td>
</tr>
<tr>
<td>Lower Logic Board:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2F</td>
<td>1</td>
<td>ON</td>
<td>Supply DTR signal</td>
</tr>
<tr>
<td>2F</td>
<td>2</td>
<td>ON</td>
<td>Supply CD signal</td>
</tr>
<tr>
<td>3F</td>
<td>1</td>
<td>ON</td>
<td>Supply DSR signal</td>
</tr>
<tr>
<td>3F</td>
<td>2</td>
<td>OFF</td>
<td>End of form = 13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>End of form = 13</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>-----------------</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>ON</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>ON</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>OFF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>OFF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>OFF</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Unlock reader = 17</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ON</td>
</tr>
<tr>
<td>2</td>
<td>OFF</td>
</tr>
<tr>
<td>3</td>
<td>OFF</td>
</tr>
<tr>
<td>4</td>
<td>OFF</td>
</tr>
<tr>
<td>5</td>
<td>ON</td>
</tr>
<tr>
<td>6</td>
<td>OFF</td>
</tr>
<tr>
<td>7</td>
<td>OFF</td>
</tr>
</tbody>
</table>

If your reader is a half-page reader, and has a switch to choose whether to transmit bubbles 1-6, 7-12, or 1-12, set the switches to choose the 1-12 option.

**Operation Notes**

Forms are to be loaded so they enter the reader with the side to be read facing out (toward the front), and the timing marks on the forms are on the bottom. Unless your reader has an automatic feeder, only load one form at a time into the form input queue. The form will wait in the input queue until the program instructs the reader to release the form. As each form is read, another can be placed in the input queue.

The three position rocker switch labeled “Standby”, “On”, and “End of Batch” should be in the “On” position to allow forms to be read. The “Online” lamp should be illuminated, and the “Aux” lamp off.

Some readers with scoring features have additional switches. If your reader has a rocker switch labeled “Score Only”, “Score and Transmit”, and “Transmit Only”, place this switch in the “Transmit Only” position so the results are transmitted to the program.

After the last form has been read, press the “End of Batch” switch to indicate to the program the last form has been read to terminate the read process. You can also click Cancel to signal to the program that reading is complete. The “End of Batch” switch is only active when the “Feed Form” lamp is on. If the program continues polling the reader for forms, wait for the “Feed Form” to go on; then press “End of Batch”.

Some forms may require multiple passes through the reader as only one side of the form is read each pass through the reader. Follow the direction on the form for multi-pass forms.
LXR•TEST Software Setup

Under Reader and Form Setup (Reader menu), select the Reader Setup tab to choose your reader and to configure LXR•TEST to properly communicate with your reader. Select the Form Setup tab to select your form and to configure LXR•TEST to properly read your form. Refer to Chapter 10: "Mark Reader Installation" on stepping through the Reader and Form set up process.

The reader sensitivity control is not implemented with these model readers.

In the Reader Setup tab, start with the settings as follows (unless your hardware manual or current configuration is different):

**Table 27: Scantron 1400/ 5200/ 5200S Communications Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port</td>
<td>COM1</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9,600</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>2</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Minimum Read Level</td>
<td>N/A</td>
</tr>
<tr>
<td>Mark Difference</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Scantron Corporation 8000, 8200, 8400, 8600

Hardware Setup

The 8000 series of readers includes models 8000, 8200, 8400, and 8600. The features available will vary from model to model, but are set up and operate similarly.

These readers are available with either 25-channel (option 2), 40-channel, or 48-channel head spacing. After choosing the correct reader model in the Reader Setup tab and pressing Test Current Settings, the number of channels and heads will be determined. The forms supported for each reader will depend on the number of channels available on the reader. For example, if the reader has 25-channel heads, only 25-channel forms will be listed.

Automatic negotiations of the communications settings is supported on these models. If you need to change the settings of the reader, use the appropriate reader configuration sheet supplied with your reader and follow the instructions in your reader manual. In most cases, LXR•TEST will be able to work with your reader without any changes.

<table>
<thead>
<tr>
<th>Table 28: Scantron 8000 Series Programmed Configuration Sheet Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Word Length</td>
</tr>
<tr>
<td>(Data Bits)</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
<tr>
<td>CTS</td>
</tr>
<tr>
<td>Handshake</td>
</tr>
<tr>
<td>Block Size</td>
</tr>
<tr>
<td>Last Block Character</td>
</tr>
<tr>
<td>ACK Character</td>
</tr>
<tr>
<td>NAK Character</td>
</tr>
<tr>
<td>CMD Prefix</td>
</tr>
<tr>
<td>EOF Character</td>
</tr>
</tbody>
</table>
**Operation Notes**

Make sure the reader is connected to the computer and powered on before choosing “Read Response Forms” so LXR•TEST can program the reader. If the reader is powered off while reading forms, the programming commands sent to the reader are lost and the read cycle must be restarted by choosing “Read Response Forms” again.

Fill the hopper with the forms before using the “Read Response Forms” menu item. Forms are loaded so that they enter the reader with the side to be read face-up and the timing marks on the forms at the bottom.

After each form is read, the message “Feed Form” appears on the reader. If an automatic feeder is used, the forms will be fed into the reader automatically. If manually feeding, load a form so it will be ready to be read any time the “Feed Form” message is displayed on the reader. After the last form has been fed, press the “END” switch to indicate that the last form has been read. After pressing it, the display on the reader should indicate “Ready” and the program should exit the read cycle. The “END” switch is effective only when the “Feed Form” message is displayed in the LCD display. If the “Ready” message does not appear when you press “END,” wait for the “Feed Form” message and then press it again. The reader will also time itself out, after a few seconds, once the last form has been read.

If your reader has only 1 read head and the form has multiple sides, you may be prompted for the side of the form you are about to read. If your reader has 2 read heads, you may be prompted for the side you intend to read if the form does not have unique side identification information on it.

When an 8000 series reader is connected to the PC serial port and is powered on, you may see a message “Framing Error” flickering on the display of the reader. This is normal. As soon as the “Read Response Forms” menu item is selected, the serial port is initialized and the reader should indicate “Ready” and begin reading forms. If this message appears after choosing “Read Response Forms”, then it indicates a mismatch in communication settings between LXR•TEST and the reader.
LXR•TEST Software Setup

Under Reader and Form Setup (Reader menu), select the Reader Setup tab to choose your reader and to configure LXR•TEST to properly communicate with your reader.

In the Reader Setup tab, start with the settings as follows (unless your hardware manual or current configuration is different):

```
<table>
<thead>
<tr>
<th>Com Port</th>
<th>COM1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud Rate</td>
<td>9,600</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>2</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Minimum Read Level</td>
<td>25</td>
</tr>
<tr>
<td>Mark Difference</td>
<td>13</td>
</tr>
</tbody>
</table>
```

Press the Test Current Settings button to verify that the reader is communicating. You should notice the green SEND and RECEIVE lamps flash on the reader. After communications are verified, press Apply to save the reader settings.

Select the Form Setup tab to select your form and to configure LXR•TEST to properly read your form. Refer to Chapter 10: “Mark Reader Installation” on stepping through the Reader and Form set up process.
Scantron Corporation Scanmark 2000, 2010, 2250, 2260, 2500

Hardware Setup

The 2000 series of readers includes Scanmark models 2000, 2010, 2250, 2260, and 2500. The features available will vary from model to model, but are set up and operate similarly.

These readers are available with either 25-channel (option 2), 40-channel, or 48-channel head spacing. After choosing the correct reader model in the Reader Setup tab and pressing Test Current Settings, the number of channels and heads will be determined. The forms supported for each reader will depend on the number of channels available on the reader. For example, if the reader has 25-channel heads, only 25-channel forms will be listed.

Automatic negotiations of the communications settings is supported on these models. If you need to change the settings of the reader, use the appropriate reader configuration sheet supplied with your reader and follow the instructions in your reader manual. In most cases, LXR•TEST will be able to work with your reader without any changes.

Table 30: Scantron 2000 Series Programmed Configuration Sheet Settings

<table>
<thead>
<tr>
<th>Label</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud Rate</td>
<td>9,600</td>
</tr>
<tr>
<td>Word Length (Data Bits)</td>
<td>8</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>2</td>
</tr>
<tr>
<td>CTS</td>
<td>OFF</td>
</tr>
<tr>
<td>Handshake</td>
<td>NONE</td>
</tr>
<tr>
<td>Block Size</td>
<td>Leave blank</td>
</tr>
<tr>
<td>Last Block Character</td>
<td>Leave blank</td>
</tr>
<tr>
<td>ACK Character</td>
<td>Leave blank</td>
</tr>
<tr>
<td>NAK Character</td>
<td>Leave blank</td>
</tr>
<tr>
<td>CMD Prefix</td>
<td>027</td>
</tr>
<tr>
<td>EOF Character</td>
<td>013</td>
</tr>
</tbody>
</table>
Operation Notes

Make sure the reader is connected to the computer and powered on before choosing “Read Response Forms” so LXR•TEST can program the reader. If the reader is powered off while reading forms, the programming commands sent to the reader are lost and the read cycle must be restarted by choosing “Read Response Forms” again.

Fill the hopper with the forms before using the “Read Response Forms” menu item. Forms are loaded so that they enter the reader with the side to be read face-up and the timing marks on the forms at the bottom.

After each form is read, the message “Feed Form” appears on the reader. If an automatic feeder is used, the forms will be fed into the reader automatically. If manually feeding, load a form so it will be ready to be read any time the “Feed From” message is displayed on the reader. After the last form has been fed, press the “END” switch to indicate the last form has been read. After pressing it, the display on the reader should indicate “Ready” and the program exits the read cycle. The “END” switch is effective only when the “Feed Form” message is displayed in the LCD display. If the “Ready” message does not appear when you press “END” wait for the “Feed Form” message and then press it again.

If you are using a reader that does not have a display window, you will not see the message on the reader as described above. You will need to observe the status of the “Ready” lamp to determine the reader status. Refer to the Scanmark user’s guide for the status display indications.

If your reader has only 1 read head and the form has multiple sides, you may be prompted for the side of the form you are about to read. If your reader has 2 read heads, you may be prompted for the side you intend to read if the form does not have unique side identification information on it.

When a 2000 series reader is connected to the PC serial port and is powered on, you may see a message “Framing Error” flickering on the display of the reader. This is normal. As soon as the “Read Student Responses” menu item is selected, the serial port is initialized and the reader should indicate “Ready” and begin reading forms.
LXR•TEST Software Setup

Under Reader and Form Setup (Reader menu), select the Reader Setup tab to choose your reader and to configure LXR•TEST to properly communicate with your reader.

In the Reader Setup tab, start with the settings as follows (unless your hardware manual or current configuration is different):

<table>
<thead>
<tr>
<th>Table 31: Scantron Scanmark 2000 Series Communications Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Word Length (Data Bits)</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Minimum Read Level</td>
</tr>
<tr>
<td>Mark Difference</td>
</tr>
</tbody>
</table>

Press the Test Current Settings button to verify that the reader is communicating. You should notice the green SEND and RECEIVE lamps flash on the reader. After communications are verified, press Apply to save the reader settings.

Select the Form Setup tab to select your form and to configure LXR•TEST to properly read your form. Refer to Chapter 10: “Mark Reader Installation” on stepping through the Reader and Form setup process.

The optional reject stacker is supported for the Scanmark 2500 reader.
Appendix F:
Sample Forms

The following contains images of mark reader forms available directly from LXR. These forms are designed to take optimum advantage of LXR•TEST’s features. Numerous other forms are available from other sources. Refer to our web site at www.lxr.com for the latest information concerning supported OMR forms.
Figure 145: LXR•TEST Response Form 26133
# Appendix G:
## Keyboard Shortcuts

<table>
<thead>
<tr>
<th>File menu:</th>
<th>Key Equivalent:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open...</td>
<td>CTRL+O</td>
</tr>
<tr>
<td>Save...</td>
<td>CTRL+S</td>
</tr>
<tr>
<td>Exit</td>
<td>ALT+F4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edit menu:</th>
<th>Key Equivalent:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>CTRL+Z</td>
</tr>
<tr>
<td>Redo</td>
<td>CTRL+Y</td>
</tr>
<tr>
<td>Cut</td>
<td>CTRL+X</td>
</tr>
<tr>
<td>Copy</td>
<td>CTRL+C</td>
</tr>
<tr>
<td>Paste</td>
<td>CTRL+V</td>
</tr>
<tr>
<td>Select All</td>
<td>CTRL+A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Questions Window:</th>
<th>Key Equivalent:</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Question</td>
<td>CTRL+N</td>
</tr>
<tr>
<td>Duplicate Question...</td>
<td>CTRL+D</td>
</tr>
<tr>
<td>Delete Question...</td>
<td>CTRL+K</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Show/Hide (Horizontal) Text ruler</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Show/Hide Invisible Characters</td>
</tr>
<tr>
<td>Next Edit Box</td>
<td>TAB</td>
</tr>
<tr>
<td>Prior Edit Box</td>
<td>SHIFT+TAB</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Go to Beginning of Text</th>
<th>Go to End of Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+Home</td>
<td>CTRL+End</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Move graphic up 10 Pixels*</th>
<th>Move to Tab marker</th>
</tr>
</thead>
<tbody>
<tr>
<td>↑</td>
<td>CTRL+T</td>
</tr>
<tr>
<td>Move graphic down 10 Pixels*</td>
<td>Next Area</td>
</tr>
<tr>
<td>↓</td>
<td>F6</td>
</tr>
<tr>
<td>Move graphic left 10 Pixels*</td>
<td>Previous Area</td>
</tr>
<tr>
<td>←</td>
<td>SHIFT+F6</td>
</tr>
<tr>
<td>Move graphic right 10 Pixels*</td>
<td></td>
</tr>
<tr>
<td>→</td>
<td></td>
</tr>
</tbody>
</table>

*Note*: Graphics can also be moved 1 pixel at a time by holding the CTRL key while pressing the direction arrows.
### Font/Size/Style menu:

<table>
<thead>
<tr>
<th>Font/Size/Style menu</th>
<th>Key Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>CTRL+P</td>
</tr>
<tr>
<td>Bold</td>
<td>CTRL+B</td>
</tr>
<tr>
<td>Italic</td>
<td>CTRL+I</td>
</tr>
<tr>
<td>Underline</td>
<td>CTRL+U</td>
</tr>
<tr>
<td>Superscript</td>
<td>CTRL+H</td>
</tr>
<tr>
<td>Subscript</td>
<td>CTRL+L</td>
</tr>
<tr>
<td>Larger Font Size</td>
<td>CTRL+ALT+&gt;</td>
</tr>
<tr>
<td>Smaller Font Size</td>
<td>CTRL+ALT+&lt;</td>
</tr>
</tbody>
</table>

### Utilities menu:

<table>
<thead>
<tr>
<th>Utilities menu</th>
<th>Key Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Changes</td>
<td>CTRL+M</td>
</tr>
</tbody>
</table>

### Help menu:

<table>
<thead>
<tr>
<th>Help menu</th>
<th>Key Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context Sensitive Help</td>
<td>F1</td>
</tr>
</tbody>
</table>

### Question Selection:

<table>
<thead>
<tr>
<th>Question Selection</th>
<th>Key Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection Window</td>
<td>CTRL+G</td>
</tr>
<tr>
<td>Select One</td>
<td>CTRL+A</td>
</tr>
<tr>
<td>Select All</td>
<td>CTRL+;</td>
</tr>
<tr>
<td>Select Inverse</td>
<td>CTRL+ALT+N</td>
</tr>
<tr>
<td>Clear Selection</td>
<td>CTRL+-</td>
</tr>
<tr>
<td>Find A Question</td>
<td>CTRL+F</td>
</tr>
</tbody>
</table>

### Question Navigation:

<table>
<thead>
<tr>
<th>Question Navigation</th>
<th>Key Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Question</td>
<td>CTRL+ALT+→</td>
</tr>
<tr>
<td>Last Question</td>
<td>CTRL+ALT+←</td>
</tr>
<tr>
<td>Next Question</td>
<td>ALT+→ or ALT+↑ or Page Down</td>
</tr>
<tr>
<td>Previous Question</td>
<td>ALT+← or ALT+↓ or Page Up</td>
</tr>
</tbody>
</table>

**Note:** Some keyboard shortcuts are not listed. To activate these, follow standard Windows keyboard-shortcuts protocol: press “ALT” to activate menu control, then press the key of the underlined letter corresponding to the desired choice.

For example, to insert a floating graphic, press “ALT”, then “I” to activate the Insert menu, and then “H” to insert the floating graphic.
CAUTION! Installation of a web server introduces security risks to a network. Prior to installation, check with your local security administrator to ensure you follow all security policies established for your site and you understand the security implications involved.

In order to administer web tests, Microsoft Internet Information Server (IIS) v4.0, or later version, must be installed on the server. When installing IIS, it is recommended that you write down the name of your computer for later reference (e.g., myserver). You must be logged on as an administrator of the local machine to install or administer IIS. These are the minimum required components:

<table>
<thead>
<tr>
<th>NT 4.0, IIS installed from the NT 4.0 Option Pack:</th>
<th>Windows 2000, IIS installed from the Control Panel, Add/Remove Programs:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a)  Internet Information Server (IIS) 4.0</td>
<td>a)  Internet Information Server (IIS) 5.0</td>
</tr>
<tr>
<td>Required subcomponents:</td>
<td>Required subcomponents:</td>
</tr>
<tr>
<td>Internet Service Manager</td>
<td>Common Files</td>
</tr>
<tr>
<td>World Wide Web Server</td>
<td>Internet Information Service Snap-In</td>
</tr>
<tr>
<td></td>
<td>World Wide Web Server</td>
</tr>
<tr>
<td>b)  Microsoft Data Access Components 1.5</td>
<td></td>
</tr>
<tr>
<td>Required subcomponents:</td>
<td></td>
</tr>
<tr>
<td>Data Sources</td>
<td></td>
</tr>
<tr>
<td>MDAC: ADO, ODBC, and OLE DB</td>
<td></td>
</tr>
<tr>
<td>c)  Microsoft Management Console</td>
<td></td>
</tr>
<tr>
<td>d)  NT Option Pack Common Files</td>
<td></td>
</tr>
</tbody>
</table>
After installing any components to the Windows Operating System, it is recommended that you reinstall the latest service pack. For Windows NT 4.0, you should install service pack 5 or later.

Note: If you install IIS after installing the LXR•TEST Web Server Extensions package, you should remove and reinstall the Web Server Extensions package to ensure that you have the latest MDAC components and that the LXRWeb virtual directory is setup correctly.

After installing both IIS and the Web Server Extensions package, manual configuration is required for web testing feature to run:

**Caveat!** Each testing environment is different. The following steps are general guidelines for use only in a controlled intranet for testing purposes. You may need to adjust the share permissions and file security permissions to match the security policy at your particular site.

### Setting Up the LXRWeb Folder as an Application Under IIS

Note: The Web Server Extensions component has been programmed to automatically set up the LXRWeb folder as a virtual directory under IIS. In the event that the virtual directory is not properly set up – this could be due to corruption in the IIS setup – you may have to manually set up the virtual directory via the following steps.

1. Log into your NT Server as an Administrator.

2. Launch the Internet Services Manager program, usually located under Start > Programs > Windows NT 4.0 Option Pack > Microsoft Internet Information Server > Internet Service Manager (for 2000: Start > Settings > Control Panel > Administrative Tools > Internet Services Manager).

3. When in the Manager program, under the Internet Information Server folder (for 2000, under Internet Information Services), expand the name of your server.

4. Expand the Default Web Site folder.
5. Notice that the LX RWeb currently has a folder icon by its name. Right-click on LX RWeb, choose Properties.

6. Within the Directory tab (for 2000, called Virtual Directory), click on the Create button.

7. Verify that the Name field (for 2000, called Application Name) in the Applications Settings section is LX RWeb (enter this if name is missing) and click OK (notice that LX RWeb now has a package icon by its name). (If LX RWeb has a folder icon instead of the package icon, web tests will not work properly.)

8. Click on the computer name in the left panel. Verify that the state for the Default Web Site is shown as Running in the right panel. If not, select the Default Web Site and click the Right arrow to start it.

Setting Sharing Permissions

(To setup a network share to allow administrative access to LX R•TEST data files over the LAN.)

9. Navigate to the IIS directory via Windows Explorer or My Computer; default directory is C:\Inetpub\wwwroot

10. Notice that LX RWeb currently has a folder icon by its name. Right-click on the LX RWeb folder, select Properties

11. Select the Sharing tab

12. Select "Shared As" (for 2000: select "Share this folder")

13. Click the Permissions button

14. Determine the users and/or groups you want to allow network access to the LX R•TEST data files through this share. If you are working in a controlled environment with no security concerns, you can give Full Control to the “Everyone” group. For any other situations, you should limit access to specific users and/or groups such as yourself and other instructors who will be building and maintaining the web tests. Determine the type of access you will provide to user and/or group names.

15. Click the Add button to display the list of users and groups to select from. Press the Show Users button to display user names (this feature not in 2000). (If you are using multiple domains, you may have to change the domain name in the upper list box to show names and groups from other domains.) Add the users and/or groups to whom you want to provide access through this share and set the desired type of
access for each user/group. Normally, you will want to include your personal account or group set to ‘Full Control’ access. Other groups will usually only need ‘Change’ access.

16. After you have added the users and/or groups and configured their respective file access types, click OK three times (only two times in 2000). Notice that the LXRWeb folder now includes a hand in the icon, indicating that the folder now has Shared status; other users will now be able to access files within the LXRWeb folder via the network.

### Setting File Permissions

**Note:** This part only applies if the disk has been formatted in NTFS format. Without NTFS format, you will have limited options to control user access. It is strongly recommended that you use NTFS format.

17. Right-click on the LXRWeb folder again, select Properties

18. Select the Security tab

19. Click the Permissions button (no need in 2000)

20. Ensure that both ‘Replace Permissions on Subdirectories’ and ‘Replace Permissions on Existing Files’ are checked (for 2000: need to check “Allow inheritable permissions from parent to propagate to this object”)

21. Determine which users and/or groups will have permission to access the files and folders within the LXRWeb folder and subfolders. This step allows you to set much finer controls to file access, if desired, than the (above-mentioned) network share permission allows. Typically, you will include the same users and/or groups that were added in the network share permission steps (as described above) and provide them ‘Change’ access. You will also add limited access to the students/users to take the test over the web.

22. If you are working in a controlled environment with no security concerns, then you may want to leave the default permissions which allows the Everyone group Full Control. Verify that the Everyone group has Full Control. If so, skip to step 24.

23. For any other situation, you should set the file permissions to limit access to only the required users and groups in the following steps:
• Highlight (select) the Everyone group and press Remove to eliminate this group.
• Click Add.
• Set the access type to Full Control.
• Include the User Names or Group Names that require Full Control for Web test administration, such as your personal account or group, and other instructors. You must also add the built-in SYSTEM account and the local Administrators Group account, from the local domain, with Full Control permissions.
• If the desired accounts are not listed, be sure you have the correct domain selected in "List Names From:" list box. Press the Show Users button (for NT4 only).
• Press OK to add the users/groups.

24. The anonymous account used by the IIS server for web users must have access to the data files in order to allow users taking tests over the web to access the files. The account IUSR_computername is automatically created when IIS is installed. Click Add. Select the Internet Guest Account IUSR_computername (where computername is the name of your computer, as recorded earlier) from the appropriate domain list. If the IUSR_computername is not listed, be sure you have the correct domain selected from the "List Users From:" list box, and pressed the Show Users button. Set Type of Access to ‘Change’ and press OK. (for 2000: check "Modify")

25. (The following step is not needed for 2000:)

After all users/groups have been entered and the corresponding permissions appropriately set, press OK to close the Directory Permissions dialog box. A prompt will ask if you intend to change all files and folders, answer Yes. This will change the file permissions for the LXRWeb folder and all files and subfolders within.

26. Click OK to close the properties box for the LXRWeb folder.

For more precise control of NTFS file permissions, the following general rules apply for access by Web test users (i.e., students) accessing the web server anonymously under the IUSR_computername account:

<table>
<thead>
<tr>
<th>Permissions:</th>
<th>Applies to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read &amp; Execute, and Write</td>
<td>Any folders containing any LXR•TEST database (Grading Tables, Headers, Scores, Online, Students); <strong>Online and Scores database files also need Read &amp; Execute, and Write permissions</strong></td>
</tr>
<tr>
<td>Read and Write</td>
<td>Any LXR•TEST database file (<em>.LXR</em>), except Online and Scores databases (see above)</td>
</tr>
<tr>
<td>Read</td>
<td>Images, image folders, *.htm files, *.asp files, *.jpg files, *.gif files</td>
</tr>
</tbody>
</table>
Appendices

Note: Improper permission settings may cause unpredictable results.

Installation Checklist Summary:

- IIS installed with the latest Service Pack (steps 1-3)
- LXR•TEST Web Server Extensions have been installed
- LXRWeb folder when viewed with the IIS console has the package icon (steps 4-7)
- Default Web Server is running (step 8)
- LXRWeb folder (C:\Inetpub\wwwroot\LXRWeb) is being shared for LXR•TEST access on the LAN and shows the sharing icon (steps 9-16)
- NTFS file permissions have been set to allow access to the web application account IUSR_computername (steps 17-26).

Note: Each testing environment is different. The above steps are general guidelines for use only in a controlled intranet for testing purposes. You may need to adjust the share permissions and file security permissions to match the security policy at your particular site.
Appendix I: Error Handling

LXR•TEST 6.0 has been designed and programmed, to the best of our abilities, to prevent the occurrence of error conditions during program use. Notwithstanding our best efforts, you can take steps to assist in error-free operation by properly maintaining your software and files.

Note: Additional troubleshooting documentation can be found in the support section of our web site (www.lxr.com).

Incompatible Programs

In our encounter of problems in over 15 years of developing LXR•TEST, the most frequent sources of problems were incompatibilities with other applications - particularly system programs. If you encounter a problem with LXR•TEST, your first step should be to disable any (or preferably all) other memory - resident programs and see if the problem persists.

Insufficient Memory

A second leading source of problems stems from insufficient allocated memory to LXR•TEST, typical when working with large graphic files. If you use large graphics (or movies) - or work with large question banks (thousands of questions) - make sure you have enough random-access memory (RAM).

Corrupt Files

If your PC frequently crashes, you can be assured that your files, including LXR•TEST program and datafiles, will eventually become corrupted. As good protective maintenance, you should periodically use Scandisk (or a comparable disk scanning product, such as Norton Utilities). Such system maintenance applications are good at spotting - and correcting - disk problems that can adversely affect all of your applications.

Should LXR•TEST have trouble reading a questions file, it may be because one or more of your questions is likely to be corrupt. Your course of action should first be to quit LXR•TEST and
make a copy of the questions file. Next, you should re-run LXR•TEST and use the Repair Database option (Utilities menu) to have LXR•TEST attempt to correct the problem.

Note: In general, it’s good maintenance to periodically use the Compact (or Repair) Database option (Utilities menu) to eliminate unneeded database space consumed by deleted questions.

If you are able to open the questions file, but cannot rebuild it, you should try selecting all the questions you can and exporting these to a new questions file.

Viruses

While computer viruses get a lot of press, our experience has demonstrated that they are the least frequent cause of system (and subsequently LXR•TEST) problems. However, installing and maintaining a reliable, virus-checking application is your best insurance against virus related problems. Good insurance is to always avoid software from unknown and unreliable sources.

Backups

Regardless of the stability and security of your computer, there is no substitute for a regular backup of all your data files!

If these remedies fail to solve your problem, please notify us and we will diligently work with you to get you back to normal (and correct) LXR•TEST operation as soon as possible.
LXR•TEST 6.0 uses the Microsoft Access database engine. As such, LXR•TEST databases can be upsized to Microsoft SQL Server format. This appendix serves as quick reference for the upsizing process. You may want to consult other Access and SQL Server references for further discussion.

Note: LXR•TEST incorporates Microsoft JET engine database technology which is intended for use by small workgroups. This is the same database engine used by Microsoft Access 2000. The actual number of users that can be supported by this engine depends on your network and computers. The maximum number of users is typically less than 20. If you need to support a larger number of users, you will need Microsoft’s SQL Server database technology. SQL Server database technology provides virtually unlimited scalability. All LXR•TEST databases can easily be upsized for use with SQL Server.

Microsoft SQL Server

Note: Procedures for upsizing LXR•TEST databases to SQL Server 2000 format are documented on our web site (www.lxr.com), in the support section.

Microsoft SQL Server 7 needs to be installed and set up on your server. Contact your SQL Server Administrator to verify the proper database location(s) and permission(s) have been set up on the server.

Microsoft Access

Microsoft Access 2000 needs to be installed on a workstation computer. Also, the Upsizing Wizard component needs to be installed.
To install the Upsizing Wizard:

- Have an Access database open.
- From the Tools menu, choose Database Utilities → Upsizing Wizard.
- You will be prompted to install Upsizing Wizard from the appropriate CD. Follow the installation instructions.

Upsizing Wizard

- Within Access, open the LXR•TEST database you want to upsize to SQL Server format.
- From the Tools menu, choose Database Utilities → Upsizing Wizard.
- Select Create new database. Click Next.
- Select your SQL Server from the drop-down list.
- Type in your login ID and password.

Note: You will need to verify with your SQL Server administrator the login procedure you need to follow. For instance, you may (or may not) need to use a “trusted connection” in order to login.

- Type in a name for the new SQL Server database to be created. Click Next.
- Click the double right direction arrow >> to move all Available Tables to the right panel (labeled Export to SQL Server). Click Next.

  All table attributes must be selected (i.e., indexes, validation rules, defaults, and table relationships). Choose the “Use triggers” option, let the upsizing wizard decide whether to “add timestamp fields to tables”, and leave unselected the option “Only create the table structure; don’t upsize any data.” Click Next.

- Verify that No application changes is selected. Click Next.
- Click Finish to begin the upsizing process. A report of the upsizing process is displayed upon completion.
Creating a Data Source Name (DSN)

Now that your LXR•TEST database has been upsized to SQL Server format, you need to create a DSN to reference the SQL Server database, located on your server.

- Navigate to Start ➔ Settings ➔ Control Panel ➔ ODBC Data Sources. (for 2000: Start ➔ Programs ➔ Administration Tools ➔ Data Sources (ODBC).)
- Click on the File DSN tab.
- Click Add. Select the SQL Server driver. If this driver is not listed, then you need to install the missing ODBC drivers.
- Click Next. Enter a filename to save this DSN. You can accept the default location in the Data Sources folder, or choose a different location. (Remember the data source name for later use.) Click Next.

Tip! Choose a DSN name that is suggestive of the nature of the SQL Server database. This DSN name will display when you click the ODBC button in the Open Database dialog box within LXR•TEST.

- Review the data source settings and click Finish.
- The Create a New Data Source to SQL Server wizard will ask you for further information. Type in a brief description if you desire.
- Choose the name of the SQL server where you created the SQL Server database. The server name appears in the drop-down list box.
- Click Next. Select the authentication method compatible with your SQL server. If your server is using Integrated Security, then select With Windows NT authentication using the network login ID. Click Next.
- Check the box for Change the default database to and select the name of the SQL Server database you created on the server. Leave the other options unchanged. Click Next.
- Verify that Perform translation for character data is checked. Click Finish.
- Within ODBC Microsoft SQL Server Setup click on the Test Data Source button. If it reports that tests completed successfully, press OK three times to exit.

If you did not get a successful connection to the server, review/repeat the above steps with your database administrator until you make a successful connection.
Opening the LXR•TEST 6.0 SQL Server database

- Within LXR•TEST, click on the LXR•TEST Toolbar button that corresponds to the database type of the SQL Server database, e.g., Scores.
- Within the dialog box, click on the ODBC DSN button.
- Log into the SQL server.
- Within the File Data Source tab, select the DSN corresponding to the database you want to open. Click OK.

Congratulations! You have successfully upsized an Access database to SQL Server.
End User License Agreement (EULA)

READ THIS CAREFULLY! Prior to installing or using the software you must agree to accept the following Agreement.

End User License Agreement (EULA) for:

LXR*TEST 6.0
Software Product
IMPORTANT NOTICE!

This Agreement is a legal contract between you -- either an individual or a single, legal entity (referred to herein as an organization) -- and Logic eXtension Resources Division of Applied Measurement Professionals, Inc. (referred to herein as LXR). Your installation or use of the software indicates your agreement, as an individual or as an authorized representative on behalf of the organization, to be bound by the terms and conditions of this Agreement.

If you do not agree to these terms, you must promptly delete all electronic copies of the software and return within 10 days any related media or documentation to the place from which you obtained it for a refund of the license fee.

Definitions.

"Software" means the software product identified above and consists of computer software, associated media, and documentation (which includes the user’s guide and other printed materials).

"Primary user" means a single person designated by the licensee or, if the licensee is an individual, the licensee, to use the product and to serve as the registered point of contact and administrator of the license.

"Secondary user" means one or more additional persons employed by or under contract with the licensee to use the product for the direct benefit of the licensee. Secondary users are not entitled to any warranty software support, upgrades, or revisions.
"User" means either a primary or secondary user as defined above.

"You" and "your" means either you, the individual licensee, or an authorized representative of the licensee organization.

"We", "our", and "us" means Logic eXtension Resources (LXR), a division of Applied Measurement Professionals, Inc.

License Grant.

In consideration for your payment of the licensing fee(s), Logic eXtension Resources grants you the following nonexclusive rights:

Installation and Use.

Primary and second users may install the software and documentation on a single computer for their exclusive use. Provided the software is accessible exclusively by the user, the user may also install the software on at most one additional computer (typically a portable or home computer).

A primary or secondary license fee must be paid for each user and each must accept the terms and conditions of this agreement. If the software is accessible to a greater number of individuals than are licensed, then you agree to maintain, in writing, a list of licensed users and a policy for restricting use only to these users. You agree to promptly make this information available to LXR upon request.

You may authorize a permanent transfer of primary or secondary user rights from one individual to another, provided that such rights are not transferred more than twice per year. If the software is an update, any transfer must include the update and all prior versions. You agree to notify us of a transfer involving the primary user.

No Rental.

You may not rent, lend, or lease the software.

Server Software.

A separate server license fee is required for each server when any software or databases are installed or used on that server. For each server license fee, you must have paid at least one primary user license fee for the location. You can purchase additional server license fees for a location without necessarily having to pay additional primary user license fees for each additional server.
Evaluation Software.

Certain elements of the software products are offered for "evaluation". Evaluation software must be used solely for your own, internal, non-commercial, evaluation purposes. Evaluation software may not be transferred. These products are subject to the same terms and conditions as other products except there may be no license fee. If you obtain an evaluation product, you agree, within 30 days of receipt, to delete all electronic copies of the software and return, at your expense, any related media or documentation, if any, to the place from which you obtained it. Subsequent receipts, downloads, or installations do not extend, renew, or restart this term. LXR DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, OF THE EVALUATION SOFTWARE, INCLUDING WITHOUT LIMITATION WARRANTIES OF MERCHANTABILITY AND OF FITNESS FOR A PARTICULAR PURPOSE. THE EVALUATION SOFTWARE IS PROVIDED "AS IS."

Term.

Except as provided for evaluation software, the license will continue until it is terminated. LXR may terminate the license if you fail to comply with the terms of this agreement. You may terminate the license at any time for any reason. Upon termination by either party, you must promptly return to LXR or destroy the software and all copies and extracts.

Electronic Redistribution of "Run-Time" Software.

For a distribution fee, you may reproduce and distribute certain software components identified by LXR as "run-time" software, in their entirety, with your content, up to the number of distribution instances for which you are licensed. (Typically an "instance" would be a disk or an e-mail containing a minimum set of software components that would permit the use of your content for an exam on a remote machine.) However, if you are an employee of an accredited school, college, or university, as described on LXR's web site, there may be no charge for you to redistribute run-time software, provided that you receive no remuneration or other consideration whatsoever related to the redistribution. However, LXR reserves the sole right to determine eligibility and fees for redistribution. LXR DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, OF THE RUN-TIME SOFTWARE, INCLUDING WITHOUT LIMITATION WARRANTIES OF MERCHANTABILITY AND OF FITNESS FOR A PARTICULAR PURPOSE. THE RUN-TIME SOFTWARE IS PROVIDED "AS IS." LXR SPECIFICALLY DOES NOT OFFER SUPPORT TO RECIPIENTS OF THE RUN-TIME SOFTWARE.

No Additional Licenses.

All rights to the software and documentation not expressly granted under this Agreement are reserved to LXR. You may not translate, decompile, disassemble or reverse engineer the software or documentation. This Agreement does not authorize you to use LXR's name or any of its trademarks (which include, but are not limited to the words "Logic eXtension Resources", "LXR", the LXR logo, "LXR*TEST", and the "LXR*TEST" logo).
Optional Software.

The software may include other, separately priced "optional" software components (e.g., online testing option and mark reader option). If the license fees for one or more of these optional components are paid, that component is considered part of the software product for purposes of this license and treated accordingly. No upgrade purchases may be made for any optional software unless concurrent upgrades are purchased for all related licensed products. Any authorized secondary user may also use any optional software licensed for the primary user.

Software Version and Serial.

You will receive a product serial number for each primary user fee. All secondary users, all servers, and all distribution instances (if any) will be identified by and associated with a primary license serial number for the software product. Each major software component has a version number (e.g., 6.0). Your license entitles you to install and use a product with the same or lower version number (e.g., if your version is 6.0, you may use 5.1 or 6.0 but not 6.1). LXR may periodically make available revisions (e.g., 6.0.1 or 6.0.2.2) which you may be eligible to receive during the initial warranty period and certain extended support periods, if any. Although you may be entitled to use an older version, LXR does not offer any warranty or support for any version other than the current shipping version.

Upgrades and Revisions.

An upgrade is a new release of the software that may contain additional features for an upgrade fee. A revision is a new release of the software that may contain software corrections and is typically made available at either no cost or a nominal cost, solely as determined by LXR. If software is identified as an upgrade or revision, you must be properly licensed to use it. Only you or the primary user may order or authorize the installation of software upgrades, either through proof of ownership or by properly registering the product. If an upgrade is purchased for the primary user, all eligible secondary user, server, and optional software upgrade fees must be paid concurrently, or the related rights will be cancelled.

Copyright.

The software is licensed, not sold. Title to and copyright in the software, and in any copies you are permitted to make, are owned by LXR and its suppliers and are protected by United States copyright laws and international treaty provisions. You must treat the software like any other copyrighted material (e.g., a book or recording) except that you may make one copy solely for backup or archival purposes. Specifically, you may not, without LXR’s written consent, copy or reproduce the software (except a single copy for backup or archival purposes); distribute it by sale, lending, sublicensing, renting, or the like; or prepare derivatives. You may not copy the documentation.
Export Restrictions.

The software is intended for distribution only in the U.S. and Canada. Export of the software from the United States is regulated. You agree that you will not directly or indirectly export or re-export the software to any other country unless you have received the proper export licenses.

Multiple Media.

Although you may receive the software in more than one medium (floppy disk, CD-ROM, or through one or more downloads), additional media do not of themselves convey additional licenses. You have only the licenses that you have properly purchased, regardless of the media format or quantity.

Not-For-Resale (NFR) Software.

If your software is labeled "Not-For-Resale" or "NFR", your license permits use only for demonstration or evaluation of the software, and you are not eligible for upgrades or support. LXR DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, OF "NOT-FOR-RESALE" PRODUCTS, INCLUDING WITHOUT LIMITATION WARRANTIES OF MERCHANTABILITY AND OF FITNESS FOR A PARTICULAR PURPOSE. THE "NOT-FOR-RESALE" SOFTWARE IS PROVIDED "AS IS."

Software Support and Training.

Except as otherwise indicated, LXR will provide no-charge support for the software by telephone or e-mail to the primary user for a period of 90 days from the date of delivery. You are responsible for the cost of any telephone or other communications costs that may be associated with the support. LXR may offer extended period support plans to the primary user on a fee basis. Although secondary users are not entitled to software support, LXR may also offer additional support plans to secondary users on a fee basis. No training is included with any software.

Warranties and Remedies.

Except for the evaluation software, LXR warrants that the physical media and the documentation will be free from defects in materials and workmanship under normal use for 90 days from the date of delivery to you. LXR also warrants for this same 90-day period that the software will perform free from defects that prevent the software from performing substantially in the manner described in the user’s guide. If, within the 90 days, you describe such a defect in writing to LXR, and provide sufficient electronic data to support a machine reproducible example, LXR’s sole responsibility shall be, at its option (i) to replace defective media or documentation, as the case may be, (ii) to use reasonable efforts to correct the defect in the software without charge, or (iii) to refund the license fee paid to it, if any, for the applicable copy of the software and terminate all licenses granted to you. Any replacement
software will be warranted for the remainder of the original warranty period or 30 days, whichever is longer.

By way of example, without limitation, LXR provides no warranties of any kind to any end-users accessing or otherwise using applications developed or otherwise obtained by you. LXR’s warranties do not cover damage or defects caused by or related to misuse, accident, negligence or misapplication. Because programs such as this are inherently complex, LXR does not warrant that the software is error-free or will operate without interruption. Furthermore, LXR does not warrant that the software will work with any given database, network or network application. You acknowledge that, due to the complexity of the software, it is possible that use of the software could lead to the unintentional loss or corruption of data. You assume all risks of such data loss or corruption; the warranties provided in this Agreement do not cover any damages or losses resulting from data loss or corruption.

THE REMEDIES SET FORTH ABOVE WITH RESPECT TO IDENTIFIABLE DEFECTS SHALL BE THE EXCLUSIVE REMEDIES FOR ANY BREACH OF WARRANTY WITH RESPECT TO THE SOFTWARE.

THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTY OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Limitation on Liability.

IN NO CASE SHALL LXR BE LIABLE FOR ANY INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES OR LOSS, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR THE INABILITY TO USE EQUIPMENT OR ACCESS DATA, WHETHER SUCH DAMAGES ARE BASED UPON A BREACH OF EXPRESS OR IMPLIED WARRANTIES, BREACH OF CONTRACT, NEGLIGENCE, STRICT TORT, OR ANY OTHER LEGAL THEORY. THIS IS TRUE EVEN IF LXR IS ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO CASE WILL LXR’S LIABILITY EXCEED THE AMOUNT OF THE LICENSE FEE(S) ACTUALLY PAID BY YOU TO IT.

SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE WARRANTY LANGUAGE ABOVE MAY NOT APPLY TO YOU. IN SUCH A CASE, THE ABOVE LIMITATION OF REMEDIES PROVISION SHALL STILL APPLY.


If the software is licensed under a U.S. Government contract, you acknowledge that the software and related documentation are "commercial items," as defined in 48 C.F.R. 2.01, consisting of "commercial computer software" and "commercial computer software documentation," as such terms are sued in 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1. You also acknowledge that the software is "commercial computer software" as defined in 48 C.F.R. 252.227-7014(a)(1). U.S. Government agencies and entities and others acquiring under a U.S.
Government contract shall have only those rights, and shall be subject to all restrictions, set forth in this Agreement.

**Governing Law.**

This Agreement is governed by the laws of the State of Kansas, United States of America.

**Assignment.**

You may not, without the prior written consent of LXR, assign, delegate or transfer this Agreement or any rights or obligations hereunder.

**Severability.**

Should any part, term or provision of this Agreement be declared, illegal or in conflict with any law, rule, or regulation, the validity of the remaining portion, terms, or provisions shall not be affected thereby and such invalid, illegal or unenforceable provision shall be replaced by such valid, legal and enforceable provision which comes closest to the intention of the parties underlying the invalid, illegal or unenforceable provision.

**Entire Agreement.**

The terms and conditions contained herein constitute the entire agreement between you and LXR and supersede all prior and contemporaneous written and oral agreements, understandings, representations, and discussions, whether oral or written, relating to the subject matter hereof, except as specifically referenced herein.

**Headings.**

The headings or captions are used for convenience only and are not to be used in attempting to construe any part of this Agreement.

**Interpretation.**

Unless the context indicates otherwise, words importing the singular number shall include the plural and vice versa, and words importing person shall include firms, associations, partnerships, limited liability companies and corporations, including public bodies and entities, as well as natural persons, and words of masculine gender shall be deemed and construed to include correlative words of the feminine and neuter genders and vice versa.
Amendment; Waiver.

None of the provisions of this Agreement may be amended without the written consent of LXR. Any waiver by LXR of any provision or condition of this Agreement shall not be construed or deemed to be a waiver of any other provision or condition of this Agreement, nor a waiver of a subsequent breach of the same provision or condition, unless such waiver be so expressed in writing and signed by LXR's authorized representative.

Binding Effect.

This Agreement shall be binding upon and inure to the benefit of and be enforceable by the legal representatives, successors or assigns of the parties.

Authority; Counterparts.

Any person accepting this Agreement in a representative capacity warrants and represents that such person has the authority to do so and, upon request, proof of such authority in customary form will be furnished.
<table>
<thead>
<tr>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equation Object</td>
<td>Factory Settings</td>
<td>GIF</td>
</tr>
<tr>
<td>Equator</td>
<td>Feedback</td>
<td>Global Changes</td>
</tr>
<tr>
<td>Error Handling</td>
<td>Feedback Area</td>
<td>Clear Statistics</td>
</tr>
<tr>
<td>Errors and Problems</td>
<td>File Dependencies</td>
<td>Columns</td>
</tr>
<tr>
<td>Export</td>
<td>HTML Files</td>
<td>Font/Size/Style</td>
</tr>
<tr>
<td>Gradebook Files</td>
<td>Merge Files</td>
<td>Question Type</td>
</tr>
<tr>
<td>Grading Table</td>
<td>Native Files</td>
<td>Reclassify</td>
</tr>
<tr>
<td>HTML Files</td>
<td>Rich Text Files</td>
<td>Reformat</td>
</tr>
<tr>
<td>Merge Files</td>
<td>Scores</td>
<td>Scramble</td>
</tr>
<tr>
<td>Native Files</td>
<td>Students</td>
<td>Search &amp; Replace</td>
</tr>
<tr>
<td>Online</td>
<td>Test Specifications</td>
<td>Glossary</td>
</tr>
<tr>
<td>Questions</td>
<td>Tests</td>
<td>Grade Test</td>
</tr>
<tr>
<td>Rich Text Files</td>
<td>Text Files</td>
<td>Gradebook Format</td>
</tr>
<tr>
<td>Scores</td>
<td></td>
<td>Grading Window</td>
</tr>
<tr>
<td>Students</td>
<td></td>
<td>Graphic Formats</td>
</tr>
<tr>
<td>Test Specifications</td>
<td></td>
<td>Headers Toolbar</td>
</tr>
<tr>
<td>Tests</td>
<td></td>
<td>Headers Window</td>
</tr>
<tr>
<td>Text Files</td>
<td></td>
<td>Help Menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HTML Format</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HTML Help</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Images</td>
</tr>
<tr>
<td>Import</td>
<td>20, 61, 62, 65, 66, 104, 145, 147, 157, 199, 374, 383</td>
<td></td>
</tr>
<tr>
<td>Answer Keys</td>
<td>199, 387</td>
<td></td>
</tr>
<tr>
<td>Grading Table</td>
<td>250</td>
<td></td>
</tr>
<tr>
<td>Merge Files</td>
<td>148</td>
<td></td>
</tr>
<tr>
<td>Native Files</td>
<td>147</td>
<td></td>
</tr>
<tr>
<td>Question Selection</td>
<td>149</td>
<td></td>
</tr>
<tr>
<td>Questions</td>
<td>145</td>
<td></td>
</tr>
<tr>
<td>Scores</td>
<td>235</td>
<td></td>
</tr>
<tr>
<td>Students</td>
<td>258</td>
<td></td>
</tr>
<tr>
<td>Test Specifications</td>
<td>208</td>
<td></td>
</tr>
<tr>
<td>Text Files</td>
<td>150</td>
<td></td>
</tr>
<tr>
<td>Inline Format</td>
<td>20, 51, 114, 156, 159</td>
<td></td>
</tr>
<tr>
<td>Inline Graphics</td>
<td>161</td>
<td></td>
</tr>
</tbody>
</table>
Index | 507

Inline Objects ................................. 162
Insert Menu ...................................... 262
Insert Question.................. See Question Menu:
  Resequence Insert
Inserting Equations ....................... 67
Inserting Graphics ............................ 51
Inserting Objects ............................... 162
Installation
LXRTEST .......................................... 23, 26
Mark Reader Option ............................. 327
Online Testing Option ......................... 275
Student LAN Client ............................ 278
Web Server Extensions ........................ 277
Introduction
LXRTEST .......................................... 17
Mark Reader Option ............................. 323
Online Testing Option ......................... 273
Item .................................................. See Question

J

JPEG ................................................. 20, 115, 161, 301, 307
JPG .................................................. See JPEG

L

Layout Toolbar ................................ 123
Left Panel...See Questions Panel, also Tests
  Window
Letter Answer ................................... See Choice
Letter Item Type .. See Question: Type: Free
  Format: Letter Response
Letter Response ............................... See Choice
Licensing ....................................... 497
Link Window ................................ 56, 57, 119, 165, 166
  Exclusive Linking ............................ 167
Hard, Inclusive Linking ....................... 58, 167
Soft, Inclusive Linking ........................ 166
Links .............................................. 55-60
Looking Up Student Information .... 95, 240
LXRTEST Toolbar ..................32, 71, 103, 105

M

Mac-to-Windows Bank Converter ......... 28
Mark Reader Option ............................ See Optical Mark
  Reader
MathType™ ......................................... 67
Merge Format  See Import: Merge Files also
  Export: Merge Files
Merge Student Scores .......................... 210, 243
MOV ............................................... 20
Movies .......................... See Multimedia Formats
Multimedia Formats .. See AVI, MOV, WAV

N

National Computer Systems 350, 351, 431,
  435, 439, 443
Navigation Toolbar ......................... 49, 120
New ............................................... 138
New Question .................. See Question Menu: New
  Notes ....................................... See Notes Area
  Notes Area ...................................... 116
Numeric Item Type .... See Question: Type:
  Free Format: Numeric Response

O

Objective ................................. 13, 32, 39, 47, 48, 114, 120,
  141, 143, 156
Objective Name ........ See Objective, also
  Question ID
ODBC ............................................... 106, 374, 485, 495
OLE ........................................... 20, 374, 485
OMR .......................... See Optical Mark Reader
OMR Form Description Files ................... 358
Online Testing Option  See also Online Tests
  Installation .................................. 275
Overview ....................................... 273
Reference ...................................... 299
Tutorial ......................................... 279
Online Tests 104, 166, 209, 210, 216, 314
  LAN
    Administering ................................ 278
    Creating ..................................... 285
  Web
    Administering ................................ 293
    Creating ..................................... 289, 292
  Online Toolbar ................................ 314
Online Window................37, 265, 273, 301
Open..................................................138
Open Ended Item Type See Question: Type:
  Free Format: Open Ended
Optical Mark Reader ...... 124, 125, 128, 323, 350, 374
  Forms ...........................................323, 327, 335
Menu..................................................345
Setup ...........................................351, 425
Option Button ......................85, 122, 181

Package Contents................25, 277, 329
Page Setup ....... See Question Setup: Margins
Password..... 157, 252, 286, 304, 318, 388
Paste ...........................................114, 115, 159, 483
Pick Button.................................191
Pictures ........................................... See Graphic Formats
Point-biserial Statistic........... See RPB
Preferences ...... 28, 42, 51, 104, 136, 153, 174, 186, 348, 360
Preparing a Questions Bank ........39
Preparing a Test........ See Creating a Test
Preslug...........................................256
Print
  Answer Key...........................................196
  Custom Header/Footer/Cover Page...261
Questions ............................................54, 139
Response Booklet..........................197
Test ..................................................194
Test Description...............................198
Print Columns ........ See Columns: 123
Projects Window... 31, 103, 107, 109, 281, 302, 310

Question
  Appearance.......................................41
  Classification ..................................40
  ID. 48, 71, 110, 114, 140, 148, 169, 375
  Selection See Selection Window
  Type .. 32, 123, 125, 132, 142, 190, 385
  Free Format ..................................125
Letter Response.................. 123, 126
Numeric Response.............. 123, 126
Open Ended .............................. 123, 125
Scientific Response ............ 123, 127
Short Answer ......................... 123, 126
Instruction .............. 48, 53, 123, 125, 135
Matching ......................... 76, 124, 130, 150
Multiple-choice
  Multiple Response .................. 133
  Single Response ........ 87, 133, 147
True/False ..................................124
Question Area .................... 114, 119
Question Links ..... See Links
Question Menu ...................... 168
Delete ...........................................168
Delete Selected ................. 168
Duplicate................................. 168
First ...........................................168
Last............................................169
New............................................168
Next..........................................169
Previous.................................169
Resequence Insert ..........................169
Resequence Remove .................169
Question Name........ See Objective
Question Navigation .............. 120
Question Number See Sequence
Question Selection ................. 170
Question Setup..... 41, 105, 136, 173, 179
  Category Titles......................... 177
  Copyright ......................... 177, 379
  Font/Size/Style...................... 121, 175
  Labels .................................. 175
  Margins ................................ 174
Question Toolbar . 53, 56, 57, 59, 86, 118
Question Type
  Free Format.............................. 374, 379
  Instruction ................. 197, 216, 377, 380, 385
  Matching 197, 205, 216, 324, 377, 379, 385
  Multiple-choice .................. 373, 375, 377
  Multiple Response 212, 216, 374, 385
  Single Response ........ 216, 375, 385
  True/False .................................. 197, 216, 373, 377
Questions Panel ...................... 192
Questions Toolbar ................. 117
UNC........ See Universal Naming Convention
Understanding Question Selection........ 85, 122
Undo.............................................. 145, 159, 483
Universal Naming Convention.............. 303
Updating Files........................................ 27
Updating Question Statistics.............. 241
Upsizing ........................................ 106, 277, 281, 285, 493
User's Guide ...................................... 11, 13
Utilities Menu 53, 104, 105, 173, 201, 242, 484

Variables.......... See Substitution Variables
Version Answers .......... 181, 183. See Test Versions
View Menu ........ 56, 57, 59, 104, 165, 239

WAV....................................................... 20
Window Menu .................................. 103, 172